EMC® ApplicationXtender®
Document Manager
5.40

User’s Guide
P/N 300-005-636
REV A01
# Contents

**Preface**

Chapter 1 **Getting Started**

- Introduction to ApplicationXtender Concepts ........................................ 18
- Content Organization in ApplicationXtender ........................................ 18
- Glossary of ApplicationXtender Terms ............................................. 18
- Document Storage Locations .............................................................. 23
- ApplicationXtender Components .................................................... 25
- Administrator Components .............................................................. 25
- User Components ............................................................................ 29
- ApplicationXtender License Server ................................................ 30
- ApplicationXtender on Your Network ............................................... 31
- How Documents are Stored and Displayed in AppXtender ............. 33
  - Supported Files ........................................................................... 34
  - Unsupported Files ........................................................................ 38
- Ways of Using ApplicationXtender ................................................ 40
- ApplicationXtender Modes of Operation ........................................ 40
  - ODMA ......................................................................................... 43
- Selecting Data Sources ..................................................................... 44
  - Locating Data Sources ................................................................ 45
  - Specifying a Default Data Source ............................................. 47
  - Specifying Multiple Data Sources .............................................. 48
- Starting ApplicationXtender Document Manager ............................ 50
  - Variations on Login Procedures ................................................. 52
  - New Login .................................................................................. 53
  - Logging into Multiple Data Sources .......................................... 55
  - Checking for Updates .................................................................. 57
  - Installing Updates from the Windows Task Bar .......................... 58
  - Automatically Monitoring for Updates ...................................... 59
Contents

ApplicationXtender Document Manager Views ................. 60
  Application View ....................................................... 61
  Query View .............................................................. 64
  Document Display View ............................................. 67
  Index View ............................................................... 68
  Workflow Workbox ..................................................... 71
  Thumbnail View ......................................................... 72

AppXtender Document Manager Toolbars ....................... 74
  Main Toolbar ............................................................ 74
  Annotation Toolbar .................................................... 77
  Image Toolbar ............................................................ 80
  Script Toolbar ............................................................ 82
  Batch Index Toolbar..................................................... 83
  Scan Toolbar ............................................................. 84

Function Keys ............................................................ 86

Chapter 2 Customizing Your AppXtender Document Manager Workstation

Change Password ......................................................... 88
  Disabling the Remember Password Option ..................... 89

Configuring Toolbars, Title Bar, and Status Bar ............... 90
  Displaying or Hiding a Toolbar ..................................... 91
  Changing the Size of Toolbar Buttons ......................... 92
  Customizing Toolbars ............................................... 92
  Configuring the Title Bar ............................................ 93
  Displaying or Hiding the Status Bar ........................... 95

Print Setup ......................................................................... 96

Using Sticky View .......................................................... 97
  Saving Sticky View Settings ....................................... 98

Customizing AppXtender Document Manager Views ........... 99
  Docking a View .......................................................... 99
  Displaying a View as a Dialog Box ............................... 101
  Displaying a View as Subwindow ................................. 102
  Hiding a View on Use .................................................. 103
  Activating AppXtender Document Manager Full Screen Mode .................................................. 104

Managing the Query View Result Set ............................ 104

Opening the Configuration Dialog Box .......................... 109
Contents

View Tab ........................................................................................... 110
  Image Size Options ................................................................. 110
  Zoom Settings are Pixels .......................................................... 111
  Scale-to-Gray ......................................................................... 111
  Use KeyView to Display Foreign Files ................................... 112
  Use Acrobat Reader to Display PDF Files ................................. 112
  Allow Map of Unknown Data Sources to Existing Data Sources ...................................................... 112
  Display Text View of Page ...................................................... 113
  Display Text View of Page ...................................................... 113
  Restore Last Layout at Startup ............................................... 113
Display Tab.......................................................................................... 114
  Screen DPI ................................................................................. 114
  PgUp/PgDn in Dual-Page View .................................................. 114
  Query Results .......................................................................... 115
Fonts Tab............................................................................................. 117
  Screen Fonts .............................................................................. 117
  Printer Fonts ............................................................................. 119
  Simulate Box Drawing Characters ............................................ 120
Scan Tab ............................................................................................ 121
  Enabling Image Processing Options ....................................... 121
  Removing Blank Pages .............................................................. 121
  Synchronized Scan .................................................................. 123
  Scanner Manual Feed Timeout ................................................ 123
Saving and Loading Settings ................................................................. 124
  Saving Settings ......................................................................... 124
  Important Information about XSCM.CONFIG .......................... 126
  Saved Workstation Settings .................................................... 128
  Loading Settings ....................................................................... 133

Chapter 3 Creating Documents
Introduction to Document Creation ....................................................... 138
Creating New Documents ................................................................. 140
  Input Methods ........................................................................ 141
  Adding a Document by Scanning ............................................ 150
  Adding a Document from the Windows Clipboard ................... 150
  Adding a Document by Inserting an Object ............................ 155
  Adding a Document by Importing a File .................................. 160
  Adding a Document from the Fax-in Queue ............................. 167
  Creating _RSTAMP and _FORMS Documents ......................... 170
Contents

Creating Documents in Batches.................................................... 174
  Batch Import........................................................................ 174
  Batch Creation.................................................................... 181
  ApplicationXtender Image Capture .................................. 186
Indexing New Documents............................................................. 187
  OCR Proofing..................................................................... 187
  Automated Indexing Features.............................. 189
  Index Validation................................................................. 197
Indexing Batches......................................................................... 200
  Batch Indexing a Single Batch................................. 200
  Batch Indexing from a List ........................................ 202
Submitting Documents to a Full-text Queue............................... 206
  About Submitting Different File Types......................... 207
  Submitting a Displayed Document.......................... 207
  Troubleshooting............................................................... 209

Chapter 4  Scanning

  Introduction to Scanning ..................................................... 212
  Selecting a Scanner .............................................................. 214
  Optional Scanning Configurations ................................... 216
    Scan Feeder Options.................................................. 217
    Automatic Enhancement ......................................... 218
    Auto OCR ................................................................. 218
    Resolution Settings ................................................ 219
    Mode Settings............................................................. 219
    Page Size Settings .................................................. 220
    Source Setting............................................................ 220
    Auto Rotation ............................................................. 221
    Scanner Driver Configuration .................................. 221
  Scanning Documents ............................................................ 223
  Scanning Pages.................................................................. 227
    Inserting a Scanned Page before the Current Page .... 227
    Inserting a Scanned Page after the Current Page...... 228
    Appending a Scanned Page to a Document .............. 228
  Integrating QuickScan Pro with ApplicationXtender .... 229
    Creating QuickScan Pro Export Profiles in Document Manager .......................................................... 229
    Exporting QuickScan Pro Documents to ApplicationXtender .............................................................. 230
    Creating Profiles in QuickScan Pro.......................... 232
## Chapter 5 Retrieving Documents

- Introduction to Document Retrieval ............................................. 244
- What is a Query? ............................................................................. 246
- Searching a Single Application ..................................................... 248
  - Entering Index Values as Search Criteria ................................ 250
  - Entering Full-Text Values as Search Criteria .......................... 260
- Combination (Index and Full-Text) Queries ................................ 264
- Searching Multiple Applications ............................................... 265
  - Creating a New Cross Application Query ............................... 265
  - Performing a Cross Application Query ................................. 270
  - Modifying a Cross Application Query ................................. 273
- Displaying Documents from the Result Set ............................ 275
  - Displaying AppXtender Documents ..................................... 276
  - Selecting a Document Display Mode ..................................... 280
  - Displaying AppXtender Reports Mgmt Reports .................... 288
  - Viewing Full-Text Search Results ....................................... 293
  - Viewing Documents from Unknown Data Sources ............. 295
  - Viewing Documents from a Volume ................................. 297
- Document Text Searches ................................................................. 298
  - Text Search from the Document Display View .................... 298
  - Text Search from the Result Set .......................................... 300
  - Special Search Characters .................................................. 301
- Managing Queries ........................................................................... 303
  - Saving a Query ................................................................. 303
  - Running a Query .............................................................. 304
  - Editing a Query .................................................................. 304
  - Making a Query Public or Private .................................. 305
  - Renaming a Saved Query .................................................. 306
  - Deleting a Query ............................................................. 306

## Chapter 6 Viewing Documents

- Introduction to Viewing Documents ............................................. 308
- Selecting Pages to View within a Document .............................. 309
  - Next, Previous, and Go To Page ....................................... 309
  - Viewing Thumbnails ......................................................... 310
  - Viewing Versions of a Page .............................................. 313
  - Viewing Subpages ........................................................... 314
- Displaying Multiple Documents and Pages ............................. 316
  - Cascade ........................................................................... 316
  - Tile ................................................................................ 316
  - Split View .......................................................................... 317
  - Displaying Documents in a Duplicate Window .................... 317
Contents

Page View Functions Available for Multiple Page Types 318
Using Sticky View 318
Using Zoom 321
Using Rotate 324
Using the Magnifier 324
Using Scale-to-Gray 326
Using Regions 326
Viewing Specific Page Types 332
Viewing Image Pages 332
Viewing Text Pages 333
Viewing PDF Files 338
Viewing Foreign Files 338
Viewing OLE Objects 342
Document View Properties 344
General Tab 344
Image Tab 346
Text Tab 348
OCR Tab 350
Page Information 353

Chapter 7 Managing Documents

Adding Pages to Documents 356
Adding a Page by Scanning 356
Adding a Page from the Windows Clipboard 356
Adding a Page by Inserting an Object 359
Adding a Page by Importing a File 363
Adding a Page by Dragging a File 364
Adding a Page from the Fax-in Queue 365
Replacing Pages 367
Page Versions 368
Modifying Document Indexes 369
Applying Digital Signatures 370
Viewing Signature History 371
Printing or Faxing Documents and Pages 373
Printing or Faxing Documents 374
Printing or Faxing Pages 379
Printing or Faxing a Region 381
Changing AppXtender Printer Fonts 382
E-Mailing Documents and Pages 383
E-Mailing from the Result Set 384
E-Mailing Displayed Documents 387
E-Mailing Document References 389
E-Mailing Pages 391
Chapter 8 Using ODMA With AppXtender Documents

Introduction to ODMA ...................................................... 436
ApplicationXtender ODMA Support ................................. 439
Configuring ODMA Support in ApplicationXtender ............ 440
Creating New AppXtender Documents through ODMA ...... 442
  Opening Non-AppXtender Documents with ODMA .......... 443
  Saving New ODMA Documents to AppXtender ................. 445
  Entering AppXtender Document Properties .................... 448
  Checking a New Document into AppXtender .................... 452
Retrieving AppXtender Documents through ODMA .......... 453
  Opening an AppXtender Application to Search ................. 454
  Searching for Documents ............................................. 456
  Opening a Document from the Result Set ....................... 458
  Choosing a Viewing Mode for an AppXtender Document 461
### Chapter 9  Annotations

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to Annotations</td>
<td>484</td>
</tr>
<tr>
<td>Annotation Types</td>
<td>486</td>
</tr>
<tr>
<td>Saving Annotations</td>
<td>487</td>
</tr>
<tr>
<td>Creating Line and Shape Annotations</td>
<td>488</td>
</tr>
<tr>
<td>Configuring Annotation Settings</td>
<td>488</td>
</tr>
<tr>
<td>Creating a Line or Shape Annotation</td>
<td>492</td>
</tr>
<tr>
<td>Creating a Highlight Annotation</td>
<td>498</td>
</tr>
<tr>
<td>Creating Text Annotations</td>
<td>499</td>
</tr>
<tr>
<td>Using the Annotation Text Editor</td>
<td>499</td>
</tr>
<tr>
<td>Using the In-place Text Editor</td>
<td>501</td>
</tr>
<tr>
<td>Working with Rubber Stamp Annotations</td>
<td>503</td>
</tr>
<tr>
<td>Creating a New Text Rubber Stamp Annotation</td>
<td>503</td>
</tr>
<tr>
<td>Creating a Text Rubber Stamp Annotation from an</td>
<td>509</td>
</tr>
<tr>
<td>Existing File</td>
<td></td>
</tr>
<tr>
<td>Creating an Image Rubber Stamp Annotation from an</td>
<td>511</td>
</tr>
<tr>
<td>Existing File</td>
<td></td>
</tr>
<tr>
<td>Adding Rubber Stamp Annotations to Pages</td>
<td>512</td>
</tr>
<tr>
<td>Overlapping Annotations</td>
<td>515</td>
</tr>
<tr>
<td>Assigning an Annotation to an Annotation Group</td>
<td>516</td>
</tr>
<tr>
<td>Assigning a Default Annotation Group</td>
<td>517</td>
</tr>
<tr>
<td>Showing or Hiding Annotations</td>
<td>518</td>
</tr>
<tr>
<td>Hiding Annotations When Viewing Documents</td>
<td>518</td>
</tr>
<tr>
<td>Hiding Annotations When Printing</td>
<td>520</td>
</tr>
<tr>
<td>Hiding Annotations When E-mailing</td>
<td>521</td>
</tr>
<tr>
<td>Hiding Annotations When Exporting</td>
<td>523</td>
</tr>
<tr>
<td>Modifying Annotation Settings</td>
<td>525</td>
</tr>
<tr>
<td>Selecting Annotations</td>
<td>526</td>
</tr>
<tr>
<td>Moving Annotations</td>
<td>527</td>
</tr>
<tr>
<td>Resizing an Annotation</td>
<td>527</td>
</tr>
<tr>
<td>Modifying Shape Annotations</td>
<td>527</td>
</tr>
<tr>
<td>Modifying Text Annotations</td>
<td>529</td>
</tr>
<tr>
<td>Editing Text Rubber Stamp Annotations</td>
<td>532</td>
</tr>
<tr>
<td>Printing Text Annotations</td>
<td>535</td>
</tr>
<tr>
<td>Removing Annotations</td>
<td>536</td>
</tr>
<tr>
<td>Erasing Annotations</td>
<td>536</td>
</tr>
<tr>
<td>Deleting Annotations</td>
<td>537</td>
</tr>
</tbody>
</table>
Chapter 10  Image Enhancement

Introduction to Image Enhancement .......................... 540
Enhancing an Image ................................................. 541
Configuring Image Enhancement ............................... 542
Performing Advanced Image Enhancement ............... 544
  Using Advanced Deskew ......................................... 544
  Using Advanced Registration ................................. 548
  Using Advanced Dot Shading Removal ...................... 553
  Using Speck Removal ........................................... 557
  Using Advanced Line Removal ............................... 561
  Using Advanced Inverse Text Correction ................. 565
  Smoothing Characters .......................................... 568
Using Manual Crop ................................................. 571
Resizing an Image ................................................... 573
Using Advanced Sub Image ..................................... 576
Using IntelligentCrop ................................................ 579

Appendix A  Working with Centera Retention

Overview ............................................................... 584
  Centera Retention Concepts ................................... 584
  Identifying Retention Applications ........................... 585
Filing Documents for Centera Retention .................... 586
  Filing a Document for Retention from Document Display View .................................................. 586
  Filing a Document for Retention from the Query View Result Set ..................................................... 587
  Filing Multiple Documents for Retention .................. 589
Processing Documents for Centera Retention Hold ....... 591
  Applying Centera Retention Holds ......................... 591
  Removing Centera Retention Holds ......................... 593
Appendix B  Working with Records Manager for AppXtender

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to Records Manager for ApplicationXtender</td>
<td>598</td>
</tr>
<tr>
<td>RM for AppXtender Concepts</td>
<td>600</td>
</tr>
<tr>
<td>Filing Systems and File Plans</td>
<td>600</td>
</tr>
<tr>
<td>Records Management</td>
<td>601</td>
</tr>
<tr>
<td>Retention Administration</td>
<td>602</td>
</tr>
<tr>
<td>Identifying RM for AppXtender Applications in AppXtender</td>
<td>603</td>
</tr>
<tr>
<td>Transferring AppXtender Documents for Records Management</td>
<td>605</td>
</tr>
<tr>
<td>Filing AppXtender Documents for Retention Administration</td>
<td>608</td>
</tr>
<tr>
<td>Working With AppXtender Documents That Are Filed for Retention</td>
<td>611</td>
</tr>
</tbody>
</table>

Glossary                                                                 | 613  |

Index                                                                   | 621  |
This document provides instructions on using ApplicationXtender Document Manager to create and manage ApplicationXtender documents.

As part of an effort to improve and enhance the performance and capabilities of its product lines, EMC periodically releases revisions of its hardware and software. Therefore, some functions described in this document may not be supported by all versions of the software or hardware currently in use. For the most up-to-date information on product features, refer to your product release notes.

If a product does not function properly or does not function as described in this document, please contact your EMC representative.

Audience

This document is part of the ApplicationXtender Document Manager documentation set and is intended for use by administrators and end users who are responsible for managing AppXtender documents, including creating documents, retrieving documents, viewing documents, and performing tasks such as adding, searching for, editing, and deleting documents.

Related documentation

Post-release information is contained in the ApplicationXtender Release Notes. This document is available at http://Powerlink.EMC.com. Refer to the web site periodically to view the latest Release Notes.

Related documents include:

- ApplicationXtender Technical Product Overview
- ApplicationXtender Document Manager Quick Reference
- ApplicationXtender Core Components Administrator’s Guide
Most of these documents can be found in the Documentation directory on the product media kit. All documents are in Adobe Acrobat Portable Document Format (PDF), and can be viewed by downloading and installing the Adobe Acrobat Reader. The Reader is available from Adobe at www.adobe.com. To install and use the Reader on the preferred platform, refer to the instructions on the Adobe web site.

EMC uses the following conventions for special notices.

---

**Note:** A note presents information that is important, but not hazard-related.

---

**CAUTION**

A caution contains information essential to avoid data loss or damage to the system or equipment. The caution may apply to hardware or software.

---

**IMPORTANT**

An important notice contains information essential to operation of the software. The important notice applies only to software.

---

**Typographical conventions**

EMC uses the following type style conventions in this document:

**Normal**

Used in running (nonprocedural) text for:

- Names of interface elements (such as names of windows, dialog boxes, buttons, fields, and menus)
- Names of resources, attributes, pools, Boolean expressions, buttons, DQL statements, keywords, clauses, environment variables, filenames, functions, utilities
- URLs, pathnames, filenames, directory names, computer names, links, groups, service keys, file systems, notifications

**Bold:**

Used in running (nonprocedural) text for:

- Names of commands, daemons, options, programs, processes, services, applications, utilities, kernels, notifications, system call, man pages

Used in procedures for:

- Names of interface elements (such as names of windows, dialog boxes, buttons, fields, and menus)
- What user specifically selects, clicks, presses, or types
Where to get help

EMC support, product, and licensing information can be obtained as follows.

**Product information** — For documentation, release notes, software updates, or for information about EMC products, licensing, and service, go to the EMC Powerlink website (registration required) at:

[http://Powerlink.EMC.com](http://Powerlink.EMC.com)

**Technical support** — For technical support, go to EMC Customer Service on Powerlink. To open a service request through Powerlink, you must have a valid support agreement. Please contact your EMC sales representative for details about obtaining a valid support agreement or to answer any questions about your account.
Getting Started

ApplicationXtender (AppXtender) is a content management system that uses image processing to bring large amounts of data online in a cost-effective manner. ApplicationXtender Document Manager (AppXtender Document Manager), AppXtender’s end user desktop module, can be used to create, enhance, store, retrieve, and output any type of document.

You can use AppXtender Document Manager to add documents and pages ApplicationXtender through scanning, importing, faxing, using the Windows Clipboard, or inserting objects from other applications. Once a document has been added to the AppXtender database, it can be retrieved and accessed so that you can work with the document. For example, you may need to fax a copy to someone, add an electronic signature, or annotate the document.

This section presents essential concepts related to ApplicationXtender, as well as information and instructions for getting started with AppXtender Document Manager. The section includes the following topics:

- Introduction to ApplicationXtender Concepts ....................... 18
- ApplicationXtender Components ............................................. 25
- ApplicationXtender on Your Network ..................................... 31
- How Documents are Stored and Displayed in AppXtender ....... 33
- Ways of Using ApplicationXtender .......................................... 40
- Selecting Data Sources ............................................................. 44
- Starting ApplicationXtender Document Manager .................. 50
- ApplicationXtender Document Manager Views ....................... 60
- AppXtender Document Manager Toolbars ............................... 74
- Function Keys ........................................................................... 86
Introduction to ApplicationXtender Concepts

The functionality of the ApplicationXtender system centers on a few key concepts. An understanding of these concepts helps you use AppXtender effectively.

Content Organization in ApplicationXtender

The highest level of organization in ApplicationXtender is the application. Applications, which are designed by the AppXtender system administrator, contain documents consisting of one or more pages. Pages, in turn, consist of one or more page versions.

During application creation, one or more index fields are specified for each application. Information entered in the index fields when a document is added to an application acts as a label identifying the document in the ApplicationXtender system.

Glossary of ApplicationXtender Terms

Annotations

An annotation is a text note or a shape added to a page, typically to focus attention on a particular part of the page. You can use annotations to comment on the contents of a page, highlight important information, or block areas of the page from view. The types of annotations available in ApplicationXtender Document Manager include text, highlighting, lines, arrows, and shapes.
Getting Started

Note: An annotation that blocks part of a page from view is called a redaction.

ApplicationXtender allows you to add annotations to the following page types:

- Images
- Text
- Portable Document Format (PDF) files

When you create an annotation, it is related to the AppXtender page to which it was added. When you view the page, the annotation appears as part of the image or text on the page. However, annotations are stored separately from documents and pages in the AppXtender system.

Applications

An application is the highest level of organization in ApplicationXtender. You store documents in applications and retrieve documents from applications.

AppXtender system administrators create applications through the ApplicationXtender Application Generator (AppXtender AppGen) module. During this process, the system administrator names the application and defines one or more indexes for the application.

Every time you store a document in an application, you must enter index information for that particular document. AppXtender stores the index information in a database, allowing you to search for and retrieve the document as needed.

COLD/ERM Data

COLD (Computer Output to Laser Disk) data and ERM (Enterprise Report Management) data is report data generated for existing applications, indexed using an extraction process, and downloaded into AppXtender applications.

COLD/ERM data is added to AppXtender as documents via ApplicationXtender Reports Management® (AppXtender Reports Mgmt). AppXtender Reports Mgmt produces ASCII or PDF documents known as AppXtender Reports Mgmt documents. To allow users to view the report data in the context of a standard form, form overlays can be added to AppXtender Reports Mgmt ASCII document.

Note: Form overlays cannot be added to PDF documents.
AppXtender Document Manager can perform text searches on individual AppXtender Reports Mgmt documents, allowing you to locate important data within the report.

Digital Signatures
Digital signatures allow users to electronically sign any page version in AppXtender and ApplicationXtender Web Access (AppXtender Web Access). Like a written signature, the purpose of a digital signature is to guarantee that the individual signing the page really is who he or she claims to be and that the document has not changed since the date of the signature.

Documents
A document is a file or group of files stored in an AppXtender application and identified by index information. Each page of a document is a single object, such as a scanned image file or a word processing document. Documents can contain any combination of objects, each stored as a page within the document. For instance, a document for a hospital patient might include scanned admission forms, a doctor’s report in Microsoft Word format, and an x-ray image file. A single document can contain one page or thousands of pages.

Note: For more information on the types of files that can be stored in AppXtender, refer to “How Documents are Stored and Displayed in AppXtender” on page 33.

You create documents in AppXtender by adding objects to applications. Part of this process is to enter information from the document into each of the application’s index fields. This information acts as a "label" for the document. Once a document is added to the database, you can then add additional objects as additional pages. If you have the proper security privileges, you can modify documents and their indexes at any time.

Because document index information is stored in a database, you can search for the document’s "label" to retrieve the document. When you make a search request in ApplicationXtender, all records of index information containing a match with the information you requested will appear in the search results. You can then retrieve and view any document by selecting its record from the result set. You can process (print, fax, mail, or export) documents pages individually or together as a single unit. You can also print or fax several documents simultaneously by selecting them from the result set and choosing the appropriate command.
Some applications are configured so that you can have documents indexed for full-text searching. With full-text search, you can find documents without knowing any of the document’s index values. You can also use full-text searching to narrow down results from an index value search.

To be available for full-text search, documents must be submitted to the ApplicationXtender Index Server for full-text indexing. The following types of documents can be full-text indexed in AppXtender:

- Bi-level (black and white) and color images
- Rich Text Format (RTF) files
- Hypertext Markup Language (HTML) files
- Portable Document Format (PDF) files
- Foreign files added by importing the files into AppXtender

An ApplicationXtender index is a group of fields where information relating to a document is stored. The index values you enter identify the document when it is stored in an AppXtender application.

As the part of the ApplicationXtender system that allows you to organize stored documents efficiently, the index is the central component in an AppXtender application. Documents can be stored in ApplicationXtender in random order and yet still be easily retrieved. Because an index record is attached to every document, you can search all stored index values for an application to retrieve relevant documents.

The AppXtender administrator specifies the index information required for each ApplicationXtender application. During application creation, the administrator decides what index information will be requested from the user and what the format for that information will be. The administrator plans how many descriptive entries to request for each stored document, what type of information to use to identify the documents, how much space to provide for each entry, and how the information for a particular entry will be entered.
AppXtender uses the fields specified during application creation to build an Index view. Whenever you add a document to an application from AppXtender Document Manager, the Index view for the application specifies the exact information you need to enter and provides input fields for you to enter each value.

OCR

With AppXtender, you can use optical character recognition (OCR) to process bi-tonal (black and white) and color images and convert an image of text into actual text. After an image is processed using OCR, you can submit the resulting text to the ApplicationXtender Index Server for full-text searching.

ODMA

Open Document Management API (ODMA) support allows you to work with AppXtender documents within ODMA-compliant applications such as Microsoft Word and Microsoft Project. Through the ODMA check-in process, you can save a non-AppXtender document as a new AppXtender document, adding AppXtender index values and document summary information. You can also check out and modify an existing AppXtender document and then check it back into AppXtender as a major revision, a minor revision, a new page version, or a replacement page version (depending on your user privileges). Through the ODMA checkout process, you can retrieve previous document revisions and the most recent page version of the first page in a document from AppXtender.

When you search for AppXtender documents through ODMA, you can utilize all of AppXtender’s normal search functionality. The search dialog box that appears in the ODMA-compliant application is similar to the Query view used in AppXtender.

Pages

The word "page" typically implies a single entity. Because ApplicationXtender supports multiple object types, a page in AppXtender is defined as a single object. A page came come from one of many different sources. For example, a very long word processing file is a page to AppXtender. A page could also be a single scanned image, for example, a 30-minute video clip, or an audio recording.
When you create a document in AppXtender, the object added as the new document is the first page of that document. Up to 250,000 pages can be attached to a document. The same index record is attached to all of the pages in a single document.

Authorized users can select commands from the AppXtender Document Manager Document menu to process all of the pages in a document simultaneously or select commands from the Page menu to process pages individually. Authorized users can also insert or delete pages at any time.

**Redactions**

Redactions are annotation shapes that are filled and opaque. They can be used to secure (hide) portions of image and text pages.

You can apply redaction to all available annotation shapes: freehand lines, straight lines, arrows, rectangles, rounded rectangles, and ovals. When applied, the area of the page behind the redaction is hidden from view.

**KeyView Viewer**

The KeyView Viewer allows you to view the content of some foreign files in AppXtender Document Manager. The major benefit of having the KeyView Viewer is that a third-party viewer, such as Microsoft Word, is no longer needed to display the content of the files.

The appearance of a foreign file in the KeyView viewer is similar to but not exactly the same as its appearance in its native viewer. As soon as the content of the file appears, you can launch its native software program from the Page menu and then edit the file.

**Document Storage Locations**

Unlike document indexes for ApplicationXtender applications, which are stored in a database, the actual document files (scanned images and text files, for example) are stored in a directory designated by the administrator as the application’s document write path.

AppXtender applications can be configured to store documents to any storage device that can be mapped by the AppXtender workstation. This includes devices such as a network file server, local hard disk, or erasable and WORM optical media.
This document provides a guide to using the LEGATO DiskXtender® (DX) software and ArchiveXtender - Ascent Storage Edition (ArcX-ASE) with the ApplicationXtender Document Manager. DiskXtender can be used as a Document Server for your AppXtender document storage. By intelligently controlling hardware devices and access to files on media, DiskXtender allows you to save and retrieve files to and from its extended NTFS volumes (DX "extended drives"). DX moves files out to media, keeping track of each file's location. When files are needed, DX seamlessly retrieves and delivers them to the user. DX lets the administrator automate file migration through a user-friendly interface that displays hardware, media, and extended drives in a single, unified "tree" structure.

To write AppXtender documents to DiskXtender, the document write path for the application simply points to a DiskXtender extended drive. The administrator can also configure a dedicated connection between AppXtender and the DX server using Microsoft’s Distributed Object Component Model (DCOM) or Remote Procedure Call (RPC) technologies. For information on configuring DX server connectivity, refer to the "Using a Document Storage Server" chapter of the ApplicationXtender Core Components Administrator’s Guide.

ArcX-ASE is a complete archival solution that aggregates optical devices into a virtual storage pool, allowing Windows, UNIX, and Macintosh clients to archive and retrieve data from the same network location. ArcX-ASE can be used as a Document Server for AppXtender document storage. ArcX-ASE is supported only for legacy purposes for Minolta customers.

To write AppXtender documents to ArcX-ASE, your administrator must include the ArcX-ASE Configuration component in the AppXtender installation. For instructions, refer to the "Installing ApplicationXtender" section of the ApplicationXtender Installation Guide. Some configuration is also required for the application write path and for each AppXtender Document Manager workstation that will write AppXtender documents to ArcX-ASE or retrieve documents from ArcX-ASE. For instructions on performing this configuration, refer to the "Using a Document Storage Server" section of the ApplicationXtender Core Components Administrator’s Guide.
ApplicationXtender Components

An ApplicationXtender system can contain several AppXtender products and modules, each of which performs a specific function within the system. For more information, refer to the following topics:

- “Administrator Components” on page 25
- “User Components” on page 29
- “ApplicationXtender License Server” on page 30

Administrator Components

The AppXtender system administrator uses the following components to create and maintain the ApplicationXtender content management system.

- “ApplicationXtender Application Generator” on page 25
- “ApplicationXtender Index Server” on page 26
- “Import Wizards” on page 26
- “Administrator Utilities” on page 27

For more information on any of the administrator components, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

ApplicationXtender Application Generator

The ApplicationXtender Application Generator (AppXtender AppGen) module is used by AppXtender system administrators to set up AppXtender systems, including creating applications and configuring user and group security. Once the system is set up, AppXtender AppGen is used to maintain user and group information, modify applications, or maintain a workstation’s License Server connection.

AppXtender AppGen provides access to many administrative functions. For example, system security on the application, functional, and document levels is configured through AppXtender user profiles, group profiles, and the Document Level Security feature. Customized specifications can be created to import specific index information using the ApplicationXtender Auto Index Import Wizard, ApplicationXtender Key Reference Import Wizard, or ApplicationXtender Index Image Import Wizard.
Actions taking place within the ApplicationXtender system can be tracked using the AppXtender AppGen Audit Trails feature. For example, creation and deletion of documents and applications can be tracked by enabling audit trails for those items.

For more information on ApplicationXtender Application Generator, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

**ApplicationXtender Index Server**

The ApplicationXtender Index Server (AppXtender Index Server) module provides full-text search functionality and OCR processing for AppXtender systems. You can submit an image to the AppXtender Index Server for OCR processing or add text information for full-text indexing. You can process scanned images using OCR and then add the resultant text version of the document to the AppXtender Index Server, allowing users to search on “key” words that might be located anywhere in the document.

**Import Wizards**

AppXtender has three import wizards. For more information, refer to the following topics:

- “ApplicationXtender Index Image Import Wizard” on page 26
- “ApplicationXtender Key Reference Import Wizard” on page 26
- “ApplicationXtender Auto Index Import Wizard” on page 27

**ApplicationXtender Index Image Import Wizard**

If images, text, or foreign file format files and associated index data exist in another system, you can import them into AppXtender using the ApplicationXtender Index Image Import Wizard.

For information on importing index information and images together, consult your AppXtender system administrator or refer the ”Import Wizards” section of the ApplicationXtender Core Components Administrator’s Guide.

**ApplicationXtender Key Reference Import Wizard**

This wizard is used to import key reference information into the AppXtender system by importing data into a table to be used for automatic index population. This table is a central holding area for index information and operates on a "static data" basis, which means that records remain in the table even after they are used. If changes occur (such as an address or name), then those changes are immediately reflected across the entire application, because any documents in the application indexed using Key Reference data obtain their index information from the Key Reference table.
For information on importing Key Reference information, consult your AppXtender system administrator or refer to the "Import Wizards" section of the ApplicationXtender Core Components Administrator's Guide. For information on using the Key Reference Import table, refer to “Automated Indexing Features” on page 189.

**ApplicationXtender Auto Index Import Wizard**

This wizard is used to import Auto Index information into the AppXtender system. When you perform an Auto Index Import, AppXtender imports the data into an Auto Index table; that information is then used for the automatic population of AppXtender indexes.

The Auto Index table operates on a "use once and discard" basis, which means that when an item is extracted from the table, it is automatically deleted. This feature is used when initially creating documents, so that all unindexed records can be tracked.

For information on importing Auto Index information, consult your AppXtender system administrator or refer to the "Import Wizards" section of the ApplicationXtender Core Components Administrator's Guide. For information on using the Auto Index Import table, refer to “Automated Indexing Features” on page 189.

**Administrator Utilities**

AppXtender has utilities for the AppXtender system administrator. For more information, refer to the following topics:

- “ApplicationXtender Archive Wizard” on page 28
- “ApplicationXtender Queue Manager” on page 28
- “ApplicationXtender Migration Wizard” on page 28
- “ArchiveXtender - Ascent Storage Edition Configuration” on page 29
ApplicationXtender Archive Wizard
Documents are usually accessed frequently for a period of time after they are added to an application. After the documents are no longer current, however, they may be accessed infrequently, if at all.

The ApplicationXtender Archive Wizard allows you to move less frequently accessed documents within an application from more expensive, faster access storage, such as a hard drive, to less expensive, larger capacity media, such as WORM. By archiving older documents to removable media, you can free storage space on faster access media, then use that space to store more frequently accessed documents. When documents are archived, they can still be accessed by searching and retrieving them within the application where they were originally stored; AppXtender only changes the document’s physical storage location and sets a new pointer to the document’s new location.

For more information on using the ApplicationXtender Archive Wizard, consult your AppXtender system administrator or refer to the “Managing Existing Applications” section of the ApplicationXtender Core Components Administrator’s Guide.

ApplicationXtender Queue Manager
ApplicationXtender Queue Manager allows you to manage all of your AppXtender data sources and queues.

You can view the contents of a data source, create a new data source, set a data source as default, delete a data source, rename a data source, or edit properties of a data source. In each data source, you can manage AppXtender Index Server queues for full-text indexing and AppXtender Index Server queues for OCR processing. You can also run saved queries from ApplicationXtender Queue Manager. For more information on ApplicationXtender Queue Manager, consult your AppXtender system administrator or refer to the ApplicationXtender Server Monitoring Guide.

ApplicationXtender Migration Wizard
The ApplicationXtender Migration Wizard moves or copies AppXtender application definitions, application import specifications, application data, user lists and group lists from one AppXtender data source to another AppXtender data source.

The ApplicationXtender Migration Wizard can be used to distribute information to other sites or to scale AppXtender solutions to larger or smaller databases. The administrator can choose to migrate all AppXtender application data or just a subset of the information.
Several applications can be migrated without exiting the wizard to change the source database. The administrator can automate application migration using the save and load settings features or using extensive command line options. Only users who have been given AppXtender Administrator privileges in AppXtender Desktop can perform migrations.

**ArchiveXtender - Ascent Storage Edition Configuration**
The ArchiveXtender - Ascent Storage Edition (ArcX-ASE) Configuration component allows the administrator to specify the name of an ArcX-ASE server for an AppXtender Document Manager workstation. This procedure is necessary if the workstation will be used to write AppXtender documents to ArcX-ASE or retrieve documents from ArcX-ASE. For more information on ArchiveXtender - Ascent Storage Edition Configuration, consult your AppXtender system administrator or refer to the "Using a Document Storage Server" section of the *ApplicationXtender Core Components Administrator’s Guide*.

*Note:* ArcX-ASE is supported only for legacy purposes for Minolta customers.

**User Components**

Three components—ApplicationXtender Document Manager, ApplicationXtender Image Capture, and ApplicationXtender Data Source Selector—are used by all system users, including the administrator. For more information, refer to the following topics:

- "ApplicationXtender Document Manager" on page 29
- "ApplicationXtender Image Capture" on page 30
- "ApplicationXtender Data Source Selector" on page 30

**ApplicationXtender Document Manager**

ApplicationXtender Document Manager (AppXtender Document Manager), the central program in the AppXtender system, provides the interface through which users store, retrieve, view, and process documents. Documents and pages can be added one at a time or imported together in groups, called batches. The documents can then be indexed so that they can be located and retrieved later as needed.
You can perform index searches in AppXtender Document Manager to locate documents. As soon as a document has been retrieved in AppXtender Document Manager, you can adjust the display of the document. You can add comments to documents or batches in the form of text annotations. You can also use a variety of annotation shapes to highlight areas of pages and apply redactions to documents. You can print, fax, mail, or export documents and pages from AppXtender.

Note: The Configuration dialog box in AppXtender Document Manager provides a way for you to configure several features that effect the way AppXtender Document Manager looks or performs.

**ApplicationXtender Image Capture**

ApplicationXtender Image Capture® (AppXtender Image Capture), a separate module installed with AppXtender Document Manager, provides batch scanning functionality, allowing you to scan documents and then index them at a later time in AppXtender Document Manager. For more information on ApplicationXtender Image Capture, consult your system administrator or refer to the ApplicationXtender Image Capture User’s Guide.

**ApplicationXtender Data Source Selector**

The ApplicationXtender Data Source Selector allows you to locate and select data sources that have been created in the ApplicationXtender Administrator module. When multiple data sources are available, you may be able to select two or more data sources to be accessed within ApplicationXtender Document Manager. This allows you to work with applications from different data sources during a single AppXtender Document Manager session. For information on using the ApplicationXtender Data Source Selector, refer to “Selecting Data Sources” on page 44.

**ApplicationXtender License Server**

ApplicationXtender uses the ApplicationXtender License Server to monitor licensing for AppXtender Document Manager workstations. The License Server is a central license server that manages licensing for all ApplicationXtender products. For information on using the License Server, refer to the ApplicationXtender Core Components Administrator’s Guide.
ApplicationXtender on Your Network

The modules that make up AppXtender, the files that you store and manage through AppXtender, and the database used by AppXtender can all be located on separate computers across a network to increase performance. When you store a document to AppXtender, you are probably storing it to a location on the network rather than onto your local computer. The database that you are using to store index information is also probably on a server somewhere on your network.

However, from your perspective as a user of AppXtender, database location and document storage location are relatively unimportant. The benefit of AppXtender to you as a user is that you do not have to decide where to store documents or remember where to go to locate them. You simply open an AppXtender application and use the search function to find the documents you want, and AppXtender knows where to go to retrieve them.

Here is an example of how AppXtender document storage, indexing, and retrieval might be set up in an office environment:
In order to understand how your particular AppXtender system works, you may want to consult your AppXtender system administrator to find out if you have access to an ApplicationXtender Index Server, which full-text engine has been selected for the applications you use, what functionality is configured for your workstation, what AppXtender data sources are configured for you, and what functions you have rights to in AppXtender. Having an understanding of what functions are available to you will help you to better understand how you can use AppXtender.
How Documents are Stored and Displayed in AppXtender

You can store any type of file in AppXtender. Depending on the file type, AppXtender stores the file as a supported file type such as image or text, or as an unsupported file type such as foreign or OLE. When files are created in AppXtender, AppXtender verifies the file type and then stores the file as the identified type (such as image, text, foreign file format).

Many of the functions available in AppXtender are file-type dependent. Because AppXtender is geared toward providing access to as many useful functions as possible, features are provided that can be used to work with particular file types. However, these functions are frequently not available when you are working with other file types.

A good example of this is the Enhance Image function. If you are viewing a scanned image of an invoice, for example, it might be very helpful to use image enhancement to clean up the image and make it easier to read. However, when you are working with a Microsoft Word document stored as a foreign file, image enhancement is not available (because it would not be of any use with the Microsoft Word document).

AppXtender has the capability to display file types in a variety of ways. The content of supported file types can be displayed in the Document Display view. Depending on your AppXtender configuration, an unsupported file type can be displayed as an icon representing a foreign file, through KeyView Viewer support, or in its native application in the Document Display view.

**Note:** Access to AppXtender functions depends on the rights granted in your AppXtender user profile. For more information on your user privileges in AppXtender, consult your AppXtender system administrator or refer to the “Implementing Security” section of the *ApplicationXtender Core Components Administrator’s Guide*.

**Note:** Access to AppXtender functions also depends on the “mode” in which you are using AppXtender: check in/check out mode or normal AppXtender mode. For more information on the different operational modes for AppXtender, refer to “Ways of Using ApplicationXtender” on page 40.
Supported Files

Supported files are files that AppXtender natively supports. Supported file types include: image files (for example, TIFF, GIF, Bitmap, PCX, DCX, JPEG, and TGA files), Rich Text Format (RTF) files, Hypertext Markup Language (HTML) files, and Adobe Portable Document Format (PDF) files. The following topics describe the AppXtender-supported files:

- “Image Files” on page 34
- “ERM/Text Files” on page 35
- “Rich Text Format (RTF) Files” on page 36
- “Hypertext Markup Language (HTML) Files” on page 37
- “Portable Document Format (PDF) Files” on page 37

Image Files

AppXtender has the ability to store image files in their native format or in a different format supported by AppXtender. Image files contain graphic data. AppXtender displays image files in their stored format. Depending on the image storage format, black and white files and 4/8-bit color files can be displayed in their native format as well as TIFF or Windows bitmap files. True color files can be displayed in their native format as well as TIFF, Windows bitmap, or JPEG files. If you store images using the JPEG format, you can configure the level of compression of the images through AppXtender.

By default, AppXtender stores images in their native format (for example, a TIFF file is stored as TIFF). When you choose to store an image file in a specific image format, AppXtender ignores the original format and stores all images in that format.
Images are added to AppXtender by importing them or by scanning in paper documents. You have access to a large range of AppXtender functionality when you are working with supported images in AppXtender. You can add annotations, enhance the image quality, process the image using Optical Character Recognition (OCR), and adjust the display of the image in many ways to allow optimal viewing of the image. You can also perform all of the export functions (such as printing, faxing, exporting, and e-mailing). If you have access to an ApplicationXtender Index Server for full-text indexing, you can submit images that contain text to the ApplicationXtender Index Server, using OCR to extract the text for indexing. Document Display properties are also available for image files, allowing you to change display settings from the Document Display view.

Text files can be added to AppXtender by importing them or by performing an ApplicationXtender Reports Management extract and upload. Once the files are in AppXtender, they are stored as AppXtender-proprietary compressed text file format.

**Note:** In most cases, text files display as text files; otherwise, they display as foreign files. If you map text extensions on the File Types tab rather than having AppXtender do the mapping automatically, the files may not display properly. For information on configuring the File Types tab, consult your AppXtender system administrator or refer to the "Configuring AppXtender Workstations" section of the ApplicationXtender Installation Guide.

You have access to a large range of AppXtender functionality when you are working with text files in AppXtender. You can add annotations and adjust the display of the image in many ways to allow optimal viewing of the image. You can also perform all of the export functions (such as printing, faxing, exporting, and e-mailing). If you have access to an ApplicationXtender Index Server for full-text indexing, you can submit text files to the ApplicationXtender Index Server. Document Display properties are also available for text files, allowing you to change display settings from the Document Display view.
Form overlays can be added to ASCII documents from AppXtender Reports Mgmt to allow users to view the report data in the context of a standard form. (Form overlays cannot be added to PDF documents from AppXtender Reports Mgmt.) Depending on your AppXtender configuration, ERM documents with form overlay can be displayed with either text form overlay or image form overlay, or image form overlay only. ERM documents without form overlay are displayed in an ASCII format.

The following table provides an explanation of each supported text format.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>ASCII stands for the American Standard Code for Information Interchange. This character set is used on most PCs, Macintosh's, and other desktop computers. A report generated on a desktop computer is likely to be in an ASCII format.</td>
</tr>
<tr>
<td>EBCDIC</td>
<td>EBCDIC stands for Extended Binary Coded Decimal Interchange Code. This character set is used on IBM mainframes. A report generated on an IBM mainframe will be in EBCDIC format.</td>
</tr>
<tr>
<td>EBCDIK</td>
<td>EBCDIK is the Japanese variation on EBCDIC. This character set is used on IBM mainframes manufactured in Japan. A report generated on a Japanese IBM mainframe will probably be in EBCDIK format.</td>
</tr>
</tbody>
</table>

**Rich Text Format (RTF) Files**

AppXtender stores RTF files in their native format. You can perform all of the export functions (such as printing, faxing, exporting, and e-mailing). If you have access to an ApplicationXtender Index Server for full-text indexing and RTF file conversion is configured on the ApplicationXtender Index Server, you can submit RTF files for full-text indexing. (RTF file conversion is not necessary if your application is configured to use the K2 full-text engine.) Document Display properties are not available for RTF files.

RTF files are displayed in their native format. The contents of the RTF file appear in the Document Display window, even if you do not have the KeyView Viewer enabled for foreign files. Because RTF is natively supported in AppXtender, the KeyView Viewer is not required to view file contents.
HTML files are files written in the language used for display on the World Wide Web. A web page is typically in HTML format.

AppXtender stores HTML files in their native format. You can perform all of the export functions (such as printing, faxing, exporting, and e-mailing). If you have access to an ApplicationXtender Index Server for full-text indexing and HTML file conversion is configured on the ApplicationXtender Index Server, you can submit HTML files for full-text indexing. (HTML file conversion is not necessary if your application is configured to use the K2 full-text engine.) Document Display properties are available for HTML files.

PDF files are files in a proprietary Adobe format. AppXtender stores and displays PDF files in their native format. Because PDF is natively supported in AppXtender, the KeyView Viewer is not required to view file contents. The contents of the PDF file appear in the Document Display view document viewer, even if you do not have the KeyView Viewer enabled for foreign files.

You can add annotations and adjust the display of the PDF file in many ways to allow optimal viewing. Document Display properties are available for PDF files. You can also perform all of the AppXtender export functions (such as printing, faxing, exporting, and e-mailing). Depending on the privileges assigned to your user account, while using these export functions, you may be able to hide annotations on a PDF file.

If the software cannot extract text from a PDF file, the pages are then processed for text content using OCR.

If you have access to an ApplicationXtender Index Server for full-text indexing, you can submit PDF files for full-text indexing. PDF files that have been submitted for full-text indexing can be full-text searched in releases previous to 4.6. However, the display of hits differs from that of PDF files submitted in release 4.6 or later releases.
Unsupported Files

Unsupported files are stored in AppXtender in their native format. Unsupported files include foreign files and OLE files. For most unsupported file types, you can choose whether to add the file as an OLE object or a foreign file when you add the file to AppXtender. For more information, refer to the following topics:

- “Foreign Files” on page 38
- “OLE Objects” on page 39

Foreign Files

When you import a file that is not natively supported in AppXtender, AppXtender stores that file as a foreign file. All files other than TIFF, Windows bitmaps, JPEG, TGA, GIF, PCX, DCX, RTF, and HTML are stored in AppXtender as foreign files. AppXtender stores foreign file types in their native file format.

You can perform all of the export functions (such as printing, faxing, exporting, and e-mailing) for foreign files. If you have access to an ApplicationXtender Index Server for full-text indexing and foreign file conversion is configured on the ApplicationXtender Index Server, you can submit foreign files to the ApplicationXtender Index Server. (Foreign file conversion is not necessary if your application is configured to use the K2 full-text engine.) You can view page information for foreign files in AppXtender. Document Display properties are also available for foreign files. If you would like to edit a foreign file, you can launch the foreign file in its associated source application to do so.

Certain foreign files can be created, accessed and modified using ODMA. If you want to create AppXtender documents with files from an ODMA-compliant application that is supported by AppXtender, you can do so. When you create a document through ODMA, that file is stored in AppXtender as a foreign file.

For a list of the AppXtender-supported applications that are ODMA-compliant, refer to “AppXtender Document Properties: the General Tab” on page 448.

CAUTION

Use of ODMA with any of the Corel Office 2000 suite of products causes system failure and is not supported with AppXtender.
You can choose how to display foreign files in your AppXtender Document Display view. If you enable the KeyView Viewer in AppXtender Configuration, the content of foreign files that are supported under KeyView will appear in the view. If you do not enable the KeyView Viewer, foreign files appear as icons in the Document Display view.

For a list of the foreign files that can be viewed using the KeyView Viewer feature, refer to “KeyView File Support” on page 144.

**OLE Objects**

When you insert a file that is not supported in AppXtender as an object, AppXtender uses Object Linking and Embedding (OLE) to embed the file in AppXtender. AppXtender stores OLE objects in their native file format.

You can perform all of the export functions (such as printing, faxing, exporting, and e-mailing) for OLE objects. You can view page information for OLE objects in AppXtender. Document Display properties are also available for OLE objects.

You can choose how to display OLE objects in your AppXtender Document Display view. If you choose to insert the object normally, the content of the object appears in the view. If you choose to Display as Icon, the OLE object will appear as an icon in the Document Display view.

You can double-click an OLE object to activate it and start the source application (if you chose to display the object as an icon) or to perform in-place editing (if you did not choose to display as icon). In-place editing means that the AppXtender Document Manager menus change to the menus of the source application for the OLE object, and you can access source application commands without leaving the AppXtender Document Display view.

---

**Note:** OLE objects cannot be submitted for full-text indexing.
Ways of Using ApplicationXtender

You can use ApplicationXtender applications to store documents through the AppXtender interface, or you can use them to add document storage and processing capabilities to other third-party software programs.

ApplicationXtender Modes of Operation

You can use ApplicationXtender applications to store and retrieve documents through the AppXtender interface. AppXtender has two modes of operation that you may be able to choose from: normal AppXtender mode and check in/check out mode. Your administrator may have configured check in/check out mode at the application level, which means that you do not have control over the mode on your workstation. Your administrator may also have enabled required comments on check in and/or check out of documents and reason audit mode for some or all of the applications you work with.

The normal AppXtender and check in/check out modes of operation relate to the use of revision control in AppXtender. Revision control keeps track of who is working on a document and can be used to track previous revisions of a document. When revision control is in use, you must check a document out before you can modify it. When you finish modifying the document, you must then decide how (or whether) to resave the document to the AppXtender document repository.

When you check out a document, a copy of the document as it exists in the AppXtender repository is created by AppXtender. This copy becomes your working copy. Even when you close a document, you can keep the document checked out in order to continue working on it.

When you finish your modifications, you can choose to check the document back into the repository. You can replace the most recent revision in the repository with the current revision, or you can check it in as a new revision and mark it as a minor revision or a major revision.
If the application you are working with has Prompt for checkout on open enabled, when you check in a document that is in final form, you can mark the document as a final revision. Once this is done, users can open the document only in read-only mode and cannot modify the document. For information on enabling final revision functionality when you set up AppXtender applications, refer to "Creating an Application" in the ApplicationXtender Core Components Administrator’s Guide.

Note: Users with deletion privileges can delete final document revisions from the AppXtender repository.

Note: The final revision option on check-in is not available when checking in documents through ODMA.

You can also choose to cancel checkout of the document. When you cancel checkout of the document, the working copy created when you checked the document out is deleted, and AppXtender considers the revision of the document that you checked out as the current revision. Any changes that you made to the working copy are discarded.

Reason audit mode, which is configured by your administrator at the application level, requires you to enter comments whenever you create, display, export, print, or email documents. When you display documents in reason audit mode, you must select options to print, email, or export if you want access to those functions once the documents are displayed.

An AppXtender Document Manager workstation is in check in/check out mode when the Prompt for check out when open option of the workstation configuration is enabled. An AppXtender application is in check in/check out mode when the Prompt for checkout when open documents option of the application configuration is enabled. Check in/check out mode is enabled for you if it is enabled for either your workstation or the current application.

When AppXtender is in check in/check out mode, use of revision control with AppXtender documents is mandatory. If you attempt to open a document, AppXtender will prompt you to either check out the document or open it in read-only mode. You must check out the document in order to modify it.
The application may also be configured so that comments are required when you check in or check out documents. The final revision option on check-in is only available when the AppXtender application is in check in/check out mode.

**Reason Audit Mode**

The Health Insurance Portability and Accountability Act of 1996 (HIPAA) was put in place to protect health care patients by regulating how patient records are stored and accessed. ApplicationXtender contains options that can be used to help create a content management solution that facilitates compliance with the HIPAA regulations. When the Reason Code option is enabled for an AppXtender application and the Audit Trail option is enabled, all document creation, printing, email, and export actions are audited. You are required to enter comments explaining the reason for document creation, printing, email, and export, and to enable printing, email, and export options indicating the functionality you intend to use. Those comments, along with your user identity, are logged used the Audit Trail feature.

**Normal Mode**

An AppXtender Document Manager workstation is in normal mode when the Prompt for check out when open option of the workstation configuration is not enabled. An AppXtender application is in normal mode when the Prompt for checkout when open documents option of the application configuration is not enabled. Normal mode is enabled for you if it is enabled for both your workstation and for the current application.

When AppXtender is in normal mode, use of revision control with AppXtender documents is not mandatory. You can open and modify documents, and when you close them, the modifications are automatically saved to the AppXtender document repository.

You can check out documents while AppXtender is in normal mode, in order to prevent other users from making modifications while you are working on a document. This is useful if making modifications to a document will extend past the current AppXtender Document Manager session. However, you are not required to check out a document in order to make modifications to it.

If your workstation is in normal mode and you attempt to open a document that is checked out by another user, you will automatically receive a read-only copy of the document and you will not be able to make changes. Read-only status is indicated by an ‘(RO)’ notation in the title bar.
If your workstation is in normal mode and you attempt to open a document that you already have checked out, you will receive a dialog box that gives you the option of opening your checked out copy of the document or opening a read-only copy of the document (the AppXtender repository copy which is the document as it was when you checked it out).

ODMA

The ODMA feature is an alternate way to create, index, and retrieve AppXtender documents. Before you can access this feature, ODMA support must be enabled on your AppXtender Document Manager workstation. ODMA uses the Open ApplicationXtender Document dialog box to interface with ODMA-compliant applications and the ApplicationXtender system to create and access AppXtender documents. For example, on the Open ApplicationXtender Document dialog box, you can open and save non-AppXtender documents to AppXtender using the File Selection button, enter search criteria to perform queries to find existing AppXtender documents from the Search tab, and check out an existing AppXtender document for modifications, or open it as read-only from a Result Set tab like the one in AppXtender.

As soon as all modifications are completed, you can check in the modified document to AppXtender as a major revision, as a minor revision, as a new page version, or as a replacement page version (depending on your user rights). For more information on foreign files types that can be accessed using ODMA, refer to “Foreign Files” on page 38. For more information on using ODMA with AppXtender documents, refer to Chapter 8, “Using ODMA With AppXtender Documents.”
Selecting Data Sources

A data source is the means by which ApplicationXtender accesses data from a database. Information that is stored in the AppXtender database includes application definitions, security information, document index information, and pointers to document locations.

Multiple data sources can be viewed simultaneously within AppXtender Document Manager. In this way, you can access applications located on different data sources during a single AppXtender Document Manager session, provided you have security rights to access those data sources.

For more information, refer to:

◆ “Locating Data Sources” on page 45
◆ “Specifying a Default Data Source” on page 47
◆ “Specifying Multiple Data Sources” on page 48

For information on data source creation and configuration, consult your AppXtender system administrator or refer to the "ApplicationXtender Data Sources" section of the ApplicationXtender Core Components Administrator’s Guide.

Note: You can save data source settings (which data sources are default and which are selected) to a file, along with other AppXtender Document Manager workstation settings. Also, if you have such a saved settings file, you can load the data source settings from that file. For instructions, refer to “Saving and Loading Settings” on page 124.

CAUTION

All of the settings that you enter in the ApplicationXtender Data Source Selector are stored in C:\Documents and Settings\All Users\Application Data\XSCM.CONFIG. Do not edit the contents of the XSCM.CONFIG file.
Locating Data Sources

The ApplicationXtender Data Source Selector allows you to locate data sources from your workstation.

To locate data sources:

1. From the Windows Start menu, select Programs and then ApplicationXtender Desktop.
2. From the ApplicationXtender Desktop menu, select AppXtender Data Source Selector. The AppXtender Data Source Selector dialog box appears.

![AppXtender Data Source Selector Dialog Box](Figure 4)

3. Click Locate. The Data Link Properties dialog box appears.
4. Click the Provider tab label to reveal the tab.

![Data Link Properties Dialog Box - Provider Tab](Figure 5)
5. On the Provider tab, select the appropriate data provider for one of the data sources in the data source group that you want to locate.

6. Click the Connection tab label to reveal the tab.

7. On the Connection tab, enter appropriate server and database information.

   **Note:** For more information, consult your AppXtender system administrator or refer to the "ApplicationXtender Data Sources" section of the ApplicationXtender Core Components Administrator’s Guide.

8. To verify that you correctly entered the server and database information, on the lower right, click Test Connection.

9. If the test is successful, save the settings by clicking OK. The Data Link Properties dialog box closes and you are returned to the AppXtender Data Source Selector dialog box.

10. To locate another data source, repeat steps 3 through 9.

11. Specify a default data source. For more information, refer to “Specifying a Default Data Source” on page 47.

   **Note:** You must specify a data source as default before you can close the AppXtender Data Source Selector dialog box.

12. To save the settings and close the dialog box, click OK.
Selecting Data Sources

Specifying a Default Data Source

The ApplicationXtender Data Source Selector allows you to set a data source as default. This setting determines which data sources are in use for AppXtender Desktop, the import wizards, and ApplicationXtender Move Online.

To set a data source as default:

1. From the Windows Start menu, select Programs and then ApplicationXtender. From the AppXtender menu, select ApplicationXtender Data Source Selector. The AppXtender Data Source Configuration dialog box appears.

2. In the list box, double-click the data source you want to set as default. A white check mark on a black background should appear next to it.

3. To save your setting, click OK or Apply. (OK saves your changes and closes the dialog box. Apply saves your changes without closing the dialog box.)
Note: Even when multiple data sources are designated for viewing within AppXtender Document Manager, only the data source designated as the default data source can be accessed using ApplicationXtender Move Online.

The next time you log into ApplicationXtender Document Manager, the default data source will automatically "open" so that you can access its applications.

**Specifying Multiple Data Sources**

If multiple data sources are available from the AppXtender Data Source Selector dialog box, multiple data sources may be designated to be viewed from within AppXtender Document Manager. This allows authorized users to access and work with applications from two or more data sources during a single AppXtender Document Manager session.

Note: You can log into only those data sources for which you have a user account. For more information on creating a user account in a data source, consult your system administrator or refer to the "Implementing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

To configure multiple data sources to be viewed in AppXtender Document Manager:

1. Access the ApplicationXtender Data Source Selector dialog box. For specific steps, refer to “Locating Data Sources” on page 45.
2. From the list of available data sources, select a data source that you want to appear within AppXtender Document Manager (other than the default data source).
3. Click Show/Hide. A black check mark should appear next to the selected data source.
4. Repeat steps 2 and 3 for each data source you want to be accessible within AppXtender Document Manager.
5. To save your settings, click OK or Apply. (OK saves your changes and closes the dialog box. Apply saves your changes without closing the dialog box.) The next time you launch AppXtender Document Manager, all data sources that you placed check marks next to are accessible.
Note: Even when multiple data sources are designated for viewing within AppXtender Document Manager, only the data source designated as the default data source can be accessed using ApplicationXtender Move Online.
Starting ApplicationXtender Document Manager

The ApplicationXtender Document Manager program is the ApplicationXtender module most frequently accessed by users. Documents are stored, retrieved, and processed within this module.

ApplicationXtender is password protected, which means that it monitors each user’s activity and allows or denies access to certain information and functions based on that user’s assigned privileges. Privileges—such as the ability to display, print, fax, modify, or delete—are assigned to a user’s account by the administrator. AppXtender has varying levels of security, from initial login to document level.

The administrator can assign full system rights for all applications or different rights from one application to another. For example, a user may have full privileges for the "Purchase Orders" application but only display and print privileges for the "Human Resources" application.

Each user account is driven by the user name and password, making this information required when logging on to the system. If you have not been assigned an AppXtender user name and password, consult your AppXtender system administrator to obtain a user account.

If you cannot perform a particular AppXtender function, consult the system administrator to verify your security privileges. For more information on security in ApplicationXtender, refer to the "Implementing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

Note: Your login procedure may vary depending on the security provider in use for the current data source. For information, refer to “Variations on Login Procedures” on page 52.

To start AppXtender Document Manager:

1. From the Windows Start menu, select Programs > ApplicationXtender Desktop > AppXtender Document Manager. The ApplicationXtender Document Manager copyright screen appears for a short period of time and then closes automatically. If you are required to log in to access AppXtender Document Manager, the Login dialog box will appear next.
Getting Started

Starting ApplicationXtender Document Manager

Figure 9 ApplicationXtender Document Manager Login Dialog Box

2. If the Login dialog box appears, from the Logon Type drop-down list, select the logon type. The following table describes the licenses required for each logon type:

Table 2 AppXtender Desktop License Types

<table>
<thead>
<tr>
<th>Logon Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppXtender</td>
<td>Logs into ApplicationXtender using an AppXtender Desktop license only.</td>
</tr>
<tr>
<td>AppXtender Reports Mgmt</td>
<td>Logs into ApplicationXtender using an ApplicationXtender Reports Management license so that you can view AppXtender Reports Mgmt data.</td>
</tr>
<tr>
<td>AppXtender &amp; AppXtender Reports Mgmt</td>
<td>Logs into ApplicationXtender using both an AppXtender Desktop license and an AppXtender Reports Mgmt license so that you can view both AppXtender and AppXtender Reports Mgmt data.</td>
</tr>
</tbody>
</table>

3. In the User Name text box, enter a user name that is appropriate for the selected data source.
4. In the Password text box, enter your password.
5. If you are the only person that uses AppXtender Document Manager on this workstation, to have AppXtender Document Manager remember your user name and password and bypass the Login dialog box for all subsequent logins, select the Remember password option.

**Note:** The Remember password option is only available if it has been enabled for the AppXtender Document Manager workstation. For information on disabling this feature, refer to “Disabling the Remember Password Option” on page 89.

6. Click Login. If the information you entered is correct, AppXtender Document Manager will start. If the information is incorrect, an error message will appear.
7. For information about AppXtender’s built-in security, consult your AppXtender system administrator or refer to the “Implementing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

Note: When you click Login, if a message appears indicating that AppXtender Document Manager cannot find the data source or licensing information it needs to connect to the AppXtender database, you can load settings to provide AppXtender Document Manager with connection information. For more information, refer to “Disabling the Remember Password Option” on page 89.

Variations on Login Procedures

The variations in login procedures depend primarily on the security provider in use for the data source. The following table describes each variation:

<table>
<thead>
<tr>
<th>Variation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the current data source is using the CM security provider</td>
<td>Passwords are not case-sensitive.</td>
</tr>
</tbody>
</table>
ApplicationXtender allows you to log into AppXtender Document Manager during another user’s AppXtender Document Manager session on the same workstation. For example, when a system administrator wants to make a change to a setting on the AppXtender Configuration dialog box and comes to the workstation that Bob is logged into, he can select New Login from the File menu and log in using his user name. After making the change, he can again select New Login from the File menu and log back in as Bob.

Note: Your login procedure may vary depending on the security provider in use for the current data source. For information, refer to “Variations on Login Procedures” on page 52.
Note: If the AppXtender system is using the Windows security provider and you are logging into AppXtender Document Manager on a workstation on which someone else has logged in using his or her Windows user name and password, you must have the Act as part of operating system privilege configured for your Windows user account, either on the local domain for the computer where you are logging in or on the License Server. For more information, consult your AppXtender system administrator or refer to the "Implementing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

To log in as a new user:

   The ApplicationXtender Document Manager program is executed.
2. From the File menu, select New Login.
   The AppXtender Document Manager Login dialog box appears.
3. From the Logon Type drop-down list, select the logon type. For a description of each logon type, refer to “Starting ApplicationXtender Document Manager” on page 50.
4. In the User Name text box, enter a user name that is appropriate for the selected data source.
5. In the Password text box, enter your password.
6. Click Login.
   If the information you entered is correct, AppXtender Document Manager restarts using the new user name and password. For more information about AppXtender’s built-in security, consult your AppXtender system administrator or refer to the "Implementing Security" section of the ApplicationXtender Core Components Administrator’s Guide.
Logging into Multiple Data Sources

If multiple data sources have been configured using the AppXtender ApplicationXtender Data Source Selector, you can access them all from the AppXtender Document Manager interface. In this way, you can access applications located on many different data sources during a single AppXtender Document Manager session. For more information on data sources, refer to “Selecting Data Sources” on page 44.

**Note:** You can log into only those data sources for which you have a user account.

**Note:** You cannot configure Cross Application Queries to be run across data sources. Applications must reside within the same data source to be included together in a Cross Application Query.

**Note:** Your login procedure may vary depending on the security provider in use for the current data source. For information, refer to “Variations on Login Procedures” on page 52.

When logging in, by default, you are logged into only one of the available data sources. To log into other data sources available in the Application view, use the following procedures.

To log into another data source:

1. Log into AppXtender Document Manager.
   The AppXtender Document Manager interface appears with a list of available data sources appearing within the Application view pane. The active data source (data source you logged into) appears in the data source list in bold type, and the list of applications is expanded under the data source name.
2. To log into an additional data source, right-click the data source you want to log into and select Login. The Login dialog box appears.

3. From the Logon Type drop-down list, select the logon type.

   **Note:** For a description of each logon type, refer to “Starting ApplicationXtender Document Manager” on page 50.

4. In the User Name text box, enter a user name that is appropriate for the selected data source.

5. In the Password text box, enter your password.

6. If you are the only person that uses AppXtender Document Manager on this workstation, to have AppXtender Document Manager remember your user name and password and bypass the Login dialog box for all subsequent logins, select the Remember password option.

   **Note:** The Remember password option is only available if it has been enabled for your AppXtender Document Manager workstation. For information on disabling this feature, refer to “Saving and Loading Settings” on page 124.

7. Click Login to log into the data source.
Checking for Updates

The Check for Updates utility allows you to check for updates that your AppXtender system administrator has placed on the network.

To check for updates:

1. From the Utilities menu, select Check for Updates. The ApplicationXtender Updater dialog box appears, listing the update packages that are available.

![ApplicationXtender Updater Dialog Box](image)

Note: If a message appears indicating that the License Server has not stored the update directory, it may be that your AppXtender system administrator has not placed any updates on the network. For more information, consult your AppXtender system administrator.

2. To see version, vendor, and poc information about the packages, select each package in the list. The Package Version, Package Vendor, and Package POC text boxes appear.

3. For each package that you do not want to install, clear the corresponding check box.

4. Click Continue. All selected packages are installed.
When new updates are available in the update directory, the ApplicationXtender Update Notification icon appears in the icon tray of the Windows task bar.

![ApplicationXtender Update Notification Icon](image1.png)

To install updates from the Windows task bar:

1. Double-click the ApplicationXtender Update Notification icon. The ApplicationXtender Updater dialog box appears.

![ApplicationXtender Updater Dialog Box](image2.png)

2. Click View Updates. The ApplicationXtender Updater dialog box appears, listing the update packages that are available.

   **Note:** If you click Notify Me Later, the ApplicationXtender Update Notification icon will clear and then reappear after the amount of time specified for the ApplicationXtender Update Monitor scheduled task. The default is 3 hours.

3. For each package that you do not want to install, clear the corresponding check box.

4. Click Continue. All selected packages are installed.
Automatically Monitoring for Updates

You can configure your AppXtender Document Manager workstation to automatically check the update directory periodically for new updates and notify you when updates are available. You do this by enabling the ApplicationXtender Update Monitor.

To enable the ApplicationXtender Update Monitor:

1. From the Utilities menu, select Check for Updates. The ApplicationXtender Updater dialog box appears.

   **Note:** If a message appears indicating that the License Server has not stored the update directory, it may be that your AppXtender system administrator has not placed any updates on the network. For more information, consult your AppXtender system administrator.

2. Select the Automatically notify you when new updates are available? option. This enables the ApplicationXtender Update Monitor as a Windows scheduled task. By default, it checks the update directory for new updates every 3 hours.

   **Note:** You can modify the settings for the ApplicationXtender Update Monitor just like any Windows scheduled task. For instructions, refer to your Windows documentation.
ApplicationXtender Document Manager Views

The ApplicationXtender Document Manager desktop consists of many views, or panes, that you can customize to fit your preferences. You can show or hide each view. If you want a certain view to always appear in a certain location on the desktop, you can dock that view on the desktop.

![Multiple Views Open on ApplicationXtender Desktop](image)

Figure 14  Multiple Views Open on ApplicationXtender Desktop

When two or more views are showing, only one of the views is active.

**Note:** If you installed the AppXtender demo database during ApplicationXtender installation, you can use the applications and documents in that database to practice using AppXtender Document Manager views to display information.
Application View

The Application view contains a tree structure listing available data sources, applications, and queries.

![Application View](image)

The data source icons show which data sources you are currently logged into on your workstation. When you are logged into a data source, the icon shows a key. When you are not logged in, the icon shows a locked padlock.

**Figure 16 ApplicationXtender Data Source Icons Showing Login State**

When you are logged into more than one data source simultaneously, the name of the currently active data source appears in bold-faced type.

**Note:** For information on logging into a data source from Application view, refer to “Logging into Multiple Data Sources” on page 55.

To show or hide the Application view:

- From the View menu, select Applications.
For each active data source in the Application view, you can show or hide a list of its applications. You can also show or hide a list of available queries for each application.

To show or hide applications and available queries lists:

1. If you have not done so already, log into the data source. When you log into the data source, the data source node expands to show a list of available applications.

   **Note:** For information on logging into a data source from Application view, refer to “Logging into Multiple Data Sources” on page 55.

2. To show a list of available queries for an application, click the plus sign to the left of the application name. The plus sign changes to a minus sign, and the application node expands to show a list of available queries.
3. To hide the list of queries, click the minus sign to the left of the application name. The application node closes, and the minus sign changes to a plus sign.

![Application Node Closed](imageapp-misc_image_app.png)

**Figure 19 Application Node Closed**

4. To hide the list of applications, click the minus sign to the left of the data source name. The list closes, and the minus sign changes to a plus sign.

![Data Source Node Closed](imageapp-misc_image_app.png)

**Figure 20 Data Source Node Closed**

Another way to show or hide the list of available applications and queries for a data source is by selecting from a shortcut menu.

To show or hide lists of applications and queries using shortcut menu commands:

1. If you have not done so already, log into the data source.

   **Note:** For information on logging into a data source from Application view, refer to “Logging into Multiple Data Sources” on page 55.

2. To access the shortcut menu for the data source, right-click the data source name.

   When the shortcut menu appears, you have the following choices:

   - To show the list of applications, click Expand.
   - To show the list of applications and the list of queries for each application, click Expand All.
   - To hide the lists, click Collapse.
Activating an Application

To work with an application, you must first activate it.

To activate an application:

◆ Double-click the application name. The application name appears in bold-faced type, indicating the application is now active.

Note: When you are logged into two or more data sources and you activate an application located in a data source other than the currently active data source, you also activate the data source in which the application is located.

Query View

The Query view is a tabbed dialog box containing the Search tab, the Result Set tab, and the Text Search tab. The Search tab allows you to query for AppXtender documents by entering index data, full-text data, or both index and full-text data as search criteria. The Result Set tab and Text Search tab show the results of the queries you perform from the Search tab (the result set).

To show the Query view for a new query:

◆ In the Application view, right-click the name of the application you want to query. A shortcut menu appears.

◆ From the menu, select New Query. The Query view appears with the Search tab revealed.

Search Tab

The application fields available for searching are listed in a table on the Search tab of the Query view.
You set up queries by entering values in the Value column of the table. (The procedure to query an application is discussed in detail in “Retrieving Documents” on page 243.)

You can adjust the height of the table cells on the Search tab to suit your preferences, as well as restore resized cells to the default height.

To change cell height for a row:

- In the Fields column, drag the lower boundary line for the row you want to resize up or down to increase or decrease the height of the cells.

  **Note:** Resizing the height of the cells in a row does not change the height of the cells in the other rows on the Search tab.

To restore resized cells to the default height:

- In the Fields column, right-click and then select Restore Cells. AppXtender Document Manager automatically resets all cells to their default height.
**Getting Started**

**Result Set Tab**

When you search for documents, if the search is successful, the search results appear on the Result Set tab of the Query view.

![Query View: Result Set Tab](image)

*Figure 22 Query View: Result Set Tab*

From the list on the Result Set tab, you can select documents and then select commands from the Document menu to process those documents. For example, you can display, print, fax, or delete documents from the Result Set, or you can submit them to the ApplicationXtender Index Server.

*Note:* If only one document matches the search criteria, the document automatically appears in the Document Display view. For more information, refer to "Document Display View" on page 67.

When you create and run a query, the query is automatically added to the list of queries for the corresponding application in the Application view. This way, you can run the query later in the session without having to enter the search criteria again.

*Figure 23 New Query Listed Under Application in Application View*
Running an Existing Query

If you want to run a query in later sessions, you can save the search criteria and give the query a name. Otherwise, any queries you create during a session are deleted when you exit ApplicationXtender Document Manager.

To run an existing query:
1. In the Application view, expand the node for the application.
2. Double-click the name of the query you want to run.

Showing or Hiding the Query View

To show or hide the Query view:
- From the View menu, select Query.

Document Display View

The Document Display view allows you to view a stored document after you have retrieved it or a new document while you are indexing it. For information on adding and indexing new documents, refer to “Creating Documents” on page 137.

To display a stored document in Document Display view:
1. Access the Query view and search for the document you want to display.
2. On the Result Set tab in the Query view, double-click the entry for the document you want to view. The document appears in the Document Display view.

Figure 24 Document Display View
Note: For more information on retrieving stored documents, refer to Chapter 5, “Retrieving Documents.”

When you display a document in the Document Display view, an image toolbar appears below the main toolbar on your desktop.

You can use the pointer to manipulate the displayed document in several ways, depending on the current pointer mode. In pan mode, you can drag the image in the view to see more of it. In selection mode, you can select a region of the image and implement one or more commands on that region.

To switch between pan mode and selection mode:

◆ On the Image toolbar, click the Pan Mode button.

Index View

In the Index view, you can index new documents and view existing index information for displayed documents. For information on indexing new documents, refer to “Indexing New Documents” on page 187. For information on modifying indexes, refer to “Modifying Document Indexes” on page 369.

There are three separate Index views in AppXtender Document Manager: the Index view that appears when you add a new document, the Index view that appears when you display an existing document index, and the Index view that appears when you use the AppXtender Document Manager Batch Index function. By default, each of these Index views appears to the left of the Document Display view.
Each of the three Index views can be repositioned in relation to the Document Display view based on your preferences. When you reposition an Index view, AppXtender Document Manager saves the new position information. The next time you open that Index view, AppXtender Document Manager displays it in the new position instead of in the default position. For example, if you select Document, New, and then any option from the menu that appears (such as Scan, Clipboard Paste, Clipboard Paste Special, Insert Object, Import File, or Fax-in Queue), the Index view appears to the left of the Document Display view. If you then move the Index view to the right of the Document Display view, the next time you select Document, New, and an option, the associated Index View will appear to the right of the document.

AppXtender Document Manager saves the position of each of the three Index views separately. Changing the position of one Index view does not affect the position of the other two views.
**Showing and Hiding the Index View**

To show the Index view:
- Click the Index View button on the Image toolbar until the Index view appears where you want it. You can display it to the left, right, top, or bottom of the Document Display view.

![Index View Button](image)

**Note:** This button is available only when a document is displayed.

To hide the Index view:
- Click the Index View button on the Image toolbar until the Index view is hidden.

**Adjusting Cell Height**

You can also change the height of Index view cells and then restore them to their original size.

To change cell height for a row in Index view:
- In the Fields column, drag the lower boundary line for the row you want to resize up or down to increase or decrease the height of the cells.

**Note:** Resizing the cell height for a row does not change the height of the cells in the other rows.

To restore resized cells to the default height:
- In the Fields column, right-click and then select Restore Cells. AppXtender Document Manager automatically resets all cells to their default height.
Workflow Workbox

The Workflow Workbox (Workflow view) is a dialog box containing tabs for the ApplicationXtender Workflow® (AppXtender Workflow) Inbox and Groupbox. Depending on the AppXtender configuration, this dialog box may also contain an Action Pending tab, an All Work tab, a My History tab, and/or a Completed tab. For information on configuring the Workflow Workbox and connecting to AppXtender Workflow, the ApplicationXtender Workflow User’s Guide.

Note: The Check for Updates command on the Utilities menu allows you to install the AppXtender Workflow client. For information, “Checking for Updates” on page 57.

Figure 28 Workflow Workbox

To show or hide the Workflow view:

◆ From the View menu, select Workflow.

Note: Workflow appears on the View menu only when ApplicationXtender Workflow is installed and configured on your workstation.
The Thumbnail view contains a series of miniature images or icons representing the pages of the currently displayed document.

Figure 29  Thumbnail View

A thumbnail appears either as a miniature rendering of the image in the Document Display view or as an icon. The following table provides information of the types of thumbnails used to represent different page types:

Table 4  Page and Thumbnail Types

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Thumbnail Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>Miniature image</td>
<td>![Image Icon]</td>
</tr>
<tr>
<td>COLD/ERM text (with or without form overlay)</td>
<td>Icon</td>
<td>![Icon Icon]</td>
</tr>
<tr>
<td>Foreign file</td>
<td>Icon or miniature image, depending on configuration</td>
<td>![Foreign File Icon]</td>
</tr>
<tr>
<td>OLE</td>
<td>Miniature image</td>
<td>![OLE Icon]</td>
</tr>
</tbody>
</table>
For information on configuring thumbnails, including the options to display foreign file thumbnails and RTF thumbnails as miniature images, the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

To show or hide the Thumbnail view:

- From the View menu, select Thumbnail.

**Note:** Depending on the configuration of your AppXtender Document Manager workstation, thumbnails do not always appear when Thumbnail view appears. For information on displaying thumbnails in Thumbnail view, “Displaying Thumbnails” on page 311.
AppXtender Document Manager Toolbars

ApplicationXtender Document Manager (AppXtender Document Manager) has six toolbars. These toolbars provide shortcut buttons for the most frequently used AppXtender Document Manager commands. When the mouse pointer is held over a toolbar button, a description of the button’s function appears as a tool tip and in the status bar.

Each toolbar can be shown or hidden, depending on your preference. You can also customize the toolbars based on your work requirements. For information on showing, hiding, and customizing a toolbar, refer to “Configuring Toolbars, Title Bar, and Status Bar” on page 90.

For information on each of the toolbars, refer to the following topics:

- “Main Toolbar” on page 74
- “Annotation Toolbar” on page 77
- “Image Toolbar” on page 80
- “Script Toolbar” on page 82
- “Batch Index Toolbar” on page 83
- “Scan Toolbar” on page 84

Main Toolbar

The Main toolbar contains buttons that allow you to access the essential functions of AppXtender Document Manager.

![Main Toolbar Image]
The following table describes the function of each button on the Main toolbar:

### Table 5  ApplicationXtender Document Manager Main Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>For More Information, Refer To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button 1]</td>
<td>Shows or hides the Application view.</td>
<td>“Application View” on page 61</td>
</tr>
<tr>
<td>![Button 2]</td>
<td>Shows or hides the Query view for the current query.</td>
<td>“Query View” on page 64</td>
</tr>
<tr>
<td>![Button 3]</td>
<td>Shows or hides the Workflow Workbox.</td>
<td>ApplicationXtender Workflow User’s Guide</td>
</tr>
<tr>
<td>![Button 4]</td>
<td>Shows or hides the Thumbnail view.</td>
<td>“Thumbnail View” on page 72</td>
</tr>
<tr>
<td>![Button 6]</td>
<td>Runs the selected query.</td>
<td>“Running a Query” on page 304</td>
</tr>
<tr>
<td>![Button 7]</td>
<td>Begins a new query on the active application.</td>
<td>“Searching a Single Application” on page 248</td>
</tr>
<tr>
<td>![Button 8]</td>
<td>Opens the New Cross Application Query dialog box so you can configure a new query that searches across multiple applications.</td>
<td>“Creating a New Cross Application Query” on page 265</td>
</tr>
<tr>
<td>![Button 9]</td>
<td>Depending on how the Print feature is configured, prints either the currently displayed document or the currently displayed page. <strong>Note:</strong> If the Print configuration is set to Prompt, when you use the Print toolbar button to print, regardless of which option you select from the Print dialog box, only the currently displayed page will print.</td>
<td>“Printing or Faxing Documents and Pages” on page 373</td>
</tr>
<tr>
<td>![Button 10]</td>
<td>Cuts the displayed page to the Windows Clipboard.</td>
<td>“Adding a Document from the Windows Clipboard” on page 150 and “Adding a Page from the Windows Clipboard” on page 356</td>
</tr>
</tbody>
</table>
### Table 5  ApplicationXtender Document Manager Main Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>For More Information, Refer To:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Clipboard" /></td>
<td>Copies the displayed page to the Windows Clipboard.</td>
<td>“Adding a Document from the Windows Clipboard” on page 150 and “Adding a Page from the Windows Clipboard” on page 356</td>
</tr>
<tr>
<td><img src="image" alt="AppXtender Configuration" /></td>
<td>Creates a new document from the Windows Clipboard or adds a new page to the displayed document from the Windows Clipboard.</td>
<td>“Adding a Document from the Windows Clipboard” on page 150 and “Adding a Page from the Windows Clipboard” on page 356</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Performs a text search on the currently displayed document.</td>
<td>“Text Search from the Result Set” on page 300</td>
</tr>
<tr>
<td><img src="image" alt="AppXtender Configuration" /></td>
<td>Opens the AppXtender Configuration dialog box.</td>
<td>“Customizing AppXtender Document Manager Views” on page 99</td>
</tr>
<tr>
<td><img src="image" alt="Tile" /></td>
<td>Vertically tiles multiple documents in Document Display view.</td>
<td>“Tile” on page 316</td>
</tr>
<tr>
<td><img src="image" alt="Tile" /></td>
<td>Horizontally tiles multiple documents in Document Display view.</td>
<td>“Tile” on page 316</td>
</tr>
<tr>
<td><img src="image" alt="Cascade" /></td>
<td>Cascades multiple documents in Document Display view.</td>
<td>“Cascade” on page 316</td>
</tr>
</tbody>
</table>
| ![Maximize](image) | Maximizes the Document Display view and any open toolbars to fill the entire screen. If the Index view and the Thumbnail view are open, they will appear along with the Document Display view.  
**Note:** Once in full-screen mode, if available, you can use the toolbar buttons to show the Application view, the Query view, or both. | “Activating AppXtender Document Manager Full Screen Mode” on page 104 |
| ![Select Scanner](image) | Opens the Select Scanner dialog box. | “Selecting a Scanner” on page 214 |
| ![Scan](image) | Scans a new document into the active application. | “Scanning Documents” on page 223 |
| ![EmailXtender Search](image) | Opens the EmailXtender Search plug-in so that you can search for and retrieve archived e-mail messages. This option is only available if the EmailXtender Search plug-in is installed on the workstation and if Microsoft Outlook is the e-mail client in use with EmailXtender®. | EmailXtender Search User’s Guide |
Annotation Toolbar

The Annotation toolbar allows you to add annotations to documents and batch pages. All of the functions available from the Annotation toolbar can also be accessed from the Annotate menu.

![Annotation Toolbar](image)

**Note:** Only users with appropriate privileges can access commands and buttons in the Annotations menu and toolbar. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Implementing Security” section of the *ApplicationXtender Core Components Administrator’s Guide*.

This topic briefly explains the function of each Annotation toolbar button. For more information on adding an annotation, refer to Chapter 9, “Annotations.”

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Selection Icon" /></td>
<td>Allows selection of annotations (toggle). For information, refer to “Modifying Annotation Settings” on page 525.</td>
</tr>
<tr>
<td><img src="image" alt="Text Icon" /></td>
<td>Creates a text annotation. For information, refer to “Creating Text Annotations” on page 499.</td>
</tr>
<tr>
<td><img src="image" alt="Highlight Icon" /></td>
<td>Creates a highlight annotation. For information, refer to “Creating a Highlight Annotation” on page 498.</td>
</tr>
<tr>
<td><img src="image" alt="Line Icon" /></td>
<td>Creates a freehand line annotation. For information, refer to “Creating a Basic Line Annotation” on page 493.</td>
</tr>
<tr>
<td><img src="image" alt="Line Icon" /></td>
<td>Creates a straight line annotation. For information, refer to “Creating a Basic Line Annotation” on page 493.</td>
</tr>
<tr>
<td><img src="image" alt="Arrow Icon" /></td>
<td>Creates an arrow annotation. For information, refer to “Creating a Basic Line Annotation” on page 493.</td>
</tr>
</tbody>
</table>
### Table 6  Annotation Toolbar Buttons (continued)

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create Rectangular Annotation" /></td>
<td>Creates a rectangular annotation. For information, refer to “Creating a Basic Shape Annotation” on page 496.</td>
</tr>
<tr>
<td><img src="image" alt="Create Rounded Rectangular Annotation" /></td>
<td>Creates a rounded rectangular annotation. For information, refer to “Creating a Basic Shape Annotation” on page 496.</td>
</tr>
<tr>
<td><img src="image" alt="Create Oval Annotation" /></td>
<td>Creates an oval annotation. For information, refer to “Creating a Basic Shape Annotation” on page 496.</td>
</tr>
<tr>
<td><img src="image" alt="Create Polyline Annotation" /></td>
<td>Creates a polyline annotation. For information, refer to “Creating a Polygon Annotation” on page 497.</td>
</tr>
<tr>
<td><img src="image" alt="Create Polygon Annotation" /></td>
<td>Creates a polygon annotation. For information, refer to “Creating a Polygon Annotation” on page 497.</td>
</tr>
<tr>
<td><img src="image" alt="Erase Annotation" /></td>
<td>Erases the annotation. For information, refer to “Erasing Annotations” on page 536.</td>
</tr>
<tr>
<td><img src="image" alt="Create Filled or Hollow Annotation" /></td>
<td>Creates a filled or hollow annotation (toggle). For information, refer to “Default Filled or Hollow Setting” on page 490.</td>
</tr>
<tr>
<td><img src="image" alt="Create Redaction Annotation" /></td>
<td>Creates an annotation with redaction (toggle). For information, refer to “Default Redaction Setting” on page 491.</td>
</tr>
<tr>
<td><img src="image" alt="Select Default Annotation Group" /></td>
<td>Selects the default annotation group. For information, refer to “Assigning a Default Annotation Group” on page 517.</td>
</tr>
<tr>
<td><img src="image" alt="Select All Annotations" /></td>
<td>Selects all annotations. For information, refer to “Modifying Annotation Settings” on page 525.</td>
</tr>
<tr>
<td><img src="image" alt="Move Annotation Forward" /></td>
<td>Moves the selected annotation in front of another annotation. For information, refer to “Overlapping Annotations” on page 515.</td>
</tr>
<tr>
<td><img src="image" alt="Move Annotation Backward" /></td>
<td>Sends the selected annotation behind another annotation. For information, refer to “Overlapping Annotations” on page 515.</td>
</tr>
<tr>
<td><img src="image" alt="Show or Hide Annotations" /></td>
<td>Shows or hides annotations (toggle); allows you to hide annotations by annotation group. For information, refer to “Showing or Hiding Annotations” on page 518.</td>
</tr>
<tr>
<td><img src="image" alt="Select Line Width" /></td>
<td>Selects line width. For information, refer to “Default Line Width” on page 489.</td>
</tr>
<tr>
<td>Button</td>
<td>Function</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
</tr>
<tr>
<td>Creates a rectangular annotation. For information, refer to “Creating a Basic Shape Annotation” on page 496.</td>
<td></td>
</tr>
<tr>
<td>Creates a rounded rectangular annotation. For information, refer to “Creating a Basic Shape Annotation” on page 496.</td>
<td></td>
</tr>
<tr>
<td>Creates an oval annotation. For information, refer to “Creating a Basic Shape Annotation” on page 496.</td>
<td></td>
</tr>
<tr>
<td>Creates a polyline annotation. For information, refer to “Creating a Polygon Annotation” on page 497.</td>
<td></td>
</tr>
<tr>
<td>Creates a polygon annotation. For information, refer to “Creating a Polygon Annotation” on page 497.</td>
<td></td>
</tr>
<tr>
<td>Erases the annotation. For information, refer to “Erasing Annotations” on page 536.</td>
<td></td>
</tr>
<tr>
<td>Creates a filled or hollow annotation (toggle). For information, refer to “Default Filled or Hollow Setting” on page 490.</td>
<td></td>
</tr>
<tr>
<td>Creates an annotation with redaction (toggle). For information, refer to “Default Redaction Setting” on page 491.</td>
<td></td>
</tr>
<tr>
<td>Selects the default annotation group. For information, refer to “Assigning a Default Annotation Group” on page 517.</td>
<td></td>
</tr>
<tr>
<td>Selects all annotations. For information, refer to “Modifying Annotation Settings” on page 525.</td>
<td></td>
</tr>
<tr>
<td>Moves the selected annotation in front of another annotation. For information, refer to “Overlapping Annotations” on page 515.</td>
<td></td>
</tr>
<tr>
<td>Sends the selected annotation behind another annotation. For information, refer to “Overlapping Annotations” on page 515.</td>
<td></td>
</tr>
<tr>
<td>Shows or hides annotations (toggle); allows you to hide annotations by annotation group. For information, refer to “Showing or Hiding Annotations” on page 518.</td>
<td></td>
</tr>
<tr>
<td>Selects line width. For information, refer to “Default Line Width” on page 489.</td>
<td></td>
</tr>
</tbody>
</table>
Getting Started

Table 6  
Annotation Toolbar Buttons (continued)

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image-url" alt="Select Annotation Colors" /></td>
<td>Selects annotation colors. For information, refer to “Default Color for Line and Shape Annotations” on page 489.</td>
</tr>
<tr>
<td><img src="image-url" alt="Delete Annotation" /></td>
<td>Deletes the selected annotations. For information, refer to “Deleting Annotations” on page 537.</td>
</tr>
<tr>
<td><img src="image-url" alt="Save Annotations" /></td>
<td>Saves all annotations.</td>
</tr>
<tr>
<td><img src="image-url" alt="Cancel Changes" /></td>
<td>Cancels annotation changes.</td>
</tr>
<tr>
<td><img src="image-url" alt="Add Rubber Stamp" /></td>
<td>Adds the selected rubber stamp annotation to a page. For information, refer to “Adding Rubber Stamp Annotations to Pages” on page 512.</td>
</tr>
</tbody>
</table>

Image Toolbar

The Image toolbar contains buttons that allow you to manipulate document images appearing in the Document Display view.

Figure 32  
ApplicationXtender Document Manager Image Toolbar

The following table describes the function of each button on the Image toolbar:

Table 7  
ApplicationXtender Document Manager Image Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>For More Information, Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image-url" alt="Select View" /></td>
<td>Displays the selected view of the current page (rotated, enlarged, reduced, fit top to bottom, fit left to right) in the Document Display view.</td>
<td>“Using Sticky View” on page 97</td>
</tr>
<tr>
<td><img src="image-url" alt="Fit to Window" /></td>
<td>Fits the displayed page in the Document Display view.</td>
<td>“Fit to Window” on page 323</td>
</tr>
<tr>
<td><img src="image-url" alt="Fit to Window Height" /></td>
<td>Fits the displayed page in the Document Display view from top to bottom.</td>
<td>“Fit to Window Height” on page 323</td>
</tr>
</tbody>
</table>
**Table 7 ApplicationXtender Document Manager Image Toolbar Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>For More Information, Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="refresh" /></td>
<td>Rotates the displayed page 90° to the right in the Document Display view.</td>
<td>“Rotate Right” on page 324</td>
</tr>
<tr>
<td><img src="image" alt="zoom_in" /></td>
<td>Zooms in so the image in the Document Display view appears larger.</td>
<td>“Zoom In” on page 322</td>
</tr>
<tr>
<td><img src="image" alt="zoom_out" /></td>
<td>Zooms out so the image in the Document Display view appears smaller.</td>
<td>“Zoom Out” on page 322</td>
</tr>
<tr>
<td><img src="image" alt="magnifier" /></td>
<td>Opens the Magnifier window.</td>
<td>“Using the Magnifier” on page 324</td>
</tr>
<tr>
<td><img src="image" alt="prev_page" /></td>
<td>Displays the previous page of a multipage document</td>
<td>“Previous Page” on page 309</td>
</tr>
<tr>
<td><img src="image" alt="next_page" /></td>
<td>Displays the next page of a multipage document.</td>
<td>“Next Page” on page 309</td>
</tr>
<tr>
<td><img src="image" alt="prev_version" /></td>
<td>Displays the previous version of the page in the Document Display view.</td>
<td>“Previous Version” on page 314</td>
</tr>
<tr>
<td><img src="image" alt="next_version" /></td>
<td>Displays the next version of the page in the Document Display view.</td>
<td>“Next Version” on page 314</td>
</tr>
<tr>
<td><img src="image" alt="view_text" /></td>
<td>Shows the text or the image for the displayed document.</td>
<td>“Viewing Image Pages” on page 332</td>
</tr>
<tr>
<td><img src="image" alt="ocr" /></td>
<td>Performs optical character recognition (OCR) on the displayed page.</td>
<td>“Processing a Page Using OCR” on page 405</td>
</tr>
<tr>
<td><img src="image" alt="mode" /></td>
<td>Switches the Document Display view between pan mode and selection mode.</td>
<td>“Document Display View” on page 67</td>
</tr>
</tbody>
</table>
The Script toolbar allows you to perform up to 20 script-based functions. In order to activate the buttons on this toolbar, your system administrator must create a file named AEX32.TXT containing a script that assigns AppXtender Document Manager functions to the Script toolbar buttons.

### Table 7  ApplicationXtender Document Manager Image Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>For More Information, Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Shows or hides Index view.</td>
<td>“Index View” on page 68</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Shows or hides form overlays on COLD/ERM documents.</td>
<td>“Viewing Documents with Form Overlay” on page 333</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>For ICE format pages, displays the previous subpage. This button is available only if it has been added through the Customize Toolbar dialog box.</td>
<td>“Viewing Subpages” on page 314</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>For ICE format pages, displays the next subpage. This button is available only if it has been added through the Customize Toolbar dialog box.</td>
<td>“Viewing Subpages” on page 314</td>
</tr>
</tbody>
</table>

### Script Toolbar

The AppXtender Desktop software development kit (SDK) provides documentation on AppXtender Document Manager scripting. For more information, contact your sales representative.
The Batch Index toolbar allows you to perform batch indexing operations.

![ApplicationXtender Document Manager Batch Index Toolbar](image)

**Note:** For information on batch indexing, refer to “Indexing Batches” on page 200

The following table describes the function of each button on the Batch Index toolbar:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Creates a new document and attaches the current page in the batch to the new document.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Attaches the current page in the batch to the current document.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Attaches all pages in the batch to the current document.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Deletes the current page from the batch or the current document.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Displays the previous page in the batch.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Displays the next page in the batch.</td>
</tr>
</tbody>
</table>
Scan Toolbar

The Scan toolbar allows you to perform and configure scanning operations. All of the functions on the Scan toolbar can also be accessed from the Scan menu.

Figure 35 ApplicationXtender Scan Toolbar

This topic briefly explains the function of each Scan toolbar button and drop-down list. For more information on scanning, refer to Chapter 4, “Scanning.”.

Note: All of the following conditions must be met for a user to access features in the Scan toolbar or menu:

- Scanning hardware is installed on the user’s workstation
- The scanner drivers appropriate for the scanner are installed on the user’s workstation
- AppXtender Document Manager scanner support files are installed on the user’s workstation
- AppXtender scanning privileges are assigned to the user

For information on hardware and drivers, refer to the documentation provided by the scanner manufacturer. For a list of scanners that AppXtender supports, refer to “Selecting a Scanner” on page 214. For information on support files and privileges, consult your AppXtender system administrator or refer to the ApplicationXtender User’s Guide.
In addition to these buttons, the Scan toolbar also has four drop-down lists. These lists allow you to change the following settings for the images that you scan:

- DPI resolution setting
- Color
- Page size
- Scanner source

### Table 9: ApplicationXtender Document Manager Scan Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Scan button" /></td>
<td>Begins a scanning session. If a document is displayed in Document Display view, AppXtender Document Manager creates a new page. If no document is displayed, AppXtender Document Manager creates a new document.</td>
</tr>
<tr>
<td><img src="image" alt="Repeat button" /></td>
<td>Repeats the previous scan.</td>
</tr>
<tr>
<td><img src="image" alt="Auto Feed button" /></td>
<td>Enables auto feed mode. In auto feed mode, AppXtender Document Manager scans all of the pages in the feeder and then ends the scan session.</td>
</tr>
<tr>
<td><img src="image" alt="Manual Feed button" /></td>
<td>Enables manual feed mode. In manual feed mode, AppXtender Document Manager scans all of the pages in the feeder and then waits for you to add more pages to the feeder. If you do not add more pages before the scan session times out, the session ends.</td>
</tr>
<tr>
<td><img src="image" alt="Single Feed button" /></td>
<td>Enables single feed mode. In single feed mode, AppXtender Document Manager scans only one page at a time. After each page is scanned, you must click the Scan button again to scan the next page.</td>
</tr>
<tr>
<td><img src="image" alt="Rotation button" /></td>
<td>Configures the automatic rotation of images as they are scanned.</td>
</tr>
<tr>
<td><img src="image" alt="Rotation button" /></td>
<td>Configures the automatic rotation of images as they are scanned.</td>
</tr>
<tr>
<td><img src="image" alt="Shortcut button" /></td>
<td>Displays a shortcut menu so that you can configure scanning.</td>
</tr>
<tr>
<td><img src="image" alt="Enhancement button" /></td>
<td>Enables or disables automatic enhancement of images as they are being scanned.</td>
</tr>
</tbody>
</table>
Function Keys

ApplicationXtender Document Manager provides function keys that help you perform indexing and searches. The available function keys are identified and their functions are described in the following table.

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[F1]</td>
<td>Opens online help.</td>
</tr>
<tr>
<td>[F3]</td>
<td>Opens the Search dialog box. This key functions for text documents only. For more information, refer to “Text Search from the Document Display View” on page 298.</td>
</tr>
<tr>
<td>[F4]</td>
<td>Searches for existing document indexes during the indexing process, allowing you to append pages to existing documents. For more information, refer to “Appending Pages to Documents” on page 194.</td>
</tr>
<tr>
<td>[SHIFT]+ [F4]</td>
<td>Searches for unused Key Reference records that meet specified criteria and documents previously indexed with the same values. For more information, refer to “Using AppXtender Key Reference Import to Index Documents” on page 192.</td>
</tr>
<tr>
<td>[F5]</td>
<td>Displays the List of Values dialog box for the selected index field. This key functions during search only. For more information, refer to “List of Values Query” on page 255.</td>
</tr>
<tr>
<td>[F7]</td>
<td>Performs auto-indexing. This key functions during document creation for Auto Index fields only. For more information, refer to “Using AppXtender Auto Index Import to Index Documents” on page 191.</td>
</tr>
<tr>
<td>[F8]</td>
<td>Displays the Search Expression dialog box for the selected index field. This key functions during search only. For more information, refer to “Expression Range Query” on page 253.</td>
</tr>
<tr>
<td>[F9]</td>
<td>Duplicates index data from the last document index saved. This key functions during document creation only. For more information, refer to “Automated Indexing Features” on page 189.</td>
</tr>
</tbody>
</table>
Many configuration options are available to accommodate individual workstation preferences. Some configuration options are integral to AppXtender’s functionality, such as a default digital certificate, the file types and formats that AppXtender uses, and interface options with mail and optical character recognition (OCR) packages.

Other configuration options are cosmetic and do not alter the way the system performs, such as options controlling the look and feel of the AppXtender Document Manager interface. You can adjust the layout of the AppXtender Document Manager desktop and the behavior of the desktop views. You can also customize toolbar display and settings.

- Change Password
- Configuring Toolbars, Title Bar, and Status Bar
- Print Setup
- Using Sticky View
- Customizing AppXtender Document Manager Views
- Opening the Configuration Dialog Box
- View Tab
- Display Tab
- Fonts Tab
- Scan Tab
- Saving and Loading Settings

CHANGE PASSWORD

CUSTOMIZING YOUR APPXTENDER DOCUMENT MANAGER WORKSTATION
Change Password

ApplicationXtender is password protected. If the AppXtender system is using the CM security provider, you can change your password at any time to ensure system security.

**Note:** If the AppXtender system is using the CM security provider, AppXtender passwords are not case-sensitive.

**Note:** If the AppXtender system is using the Windows security provider or a directory service security provider, you cannot change your password in AppXtender. The only user whose password can be changed when AppXtender is using the Windows security provider is the SYSOP user. To change your Windows password, refer to your Windows documentation. To change your directory service password, refer to your directory service documentation.

To change your password:

1. From the File menu, select Change Password. The Change Password dialog box appears, with the current user name in the User Name text box.

![Change Password Dialog Box](image)

**Figure 36 Change Password Dialog Box**

**Note:** If you have the necessary privileges to access ApplicationXtender Workflow and it is installed on your system, you can change your ApplicationXtender Workflow password in the Change Password dialog box as well. For more information, refer to the ApplicationXtender Workflow User's Guide.
2. In the Current Password text box, type the original password for the current user name.

   **Note:** If you have forgotten your password, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the *ApplicationXtender Core Components Administrator’s Guide*.

3. In the New Password text box, type the new password that you want to use for the current user name.

4. In the Confirm New Password text box, type the new password again. The purpose of this step is to ensure data entry accuracy.

5. Click OK. The new password is saved with the current user name.

---

**Disabling the Remember Password Option**

If you chose to enable Remember password while logging into AppXtender Document Manager, the Login dialog box no longer appears when you open AppXtender Document Manager. (For instructions on enabling the Remember password feature, refer to “Starting ApplicationXtender Document Manager” on page 50.) The following procedure describes how to disable the Remember password option, so that the Login dialog box appears when you open AppXtender Document Manager.

To disable the Remember Password feature:

1. From the File menu, select Change Password. The Change Password dialog box appears.

2. Clear the Remember Password check box and click OK.

The next time you start AppXtender Document Manager, the Login dialog box appears because AppXtender Document Manager no longer remembers your password.

**Note:** If the Allow remember password option is not enabled in the Data tab of the AppXtender Document Manager Configuration dialog box, the Remember Password option will not be available. For more information on the Data tab options, consult your AppXtender system administrator or refer to the “Configuring AppXtender Document Manager Workstations” chapter of the *ApplicationXtender Installation Guide*. 
Configuring Toolbars, Title Bar, and Status Bar

You can customize the ApplicationXtender Document Manager (AppXtender Document Manager) toolbars, the Document Display view title bar, and the AppXtender Document Manager status bar to meet your needs. For instructions, refer to the following topics:

- “Displaying or Hiding a Toolbar” on page 91
- “Changing the Size of Toolbar Buttons” on page 92
- “Customizing Toolbars” on page 92
- “Configuring the Title Bar” on page 93
- “Displaying or Hiding the Status Bar” on page 95

The following table briefly describes the functions available on each toolbar:

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main</td>
<td>The Main toolbar provides shortcuts to common ApplicationXtender commands, such as print, scan, query, and configure. These commands can be executed by clicking the buttons on the toolbar, eliminating the series of steps necessary when using the pull down menus. For a detailed description of each button on the Main toolbar, refer to “Main Toolbar” on page 74.</td>
</tr>
<tr>
<td>Annotation</td>
<td>The Annotation toolbar contains shortcuts to the annotation features, such as select, save, delete, and create. For a detailed description of each button on the Annotation toolbar, refer to “Annotation Toolbar” on page 77.</td>
</tr>
<tr>
<td>Image</td>
<td>The Image toolbar provides shortcuts for manipulating images. Some of the buttons available are pan mode, process a page using OCR, show index value, rotating, and zooming. For a detailed description of each button on the Image toolbar, refer to “Image Toolbar” on page 80.</td>
</tr>
</tbody>
</table>
Customizing Your AppXtender Document Manager Workstation

## Configuring Toolbars, Title Bar, and Status Bar

### Displaying or Hiding a Toolbar

ApplicationXtender Document Manager toolbars can be shown or hidden from view. All AppXtender features are always available from menus, even if the toolbar is hidden. Toolbars can be removed to create more space for displaying documents.

### Table 11: AppXtender Document Manager Toolbars (continued)

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>The Script toolbar provides shortcuts for up to 20 script-based functions. In order to activate the buttons on this toolbar, your system administrator must create a file named AEX32.TXT containing a script that assigns AppXtender functions to the Script toolbar buttons. The AppXtender software development kit (AppXtender SDK) provides documentation on AppXtender scripting. For more information, contact your sales representative.</td>
</tr>
<tr>
<td>Batch Index</td>
<td>The Batch Index toolbar provides shortcuts to the batch indexing feature. From the Batch Index toolbar, you can create new documents and pages from a batch, delete a page from a batch, and navigate from page to page in a batch or document. For a detailed description of each button on the Batch Index toolbar, refer to “Batch Index Toolbar” on page 83.</td>
</tr>
<tr>
<td>Scan</td>
<td>The Scan toolbar contains shortcuts for scanning options and configuration settings such as manual feed, auto feed, single feed, rescan, and different automatic-rotation options. For a detailed description of each button on the Scan toolbar, refer to “Scan Toolbar” on page 84.</td>
</tr>
</tbody>
</table>

![Displaying Toolbars](image)
To display or hide a toolbar:
1. From the View menu, select Toolbars. In the Toolbars submenu, the name of each displayed toolbar has a check mark next to it.
2. In the Toolbars submenu, click the name of the toolbar you want to display or hide. If the toolbar you selected was previously displayed, it is now hidden. If the toolbar you selected was previously hidden, it is now displayed.

### Changing the Size of Toolbar Buttons

The default size of ApplicationXtender Document Manager toolbar buttons may be too small for some users. You can change the size of AppXtender Document Manager toolbar buttons, if necessary.

To make small toolbar buttons larger:
1. From the View menu, select Toolbars. In the Toolbars submenu, a check mark indicates the current button size setting.
2. If Small Icons are enabled, in the Toolbars submenu, click Large Icons. The buttons increase in size.

To make large toolbar buttons smaller:
1. From the View menu, select Toolbars. In the Toolbars submenu, a check mark indicates the current button size setting.
2. If Large Icons are enabled, in the Toolbars submenu, click Small Icons. The buttons decrease in size.

### Customizing Toolbars

Any AppXtender Document Manager toolbar can be customized to meet your needs. Buttons can be deleted from the toolbar, added to the toolbar, or reordered.

To customize a toolbar:
1. Right-click the toolbar to be customized. From the shortcut menu that appears, select Customize. The Customize Toolbar dialog box appears.
Configuring Toolbars, Title Bar, and Status Bar

2. You have several choices:
   - Remove buttons from the toolbar by double-clicking on the button name in the Current toolbar buttons list or by selecting the button name and clicking Remove.
   - Add buttons to the toolbar by double-clicking on the button name in the Available buttons list or by selecting the button name and clicking Add.
   - Re-order buttons by selecting a button name in the Current toolbar buttons list and clicking Move Up or Move Down or by dragging the button name to the new location.
   - Reset to a pre-defined list of toolbar buttons by clicking Reset.

3. After you have completed customizing the toolbar, click Close.

Figure 38  Customize Toolbar Dialog Box

Configuring the Title Bar

When documents are displayed in the Document Display view, information about each document appears in the Document Display view title bar, including a value for each document from one of its index fields. If a document window is maximized in the Document Display view, this information appears in the title bar for the main ApplicationXtender Document Manager window.

For each application, you can specify which index field is used to populate the title bar. You can also configure the title bar to display the name of the AppXtender data source that contains the document, the name of the application that contains the document, or both for each application.

To configure the Document Display view title bar:

1. In the Applications view, right-click the application for which you want to configure the Document Display view title bar. From the shortcut menu that appears, select Properties. The Properties dialog box for that application appears.
2. Select the Title tab.

![Figure 39 Properties Dialog Box: Title Tab](image)

3. Specify whether you want the name of the AppXtender data source to appear in the Document Display view title bar. You have the following choices:
   - To include the name of the AppXtender data source, enable the Data Source Name check box.
   - To leave out the name of the AppXtender data source, clear the Data Source Name check box.

4. Specify whether you want the name of the application to appear in the Document Display view title bar. You have the following choices:
   - To include the name of the application, enable the Application Name check box.
   - To leave out the name of the application, clear the Application Name check box.

5. In the Field Value of drop-down list, select the name of the index field that you want to include in the Document Display view title bar.

6. Save your changes. You have the following choices:
   - To save changes and keep the Properties dialog box open, click Apply.
   - To save changes and close the Properties dialog box, click OK.
The next time you display a document, the Document Display view title bar reflects your changes.

**Displaying or Hiding the Status Bar**

The status bar appears at the bottom of the AppXtender Document Manager desktop and contains each of the following from left to right:

- Help messages for ApplicationXtender Document Manager functions, describing toolbar button functions and menu item functions
- The name of the active application
- The page number of the currently displayed page
- The total number of pages in the currently displayed document
- The version number of the currently displayed version
- The total number of versions in the currently displayed page

The AppXtender Document Manager status bar can be removed from the desktop to save space for the Document Display view.

To display or hide the status bar:

1. Click the View menu. In the View menu, the Status Bar command has a check mark next to it if the status bar is currently displayed.
2. From the View menu, select Status Bar. If the status bar was previously displayed, it is now hidden. If the status bar was previously hidden, it is now displayed.
Print Setup

The Print Setup dialog box allows you to set up the default print settings. From this dialog box, you can select the printer, the orientation, the paper size, the paper source, and other properties of future print jobs.

To configure printing:

1. From the File menu, select Print Setup. The standard Windows Print Setup dialog box appears.

2. If you want to connect to a printer on the network, click Network. For further instructions, refer to your Windows documentation.

3. In the Print Setup dialog box, select a default printer from the Name list, and select the default paper size, source, and orientation.

4. If you want to configure advanced properties of the selected printer, click Properties. For further instructions, refer to your Windows documentation.

5. Click OK. The dialog box closes and the changes you have made are saved.
Using Sticky View

Sticky View means that ApplicationXtender Document Manager can "remember" display settings (zoom, rotation, and scale-to-gray) for similar page types. For example, bi-tonal (black and white) pages can be "stuck" to open with certain zoom and rotation settings. A different Sticky View could be set for bitmaps. Sticky View can be helpful when scanning similar paper documents, by displaying the page at its actual size to facilitate monitoring the quality of the scan. ApplicationXtender Document Manager automatically discerns which page type is displayed and responds with the appropriate settings.

You can use Sticky View with the following page types. (The Information dialog box displays a page's type. For more information, refer to “Page Information” on page 353.)

◆ Images
◆ COLD/ERM with Image Overlay
◆ COLD/ERM with Text Overlay
◆ COLD/ERM/Text with no overlay
◆ Text (as defined in the File Types tab of the Configuration dialog box)
◆ OLE Objects

Note: For more information on the File Types tab of the Configuration dialog box, consult your system administrator or refer to the "Configuring ApplicationXtender Workstations” chapter of the ApplicationXtender Installation Guide.

Sticky View is different from the default display configuration in that the pages are not stored with the sticky settings; the pages appear in Sticky View simply for document creation and retrieval. The sticky settings are in effect until Sticky View is turned off.

Sticky View applies the following settings:

◆ Zoom, as described in “Using Zoom” on page 321
◆ Rotation, as described in “Using Rotate” on page 324
◆ Scale-to-gray, as described in “Using Scale-to-Gray” on page 326
◆ Form overlay, as described in “Viewing Documents with Form Overlay” on page 333
You can also save multiple sticky view settings for a displayed document and switch between each of the saved sticky view settings. For more information, refer to “Saving Sticky View Settings” on page 98 and “Switching Sticky View Settings” on page 319.

The Save Settings feature allows you to store multiple sticky view settings for each document type. You can save up to five different sticky view settings for each document type.

To save a sticky view setting:

1. Display a document with the desired settings.
2. Select a Save Settings view. From the View menu, select Sticky View and then Save Settings. The Save Settings menu appears. Highlight the appropriate view (for example, View 1).

   ![Saved Settings Menu](image1)

   **Figure 41** Saved Settings Menu

   A check mark appears next to the saved view setting.

   ![Saved Settings Menu with Selected Saved Settings View](image2)

   **Figure 42** Saved Settings Menu with Selected Saved Settings View

3. Repeat steps 1 and 2 to save more views.
Customizing AppXtender Document Manager Views

The Applications, Query, Workflow, and Thumbnail views can be modified to meet your preferences. By changing the way AppXtender Document Manager views display, you can customize the AppXtender Document Manager desktop.

The Applications, Query, Workflow, and Thumbnail views can each be configured to appear as a docked view, as a dialog box, or as a subwindow. The Applications view and the Query view can also be configured to "hide on use."

**Note:** The ApplicationXtender Workflow Workbox view is only available if the ApplicationXtender Workflow client is installed on the AppXtender Document Manager workstation.

For more information, refer to the following topics:

- **Docking a View** on page 99
- **Displaying a View as a Dialog Box** on page 101
- **Displaying a View as Subwindow** on page 102
- **Hiding a View on Use** on page 103
- **Activating AppXtender Document Manager Full Screen Mode** on page 104
- **Managing the Query View Result Set** on page 104

**Docking a View**

An AppXtender Document Manager docked view has a grab bar. A grab bar is similar to a title bar except that it does not contain a title.

![AppXtender Document Manager Docked View Grab Bar](image)

You can drag the view to the left, right, top, or bottom of the AppXtender Document Manager window by dragging this bar. A docked view automatically aligns with the AppXtender Document Manager window borders and cannot be moved beyond the borders. By default, the Applications, Query, Workflow, and Thumbnail views appear as docked views.
Customizing Your AppXtender Document Manager Workstation

**Note:** The ApplicationXtender Workflow Workbox view is only available if the ApplicationXtender Workflow client is installed on the AppXtender Document Manager workstation.

**Note:** The following procedure applies to only the Applications, Query, Workflow, and Thumbnail views. It does not apply to the Document Display view or the Index view.

To dock a view that is now a dialog box:

1. Right-click inside the dialog box. From the shortcut menu that appears, select Allow Docking. Allow Docking can be toggled on or off.

2. Click the grab bar, and drag the view to the desired position on the AppXtender Document Manager desktop. For the view to dock, you must drag it to the left, right, top or bottom edge of the AppXtender Document Manager desktop. When you release the mouse button, the view moves to that location.

![AppXtender Document Manager Desktop with Docked Views](image)

**Figure 44** AppXtender Document Manager Desktop with Docked Views
Displaying a View as a Dialog Box

An AppXtender Document Manager dialog box has a title bar with a Close button. You can drag the view to a different location on your desktop by dragging the title bar. A dialog box is independent of the AppXtender Document Manager window borders. That is, it can be moved away from the AppXtender Document Manager window borders, in any direction. This behavior is often described as "floating."

Note: The ApplicationXtender Workflow Workbox view is only available if the ApplicationXtender Workflow client is installed on the AppXtender Document Manager workstation.

Note: The following procedure applies to only the Applications, Query, Workflow, and Thumbnail views. It does not apply to the Document Display view or the Index view.

To display a view as a dialog box:

1. Double-click the grab bar. The docked view becomes a dialog box.
2. Click the Title bar and drag the dialog box to the desired location on the AppXtender Document Manager desktop.
Displaying a View as Subwindow

An AppXtender Document Manager subwindow has a title bar with Minimize, Maximize, and Close buttons. You can drag the view to a different location in the AppXtender Document Manager window by dragging the title bar. A subwindow is independent of the AppXtender Document Manager window borders but cannot be moved beyond them. This behavior is often described as "floating as an MDI window."

Figure 47  AppXtender Document Manager Subwindow Title Bar

Note: The ApplicationXtender Workflow Workbox view is only available if the ApplicationXtender Workflow client is installed on the AppXtender Document Manager workstation.

Note: The following procedure applies to only the Applications, Query, Workflow, and Thumbnail views. It does not apply to the Document Display view or the Index view.

To display a view as a subwindow:

1. Right-click in the docked view or view dialog box. From the shortcut menu that appears, select Float as MDI Window.
2. Click the Title bar and drag the subwindow to the desired location on the AppXtender Document Manager desktop.
Customizing Your AppXtender Document Manager Workstation

Hiding a View on Use

By default, the views remain in the AppXtender Document Manager window until you close, or hide, them. That is, when you display the Query View, the Applications View remains. Also, when you display a document, the Query View remains. You can configure the Applications view to hide when you display the Query View, and you can configure the Query View to hide when you display a document.

This is described as "hiding on use" because you use the Applications view to display the Query View and you use the Query View to display a document. When a view is configured to hide on use, this configuration is often described as "hide on use mode." In this mode, AppXtender Document Manager automatically hides the view after items have been selected.

You can always display the hidden view using the Applications View button or the Query View button on the Main toolbar. The hide on use mode can be used on a view whether it displays as a docked view, as a dialog box, or as a subwindow.
Customizing Your AppXtender Document Manager Workstation

**Note:** The following procedures apply to only the Applications view and the Query view. They do not apply to the Document Display, Index, Workflow, or Thumbnail view.

To configure a docked view to hide on use:

- Right-click the view’s grab bar. From the shortcut menu that appears, select Hide on Use.

To configure a dialog box or subwindow to hide on use:

- Right-click inside the dialog box or subwindow. From the shortcut menu that appears, select Hide on Use.

**Activating AppXtender Document Manager Full Screen Mode**

The Full Screen feature allows you to expand AppXtender Document Manager to fill the entire monitor screen. This feature allows you to maximize AppXtender Document Manager viewing.

To enable or disable full screen:

- From the View menu, select Full Screen.

**Managing the Query View Result Set**

After you search for a document, the Query view Result Set tab displays the document index records that met the search criteria you entered. There is a column for each field in the result set. You can control the display of columns from the Result Set. For example, you can show or hide, reorder, or save columns from the Result Set. For more information, refer to the following topics:

- “Changing the Way the Result Set Lists Documents” on page 105
- “Hiding or Showing Result Set Columns” on page 106
- “Sorting the Result Set” on page 106
- “Reordering the Result Set Columns” on page 107
- “Resizing the Result Set Columns” on page 107
- “Saving the Result Set Columns” on page 107
- “Resetting Result Set Column Configuration” on page 107
- “Collapsing the Result Set” on page 108
Customizing Your AppXtender Document Manager Workstation

Changing the Way the Result Set Lists Documents

You can change the way the Result Set lists your documents.

To change the way the Result Set lists your documents:

1. Right-click the Result Set. From the shortcut menu that appears, select View As. Another shortcut menu appears.

2. You have the following choices:

   • To display only the first index field of each record and a small folder icon next to each record, select Names.

   ![Figure 49 Displaying Names in the Result Set]

   • To display all index fields and a small folder icon next to each record, select Details.

   ![Figure 50 Displaying Details in the Result Set]

   • To display only the first index field of each record and a large folder icon above each record, select Folders.

   ![Figure 51 Displaying Folders in the Result Set]
Hiding or Showing Result Set Columns

The first time you log into an AppXtender application, the Result Set tab displays a column for each of the index fields in the application, plus a column for the number of pages in each document. You can hide any of these columns. There is also a column for the document ID, which is hidden by default. You can configure this column to appear in the Result Set.

To hide or show a column:

1. Right-click a column heading in the Result Set. From the shortcut menu that appears, select Settings. The List Column Editor dialog box appears.

   ![List Column Editor Dialog Box](Figure 52)

   **Figure 52** List Column Editor Dialog Box

   2. Click the check box next to the name of the column that you want to hide or show.

   3. When each column that you want to hide has no check mark and each column that you want to show has a check mark, click OK.

Sorting the Result Set

Ascending or descending sorts can be performed on any index column listed in the Result Set tab. To sort a field in ascending order, click the column heading of the desired field. To sort a field in descending order, click the column heading of the field again.

In addition, your workstation may be configured to sort the result set automatically based on the last column selected or based on the document ID. The Display tab of the Configuration dialog box allows this configuration. For information, refer to “Use KeyView to Display Foreign Files” on page 112.
### Reordering the Result Set Columns

The first time you log into an AppXtender application, the Result Set tab displays columns in a default order. You can change the order of these columns.

To move a column:
- Drag the column to the position you want to use.

### Resizing the Result Set Columns

The first time you log into an AppXtender application, the Result Set tab displays default column widths for each index field. These column widths are resizable. Because the data is truncated in narrow columns, resizing is a useful display tool.

To resize a column width:
1. Drag the boundary between column headings to the position you want.
2. Right-click the column headings. From the shortcut menu that appears, select Save Columns. The column configuration is saved for the current user name and application.

### Saving the Result Set Columns

You can save Result Set column configuration changes for the current user name and application.

To save column settings:
- Right-click any column heading in the Result Set. From the shortcut menu that appears, select Save Columns. The column configuration is saved for the current user name and application.

### Resetting Result Set Column Configuration

If you have made changes to the way columns appear in the Result Set (such as hiding columns, showing the Document ID column, changing the column order, or changing the column width) you can set them back to their default configuration.

To reset Result Set columns:
1. If you have your View As option set to Folders or Names, you must first change that option to Detail. For instructions, refer to “Changing the Way the Result Set Lists Documents” on page 105.
2. Right-click any of the Result Set column headings. From the shortcut menu that appears, select Settings. The List Column Editor dialog box appears.
3. Click Reset All.
Collapsing the Result Set

You can collapse the Result Set to display only those documents that you select.

To collapse the Result Set:

1. In the Result Set tab, select the documents you want to view in the Result Set. You have the following choices:
   - If you want to select only one document, click the document.
   - If you want to select multiple documents in consecutive order, hold down [SHIFT] and click the first and last document.
   - If you want to select multiple documents that are not in consecutive order, hold down [CTRL] and select each document individually.
2. Right-click within the Result Set. From the shortcut menu that appears, select Collapse. Only the documents you selected are listed in the Result Set tab.
Opening the Configuration Dialog Box

You can customize the behavior of many aspects of AppXtender functionality through the AppXtender Document Manager Configuration dialog box. You can use the AppXtender Document Manager Configuration dialog box to change workstation defaults for most features, such as zoom and tile.

If you have the Configure WS privilege, you can refer to all of the configuration tabs, and you are able to make a wide variety of configuration changes. If you do not have the Configure WS privilege, four tabs appear: the View tab, the Display tab, the Fonts tab, and the Scan tab. This topic discusses these four tabs. For information on the other tabs available to users with the Configure WS privilege, refer to the "Configuring ApplicationXtender Workstations" chapter of the ApplicationXtender Installation Guide.

To open the Configuration dialog box:

1. From the File menu, select Configuration. The Configuration dialog box appears.
2. Set the desired options according to the instructions in the following topics:
   - “View Tab” on page 110
   - “Display Tab” on page 114
   - “Fonts Tab” on page 117
   - “Scan Tab” on page 121
3. Click OK. The Configuration dialog box closes and any changes you have made are saved.
View Tab

The View tab of the AppXtender Document Manager Configuration dialog box allows you to configure several aspects of viewing documents and batches.

Figure 53 Configuration Dialog Box: View Tab

Image Size Options

Image Size options control the default display size of images displayed in AppXtender Document Manager. You can use these options with all supported image types. (These options also apply to text when the Allow zoom option is enabled on the COLD tab of the Configuration dialog box.) For more information on which image types are supported in AppXtender Document Manager, refer to “Image Files” on page 34.

To change the default image size setting:

1. In the Configuration dialog box, select the View tab.
2. Under Image Size, select one of the five zoom settings.
These settings are explained in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit to window</td>
<td>If this option is chosen as the default, AppXtender Document Manager displays images to fit the display window either top to bottom or left to right, while maintaining the original aspect ratio of the image and displaying the entire image.</td>
</tr>
<tr>
<td>Fit to window height</td>
<td>If this option is chosen as the default, AppXtender Document Manager displays images to fit the window from top to bottom. You might need to scroll left or right to refer to the sides of the image.</td>
</tr>
<tr>
<td>Fit to window width</td>
<td>If this option is chosen as the default, AppXtender Document Manager displays images to fit the window from left to right. You might need to scroll up or down to refer to the top or bottom of the image.</td>
</tr>
<tr>
<td>Actual size</td>
<td>If this option is chosen as the default, AppXtender Document Manager displays images as actual size (one pixel stored is equal to one pixel on the monitor).</td>
</tr>
<tr>
<td>Use zoom setting</td>
<td>If this option is chosen as the default, AppXtender Document Manager displays images using the default zoom percent. The Use Zoom Setting drop-down list allows you to set the default ratio.</td>
</tr>
</tbody>
</table>

3. If you have enabled the Use zoom setting radio button, select the desired ratio. You can click the User zoom setting drop-down list and select the desired ratio (standard options range from 25% to 400%) or type the preferred percentage in the text box.

4. Click OK to save the settings.

**Zoom Settings are Pixels**

By default, AppXtender Document Manager takes into consideration both the image resolution and monitor resolution when rendering images for display. By enabling the Zoom settings are pixels option, AppXtender Document Manager displays images in raw pixel size, disregarding image and monitor resolution.

**Scale-to-Gray**

When the Scale-to-gray option is enabled, AppXtender Document Manager displays bi-tonal (black and white) images as grayscale, which is frequently a more legible format. Various shades are used to convert black and white images for the highest readability. This option applies to bi-tonal images only.
Use KeyView to Display Foreign Files

When this option is enabled, AppXtender Document Manager uses the KeyView Viewer to display the contents of various foreign files. The appearance of a foreign file in KeyView is similar to its appearance in its native viewer, but not exactly the same. For a list of KeyView Viewer-supported file types, refer to “KeyView File Support” on page 144. When this option is disabled, Document Manager and display a foreign file page as an icon.

Use Acrobat Reader to Display PDF Files

When this option is enabled, AppXtender Document Manager uses the Acrobat Reader technology to display the contents of PDF files. When this option is disabled, AppXtender Document Manager uses PDF Library to display each PDF page.

Note: If you choose to display a PDF document in Acrobat Reader, you cannot annotate the pages and full-text search hits on the PDF pages will not be highlighted. However, the PDF Library performs document printing of a PDF page regardless of the view setting.

Allow Map of Unknown Data Sources to Existing Data Sources

When this option is enabled, AppXtender Document Manager will allow you to specify a data source for a document for which the data source is unknown. The original data source may be unknown if you are opening a document that has been somehow saved to your machine or if a reference to an AppXtender document has been e-mailed to you. If the name of the data source listed in the reference is named different from the data sources that are configured on your computer and you attempt to open the file, the Pick a Data Source dialog box will appear, allowing you to specify the correct data source to use. For more information about selecting a data source from the Pick a Data Source dialog box, refer to “Viewing Documents from Unknown Data Sources” on page 295.
Display Text View of Page

AppXtender Document Manager allows users to process images using OCR, creating an alternate "text view" of the image. Users can switch between the original image and the text view of the image at will. The Display text view of page option sets the default document display to text format or image format. When the check box is enabled on the View tab of the Configuration dialog box, AppXtender Document Manager displays documents as text when applicable. If no OCR view is available, the page will be automatically processed using OCR to create an OCR view when it is viewed. When the check box is disabled, AppXtender Document Manager always displays documents in image format.

Display Text View of Page

If the Restore last layout at startup option is enabled on the View tab of the AppXtender Document Manager Configuration dialog box, the AppXtender Document Manager desktop layout is automatically saved when you exit AppXtender Document Manager. This includes the following settings:

- AppXtender Document Manager window size and location
- Toolbar locations and toolbar button size
- View type (docked view, dialog box, or subwindow) for the Applications, Query, Workflow, and Thumbnail views
- Location and size of the Applications, Query, Workflow, and Thumbnail views

If this option is disabled, the desktop layout is not saved on exit. When you open AppXtender Document Manager, the desktop layout reverts to the previously saved settings.
Customizing Your AppXtender Document Manager Workstation

Display Tab

The Display tab of the Configuration dialog box contains options for various AppXtender Document Manager display features.

![Configuration Dialog Box: Display Tab](image)

**Screen DPI**

The Screen DPI settings refer to the dots per inch of the system monitor. AppXtender Document Manager takes this information from the video interface card installed with the system. You can overwrite the defaults by entering new Horizontal or Vertical settings. If you want to change the Horizontal or Vertical settings back to the defaults from the video interface card, click Reset.

**PgUp/PgDn in Dual-Page View**

This option dictates how the [PAGE UP] and [PAGE DOWN] keys operate in AppXtender Document Manager when a document or batch is in dual-page display mode. This mode is also known as Split View. The Split View feature splits the Document Display view or the Batch Display view so that multiple pages of the same document or batch are displayed.
In Split View, the actions performed by your [PAGE UP] and [PAGE DOWN] keys depend on the PgUp/ PgDn in Dual-Page View setting in the Display tab:

- When you select Next/previous 2 pages, the keys page through two pages at a time. For example, if you display a document or batch with four pages in Split View, pages 1 and 2 appear first, then pages 3 and 4.
- When you select Next/previous page, the keys page through one page at a time. For example, if you display a document or batch with four pages in Split View, pages 1 and 2 appear first, then pages 2 and 3.

### Query Results

The Query Results options allow you to configure the maximum number of documents that will be included in a result and how the result set will be sorted.

#### Maximum Query Results

Using the Maximum Query Results option, you can set the maximum number of documents that will be included in a result set. The default is 2048 documents. The higher this value is set, the larger the result set can be. If a query returns more documents than the maximum number, the result set will be truncated.

#### Sort Result Set Automatically

This option sets the default to automatically sort index records displayed in the query result set based on the column field selected. When this option is enabled on the Display tab of the Configuration dialog box, the new query displayed in the result set is sorted by the last column field selected. When this option is disabled, AppXtender Desktop displays the index records in the query result set based on one of the two Sort Order of Document ID options specified in the Sort Order of Document ID topic. For more information, refer to “Sort Order of Document ID” on page 116.

---

**Note:** Automatic sort overrides sort order of document ID.
If the application in which you are searching has the Multiple indexes referencing single document setting enabled, the result set may contain more than one record for each document. For example, if the Maximum Query Results value on the Display tab in the Configuration dialog box is set to 2048 documents, your result set may contain more than 2048 index records. To improve performance, you can use the Maximum Index Retrieved setting to limit the number of index records that are listed in the result set.

The default setting is 1000 index records. The higher this value is set, the larger the result set can be. If a query returns more index records than the maximum number, the result set is truncated.

This feature lets you control the display of items in the query result set. When Ascending order is enabled, AppXtender Document Manager displays index records listed in the query result set by ascending chronological order. Enabling the Descending order sorts the documents in reverse chronological order.

**Ascending Order**
This option sets the sort order of the query result set in ascending chronological order, based on the document ID number. If this option is chosen as the default, AppXtender Document Manager displays index records sequentially, from low to high, in the query view.

**Descending Order**
This option sets the sort order of the query result set to descending chronological order, based on the document ID number. If this option is chosen as the default, AppXtender Document Manager displays index records sequentially, from high to low, in the query view.
Fonts Tab

Using the Fonts tab of the Configuration dialog box, you can choose the fonts for displaying and printing text documents.

![Configuration Dialog Box: Fonts Tab](image)

**Figure 55** Configuration Dialog Box: Fonts Tab

For more information, refer to:

- “Opening the Configuration Dialog Box” on page 109
- “Screen Fonts” on page 117
- “Printer Fonts” on page 119
- “Simulate Box Drawing Characters” on page 120

**Screen Fonts**

The font used for text display depends on whether the page has a text overlay, an image overlay, or no overlay at all. It also depends on whether the user is allowed to zoom in on the page.

**Note:** Zoom is configured using the Allow zoom setting on the COLD tab. For more information on configuring Allow zoom, refer to the “Configuring ApplicationXtender Workstations” chapter of the *ApplicationXtender Installation Guide.*
Using the Screen Fonts setting, you can configure the fonts used for text display.

To set the screen fonts:

1. Select the font to configure from the Screen Fonts list. You have the following choices:
   - Page (fixed size)
   - Page (variable size)
   - Image Form Overlay

   The font that you select depends on whether the text page has a text or image overlay and whether zoom is enabled. The following table describes which font is used for text display in each scenario:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>When Zoom is Enabled</th>
<th>When Zoom is Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text with no overlay</td>
<td>Page (variable size)</td>
<td>Page (fixed size)</td>
</tr>
<tr>
<td>Text with a text overlay</td>
<td>Page (variable size)</td>
<td>Page (fixed size)</td>
</tr>
<tr>
<td>Text with an image overlay</td>
<td>Image Form Overlay</td>
<td>Image Form Overlay</td>
</tr>
</tbody>
</table>

2. Click Change. The Font dialog box appears.

   **Note:** AppXtender only supports fixed pitch fonts. The fonts that are displayed are the only fixed pitch fonts currently on your machine.

3. Choose the font, style, and size you want to use for text display.

   **Note:** If you are configuring the Image Form Overlay font, you do not need to select a font size. Text on pages with an image overlay automatically appears at a calculated size that is not configurable.

4. Click OK to save the settings.
**Printer Fonts**

The font used for printing text documents depends on whether the page has a text overlay, an image overlay, or no overlay at all. It also depends on whether the user is allowed to zoom in on the page.

**Note:** Zoom is configured using the Allow zoom setting on the COLD tab. For more information on configuring Allow zoom, refer to the “Configuring ApplicationXtender Workstations” chapter of the *ApplicationXtender Installation Guide*.

Using the Printer Fonts setting, you can configure the fonts used for printing text.

You can configure the print fonts to be the same as the display fonts. For more information on configuring screen fonts, refer to “*Screen Fonts*” on page 117.

However, you may need to configure the print fonts differently from the display fonts if the fonts installed on the workstation are different from those installed on the printer.

To set the print fonts:

1. Select the font to configure from the Printer Fonts list. You have the following choices:
   - Page (fixed size)
   - Page (variable size)
   - Image Form Overlay

   The font that you select depends on whether the text page has a text or image overlay and whether zoom is enabled. The following table describes which font is used for printing text in each scenario:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>When Zoom is Enabled</th>
<th>When Zoom is Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text with no overlay</td>
<td>Page (variable size)</td>
<td>Page (fixed size)</td>
</tr>
<tr>
<td>Text with a text overlay</td>
<td>Page (variable size)</td>
<td>Page (fixed size)</td>
</tr>
<tr>
<td>Text with an image overlay</td>
<td>Image Form Overlay</td>
<td>Image Form Overlay</td>
</tr>
</tbody>
</table>

2. Click Change. The Font dialog box appears.
3. Choose the font, style, and size you want to use for text display.

Note: If you are configuring the Image Form Overlay font, you do not need to select a font size. Text on pages with an image overlay automatically prints at a calculated size that is not configurable.

4. Click OK to save the settings.

Simulate Box Drawing Characters

AppXtender uses "box drawing characters" to support the use of fonts that require box drawing characters to correctly represent AppXtender text documents. Because of this, several characters in the AppXtender font set are replaced with box drawing characters. For documents that are written in foreign languages, this substitution may interfere with the font set requirements for the foreign language. Characters display as boxes rather than as the characters that they should be.

For example, when viewing documents written in the Danish language, the box drawing character substitution interferes with the font set requirements for Danish.

You need to disable the Simulate Box Drawing Characters options to view documents and text form overlays written in any foreign language that uses characters that are assigned using the ASCII values from 176 to 223.

To allow viewing of documents written in foreign languages using the ASCII values from 176 to 223:

1. Disable the Enable Support for Form Text option to allow display of form overlays written in foreign languages using the ASCII values from 176 to 223.

2. Disable the Enable Support for Data Text option to allow display of text documents written in foreign languages using the ASCII values from 176 to 223.
Scan Tab

The Scan tab of the AppXtender Document Manager Configuration dialog box allows you to customize your batch scanning process.

Figure 56 Configuration Dialog Box: Scan Tab

Enabling Image Processing Options

Image processing is a licensed feature that allows you to enhance scanned images. To configure AppXtender Document Manager for image processing:

1. On the Scan tab of the Configuration dialog box, enable Allow Image Processing.
2. Click OK.

Note: To access image enhancement options, you must log out of ApplicationXtender and then log back in to ApplicationXtender after you enable Allow Image Processing for the first time.

Removing Blank Pages

You can configure AppXtender Document Manager to automatically remove blank pages from the batch while you are scanning.

To configure the automatic removal of blank pages:

1. On the Scan tab of the Configuration dialog box, select the Remove blank pages check box to enable the option. The Threshold slider becomes available.
Customizing Your AppXtender Document Manager Workstation

Figure 57 Configuration Dialog Box: Scan Tab: Removing Blank Pages

2. Use the Threshold slider to adjust the setting for what the scanner recognizes as a blank page. Keep in mind the following points:
   - If you want to allow a noisier image to be recognized as a blank page (and therefore removed), adjust the slider towards Noisier.
   - If you want to allow a cleaner image to be recognized as a blank page (and therefore removed), adjust the slider towards Cleaner.

3. Click OK to save the settings.

CAUTION
As you begin to use this feature, examine the pages that are scanned and take note of which pages are automatically removed from the document or batch as you scan them. If you find that pages are being removed that should not be removed, adjust the slider towards Cleaner. You must make sure that the Threshold slider setting is appropriate for the pages that you are scanning.
Synchronized Scan

With some types of scanning, the images are scanned faster than AppXtender Document Manager can display them. The Synchronized scan option slows down your scanner so that AppXtender Document Manager can display each scanned image. You have the following choices:

- If you want to review each page as it is scanned, enable the Synchronized scan option.
- If you want to allow your scanner to scan images at its highest speed, disable the Synchronized scan option.

Scanner Manual Feed Timeout

This option sets the scanner timeout for scanning that is performed while in the manual feed mode. The default is 20 seconds. The timeout option specifies how much time you will need to put more pages in the scanner without having to manually continue the scan process. This option can be set higher or lower to meet your needs.
Saving and Loading Settings

To make AppXtender system deployment easier for you, AppXtender has Save Settings and Load Settings features that allow you to copy workstation settings from one AppXtender Document Manager workstation to another. You (or the user) customize the configuration of the AppXtender Document Manager workstation in several ways, and then you save the configuration. To copy the saved configuration to other workstations, you then just load the saved settings file on each workstation and all of the saved configuration settings are applied. The following topics detail the settings that are saved and explain how to save and load settings.

Saving Settings

Once the AppXtender Document Manager workstation has been configured, you can save the customized settings to a configuration file. The saved settings file can be loaded on other AppXtender Document Manager workstations to copy the saved configuration settings to those workstations.

Note: If a profile is created in one version of AppXtender, this profile cannot be applied to later versions of AppXtender. You must save a new settings file for specific to each AppXtender release.

When you save settings for a workstation, AppXtender saves information about all of the options in the AppXtender Document Manager Configuration dialog box. When you load the settings on another workstation, the settings you saved are loaded for that workstation. If an option is enabled on the workstation where the settings are saved, the option is enabled on the other workstation once you load the settings.

In addition to AppXtender Document Manager Configuration dialog box options, Save Settings saves information about the views and toolbars on the AppXtender Desktop desktop. If, for example, Allow Docking is enabled for the Query view on the workstation where you save settings, Allow Docking is enabled on the AppXtender Desktop desktop of the second workstation once you load settings.
Additional information saved when you save settings includes default settings for annotations, the data source configurations on the AppXtender Document Manager workstation, and the last directories used for several AppXtender Desktop functions. For details on setting AppXtender annotation defaults, refer to “Creating Line and Shape Annotations” on page 488. For more information on setting up AppXtender data sources, refer to the ApplicationXtender Installation Guide.

For a detailed list of the settings that are saved, refer to “Saved Workstation Settings” on page 128.

To save a workstation settings file:

1. Make the appropriate changes to the AppXtender Document Manager Configuration settings, annotation defaults, data source configuration, and desktop arrangement.

2. Select Save Settings from the File menu. The Save AppXtender Document Manager Settings dialog box appears.

3. If you want to specify the type of file you are saving, from the Save as type drop-down list, select the type of files that you want to save. Your available choices are AppXtender Document Manager Settings Files (*.AXS) or All Files (*.*).

4. Select the location to save the file. You can select the location from the Save in drop-down list and double-click a folder or file in the box below to open it, or enter a path and file name.

5. You also have the following options:
Customizing Your AppXtender Document Manager Workstation

- To save the AppXtender Document Manager workstation configuration settings, leave the AppXtender Document Manager Settings check box enabled. Enabling this option saves all AppXtender Document Manager configuration settings, toolbar configuration, views, and status bar settings.

- To save data source settings, leave the XSCM.Config check box enabled. For more information, refer to “Important Information about XSCM.CONFIG” on page 126.

- To save settings from an AppXtender integration with Microsoft Outlook, such as targets and field mappings, enable the Outlook check box. (For information on integrating AppXtender with Microsoft Outlook, refer to the Microsoft Integration for ApplicationXtender Integration Guide.)

6. Click Save. The file is saved in the specified location.

---

Important Information about XSCM.CONFIG

When you use ApplicationXtender Administrator (AppXtender Admin), Component Setup Wizard, or Data Source Selector, settings are read from and written to C:\Documents and Settings\All Users\Application Data\XSCM.CONFIG. Each component writes different settings to this file.

CAUTION

Do not edit or distribute the XSCM.CONFIG file.

The recommended method for providing each user with access to a data source group is to have each user use the Data Source Selector to locate a data source, as described in “Locating Data Sources” on page 45.

However, the XSCM.Config file check box on the Load AppXtender Document Manager Settings dialog box and the Save AppXtender Document Manager Settings dialog box provides another method for distributing data source connectivity. When you save workstation settings with the XSCM.Config file check box selected, the contents of the XSCM.CONFIG file are included in the AppXtender Document Manager settings file. The contents of the XSCM.CONFIG file are located at the end of the AppXtender Document Manager settings file starting with line [XSCM.CFG].
The AppXtender Document Manager settings file can be distributed to other AppXtender Document Manager workstations. When your users load an AppXtender Document Manager settings file that has an [XSCM.CFG] section in it, with the XSCM.Config file check box selected, a new XSCM.CONFIG file is created. Each user is then prompted to log in to the default data source, as specified in the new XSCM.CONFIG file.

**CAUTION**
If you choose to use this method for distributing data source connectivity, you must take both of the following precautions:

- Ensure that AppXtender Admin, the Component Setup Wizard, ApplicationXtender Web Access Server, and Rendering Server have not been installed on any of the computers on which you intend to save or load the AppXtender Document Manager workstation settings.

- Ensure that no changes are made in AppXtender Admin or in the Component Setup Wizard on any computer in your AppXtender system between saving and loading AppXtender Document Manager workstation settings.

If problems occur after deployment on an AppXtender Document Manager workstation, use the Data Source Selector to locate a data source, as described in “Locating Data Sources” on page 45. If problems occur after deployment on a workstation with AppXtender Web Access components, run the Component Setup Wizard to register components again as described in the ApplicationXtender Web Access Administrator’s Guide.
The following table lists the settings that are saved when you save settings for an AppXtender Document Manager workstation:

<table>
<thead>
<tr>
<th>Saved Workstation Settings</th>
<th>Table 15 Saved Workstation Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AppXtender Document Manager Configuration</strong></td>
<td><strong>Saved Settings</strong></td>
</tr>
</tbody>
</table>
| AppXtender Document Manager Desktop Configuration | • The tab of the Configuration dialog box that was most recently viewed  
| | • The data source set as the active data source (shown in bold in the Application view)  
| | • The application set as the active application (shown in bold in the Application view)  
| | • Allow Docking option for the Application view  
| | • Allow Docking option for the Query view  
| | • Allow Docking option for the Thumbnail view  
| | • Allow Docking option for the ApplicationXtender Workflow Workbox  
| | • Hide On Use option for the Application view  
| | • Hide On Use option for the Query view  
| | • Hide On Use option for the ApplicationXtender Workflow Workbox  
| | • Float as MDI Window option for the Application view  
| | • Float as MDI Window option for the Query view  
| | • Float as MDI Window option for the Thumbnail view  
| | • Float as MDI Window option for the ApplicationXtender Workflow Workbox  
| | • New Document Index view location  
| | • Modify Document Index view location  
| | • Batch Index view location  
| | • Batch Index view column settings  
| | • Display of Enhance Image dialog box  

| Annotation Settings | • Foreground color  
| | • Background color  
| | • Line width  
| | • List of most recently used rubber stamp annotations for each AppXtender application  
| | • Default annotation group for each data source  

| Toolbars | • For all toolbars:  
| | Small icons  
| | Large icons.  
| | • For each toolbar:  
| | • Display location  
| | • Whether or not the toolbar is hidden  

128 ApplicationXtender Document Manager User’s Guide
### Table 15  Saved Workstation Settings (continued)

<table>
<thead>
<tr>
<th>AppXtender Document Manager Configuration</th>
<th>Saved Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Result Set column Configuration</td>
<td>• The settings for result set column display in the result set for each application</td>
</tr>
<tr>
<td>View Tab Configuration</td>
<td>• Image Size</td>
</tr>
<tr>
<td></td>
<td>• Fit to window</td>
</tr>
<tr>
<td></td>
<td>• Fit to window height</td>
</tr>
<tr>
<td></td>
<td>• Fit to window width</td>
</tr>
<tr>
<td></td>
<td>• Actual size</td>
</tr>
<tr>
<td></td>
<td>• Use zoom setting</td>
</tr>
<tr>
<td></td>
<td>• Zoom settings are pixels</td>
</tr>
<tr>
<td></td>
<td>• Display text view of page</td>
</tr>
<tr>
<td></td>
<td>• Scale-to-gray</td>
</tr>
<tr>
<td></td>
<td>• Restore last layout at startup</td>
</tr>
<tr>
<td></td>
<td>• Use KeyView to display foreign files</td>
</tr>
<tr>
<td></td>
<td>• Allow map of unknown data sources to existing data sources</td>
</tr>
<tr>
<td>Display Tab Configuration</td>
<td>• Screen DPI</td>
</tr>
<tr>
<td></td>
<td>• Vertical</td>
</tr>
<tr>
<td></td>
<td>• Horizontal</td>
</tr>
<tr>
<td></td>
<td>• Maximum Query Results</td>
</tr>
<tr>
<td></td>
<td>• Sort result set automatically</td>
</tr>
<tr>
<td></td>
<td>• Sort Order of Document ID</td>
</tr>
<tr>
<td></td>
<td>• Ascending Order</td>
</tr>
<tr>
<td></td>
<td>• Descending Order</td>
</tr>
<tr>
<td></td>
<td>• PgUp/PgDn in dual-page view</td>
</tr>
<tr>
<td></td>
<td>• Next/previous 2 pages</td>
</tr>
<tr>
<td></td>
<td>• Next/previous page</td>
</tr>
<tr>
<td>Fonts Tab Configuration</td>
<td>• Screen Fonts</td>
</tr>
<tr>
<td></td>
<td>• Printer Fonts</td>
</tr>
<tr>
<td></td>
<td>• Simulate Box Drawing Characters</td>
</tr>
<tr>
<td></td>
<td>• Enable Support for Form Text</td>
</tr>
<tr>
<td></td>
<td>• Enable Support for Data Text</td>
</tr>
<tr>
<td>Scan Tab Configuration</td>
<td>• Allow Image Processing</td>
</tr>
<tr>
<td></td>
<td>• Remove blank pages (and Threshold)</td>
</tr>
<tr>
<td></td>
<td>• Synchronized scan</td>
</tr>
<tr>
<td></td>
<td>• Scanner manual feed timeout</td>
</tr>
</tbody>
</table>
### Table 15  Saved Workstation Settings (continued)

<table>
<thead>
<tr>
<th>AppXtender Document Manager Configuration</th>
<th>Saved Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>COLD Tab Configuration</td>
<td>• Cache forms</td>
</tr>
<tr>
<td></td>
<td>• Allow paste text</td>
</tr>
<tr>
<td></td>
<td>• Allow zoom</td>
</tr>
<tr>
<td></td>
<td>• Display as image only</td>
</tr>
<tr>
<td></td>
<td>• Form Overlay Settings</td>
</tr>
<tr>
<td></td>
<td>Screen</td>
</tr>
<tr>
<td></td>
<td>Printer</td>
</tr>
<tr>
<td></td>
<td>• Default Color Bar settings</td>
</tr>
<tr>
<td></td>
<td>Show</td>
</tr>
<tr>
<td></td>
<td>Lines</td>
</tr>
<tr>
<td></td>
<td>Color</td>
</tr>
<tr>
<td>Print Tab Configuration</td>
<td>• Print original size</td>
</tr>
<tr>
<td></td>
<td>• Dithering</td>
</tr>
<tr>
<td></td>
<td>• Toolbar Print Button</td>
</tr>
<tr>
<td></td>
<td>• Acceleration</td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>XipPrint</td>
</tr>
<tr>
<td></td>
<td>Talaris</td>
</tr>
<tr>
<td></td>
<td>Quick PCL</td>
</tr>
<tr>
<td></td>
<td>• Endorsement</td>
</tr>
<tr>
<td></td>
<td>Endorse printed pages</td>
</tr>
<tr>
<td></td>
<td>Position</td>
</tr>
<tr>
<td></td>
<td>Text</td>
</tr>
<tr>
<td>OCR Tab Configuration</td>
<td>• OCR Engine</td>
</tr>
<tr>
<td></td>
<td>• Allow OCR</td>
</tr>
<tr>
<td></td>
<td>• OCR Result Format</td>
</tr>
<tr>
<td></td>
<td>• Template Settings</td>
</tr>
<tr>
<td></td>
<td>• Language Selection</td>
</tr>
<tr>
<td></td>
<td>• Text View</td>
</tr>
<tr>
<td></td>
<td>Enable proofing</td>
</tr>
<tr>
<td></td>
<td>Use form templates</td>
</tr>
<tr>
<td></td>
<td>• Export</td>
</tr>
<tr>
<td></td>
<td>Enable proofing</td>
</tr>
<tr>
<td></td>
<td>Use form templates</td>
</tr>
<tr>
<td></td>
<td>• Indexing</td>
</tr>
<tr>
<td></td>
<td>Enable proofing</td>
</tr>
<tr>
<td></td>
<td>• Processing Queue</td>
</tr>
<tr>
<td></td>
<td>• Prompt user with queue selection on submit</td>
</tr>
</tbody>
</table>
### Table 15  Saved Workstation Settings (continued)

<table>
<thead>
<tr>
<th>AppXtender Document Manager Configuration</th>
<th>Saved Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax-in Tab Configuration</td>
<td>• Select Fax-in Server</td>
</tr>
</tbody>
</table>
| Thumbnail Tab Configuration | • Thumbnail Width (Pixels)  
• Thumbnail Height (Pixels)  
• Color Depth  
• Render foreign file  
• Render RTF file  
• Hide annotation if allowed to do so  
• 3D icon  
• Display thumbnail of document when double-click result set  
• Always display the thumbnail of the active document |
| ApplicationXtender Workflow Tab Configuration | • Workflow Server Name  
• Workflow Database Name  
• Use ApplicationXtender user name and password for login  
• Always open latest revision |
| Document Signing Tab Configuration | • Default certificate  
• Default comment |
| E-Mail Tab Configuration | • Use PDF format if possible  
• Use XPS format if possible  
• Black &White Images Format  
• Pseudo Color Images Format  
• True Color Images Format  
• JPEG Quality Factor  
• Text Format  
• Use multi-page files  
• Vendor  
  Microsoft (MAPI32)  
  CC: Mail (SMI32) |
| Export Tab Configuration | • Use PDF format if possible  
• Black &White Images Format  
• Pseudo Color Images Format  
• True Color Images Format  
• JPEG Quality Factor  
• Text Format  
• Use multi-page files |
| File Types Tab Configuration | • File types that have been added and their associated file extensions |
### Table 15  Saved Workstation Settings (continued)

<table>
<thead>
<tr>
<th><strong>AppXtender Document Manager Configuration</strong></th>
<th><strong>Saved Settings</strong></th>
</tr>
</thead>
</table>
| **Data Tab Configuration**                  | • Enable dual data entry  
• Disable query window  
• Database connect & drop  
• Check for matching index  
• ODMA support  
• Allow remember password  
• Prompt for checkout when open  
• Enable ODMA Attribute Search  
• Auto Logout  
• Date Field with 2-digit Year Max Future Years Setting  
• Image Storage Format  
• Black & White  
• 4/8-Bit Color  
• True Color  
• Separate multi-page TIFFs  
• JPEG Quality Factor |
| **Paths Tab Configuration**                 | • Local write path use  
• Local write path  
• Personal search path  
• Volume label search drives |
Saving and Loading Settings

When you choose Load Settings from the File menu, ApplicationXtender Desktop displays the Load AppXtender Document Manager Settings dialog box. This dialog box allows you to load previously saved configuration settings on an AppXtender Document Manager workstation. The settings consist of the AppXtender Document Manager settings that are found in the AppXtender Document Manager Configuration dialog box, toolbar configuration, AppXtender Desktop views, and status bar settings, user data source settings, and system data source settings.

**Note:** When you attempt to open AppXtender Desktop, if a message appears indicating that AppXtender cannot find the data source or licensing information it needs to connect to the AppXtender database, you can load settings to provide AppXtender with connection information.

---

### Table 15: Saved Workstation Settings (continued)

<table>
<thead>
<tr>
<th>AppXtender Document Manager Configuration</th>
<th>Saved Settings</th>
</tr>
</thead>
</table>
| Full-Text Tab Configuration              | • Processing Queue  
• Allow Full text  
• Convert to text (if necessary)  
• Prompt user with queue selection on submit  
• Submit new documents for full text index |
| Directories                              | • Last import directory  
• Last export directory  
• Last Batch Create directory  
• Last Batch Import directory  
• Last OCR export directory |
| Data Source Configuration                | • Default data source setting  
• Selected data sources  
• For each data source:  
  Description  
  Encoded data source connection string  
  Full-text queues  
  OCR queues  
  Print queues |

---

**Loading Settings**

When you choose Load Settings from the File menu, ApplicationXtender Desktop displays the Load AppXtender Document Manager Settings dialog box. This dialog box allows you to load previously saved configuration settings on an AppXtender Document Manager workstation. The settings consist of the AppXtender Document Manager settings that are found in the AppXtender Document Manager Configuration dialog box, toolbar configuration, AppXtender Desktop views, and status bar settings, user data source settings, and system data source settings.

**Note:** When you attempt to open AppXtender Desktop, if a message appears indicating that AppXtender cannot find the data source or licensing information it needs to connect to the AppXtender database, you can load settings to provide AppXtender with connection information.
To load a workstation settings file:

1. From the File menu, select Load Settings. The Load AppXtender Document Manager Settings dialog box appears.

2. Select the file name. You can select the appropriate folder from the Look In drop-down list and double-click a folder or file in the box below to open it, or enter a path and file name and click Open.

   If you do not find an AXS file saved to your desktop, contact your system administrator to determine if a workstation profile has been saved for you. The system administrator can save AppXtender data source settings to a file for you from another AppXtender Document Manager workstation that is accessing the same database, and you can load that file.
3. Specify which settings are loaded from the file. You have the following choices:

- To load the AppXtender Document Manager workstation configuration settings, leave the AppXtender Document Manager Settings check box enabled. Enabling this option loads all AppXtender Document Manager Configuration settings, toolbar configuration, AppXtender Desktop views, and status bar settings.

- To load the data source settings, leave the XSCM.Config check box enabled. For more information, refer to “Important Information about XSCM.CONFIG” on page 126.

- To load settings from an AppXtender integration with Microsoft Outlook, such as targets and field mappings, enable the Outlook check box. (For information on integrating AppXtender with Microsoft Outlook, refer to the Microsoft Outlook Integration for ApplicationXtender)

**Note:** If AppXtender is having trouble connecting to the AppXtender database on your computer, you can copy the data source settings for a workstation that can successfully connect to the database and load the data source settings on your computer. If you choose not to load AppXtender Document Manager Settings when you load settings, you can load the data source configuration without affecting the rest of your AppXtender configuration.

4. Click Open. The Login dialog box appears.

**Note:** Your login procedure may vary depending on the security provider in use for the current data source. For information, refer to the ApplicationXtender Core Components Administrator’s Guide.

You must re-login to AppXtender Document Manager to load the saved profile.
5. From the Logon Type drop-down list, select the type of license that you want the logon to use. The following table describes each logon type:

<table>
<thead>
<tr>
<th>Login Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppXtender Document Manager</td>
<td>Logs into AppXtender Document Manager using an AppXtender Desktop license only.</td>
</tr>
<tr>
<td>CX/AppXtender Reports Mgmt</td>
<td>Logs into AppXtender Document Manager using a CX and AppXtender Reports Mgmt license only, so that you can view CX/AppXtender Reports Mgmt data.</td>
</tr>
<tr>
<td>AppXtender Document Manager &amp; CX/AppXtender Reports Mgmt</td>
<td>Logs into AppXtender Document Manager using both an AppXtender Document Manager and CX/AppXtender Reports Mgmt license, so that you can view both AppXtender and CX/AppXtender Reports Mgmt data.</td>
</tr>
</tbody>
</table>

6. In the User Name text box, type a user name that is valid for the default data source.

7. In the Password text box, type your password.

8. Click Login. AppXtender resets your AppXtender Document Manager workstation to the new workstation profile settings.

**Note:** If AppXtender is unable to connect to the database, check the database to make sure that it is running and accessible.
This section describes the procedures for creating, indexing, and submitting documents to a full-text queue.

- Introduction to Document Creation .................................................. 138
- Creating New Documents ................................................................. 140
- Creating Documents in Batches ......................................................... 174
- Indexing New Documents ................................................................. 187
- Indexing Batches .............................................................................. 200
- Submitting Documents to a Full-text Queue ...................................... 206
Creating Documents

Introduction to Document Creation

ApplicationXtender (AppXtender) allows you to store and organize many types of information as documents. AppXtender documents are organized in applications for easy retrieval. A variety of input methods are available for you to add documents and pages to applications. Each document is saved in AppXtender with an index that is used to search for the document. AppXtender allows you to add pages and page versions to documents after they have been created.

Note: If you would prefer to create your AppXtender documents directly from an ODMA-compliant application, such as Microsoft Word, you can do so. When you create a document through ODMA, you create the document in the ODMA-compliant application and then index the document and check it into AppXtender. For more information on creating AppXtender documents through ODMA, refer to Chapter 8, "Using ODMA With AppXtender Documents."

The following procedures provide an overview of the two document creation methods discussed in this section: creating documents one at a time and creating documents in batches.

◆ To create documents one at a time:

1. Bring the information that you want to store into AppXtender. You can use several different methods to bring information into AppXtender. For more information, refer to “Creating New Documents” on page 140. After you have brought the information into AppXtender, it appears in Document Display view and an empty Index View appears.

2. Index the new document. To enter information into the fields, you can type, use AppXtender’s automated indexing features, or both. For more information, refer to “Indexing New Documents” on page 187.

3. Click Save. The new document is stored in AppXtender with its index information.

4. If necessary, add pages to the new document. For more information, refer to “Adding Pages to Documents” on page 356.
Creating Documents

5. If necessary, submit the new document to the ApplicationXtender Index Server (AppXtender Index Server) for full-text searching. For more information, refer to “Submitting Documents to a Full-text Queue” on page 206.

   Note: Your workstation may be configured so that when you save and close a new document, it is automatically submitted to the AppXtender Index Server for full-text searching. The Full Text tab of the AppXtender Configuration dialog box allows this configuration. For information, consult your AppXtender system administrator or refer to the "Configuring Workstations" section of the ApplicationXtender Installation Guide.

- To create documents in batches:

  1. Create or import a batch of documents. For more information, refer to “Creating Documents in Batches” on page 174.

     Note: As soon as the batch has been created, it is available for indexing.

  2. Use the Batch Index utility to index the documents in the batch. To enter information into the fields, you can type, use AppXtender’s automated indexing features, or both. For more information, refer to “Indexing Batches” on page 200.

  3. If necessary, add pages to the new documents. For more information, refer to “Adding Pages to Documents” on page 356.

  4. If necessary, submit the new documents to the AppXtender Index Server for full-text searching. For more information, refer to “Submitting Documents to a Full-text Queue” on page 206.

     Note: Your workstation may be configured so that when you save and close a new document, it is automatically submitted to the AppXtender Index Server for full-text searching. The Full Text tab of the AppXtender Configuration dialog box allows this configuration. For information, consult your AppXtender system administrator or refer to the "Configuring AppXtender Document Manager Workstations" section of the ApplicationXtender Installation Guide.
Creating New Documents

When you create a document in AppXtender, you bring the document into AppXtender and enter index information that identifies the document. Index fields must be populated for every document in an application, and the combination of data entered into the fields for a particular document should be unique. Unique sets of index data keep documents organized and allow for easier retrieval and display. The index information for each document is stored in the AppXtender database along with page information and the storage location.

All the commands necessary for creating a new document are available from the Document menu. Document creation begins with the input of the first page. Each document in an application must contain at least one page. The commands to add additional pages to a document, which are similar to the Document menu commands, are found in the Page menu.

Note: In the _RSTAMP and _FORMS applications, each document can consist of only one page. For more information on the _RSTAMP and _FORMS applications, consult your AppXtender system administrator or refer to the “Configuring AppXtender Document Manager Workstations” section of the ApplicationXtender Installation Guide.

To begin the document creation process:

1. In Application view on the AppXtender user desktop, right-click the name of the application to which you want to add the document. The application shortcut menu appears.
2. From the shortcut menu, select New Document.
3. Select the input method that you want to use.
Input Methods

ApplicationXtender allows for various methods of creating documents or pages, such as:
- Scanning
- Clipboard Paste
- Clipboard Paste Special (paste as a different file type)
- Insert Object
- Import File
- Fax-in Queue

These various input sources can be used for the first page and for any successive page. Because document creation begins with adding the first page, each input source is detailed in this topic.

Note: The Insert Object input method is not available for creating documents in either the _RSTAMP or _FORMS applications.

Deciding What Input Method to Use

AppXtender allows you to create documents in many ways. The following table will help you decide the best way to bring a document into AppXtender:

Table 17 Deciding What Input Method to Use

<table>
<thead>
<tr>
<th>If the Document You Want to Create is</th>
<th>Use the Method</th>
<th>For More Information, Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>A paper document that is not yet in electronic format</td>
<td>Scanning</td>
<td>Chapter 4, &quot;Scanning,&quot; or the ApplicationXtender Image Capture User's Guide</td>
</tr>
<tr>
<td>An electronic document that is in an image format supported in AppXtender</td>
<td>Import File</td>
<td>&quot;Support for Viewing of Imported Files in AppXtender&quot; on page 143 or &quot;Adding a Document by Importing a File&quot; on page 160</td>
</tr>
<tr>
<td>An electronic document that is a text file (*.TXT)</td>
<td>Import File</td>
<td>&quot;Adding a Document by Importing a File&quot; on page 160</td>
</tr>
<tr>
<td>An electronic document that is a Rich Text Format file (*.RTF)</td>
<td>Import File</td>
<td>&quot;Adding a Document by Importing a File&quot; on page 160</td>
</tr>
<tr>
<td>An electronic document that is a Hypertext Markup Language file (*.HTM or *.HTML).</td>
<td>Import File</td>
<td>&quot;Adding a Document by Importing a File&quot; on page 160</td>
</tr>
</tbody>
</table>
### Table 17  Deciding What Input Method to Use (continued)

<table>
<thead>
<tr>
<th>If the Document You Want to Create is</th>
<th>Use the Method</th>
<th>For More Information, Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>An electronic document that is an Adobe Portable Document Format (PDF) file (*.PDF)</td>
<td>Import File</td>
<td>“Adding a Document by Importing a File” on page 160</td>
</tr>
<tr>
<td>An electronic document that is an e-mail attachment in Microsoft Outlook</td>
<td>Import File (drag and drop e-mail attachment)</td>
<td>“Adding a Document by Importing a File” on page 160</td>
</tr>
<tr>
<td>An electronic document that is in a format not natively supported by AppXtender and that you would like to index using full-text indexing</td>
<td>Import File</td>
<td>“Support for Viewing of Imported Files in AppXtender” on page 143 or “Adding a Document by Importing a File” on page 160</td>
</tr>
<tr>
<td>An electronic document that is in a format that is not natively supported by AppXtender and that you would like to work with within the application in which it was created using ODMA</td>
<td>Import File</td>
<td>“Support for Viewing of Imported Files in AppXtender” on page 143 or “Adding a Document by Importing a File” on page 160</td>
</tr>
<tr>
<td>An electronic document that is in a format that is not natively supported by AppXtender and that you would like to work with within the application in which it was created using in-place editing in AppXtender (Note that documents brought into AppXtender as objects cannot be submitted for full-text indexing.)</td>
<td>Clipboard Paste or Clipboard Paste Special or Insert Object</td>
<td>“Support for Viewing of Imported Files in AppXtender” on page 143 or “Adding a Document from the Windows Clipboard” on page 150 or “Adding a Document by Inserting an Object” on page 155</td>
</tr>
<tr>
<td>A fax in a fax server queue</td>
<td>Fax-in Queue</td>
<td>“Adding a Document from the Fax-in Queue” on page 167</td>
</tr>
</tbody>
</table>
Support for Viewing of Imported Files in AppXtender

Files imported into AppXtender are supported for viewing in three ways: using the native AppXtender viewer, using the KeyView Viewer, and using ODMA-compliant applications.

Native AppXtender File Support
AppXtender supports several file formats natively. File formats that are supported natively display in the Document Display view without need for an additional third-party viewer or any additional AppXtender configuration. AppXtender-supported file types include:

- Bitmap (BMP)
- TrueVision Targa (TGA)
- DCX
- Graphics Interchange Format (GIF)
- JPEG
- PCX
- Tagged Image File Format (TIFF)
- Rich Text Format (RTF)
- Hypertext Markup Language (HTML)

All files that are not natively supported in AppXtender are referred to as "foreign files," both in this document and in the AppXtender interface.

Keep in mind the following points:

- Multi-page TIFF and DCX files can be imported into AppXtender. Each page of the imported file becomes a page within the new AppXtender document. Your workstation may be configured to store each multi-page TIFF file as one BIN file or many BIN files. For information, consult your AppXtender system administrator or refer to the "Configuring Workstations" section of the ApplicationXtender Installation Guide.

- AppXtender does not support progressive JPEGs or GIF animation files. Importing a progressive JPEG or a GIF animation file into AppXtender results in the file being imported as a foreign file.
KeyView File Support
Several file formats that are not supported natively by ApplicationXtender are supported by the KeyView Viewer, which has been integrated with AppXtender. When the KeyView Viewer is enabled in the View tab of the AppXtender Configuration dialog box, the contents of KeyView-supported files are displayed in Document Display view without need of a third-party viewer. The appearance of a foreign file in the KeyView Viewer is similar to but not exactly the same as its appearance in its native viewer.

The following table lists the foreign file types that can be viewed using the KeyView Viewer:

<table>
<thead>
<tr>
<th>Format</th>
<th>Foreign File Type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Processing</td>
<td>Adobe Maker Interchange Format</td>
<td>Versions 5, 5.5, and 6.7</td>
</tr>
<tr>
<td></td>
<td>Applix Words</td>
<td>Versions 4.2, 4.3, 4, and 4.4</td>
</tr>
<tr>
<td></td>
<td>ASCII Text</td>
<td>All versions</td>
</tr>
<tr>
<td></td>
<td>ANSI Text</td>
<td>All versions</td>
</tr>
<tr>
<td></td>
<td>Autocad DXF &amp; Export formats</td>
<td>Versions R13, R14, and R2000</td>
</tr>
<tr>
<td></td>
<td>DisplayWrite</td>
<td>Version 4.0</td>
</tr>
<tr>
<td></td>
<td>Folio Flat File</td>
<td>Version 3.1</td>
</tr>
<tr>
<td></td>
<td>Fujitsu Oasys</td>
<td>Version 7.0</td>
</tr>
<tr>
<td></td>
<td>HTML</td>
<td>Versions 2.x through 4.x</td>
</tr>
<tr>
<td></td>
<td>IBM DCA/RFT</td>
<td>Version SC23-0758-1</td>
</tr>
<tr>
<td></td>
<td>JustSystems Ichitaro</td>
<td>Versions 8, 9, 10, and 12</td>
</tr>
<tr>
<td>Format</td>
<td>Foreign File Type</td>
<td>Version</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Lotus Ami Pro</td>
<td>Versions 2.0, 3.0, and Professional Write Plus</td>
<td></td>
</tr>
<tr>
<td>LotusSmartMaster</td>
<td>Versions 96, 97, R9, and 9.8</td>
<td></td>
</tr>
<tr>
<td>Lotus Word Pro</td>
<td>Versions 96, 97, and R9</td>
<td></td>
</tr>
<tr>
<td>Maker Interchange Format (MIF)</td>
<td>Version 5.5</td>
<td></td>
</tr>
<tr>
<td>Microsoft RTF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Word for Windows</td>
<td>Versions 2.x, 6.0, 95, 97, 2000 through 2003, and XP</td>
<td></td>
</tr>
<tr>
<td>Microsoft Word Mac</td>
<td>Versions 4.x through 6.x, and 98</td>
<td></td>
</tr>
<tr>
<td>Microsoft Word PC</td>
<td>Versions 4.5, 5.5, and 6.0</td>
<td></td>
</tr>
<tr>
<td>Microsoft Works</td>
<td>Versions 1.0 through 2000</td>
<td></td>
</tr>
<tr>
<td>Microsoft Write</td>
<td>Versions 1.0 through 3.0</td>
<td></td>
</tr>
<tr>
<td>RichText Format</td>
<td>Versions 1 through 1.7</td>
<td></td>
</tr>
<tr>
<td>Unicode</td>
<td>Versions 3 and 4</td>
<td></td>
</tr>
<tr>
<td>WordPro</td>
<td>Versions through 2003</td>
<td></td>
</tr>
<tr>
<td>WordPerfect for DOS</td>
<td>Versions through 6.1</td>
<td></td>
</tr>
<tr>
<td>WordPerfect for Linux</td>
<td>Version 6</td>
<td></td>
</tr>
<tr>
<td>WordPerfect for Mac</td>
<td>Versions 1.02 through 3.1</td>
<td></td>
</tr>
<tr>
<td>WordPerfect for Windows</td>
<td>Versions through 10, 2000, 2002, and 11</td>
<td></td>
</tr>
</tbody>
</table>
Table 18  AppXtender-Supported Foreign File Types (continued)

<table>
<thead>
<tr>
<th>Format</th>
<th>Foreign File Type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>XHTML</td>
<td></td>
<td>Version 1.0</td>
</tr>
<tr>
<td>XML</td>
<td></td>
<td>Version 1.0</td>
</tr>
<tr>
<td>XyWrite for Windows</td>
<td></td>
<td>Version 4.12</td>
</tr>
<tr>
<td>Spreadsheets</td>
<td>Appliance Spreadsheets (AS)</td>
<td>Versions 4.2 through 4.4</td>
</tr>
<tr>
<td>Comma Separated Values (CSV)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Corel Quattro Pro (QPW, WB3)</td>
<td></td>
<td>Versions 8.0 through 10.0, 2000, 2002</td>
</tr>
<tr>
<td>Lotus 1-2-3 (123)</td>
<td></td>
<td>Versions 296, 97, R9, 9.8</td>
</tr>
<tr>
<td>Lotus 1-2-3 (WK4)</td>
<td></td>
<td>Versions 2 through 5</td>
</tr>
<tr>
<td>Lotus 1-2-3 Charts (123)</td>
<td></td>
<td>Versions 2 through 5</td>
</tr>
<tr>
<td>Microsoft Excel Charts (XLS)</td>
<td></td>
<td>Versions 4 through 7</td>
</tr>
<tr>
<td>Microsoft Excel for Windows (XLS)</td>
<td></td>
<td>Versions 2.2 through 2003</td>
</tr>
<tr>
<td>Microsoft Excel for Windows XML Format</td>
<td></td>
<td>Version 2003</td>
</tr>
<tr>
<td>Microsoft Excel for Macintosh (XLS)</td>
<td></td>
<td>Version 98</td>
</tr>
<tr>
<td>Microsoft Works Spreadsheet (S30, S40)</td>
<td></td>
<td>Versions 1.0 through 4.0</td>
</tr>
<tr>
<td>Open Office (SXC)</td>
<td></td>
<td>Versions 1 and 1.1</td>
</tr>
<tr>
<td>StarOffice (SXC)</td>
<td></td>
<td>Versions 6 and 7</td>
</tr>
</tbody>
</table>
Table 18  AppXtender-Supported Foreign File Types (continued)

<table>
<thead>
<tr>
<th>Format</th>
<th>Foreign File Type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Presentations</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Applix Presents</td>
<td>Versions 4.3 and 4.4</td>
</tr>
<tr>
<td></td>
<td>Corel Presentations</td>
<td>Versions 7.0, 8.0, 10, 2000, 2002, and 11</td>
</tr>
<tr>
<td></td>
<td>Lotus Freelance</td>
<td>Version 2.x, 96, 97, R9, and 9.8</td>
</tr>
<tr>
<td></td>
<td>Microsoft Powerpoint for Windows</td>
<td>Version 4.0, 95, 97, 2000, and XP</td>
</tr>
<tr>
<td></td>
<td>Microsoft Powerpoint for Macintosh</td>
<td>Version 98</td>
</tr>
<tr>
<td></td>
<td>Microsoft PowerPoint for PC</td>
<td>Version 4</td>
</tr>
<tr>
<td></td>
<td>Microsoft Project</td>
<td>Version 98, 2000, 2002, and XP</td>
</tr>
<tr>
<td></td>
<td>Microsoft Visio</td>
<td>Version 6</td>
</tr>
<tr>
<td></td>
<td>Microsoft Visio XML Format</td>
<td>Version 2003</td>
</tr>
<tr>
<td><strong>Graphics</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AutoCAD Drawing format (DWG)</td>
<td>Versions R13, R14, and R2000</td>
</tr>
<tr>
<td></td>
<td>AutoCAD Drawing format (DXF)</td>
<td>Versions R13, R14, and R2000</td>
</tr>
<tr>
<td></td>
<td>Computer Graphics Metafile (CGM)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Corel Draw CDR (TIFF header)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Encapsulated PostScript (TIFF header)</td>
<td>TIFF header only</td>
</tr>
<tr>
<td></td>
<td>Enhanced Metafile (EMF)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fax Systems (TIFF CCITT)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Graphics Interchange Format</td>
<td>Versions 87 and 89</td>
</tr>
</tbody>
</table>
### Table 18  AppXtender-Supported Foreign File Types (continued)

<table>
<thead>
<tr>
<th>Format</th>
<th>Foreign File Type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG File Interchange Format</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus AMIDraw Graphics (SDW)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus Pic (PIC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Macintosh Raster (PICT/PCT)</td>
<td></td>
<td>Version 2</td>
</tr>
<tr>
<td>MacPaint (PNTG)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Excel Charts (PNTG)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Windows Animated Cursor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Windows Bitmap (BMP)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Windows Cursor/Icon Graphics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Windows Metafile (WMF)</td>
<td></td>
<td>Version 3</td>
</tr>
<tr>
<td>PC PaintBrush (PCX)</td>
<td></td>
<td>Version 3</td>
</tr>
<tr>
<td>Portable Network Graphics (PNG)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SGI RGBImage (RGB)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sun Raster Image (RS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tagged Image File Format (TIFF)</td>
<td></td>
<td>Version 5</td>
</tr>
<tr>
<td>Truevision Targa (TGA)</td>
<td></td>
<td>Version 2</td>
</tr>
</tbody>
</table>
Creating New Documents

Creating Documents

ODMA File Support
If you import a file and it is ODMA-compliant and is supported for use of ODMA with AppXtender, you can create and access documents through the interface of the supported applications rather than through the AppXtender interface. For more information, refer to Chapter 8, “Using ODMA With AppXtender Documents.”.

Note: If the document you want to work with is not supported for use with ODMA, you can still edit it in AppXtender using in-place editing by inserting it as an object, as long as the source application is installed on your AppXtender workstation and the application supports Object Linking and Embedding (OLE). Most Windows applications support OLE. To determine if your application supports OLE, refer to the documentation for the product. Note that documents inserted as objects in AppXtender cannot be submitted for full-text indexing.

For a list of the AppXtender-supported applications that are ODMA-compliant, refer to Chapter 8, “Using ODMA With AppXtender Documents.”.

CAUTION
Use of ODMA with any of the Corel Office 2000 suite of products causes system failure and is not supported with AppXtender.

<table>
<thead>
<tr>
<th>Format</th>
<th>Foreign File Type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>WordPerfect Graphics (WPG)</td>
<td>Versions 1.0</td>
</tr>
<tr>
<td></td>
<td>WordPerfect Graphics 1</td>
<td>Versions 2.0 and 7.0</td>
</tr>
<tr>
<td></td>
<td>WordPerfect Graphics 2</td>
<td>Versions 2.0 and 7.0</td>
</tr>
</tbody>
</table>

Table 18 AppXtender-Supported Foreign File Types (continued)
Creating Documents

Adding a Document by Scanning

New documents can be created from any scanner that is supported or certified for use with ApplicationXtender. For detailed scanning procedures and a list of certified and supported scanners, refer to “Scanning.”

If you have many paper documents you need to scan into AppXtender, you can use ApplicationXtender Image Capture to scan batches of documents and then index the documents in AppXtender. For more information on using ApplicationXtender Image Capture for batch scanning, consult your system administrator or refer to the ApplicationXtender Image Capture User’s Guide.

Adding a Document from the Windows Clipboard

ApplicationXtender allows for the sharing of data between programs using the Windows Clipboard. The contents of the Clipboard can be pasted into AppXtender to create a new document. Because the Clipboard holds any type of data, the new page can be an image, data from another application (such as WordPerfect or PowerPoint), or even a page from a different AppXtender application. Objects pasted from the clipboard are inserted as OLE objects.

You can paste a document from the Windows Clipboard using the Paste command or the Paste Special command. The Paste command pastes the document in the default format. The Paste Special command allows you to select the format for the pasted document. For more information, refer to the following topics:

- “Adding a Document by Pasting” on page 151
- “Adding a Document by Pasting in a Selected Format” on page 153

Note: To create documents in the _RSTAMP or _FORMS applications, you must use the right-click or shortcut menu to access the New Document command.
You can paste a document in the default format.

To paste a document from the Windows Clipboard:

1. Move the desired data to the Windows Clipboard. Typically, this is performed through a program’s Edit menu, and some programs have shortcuts to accomplish this function.

2. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Clipboard Paste.

If there is not a valid page in the Windows Clipboard, the Clipboard Paste option is dimmed. One or more of the following may have occurred:

- No document is available to be added.
- Text is on the Clipboard and the Allow paste text option on the COLD tab of the Configuration dialog box has not been enabled. For more information on configuring the Allow paste text option, consult your system administrator or refer to the “Configuring Workstations” section of the ApplicationXtender Installation Guide.
- The data source in which an application is located is not active.

**Note:** If the menu option is unavailable, verify that the data has been moved to the Clipboard successfully. The Clipboard viewer (supplied with Windows) can be used to view the contents of the Clipboard at any time.

3. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you plan to use when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.
Creating Documents

Figure 60  Reason Code Required Dialog Box

4. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

Figure 61  Signature Properties Dialog Box

AppXtender displays the contents of the Clipboard in the Document Display view.

5. Enter the index information for the new document and click Save.
Adding a Document by Pasting in a Selected Format

You can paste a document from the Windows Clipboard and select the format for the pasted document.

To paste a document in a selected format (Paste Special):

1. Move the desired data to the Windows Clipboard. Typically, this is performed through a program’s Edit menu, and some programs have shortcuts to accomplish this function.

2. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Clipboard Paste Special. The Paste Special dialog box appears.

3. Under As, select a format.

4. If the Display As Icon check box is available, indicate how you want the new document to be displayed and edited. You have the following choices:
   - To display the object as an icon, select the Display As Icon check box.
   - To display the object as its content, disable the Display As Icon check box.

5. Click OK.

6. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.
Creating Documents

Figure 63  Reason Code Required Dialog Box

7. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

Figure 64  Signature Properties Dialog Box

The document appears in the Document Display view.

8. Enter the index information for the new document and click Save.
You can create new documents by inserting data from applications that support ActiveX embeddable objects into AppXtender. For information, refer to the following topics:

- "Inserting a New File as an Object" on page 155.
- "Inserting an Existing File as an Object" on page 157

**Note:** The Insert Object input method for creating documents is not available for either the _RSTAMP or _FORMS applications.

To add a document as a new object:

1. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Insert Object. The Insert Object dialog box appears, listing all ActiveX server applications installed on your workstation.

2. Select Create New.

3. Under Object Type, select the name of the application that you want to use to create the new document.

4. Indicate how you want the new document to be displayed and edited. You have the following choices:
   - To display the object as an icon, select the Display As Icon check box.
   - To display the object as its content, disable the Display As Icon check box.

5. Click OK.
Creating Documents

6. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

![Reason Code Required Dialog Box](image)

Figure 66 Reason Code Required Dialog Box

7. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

![Signature Properties Dialog Box](image)

Figure 67 Signature Properties Dialog Box
A window appears in AppXtender that allows you to create and edit the new object.

**Figure 68 Object Edited in ApplicationXtender**

8. Complete the object.

9. To return to the AppXtender Document Display view, from the File menu, select Close.
   - If you enabled the Display As Icon check box, the object appears as an icon in AppXtender.
   - If you disabled the Display As Icon check box, the object appears as its content in AppXtender.

10. In Index view, enter the index information for the new document. Then click Save.

**Inserting an Existing File as an Object**

To add a new document as an object from an existing file:

1. In Application view, right-click the application name to display the shortcut menu.

2. From the shortcut menu, select New Document and then Insert Object. The Insert Object dialog box appears.

3. Select Create from File.

4. Type the path and file name for the file you want to insert, or click Browse and find the file.

Creating New Documents
Creating Documents

5. Indicate how you want the new document to be displayed and edited. You have the following choices:

- To display the object as an icon, select the Display As Icon check box.
- To display the object as its content, disable the Display As Icon check box.

6. Click OK.

7. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.
8. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

![Signature Properties Dialog Box](image)

**Figure 71** Signature Properties Dialog Box

AppXtender starts the source application.

9. Edit the ActiveX object (if necessary).


   - If you enabled the Display As Icon check box, the object appears as an icon in AppXtender.
   - If you disabled the Display As Icon check box, the object appears as its content in AppXtender.

11. Enter the index information for the new document in the Index view and click Save.
Creating Documents

Adding a Document by Importing a File

You can create a new document by importing an existing file. You can import any file type. If AppXtender supports the file type that you import, the content of the file appears in the Document Display view. Supported foreign files can be viewed in the Document Display view using the AppXtender Web Verity KeyView. The AppXtender Web Verity KeyView, when enabled on the View tab of the AppXtender Configuration dialog box, allows AppXtender to display the contents of a supported foreign file without having to open a third party viewer. If the AppXtender Web Verity KeyView is not enabled for foreign files, the files display as icons in the Document Display view.

File types that are not supported by AppXtender and are not supported using the AppXtender Web Verity KeyView require a third-party viewer to display the contents of the file.

For more information on viewing support for file formats in AppXtender, refer to “Support for Viewing of Imported Files in AppXtender” on page 143.

You can import files by using the Import File option in the Document menu, by dragging the files from the Windows Explorer, or by dragging file attachments from e-mail messages in Microsoft Outlook. For instructions, refer to the following topics:

◆ “Adding a Document by Using the Import File Option” on page 161
◆ “Adding a Document by Dragging from Windows Explorer” on page 163
◆ “Adding a Document by Dragging from Microsoft Outlook” on page 165

Note: The _RSTAMP and _FORMS applications do not support drag-and-drop import file functionality.
To add a new document by importing a file:

1. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Import File. The Import File dialog box appears, allowing selection of any file.

![Import File Dialog Box](image1)

2. Navigate to and select the files that you want to import and click Open.

3. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

![Reason Code Required Dialog Box](image2)
4. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

![Signature Properties Dialog Box](image)

**Figure 74 Signature Properties Dialog Box**

The document appears in the Document Display view. A message appears indicating how many of the selected files have been imported. You can cancel the import by clicking Cancel.

When the import is complete, the message automatically closes and AppXtender displays the new document in the Document Display view.

- If the file is a foreign file type supported by the AppXtender Web Verity KeyView and you have the AppXtender Web Verity KeyView feature enabled in the View tab of the AppXtender Configuration dialog box, the contents of the foreign file appear in the Document Display view. You can launch the file in its native application using the Launch command on the Document Display shortcut menu.

- If the file is a foreign file type that is not supported by the AppXtender Web Verity KeyView or if you do not have the AppXtender Web Verity KeyView enabled, an icon represents the new document. AppXtender stores unsupported foreign file types in their native file format. You can open the file (and the software program in which it was created) by double-clicking on the icon.
5. Enter the index information for the new document and click Save.

You can import files by dragging the files from the Windows Explorer.

To add a new document by dragging a file from Windows Explorer:
1. Make sure that the appropriate AppXtender application is active.
2. Make sure that no document is currently displayed.
3. Drag the file from Windows Explorer and drop it in the AppXtender Document Display view.
4. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.
Creating Documents

5. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

![Signature Properties Dialog Box](image)

Figure 77  Signature Properties Dialog Box

A message appears indicating how many of the selected files have been added. You can cancel the import by clicking Cancel.

When the addition is complete, the message automatically closes and AppXtender displays the new document in the Document Display view.

- If the file is a foreign file type supported by the AppXtender Web Verity KeyView and you have the AppXtender Web Verity KeyView feature enabled in the View tab of the AppXtender Configuration dialog box, the contents of the foreign file appear in the Document Display view. You can launch the file in its native application using the Launch command on the Document Display shortcut menu.

- If the file is a foreign file type that is not supported by the AppXtender Web Verity KeyView or if you do not have the AppXtender Web Verity KeyView enabled, an icon represents the new document. AppXtender stores unsupported foreign file types in their native file format. You can open the file (and the software program in which it was created) by double-clicking on the icon.

6. Enter the index information for the new document and click Save.
You can import files by dragging file attachments from e-mail messages in Microsoft Outlook.

**Note:** The ApplicationXtender Add-in for Microsoft Outlook allows you to map Outlook fields with AppXtender index fields so that you can create AppXtender documents by copying or moving items (mail, appointments, meeting requests, and contacts) from Outlook to Microsoft Outlook Integration for ApplicationXtender. You can also configure the add-in to monitor folders for incoming items and automatically export these items to AppXtender. For more information, refer to the *Microsoft Outlook Integration for ApplicationXtender Guide*.

To add a new document by dragging a file attachment from Microsoft Outlook:

1. Make sure that the appropriate AppXtender application is active.
2. Make sure that no document is currently displayed.
3. Drag the file attachment from Microsoft Outlook and drop it in the AppXtender Document Display view.
4. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

![Reason Code Required Dialog Box](image)
5. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

![Signature Properties Dialog Box](image)

Figure 79  Signature Properties Dialog Box

A message appears indicating how many of the selected files have been added. You can cancel the process by clicking Cancel.

When the addition is complete, the message automatically closes and AppXtender displays the new document in the Document Display view.

- If the file is a foreign file type supported by the AppXtender Web Verity KeyView and you have the AppXtender Web Verity KeyView feature enabled in the View tab of the AppXtender Configuration dialog box, the contents of the foreign file appear in the Document Display view. You can launch the file in its native application using the Launch command on the Document Display shortcut menu.

- If the file is a foreign file type that is not supported by the AppXtender Web Verity KeyView or if you do not have the AppXtender Web Verity KeyView enabled, an icon represents the new document. AppXtender stores unsupported foreign file types in their native file format. You can open the file (and the software program in which it was created) by double-clicking on the icon.

6. Enter the index information for the new document and click Save.
Adding a Document from the Fax-in Queue

This topic describes the addition of a single document by fax-in queue. You can also copy index information from the fax-in queue and paste it into the document index.

To add a document by fax-in queue:

1. Configure your workstation for document creation by fax-in queue. For information on configuring the Fax-in tab, consult your AppXtender system administrator or refer to the "Configuring Workstations" section of the ApplicationXtender Installation Guide.

2. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Fax-in Queue.

3. If the Login to Fax Server dialog box appears, enter the name of the fax server, your user name, and your password.

4. If you are using Castelle FAX Press for your fax-in server, you have the following choices:
   - If you want to import faxes from your personal queue, select the Import from personal queue option.
   - If you want to import faxes from the unassigned queue, disable the Import from personal queue option.

   Note: The Import from personal queue check box does not appear on the FAX Server Import dialog box if you are using RightFax for your fax-in server.
5. Click Login. The FAX Server Import dialog box appears, listing each of the incoming faxes from the selected queue (personal or unassigned).

![FAX Server Import Dialog Box](image)

**Figure 81** FAX Server Import Dialog Box

*Note:* If you are using RightFax for your fax-in server, you can customize the way columns display in the FAX Server Import dialog box. Customizable options include column title, column order, which columns appear, and the type of faxes that appear. For more information, consult your AppXtender system administrator or refer to the "Configuring Workstations" section of the ApplicationXtender Installation Guide.

6. If you want to Preview faxes in the queue, click the Preview check box to select the option. The selected fax appears in AppXtender. Use the Prev and Next buttons to navigate through the fax-in queue, page by page.

7. If you want to delete a fax, select the fax that you want to delete and click Delete.

8. If you do not want the fax that you are importing to be deleted, click the Delete after import check box to disable the option.

9. If you want to copy the index information listed for the fax to save data entry time when you index the document later, right-click on the fax. From the shortcut menu that appears, select Copy.
Creating New Documents

Note: In order to copy and paste index information, the columns in the FAX Server Import dialog box must have the same labels and appear in the same order as the fields in the Index view once the fax has been imported.

10. Click Import to import the fax.

11. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

Figure 82 Reason Code Required Dialog Box

12. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)
13. Enter the appropriate index data for this document in the Index view.

If you copied the index information from the FAX Server Import dialog box, right-click in the Index view. From the shortcut menu that appears, select Paste Form. The copied index information appears in the Index view.

14. Click Save.

Creating _RSTAMP and _FORMS Documents

Rubber stamps and forms must be created before users can access them. You can configure stamps and forms to be restricted to a specific application or user, if necessary. Rubber stamps and forms can be created only by users with the following privileges assigned to their AppXtender user profile: ApplicationXtender Administrator, Configure WS, Add Page, and Display.
The document creation procedures for the _RSTAMP and _FORMS applications are similar to the document creation procedures for any other AppXtender application. The input methods available for creating _RSTAMP and _FORMS documents include:

- Scan
- Clipboard Paste
- Clipboard Paste Special
- Import File
- Fax-In-Queue

The primary difference between creating documents in these two pre-defined AppXtender applications than in other AppXtender applications is the method for accessing the appropriate commands. Typically, an AppXtender application is made active by double-clicking on the application in ApplicationXtender. Then, selecting toolbar buttons or menu commands performs the selected action on the active application. However, double-clicking on the _RSTAMP and the _FORMS applications does not make them active in AppXtender.

Since neither of these applications can be made active, the commands to create new documents for the _RSTAMP and _FORMS applications must be accessed via the shortcut menu (opened by right-clicking on the application).

Once a new document is input into either the _RSTAMP or _FORMS application, you are required to enter the appropriate index information, so that those documents can be accessed and used with other AppXtender documents as appropriate.

The _RSTAMP index fields are as follows:

<table>
<thead>
<tr>
<th>Index Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>Name of the rubber stamp.</td>
</tr>
<tr>
<td>DESC</td>
<td>Description of the rubber stamp.</td>
</tr>
</tbody>
</table>
Table 19  Rubber Stamp Index Fields (continued)

<table>
<thead>
<tr>
<th>Index Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APP</td>
<td>Application name associated with this rubber stamp. If this field is empty, this rubber stamp is for all applications.</td>
</tr>
<tr>
<td>USER</td>
<td>User name or group name associated with this rubber stamp. If this field is empty, this rubber stamp is for all users.</td>
</tr>
<tr>
<td>DOMAIN</td>
<td>If the AppXtender system uses the Windows security provider, domain associated with this rubber stamp. If this field is empty, this rubber stamp is available to all domains. If the AppXtender system uses the CM security provider or a directory service security provider, leave this field blank. For more information about security providers, refer to the ApplicationXtender Core Components Administrator's Guide.</td>
</tr>
</tbody>
</table>

The _FORMS index fields are as follows:

Table 20  Forms Index Fields

<table>
<thead>
<tr>
<th>Index Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FORM NAME</td>
<td>Name of the form.</td>
</tr>
<tr>
<td>FORM TYPE</td>
<td>The type of form being created. Select either Image or ASCII from the drop-down list</td>
</tr>
<tr>
<td>FORM UNITS</td>
<td>Determines the units of measurement used to size the form. Select IN (inches), MM (millimeters) or LI (allows use of line measurement for top-offset setting and character measurement for left offset setting) from the drop-down list.</td>
</tr>
<tr>
<td>TOP OFFSET</td>
<td>The distance between the top of the document and the top of the form.</td>
</tr>
<tr>
<td>LEFT OFFSET</td>
<td>The distance between the left edge of the document and the left edge of the form.</td>
</tr>
<tr>
<td>CPI</td>
<td>Characters per inch setting for the form.</td>
</tr>
<tr>
<td>LPI</td>
<td>Lines per inch setting for the form.</td>
</tr>
<tr>
<td>ORIENTATION</td>
<td>Directional orientation of the form. Select Portrait or Landscape from the drop-down list.</td>
</tr>
<tr>
<td>RESIZE RATIO X</td>
<td>This index field is provided for legacy data purposes.</td>
</tr>
<tr>
<td>RESIZE RATIO Y</td>
<td>This index field is provided for legacy data purposes.</td>
</tr>
</tbody>
</table>
In addition to creating rubber stamps by adding documents to the application via the available input methods, you can also use the New Text Rubber Stamp option, available from the shortcut menu. Text rubber stamp annotations can also be created from existing files.

For more information, refer to the following topics in the Chapter 9, "Annotations," section:

- “Creating a Text Rubber Stamp Annotation from an Existing File” on page 509
- “Creating an Image Rubber Stamp Annotation from an Existing File” on page 511
Creating Documents in Batches

In addition to adding documents individually, AppXtender allows you to create and index documents in groups or batches. There are three ways to create AppXtender documents in batches:

- Importing a batch using Batch Import. For information, refer to “Batch Import” on page 174.
- Creating a batch using Batch Create. For information, refer to “Batch Creation” on page 181.
- Creating a batch using ApplicationXtender Image Capture. For information, refer to Chapter 4, “Scanning.”.

Batch Import

The Batch Import utility allows users to import a batch of files into AppXtender. AppXtender stores the batch temporarily until you are ready to attach index information to the pages in this batch. Those pages can then be used to create new documents or can be added to existing documents using the Batch Index utility. For information on indexing a batch of files in AppXtender, refer to “Indexing Batches” on page 200.

In order to perform a Batch Import, you must first create a text file referencing the files to be imported. You can import several batches at a time by grouping the imported files for a particular batch together in a file.

**Note:** When performing a Batch Import, text files that are flagged as hidden or system will not be imported.
Creating a Batch Import File

A batch import file is a text file referencing the location of files for import. This file can be created in the Windows Notepad or in DOS. You can import multiple batches by including a description for each batch in the file. Each batch description should have two components: a unique name for the batch and a reference to each of the files to be imported.

- The batch name can be up to 32 alphanumeric characters long and should always precede the file references to be included in that batch. You should use a name that is unique for the application into which you intend to import the batch. If a batch is imported into an application that already has a batch by that name, then the new batch is appended to the existing batch.

- Each reference to a file location should include either one (in the case of single-page image, PDF, RTF, and HTML files) or two (in the case of all other files) “at” (@) symbols, followed by the path where the file can be found. When importing multi-page images, use one “at” symbol (@) to import only the first page of the image, or two “at” symbols (@@) to import every page in the image. Volume labels can be referenced in place of directory paths in order to import files and images stored on removable media such as optical disks. Additionally, the asterisk (*) wildcard character can be used to import multiple files from a single location with one command line.

For details on formatting a batch file, refer to the following topics:

- “General Batch Import File Format” on page 176
- “Format for Import Referencing a Volume Label” on page 178
- “Format for Importing Multiple Files with a Single Command” on page 179
General Batch Import File Format

To successfully accomplish the import, the batch import file must be formatted correctly. One or two “at” (@) symbols should immediately precede a file name and path. The following table lists the file types that can be preceded by one “at” symbol (@) and the file types that must be preceded by two “at” symbols (@@):

<table>
<thead>
<tr>
<th>May Use One “at” Symbol (@)</th>
<th>Must Use Two “at” Symbols (@@)</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Single-page image types</td>
<td>• Foreign files, including text files (even if they have been configured on the File Types tab of the Configuration dialog box)</td>
</tr>
<tr>
<td>• PDF</td>
<td>• Multi-page image files (if you want to import every page)</td>
</tr>
<tr>
<td>• Basic Windows RTF</td>
<td></td>
</tr>
<tr>
<td>• HTM</td>
<td></td>
</tr>
<tr>
<td>• Multi-page image files (if you want to import only the first page)</td>
<td></td>
</tr>
</tbody>
</table>

Note: If you import a multi-page PDF file, the result in AppXtender is a single page with multiple subpages. If necessary, after the batch has been indexed, you can convert these subpages to pages. For instructions, refer to “Converting Subpages to Pages” on page 420.

Note: To separate multi-page TIFF and DCX pages, the Separate multi-page TIFFs option in the Data tab of the Configuration dialog box must be enabled. Each page of the imported file becomes a page within the new AppXtender batch. For information on configuring the separation of multi-page TIFF and DCX files, consult your AppXtender system administrator or refer to the “Configuring Workstations” section of the ApplicationXtender Installation Guide.

Note: To import all pages of a multi-page TIFF or DCX file, you must use two “at” symbols (@@) before the file location, even if you have enabled the Separate Multi-page TIFFs option. If you use only one “at” symbol (@) before the file location, the first page of the file becomes a page of the new AppXtender batch, but the remaining pages of the file are discarded.

Note: Multiple pages of GIF animation files cannot be imported into AppXtender. The first page of the file becomes a page of the new AppXtender batch, but the remaining pages of the file are discarded. AppXtender does not support progressive JPEGs. Importing a progressive JPEG into AppXtender results in the file being imported as a foreign file.
When AppXtender processes a batch import file with file names preceded by two "at" symbols (@@), AppXtender honors the file type mappings and image storage format settings for those file names. The following table explains the trade-off between using one "at" symbol or two:

### Table 22 Trade-Off Between Using @ vs. Using @@

<table>
<thead>
<tr>
<th>For This Scenario</th>
<th>Do This</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>All of the files listed in the batch import file are of a format that is natively supported by AppXtender.</td>
<td>Precede each file name and path with only one &quot;at&quot; symbol (@).</td>
<td>AppXtender imports the file without checking the file type. Each file must be a natively supported file format.</td>
</tr>
<tr>
<td>Some of the files listed in the batch import file are of a format that is natively supported by AppXtender and some are not, and you do not have time to edit the batch import file.</td>
<td>Precede each file name and path with two &quot;at&quot; symbols (@@).</td>
<td>AppXtender checks the file type and treats the file as the detected type (such as image, text, or foreign file format). The import time is increased by the number of files that AppXtender must check.</td>
</tr>
<tr>
<td>Some of the files listed in the batch import file are of a format that is natively supported by AppXtender and some are not, and you do have time to edit the batch import file.</td>
<td>For each supported file, precede the file name and path with only one &quot;at&quot; symbol (@). For each unsupported file, precede the file name and path with two &quot;at&quot; symbols (@@).</td>
<td>If one @ precedes the file name and path, AppXtender imports the file without checking the file type. If two @@ signs precede the file name and path, AppXtender checks the file type and treats the file as the detected type.</td>
</tr>
<tr>
<td>None of the files listed in the batch import file are of a format that is natively supported by AppXtender.</td>
<td>Precede each file name and path with two &quot;at&quot; symbols (@@).</td>
<td>AppXtender checks the file type and treats the file as the detected type (in this case, foreign file format).</td>
</tr>
</tbody>
</table>

If the following example batch import file is imported, two batches are created (Images and Fiscal Year 1996):

```
Images
@c:\bitmaps\sailboat.bmp
@c:\tifs\desert.tif
Fiscal Year 1996
@@c:\1996\report.txt
@@c:\1996\report.doc
@c:\1996\chart.bmp
```

**Note:** A character return must be inserted between the batch name and the file location in order to distinguish between the two during import.
**Format for Import Referencing a Volume Label**

A volume label can be used as the root of the file path in place of a drive letter to allow for batch import from multiple pieces of media. If, for example, the images to be stored in AppXtender are located on several different optical disks, each of those disks can be referenced in the import text file by the volume label on the disk. As references to different volume labels are found during the import, you are instructed to insert the correct media. Volume labels can be referenced by placing the name of the volume with a dollar sign in front (as in `$VOLUME_NAME`) where the drive letter would normally be.

The following example of a batch description includes the volume label `VOLUME_01`:

Images
@$VOLUME_01\images\castle.bmp
@c:\images\sky.bmp
@c:\images\leaves.bmp

**Note:** A character return must be inserted between the batch name and the file location in order to distinguish between the two during import.

During import of this example batch import file, you would be prompted to mount the optical disk that has the volume label `VOLUME_01`, unless it was already mounted.

**Note:** The removable media drive where the volume would be mounted must be added as a Volume Label Search Drive on the Paths tab of the Configuration dialog box for the AppXtender workstation performing the import so that AppXtender can find the mounted volume. For more information on adding a Volume Label Search Drive, consult your system administrator or refer to the “Configuring AppXtender Workstations” section of the *ApplicationXtender Installation Guide*. 
Format for Importing Multiple Files with a Single Command
The asterisk (*) wildcard character can be used to import several files from a single location. Rather than entering a line in the import file for each file in the directory, files with similar names can be referenced with one command. When you use the asterisk to replace some or all of the letters, AppXtender imports all of the files in the referenced directory whose names contain the remaining pattern of letters. If, for example, the filenames for all of the financial reports in the directory C:\FINANCE\ begin with the word REPORT, placing the line "c:\finance\report*./*" in the import file would retrieve all of those files. All files in a particular directory can be imported with one command by entering *.* in place of the filename.

Note: The rules for using one or two "at" (@) symbols still apply when using a wildcard character to import a batch. For more information, refer to “General Batch Import File Format” on page 176.

The following example batch import file uses the wildcard character:

Images
@$VOLUME_01\images\castle*.bmp
@c:\images\*.bmp
@c:\images\new\*. *

Note: A character return must be inserted between the batch name and the file location in order to distinguish between the two during import.

The first line after the batch name imports all bitmap files with the prefix CASTLE in the IMAGES directory on the disk labeled VOLUME_01. The second line imports all bitmap files in the C:\IMAGES directory. The third line imports all files in the C:\IMAGES\NEW directory.

As soon as a batch import file has been created, you can perform the import. AppXtender reads the text file, creating a new batch whenever it encounters a line in the file that does not begin with an @ symbol, and storing each of the successive files referenced in that batch.

Note: You cannot add documents to a batch that is being indexed. If you attempt to add documents to a batch that is being indexed, the batch creation fails.
Creating Documents

To create a new batch of imported pages:

1. Make sure that the appropriate application is active. The active application is in bold in the Application view.

2. From the Utilities menu, select Batch Import. The Select Batch Import File dialog box appears.

   ![Select Batch Import File Dialog Box](image)

   **Figure 84** Select Batch Import File Dialog Box

   3. Navigate to the location of the batch import file and select the batch import file name. Click Open.

   If any of the files listed in the batch import file are referenced by a volume label, the ApplicationXtender Utility dialog box appears.

   4. If the ApplicationXtender Utility dialog box appears, mount the specified volume and then click OK. When the import is complete, a Batch Import Status dialog box appears.

   ![Batch Import Status Dialog Box](image)

   **Figure 85** Batch Import Status Dialog Box

   5. If you want to see a log of the import, select View Log. The batch import log appears in Notepad.
Creating Documents in Batches

181

Batch Creation

The Batch Create and Fax-in Batch Create utilities allow you to select a group of files from either a file system or a fax server queue in order to import the files into AppXtender. AppXtender stores the batch temporarily until you are ready to attach index information to the pages in this batch. Those pages can then be used to create new documents or can be added to existing documents using the Batch Index utility. For information on indexing a batch of files in AppXtender, refer to “Indexing Batches” on page 200.

Note: You cannot add documents to a batch that is being indexed. If you attempt to add documents to a batch that is being indexed, a message appears indicating that the batch creation failed.

For more information on creating a batch, refer to the following topics:

◆ “File Selection Batch Create” on page 181
◆ “Fax-in Batch Create” on page 183

File Selection Batch Create

The Batch Create utility allows you to create a batch by browsing for and selecting files that are located on your computer or on a network. You can select one file or a group of files from the same location.

Note: When performing a batch import, text files that are flagged as hidden or system will not be imported.

To import a batch of files using the Batch Create utility:

1. Make sure that the appropriate application is active. The active application appears in bold in the Application view.
2. From the Utilities menu, select Batch Create. AppXtender displays the Select Files For Batch Import dialog box.

![Select Files for Batch Import Dialog Box]

3. You have the following choices:
   - Type the file name of each file that you want to import. Each file name must be enclosed in double quotes.
   - Select the files that you want to import. The selected file names are displayed in the File Name text box.
   - Select the arrow to the right of the Look in drop-down list to browse for a file on your computer. If browsing for a file, choose the file containing the import data within the search dialog box and select Open.

4. You have the following choices:
   - To create a new batch, type a name for the batch in the Batch Name text box. A batch name can contain up to 32 characters.
   - To add the selected files to an existing batch, type the name of the batch in the Batch Name text box.

   **Note:** You cannot add pages to a batch that is being indexed in AppXtender. If you attempt to add pages to a batch that is being indexed, the batch creation fails.

5. Click Open to import all selected files. A message appears, indicating the progress of the batch import. This message is displayed until all files of the batch have been imported. Click Cancel at any time to cancel the batch import.
Creating Documents in Batches

6. When the import is complete, a Batch Import Status dialog box appears.

7. If you want to see a log of the import, select View Log. The batch create log appears in Notepad.

   **Note:** When importing a file from a read-only media or drive, AppXtender places the resultant log and rejection file on the local drive (C:\Temp).

8. If you want to see a list of records that were rejected and the reasons for the rejections, select View Reject Log. The batch import reject log appears in Notepad.

**Fax-in Batch Create**

The Batch Create utility allows you to create a batch by selecting files from a fax server queue. You can select one file or a group of files from the queue.

**Note:** You must select a fax-in server from the drop-down list box on the Fax-in tab of the Configuration dialog box in order to access a fax server queue. For more information, consult your AppXtender system administrator or refer to the "Configuring AppXtender Workstations" section of the ApplicationXtender Installation Guide.

To import a batch of files using the Fax-in Batch Create utility:

1. Make sure that the appropriate application is active. The active application appears in bold in the Application view.

2. Select Fax-in Batch Create from the Utilities menu. If the Login to Fax Server dialog box appears, enter the name of the fax server, your user name, and your password.

![Login to Fax Server Dialog Box](image)
3. If you are using Castelle FAX Press for your Fax In Server, you have the following choices:
   - If you want to import faxes from your personal queue, select the Import from personal queue check box.
   - If you want to import faxes from the unassigned queue, disable the Import from personal queue check box.

   **Note:** The Import from personal queue check box does not appear on the FAX Server Import dialog box if you are using RightFax for your fax-in server.

4. Click Login. The Select Faxes for Batch Import dialog box appears.

![Select Faxes for Batch Import Dialog Box](image)

**Figure 88** Select Faxes for Batch Import Dialog Box

**Note:** If you are using RightFax for your fax-in server, you can customize the way columns display in the Select Faxes for Batch Import dialog box. Customizable options include column title, column order, which columns appear, and the type of faxes that appear. For more information, consult your AppXtender system administrator or refer to the “Configuring AppXtender Workstations” section of the *ApplicationXtender Installation Guide*. 
5. You have the following choices:
   - To import a single file, select the file from the list.
   - To import more than one file when the files are listed sequentially, press and hold down [SHIFT], and select the first and last file in the list so that the desired files are highlighted.
   - To import more than one file when the files are not listed sequentially, press and hold down [CTRL], and select each file.
   - To delete a file from the fax server queue, select the file and click Delete.

6. If you want the selected files to be deleted from the queue after you import them, click the Delete after import check box to select the option.

7. If you are importing a single file, you can copy the index information listed for the file to save data entry when you index the document later. To copy index information, right-click on the file. From the shortcut menu that appears, select Copy.

   **Note:** In order to copy and paste index information, the columns in the FAX Server Import dialog box must have the same labels and appear in the same order as the fields in the Index view once the fax has been imported.

8. You have the following choices:
   - To create a new batch, type a name for the batch in the Batch name text box. A batch name can contain up to 32 characters.
   - To add the selected files to an existing batch, type the name of the batch in the Batch name text box.

   **Note:** You cannot add pages to a batch that is being indexed in AppXtender. If you attempt to add pages to a batch that is being indexed, the batch creation fails.

9. Click Import. A message appears, containing the status of the batch import. This message is displayed until all files of the batch have been imported. Click Cancel at any time to cancel the batch import.
Creating Documents

When the import is complete, a Batch Import Status dialog box appears.

![Batch Import Status Dialog Box](image)

10. If you want to see a log of the import, select View Log. The fax-in batch create log appears in Notepad.

11. If you want to see a list of records that were rejected and the reasons for the rejections, select View Reject Log. The batch import reject log appears in Notepad.

**ApplicationXtender Image Capture**

ApplicationXtender Image Capture, a separate module installed with AppXtender, provides batch scanning functionality, allowing you to scan documents and then index them at a later time. For more information on ApplicationXtender Image Capture, consult your system administrator or refer to the ApplicationXtender Image Capture *User’s Guide*. 
Indexing New Documents

By default, indexing a document in AppXtender involves pure data entry. If you want to increase indexing speed and accuracy, you can use OCR proofing or one of the automated indexing features. For more information, refer to the following topics:

- “OCR Proofing” on page 187
- “Automated Indexing Features” on page 189

If, while you are indexing a document, a message appears indicating that another document already exists with the same unique key value, refer to “Unique Index Validation” on page 197. If a Dual Data Entry dialog box appears, refer to “Dual Data Entry” on page 198.

If you have imported a batch of documents in ApplicationXtender Image Capture, you can index this batch in AppXtender. For more information, refer to “Indexing Batches” on page 200.

If your AppXtender system is configured to use Document Level Security and the %U keyword, keep in mind the following points:

- If the AppXtender system is using the Windows security provider, you must precede the user name in the document index record with a domain and a slash. For example, typing CM\axadmin indicates the “axadmin” user on the “CM” domain.
- If the AppXtender system is using a directory service security provider, you must enter the name in the document index record exactly as it appears in ApplicationXtender Application Generator (AppXtender AppGen).

OCR Proofing

Depending on AppXtender configuration, you can use OCR proofing to index new image documents.

Note: To use this feature, you must have FineReader installed and selected as the AppXtender OCR engine, and you must have AppXtender configured to enable OCR proofing. For information on selecting an OCR engine and on configuring AppXtender to enable OCR proofing, consult your AppXtender system administrator or refer to the “Configuring AppXtender Workstations” section of the ApplicationXtender Installation Guide.
Note: Only Plain Text documents can be indexed using OCR proofing. If Rich Text Format is selected on the OCR tab of the Configuration dialog box, documents processed using OCR cannot be indexed using OCR proofing. For more information, consult your AppXtender system administrator or refer to the "Configuring AppXtender Workstations" section of the ApplicationXtender Installation Guide.

To index a new image document with OCR proofing:

1. If the image document that you want to index has been processed using OCR, make sure that the document is displayed in image view rather than in text view. Use the Show Text button to switch between text view and image view. For information, refer to “Viewing Image Pages” on page 332.


3. Press [F6]. FineReader automatically starts and a status message appears. When FineReader has finished analyzing the unindexed image document, a preview window appears.

4. If necessary, edit the text in the text boxes to accurately reflect the document you are indexing.

   Note: If the document you are indexing had been scanned into AppXtender, you can press [CTRL]+R to rescan the document while FineReader is active.

5. Click AppXtender (the button with an AppXtender icon, inside a small Done window).

6. In AppXtender Index view, click Save.
Automated Indexing Features

ApplicationXtender offers several features that allow you to reduce the amount of time spent performing data entry of index information. Index information from a text file can be used to build a table of index records with either the ApplicationXtender Auto Index Import Wizard (AppXtender Auto Index Import) or the ApplicationXtender Key Reference Import Wizard (AppXtender Key Reference Import) feature. Those records can then be used during document indexing to automatically fill in all or part of a document’s index.

Some of the features require preparation before you can use them. The following table indicates which features require preparation. For information on preparing to use these features, consult your AppXtender system administrator or refer to the "Import Wizards” section of the ApplicationXtender Core Components Administrator’s Guide. The table also indicates which keyboard key implements each feature.

<table>
<thead>
<tr>
<th>Automated Indexing Feature</th>
<th>Previous Preparation Required?</th>
<th>Associated Keyboard Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppXtender Auto Index Import</td>
<td>Yes</td>
<td>[F7]</td>
</tr>
<tr>
<td>ApplicationXtender Key Reference Import Wizard</td>
<td>Yes</td>
<td>[TAB] and [SHIFT]+[F4]</td>
</tr>
<tr>
<td>Append Page</td>
<td>No</td>
<td>[F4]</td>
</tr>
<tr>
<td>Copy Index Info</td>
<td>No</td>
<td>[F4]</td>
</tr>
<tr>
<td>Copy Previous Index Info</td>
<td>No</td>
<td>[F9]</td>
</tr>
<tr>
<td>Cut and Paste</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
Creating Documents

For more information, refer to the following topics:

- "AppXtender Auto Index Import vs. AppXtender Key Reference Import" on page 190
- "Using AppXtender Auto Index Import to Index Documents" on page 191
- "Using AppXtender Key Reference Import to Index Documents" on page 192
- "Appending Pages to Documents" on page 194
- "Copying Existing Index Information" on page 195
- "Copying the Previous Index Information" on page 195
- "Pasting Index Values from an Existing Document" on page 196

You can also configure AppXtender to automatically parse MICRE codes (from checks or other documents) into index records. For information, refer to the online help provided with the ApplicationXtender Software Development Kit.

AppXtender Auto Index Import vs. AppXtender Key Reference Import

With the AppXtender Auto Index Import function, you enter data into an index field and press the [F7] key. The entered data is matched against a record in the AppXtender Auto Index Import table. ApplicationXtender populates all other AppXtender Auto Index Import enabled index fields with data from the record, and deletes that record of data from the AppXtender Auto Index Import table.

The AppXtender Key Reference Import feature operates in a very similar manner. You enter data into one primary – or key – index field and press [TAB]; AppXtender populates all other AppXtender Key Reference Import enabled index fields with the data from the record in the AppXtender Key Reference Import table with that key field value. For example, if the key field is "social security number," then AppXtender could fill in the associated "name" and "birth date" data fields; data entry is required for the key field only. Index records populated from a AppXtender Key Reference Import table are kept in the table even after they are used to index documents. For this reason, AppXtender Key Reference Import can be a useful feature for automatically populating index information that will be used to describe several documents and that may need to be changed frequently.
The AppXtender Auto Index Import feature allows you to access imported index information in order to automatically populate a document’s index. Index information can be imported into an AppXtender Auto Index Import table and then used to index documents whenever a new document is created. When a record of imported index information is used to populate a document’s index, that record is deleted from the AppXtender Auto Index Import table.

**Note:** Before you can use the AppXtender Auto Index Import feature, the AppXtender system administrator must apply the AppXtender Auto Index Import flag to the appropriate index fields and must perform an AppXtender Auto Index Import Import. For information, consult your AppXtender system administrator or refer to the *ApplicationXtender Core Components Administrator’s Guide*.

**Note:** If an AppXtender Auto Index Import table is used to enter a value into an index field, even if that field is flagged for dual data entry, you are not prompted to enter data a second time. For information on importing data into an AppXtender Auto Index Import table, consult your AppXtender system administrator or refer to the *ApplicationXtender Core Components Administrator’s Guide*.

As soon as an AppXtender Auto Index Import has been performed, you can access the imported index information whenever a new document is created. At the time you add a new document, rather than typing in an index value for each index field, you can press the [F7] key to access the index information in the AppXtender Auto Index Import table. Pressing [F7] without filling in any fields in the Index view allows you to choose from all of the imported records of index information. By filling in one or more fields before pressing [F7], you can reduce the number of AppXtender Auto Index Import records retrieved to only those that contain the information entered. If only one record matches the information already entered, AppXtender automatically populates the index with the values from that record.

To use AppXtender Auto Index Import:

1. From the Document menu, select New and then select an input option from the submenu to create a new document. The Document Display view and Index view appear, displaying the document.

2. If desired, enter data in one or more of the index fields.
3. Press [F7]. AppXtender begins a search for AppXtender Auto Index Import records that meet the specified criteria.
   - If only one record matches the criteria, the Index view is automatically populated.
   - If more than one record is retrieved, the AppXtender Result Set dialog box appears, listing the matching index records.

4. If the AppXtender Result Set dialog box appears, you have the following choices.
   - To choose an index record, select the record and click Select.
   - To delete a record from the AppXtender Auto Index Import table, select the record and click Delete.
   - To delete all of the listed records from the AppXtender Auto Index Import table, click Delete All.
   - To exit the AppXtender Result Set without choosing an index record, click Cancel.

   **Note:** The availability of the Delete, Delete All, and Select buttons depends on your workstation configuration. For more information, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

   If you select an index record and click Select, the index information that you select appears in the new document’s Index view.

5. If necessary, make changes to the index information.

6. Click Save.

   The AppXtender Key Reference Import feature also allows you to access imported index information in order to automatically populate a document’s index. Index information can be imported into an AppXtender Key Reference Import table and then used to index documents whenever a new document is created. Records of index information imported into a AppXtender Key Reference Import table are kept in the table after they have been used to index documents.
Note: Before you can use the AppXtender Key Reference Import feature, the AppXtender system administrator must apply the AppXtender Key Reference Import and Data Reference flags to the appropriate index fields and must perform an AppXtender Key Reference Import. For information, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

As soon as an ApplicationXtender Key Reference Import Wizard has been performed, you can access the imported index information whenever a new document is created. At the time you add a new document, rather than typing in a value for each index field, you can type a value into the "key" field in the index, then press [TAB]. AppXtender locates the record that contains that key field value and fills in the data field values for that record.

A "key" field is the field that contains a unique, identifying value in the AppXtender Key Reference Import table. Each record of index information also contains index field values for each field marked as a "data" field. When an AppXtender Key Reference Import is performed, a set of data field values is associated with each key field value. Therefore, when you enter a key value, the associated data values are automatically selected to populate the Index view.

Note: When you enter a key field value that is not contained in the Key Reference table, the data fields for the document will not be automatically populated. However, AppXtender still allows you to index the document and adds the data to the Key Reference table.

To use Key Reference:

1. From the Document menu, select New and then select an input option from the submenu to create a new document. AppXtender displays the Index view.
Creating Documents

2. You have the following choices:
   - Enter a value into the key field of the index. Press [TAB] to populate the data fields in the index with the values corresponding to the key field value. (To find out which field is the key field and which fields are data fields, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.)
   - Enter data in one or more of the index fields, and then press [SHIFT]+[F4] to initiate a search for unused Key Reference records that meet the specified criteria. The AppXtender Result Set appears, listing unused Key Reference records and documents previously indexed with the same values. Select a Key Reference record and click Copy Index. The index information from the Key Reference record that you selected appears in the new document’s Index View.

3. If necessary, edit the values in each data field.

   Note: To move from field to field when indexing with a Key Reference table, consider using arrow keys rather than the [TAB] key. Each time that you press [TAB] from the key field, the data fields are repopulated from the Key Reference table.

Appending Pages to Documents

ApplicationXtender allows you to search for index information from existing documents and append pages to previously indexed documents. The Attach feature allows you to choose an existing document from a result set and add a new page to the existing document.

To append a new page to an existing document:

1. From the Document menu, select New and then select an input option from the submenu to create a new document. AppXtender displays the Index view.

2. Enter data in one or more of the index fields, and then press [F4] to initiate a search for documents that meet the specified criteria. The AppXtender Result Set appears, listing the results.

3. Select the index record and click Attach. The new page is added to the existing document that you selected.
ApplicationXtender allows you to search for index information from existing documents and copy the existing index information to populate the new document’s index. The Copy Index Info feature allows you to choose an existing document from a result set and copy the existing index information to the new document.

To copy index information to a new document:

1. From the Document menu, select New and then select an input option from the submenu to create a new document. AppXtender displays the Index view.

2. Enter data in one or more of the index fields, and then press the [F4] function key to initiate a search for documents that meet the specified criteria.

   The AppXtender Result Set appears, listing the results.

3. Select an index record and click Copy Index. The index information from the existing document that you selected appears in the new document’s Index View.

4. If necessary, make changes to the index information.

5. Click Save.

Copying the Previous Index Information

If you are adding a series of documents to AppXtender and entering similar index information for the whole series, the Copy Previous Index Info feature may help you to save time and avoid mistakes.

To copy the previous index information:

1. Add the first document in the series. Enter index information and click Save.

2. Add the next document in the series. Select one of the index fields and press [F9]. The index fields are populated with the same information as the previously indexed document.

3. If necessary, make changes to the index information.

4. Click Save.

5. Repeat steps 2-4 for each additional document in the series.
You can copy index values from the Index view for an existing document or from a document listed in a fax server queue and then paste the values into the Document Index view for a new document. This feature is generally used with ApplicationXtender Workflow. For information on ApplicationXtender Workflow, refer to the ApplicationXtender Workflow User’s Guide.

To paste index values from an existing document:

1. Copy the index information using one of the following methods:
   - Open the existing document from which you want to copy index values and then right-click in the Index view for that document. From the shortcut menu that appears, select Copy Form.
   - Copy index information from a fax in a fax server queue. For more information, refer to “Adding a Document from the Fax-in Queue” on page 167.

   Note: In order to copy and paste index information, the columns in the FAX Server Import dialog box must have the same labels and appear in the same order as the fields in the Index view once the fax has been imported.

2. Right-click in a Document Index view for the document into which you want to paste the index information. From the shortcut menu that appears, select Paste Form. The index values are pasted in the Values column.

3. If necessary, edit the pasted values.

4. Click Save.
Index Validation

Your AppXtender workstation or your AppXtender application may be configured to prevent some errors in data entry while you are indexing a document. Keep in mind the following points:

- Some index fields may be configured to automatically reformat entered values. For example, if you enter **123456789** into a social security field, the value might be automatically reformatted as **123-45-6789**.

- Some index fields may be configured to reject values that do not conform to a predetermined character pattern. For example, if you enter **abcdefghi** into a social security field, a message appears indicating that the value does not fit the pattern.

- Some index fields may be configured to automatically provide values. For example, the Date Stamp and Time Stamp data types cause the current date or time to be automatically filled in. These are read-only values that you cannot change.

- If you add the pm extension to a time index field, AppXtender helps you to convert the data in the index field to military time without having to know the conversion. For example, when you are indexing a document and enter **1:00:30 pm** in a time index field and click another index field or click Save, the time data is changed to **13:00:30**.

- A set of index fields for an application may be configured to ensure that the combination of values entered into the fields is unique to the application. For more information, refer to “Unique Index Validation” on page 197.

- Some index fields may be configured to prompt you to enter index values twice to ensure data entry accuracy. For more information, refer to “Dual Data Entry” on page 198.

Unique Index Validation

AppXtender provides a feature to ensure that the same index value or combination of index values is not entered for more than one document in an application. One or multiple index fields can be flagged as part of a unique key. This allows for a set of indexes to be unique within an application. If, during document creation, a duplicate index is entered for a particular document, a message box informs you that that index has already been used on a document. You cannot add the duplicate index.
If this message appears while you are indexing a new document, consider appending the new document as a page to the existing document. For instructions, refer to “Appending Pages to Documents” on page 194.

**Note:** This feature does not validate indexes brought into AppXtender using the AppXtender Index Image Import feature.

---

**Dual Data Entry**

When the Dual Data Entry feature is enabled, you must enter an index field’s data twice to confirm the accuracy of the data. If the information entered the second time is exactly the same as the first time, the document is indexed and added to the application. If the information is not entered correctly, a Dual Data Entry Error dialog box appears.

**Note:** If an AppXtender Auto Index Import table is used to enter a value into an index field, even if that field is flagged for dual data entry, you are not prompted to enter data a second time. For information on using an AppXtender Auto Index Import table to enter a value into an index field, refer to “Using AppXtender Auto Index Import to Index Documents” on page 191.

The Dual Data Entry flag and the Enable Dual Data Entry option together form the Dual Data Entry validation feature. Your system administrator can enable the Dual Data Entry flag for an index field using AppXtender AppGen and configure the Enable Dual Data Entry option on the Data tab of the Configuration dialog box. For more information, consult your system administrator or refer to the “Configuring AppXtender Workstations” section of the ApplicationXtender Installation Guide.
The Dual Data Entry Discrepancy dialog box ensures documents are indexed correctly. It appears only when there is a discrepancy between values that have been entered in a field that requires dual data entry.

The First Entry text box contains the first value you entered. The Second Entry text box contains the second value you entered.

To continue indexing:

- You have the following choices:
  - Click Accept 1st Entry to accept the value in the First Entry text box.
  - Click Accept 2nd Entry to accept the value in the Second Entry text box.
  - Click Re-Enter to re-enter the value in the Second Entry text box.

If the information entered the second time is exactly the same as the first time, the document is indexed and added to the application. If the information is not entered correctly, a Dual Data Entry Error dialog box appears.
Indexing Batches

If you have imported a batch of documents from ApplicationXtender Image Capture or from an AppXtender batch utility, you can index this batch in AppXtender. You can perform batch indexing in two ways:

- If you know the name of the batch you want to index, refer to “Batch Indexing a Single Batch” on page 200.
- If you want to select the batch you want to index from a list of batches, refer to “Batch Indexing from a List” on page 202.

Batch Indexing a Single Batch

The following procedure describes how to perform batch indexing if you know the name of the batch you want to index.

Note: This procedure allows you to perform batch indexing on only the batches that have been created for the active application.

To perform batch indexing:

1. Make sure that the appropriate application is active.
2. From the Utilities menu, select Batch Index (Single). The Batch Index (Single) dialog box appears.

![Batch Index (Single) Dialog Box](image)

3. In the Batch Name text box, type the name of the batch that you want to index. Click OK. The Batch Index toolbar appears and the first page of the batch appears in Document Display view. The AppXtender title bar indicates the number of pages in the batch and indicates the number of the currently displayed page.

4. For each document that you want to create from the current batch, use the Previous Page and Next Page buttons on the Batch Index toolbar to navigate to the page that you want to use to create the new document.
5. Click the New Document button on the Batch Index toolbar.

6. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

![Reason Code Required Dialog Box](image1)

**Figure 92** Reason Code Required Dialog Box

7. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

![Signature Properties Dialog Box](image2)

**Figure 93** Signature Properties Dialog Box
8. Index the new document and click Save. All AppXtender indexing features, such as AppXtender Auto Index Import ([F7]), Key Reference ([TAB]), and appending pages ([F4]), are available when you are indexing documents in batches. For details on AppXtender indexing options, refer to “Indexing New Documents” on page 187.

9. Use the Attach Page and Attach All buttons on the Batch Index toolbar to add pages to the most recently indexed document. When all pages in the batch have been added to AppXtender documents, a message appears asking whether you want to index another batch.

10. You have the following choices:
    - If you want to index another batch, click Yes. The Batch Index (Single) dialog box appears.
    - If you do not want to index another batch, click No. The current batch closes.

---

**Batch Indexing from a List**

The following procedure allows you to select a batch from a list.

To open the batch list and index a batch:

1. From the Utilities menu, select Batch Index (List). The Batch Index dialog box appears.

![Batch Index (List) Dialog Box](image)

**Figure 94** Batch Index (List) Dialog Box

2. From the Batches for application drop-down list, select an application. A list of batches appears.
3. From the list of batches, select the batch that you want to index.
4. Click Index. The Batch Index toolbar appears and the first page of the batch appears in Document Display view. The AppXtender title bar indicates the number of pages in the batch and indicates the number of the currently displayed page.

5. For each document that you want to create from the current batch, use the Previous Page and Next Page buttons on the Batch Index toolbar to navigate to the page that you want to use to create the new document.

6. Click the New Document button on the Batch Index toolbar.

7. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

8. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)
Creating Documents

Figure 96  Signature Properties Dialog Box

9. Index the new document and click Save. All AppXtender indexing features, such as AppXtender Auto Index Import ([F7]), Key Reference ([TAB]), and appending pages ([F4]), are available when you are indexing documents in batches. For details on AppXtender indexing options, refer to “Indexing New Documents” on page 187.

10. Use the Attach Page and Attach All buttons to add pages to the most recently indexed document.

When all pages in the batch have been added to AppXtender documents, a message appears asking whether you want to index another batch.

11. You have the following choices:

   • If you want to index another batch, click Yes. The Batch Index (List) dialog box appears.

   • If you do not want to index another batch, click No. The current batch closes.

Note: If a batch is stuck in an error state, you can reset the batch status. To reset the batch status, you must have the AppXtender Administrator privilege associated with your user profile. For more information on resetting a batch, consult your system administrator or refer to the “Managing Existing Application” section of the ApplicationXtender Core Components Administrator’s Guide.

For instructions on adding a memo to a batch, refer to “Adding a Memo to a Batch” on page 205. For instructions on deleting a batch, refer to “Deleting Batches” on page 433.
Adding a Memo to a Batch

To add a memo to a batch:

1. From the Utilities menu, select Batch Index (List). The Batch Index dialog box appears.
2. From the Batches for application drop-down list, select an application. A list of batches appears.
3. From the list of batches, select the batch to which you want to add a memo.
4. Click Memo. The Memo dialog box appears.
5. Type your memo, click Save, and then click Close.
Submitting Documents to a Full-text Queue

AppXtender allows you to submit documents to the AppXtender Index Server, an AppXtender add-on module, for full-text indexing. By adding documents to the AppXtender Index Server, you can expand your queries for AppXtender documents to include keywords contained within the document. For instructions, refer to the following topics:

- “About Submitting Different File Types” on page 207, provides valuable information about submitting bi-tonal images, foreign files, RTF files, and HTML files to the AppXtender Index Server for full-text indexing.
- “Submitting a Displayed Document” on page 207 describes how you can submit a displayed document from the Document menu.
- “Troubleshooting” on page 209 provides a list of items to check if the Submit Full-text Index Job command is not available.

Your workstation may be configured so that new documents are automatically submitted to the AppXtender Index Server for indexing. The Full Text tab of the AppXtender Configuration dialog box allows this configuration. For information, consult your AppXtender system administrator or refer to the “Configuring AppXtender Workstations” section of the ApplicationXtender Installation Guide.

Note: The ProIndex full-text engine cannot process documents of more than 2000 pages. However, the K2 full-text engine can process documents of up to 250,000 pages.
Text documents can be submitted directly to the AppXtender Index Server for indexing. Your AppXtender administrator may have configured the AppXtender system so that other file types can also be submitted directly to the AppXtender Index Server for indexing:

- Color and bi-tonal (gray-scale) images must first be processed using OCR. The resultant text can then be submitted for indexing. For information on OCR, refer to “Document and Page OCR” on page 403.

**Note:** Before you process an image with OCR, make sure that the image is oriented correctly. You may need to rotate the image so that it is not upside-down or sideways. For information on rotating an image, refer to “Using Rotate” on page 324.

Your workstation may be configured so that the AppXtender Index Server automatically uses optical character recognition (OCR) to process any image documents submitted for indexing. The Full Text tab of the AppXtender Configuration dialog box allows this configuration. For information, consult your AppXtender system administrator or refer to the "Configuring AppXtender Workstations” section of the ApplicationXtender Installation Guide.

- Your applications may be configured so that foreign files, RTF files, and HTML files can also be submitted for full-text indexing. If the applications are configured to use the ProIndex full-text engine, the AppXtender Index Server must be configured to convert those file types for full-text indexing. If the applications are configured to use the K2 full-text engine, no conversion is necessary for these file types.

Displayed documents can be submitted to the AppXtender Index Server for full-text indexing from the Document menu. Only the document displayed is processed.

To submit a displayed document to the AppXtender Index Server:

1. Display the document that you want to submit for full-text indexing.
2. From the Document menu, select Submit Full Text Index Job.

   **Note:** If the Submit Full Text Index Job command is not available, refer to “Troubleshooting” on page 209.

   If your workstation is configured to prompt you for queue selection upon submission of full-text index jobs, the Submit Full-Text Index Job dialog box appears. (The Full Text tab of the AppXtender Configuration dialog box allows this configuration. For information, consult your AppXtender system administrator or refer to the “Configuring AppXtender Workstations” section of the *ApplicationXtender Installation Guide.*

   ![Submit Full-text Index Job Dialog Box](image)

   **Figure 98** Submit Full-text Index Job Dialog Box

3. If the Submit Full-Text Index Job dialog box appears, select the appropriate queue, select Convert to text (if necessary) to use OCR to process any color or bi-tonal (gray-scale) pages that are submitted, select a language, and click OK.

   AppXtender submits the job to the configured full-text queue. The AppXtender Index Server processes all of the pages in the displayed document. When the AppXtender Index Server has finished processing the document, a message appears.

4. Click OK to clear the message. You now have the ability to find this document by performing a full-text query that searches for text in this document.
Note: When you index a document’s full text using the AppXtender Index Server, a text view of the document is added to the document. The next time you retrieve the document, the text view of the document is available. For foreign files, RTF files, and HTML files, if the application is using the ProIndex full-text engine, only the first 256 lines of each document page are included in the text view for that page. (Similarly, for PDF files, only one line is included in the text view.) The entire document page is full-text indexed, but only the first 256 lines are returned as a text view.

Troubleshooting

If the Submit Full Text Index Job command on the Document menu is not available, use the following procedure. You may need to contact your system administrator for assistance if you do not have administrator privileges in AppXtender.

To troubleshoot full-text indexing problems:

1. Make sure that a full-text database path has been specified in the AppXtender AppGen for the active application.

   Note: An application cannot be modified in AppXtender AppGen while it is in use in AppXtender.

   For information on specifying a full-text database path, consult your AppXtender system administrator or refer to the "Creating an Application" section of the ApplicationXtender Core Components Administrator's Guide.

   Make sure the user name that you are logged in as has privileges to perform full-text indexing. For information, consult your AppXtender system administrator refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

2. Make sure the AppXtender Index Server is running. For information, consult your AppXtender system administrator or refer to the "Managing the AppXtender Index Server" section of the ApplicationXtender Core Components Administrator's Guide.
3. Make sure a full-text queue has been created and configured properly in the AppXtender Index Server Configuration dialog box and that you have enabled text conversion of the file types you want to submit. For information, consult your AppXtender system administrator or refer to the "AppXtender Index Server" section of the ApplicationXtender Core Components Administrator’s Guide.

4. Make sure the Full Text tab on the AppXtender Configuration dialog box has been configured properly. For information, consult your AppXtender system administrator or refer to the "Configuring AppXtender Workstations" section of the ApplicationXtender Installation Guide.

Note: If you change settings on the Full Text tab, you must restart to allow the change to take effect.
This section explains how to use the two options for scanning paper documents into the ApplicationXtender system: the ApplicationXtender’s integrated scan-and-index online module and ApplicationXtender Image Capture.

- Introduction to Scanning .......................................................... 212
- Selecting a Scanner ................................................................. 214
- Optional Scanning Configurations ........................................... 216
- Scanning Documents ............................................................... 223
- Scanning Pages ........................................................................ 227
- Integrating QuickScan Pro with ApplicationXtender .......... 229
Introduction to Scanning

ApplicationXtender (AppXtender) provides two options for scanning paper documents into the AppXtender system:

- ApplicationXtender’s integrated scan-and-index online module allows you to scan and index documents in an interactive mode. Documents are scanned and indexed at the same time. For information on this module, continue reading this topic.

- ApplicationXtender Image Capture (AppXtender Image Capture), a separate module, provides batch scanning functionality, allowing you to scan documents and then index them at a later time. For more information on AppXtender Image Capture, refer to the ApplicationXtender Image Capture User’s Guide.

Note: AppXtender can display multiple unindexed documents simultaneously, allowing you to add pages from the scanner to each unindexed document as necessary. However, a displayed document is not saved to AppXtender until you index it and click Save.

AppXtender supports several different scanners and scanner interfaces. During AppXtender setup, you can choose a Scanning workstation type to install the appropriate scanner support files. After installation, you install the necessary scanner driver and then select the scanner from the AppXtender Select Scanner dialog box. For a complete list of scanners that AppXtender supports, refer to “Selecting a Scanner” on page 214.

You can customize several scanner properties to produce the desired scanning results. DPI settings, scanner feeder settings, auto rotation, auto image enhancement, brightness, dither, and other settings can be configured. Advanced settings available for each scanner are driver-specific and change from scanner to scanner. The Scanner Settings dialog box for scanners provides different, configurable parameters.
This section provides details on scanner setup, settings and procedures using the AppXtender scan-and-index online module.

- “Selecting a Scanner” on page 214
- “Optional Scanning Configurations” on page 216
- “Scanning Documents” on page 223
- “Scanning Pages” on page 227
Selecting a Scanner

Refer to the ApplicationXtender Release Notes for information on supported scanner drivers.

AppXtender installs scanner support files during the ApplicationXtender Desktop installation. For more information on installing scanner support files, consult your system administrator or refer to the "Installing ApplicationXtender" section of the ApplicationXtender Installation Guide.

The manufacturer's recommended scanner driver must also be installed on your workstation in order to scan. For more information, consult your system administrator or refer to the "Planning Your ApplicationXtender Installation" section of the ApplicationXtender Installation Guide.

Before you can begin scanning, however, the scan workstation must have the correct scanner type selected.

To select a scanner for your workstation:

1. Install and load the appropriate scanner driver on the scan workstation. For information, consult your AppXtender system administrator or refer to the "Planning Your ApplicationXtender Installation" section of the ApplicationXtender Installation Guide.

2. From the Scan menu, select Configuration and then Select Scanner. The Select Scanner dialog box appears.

![Select Scanner Dialog Box](image)
Note: If your scanner does not appear in the Select Scanner list, make sure that the scan workstation type was selected when AppXtender was installed, and that the appropriate scanner driver has been installed. For information, consult your AppXtender system administrator or refer to the "Planning Your ApplicationXtender Installation" section of the ApplicationXtender Installation Guide.

Note: If both AppXtender and AppXtender Image Capture are running at the same time on the same workstation, only one can use a scanner driver at a time. If you are using a particular scanner driver for AppXtender Image Capture, you cannot use that scanner driver for AppXtender until you close AppXtender Image Capture or select a different scanner driver in AppXtender Image Capture.

3. Select your scanner from the list, and click OK. Depending on the scanner, another dialog box might appear, allowing you to further configure the scanner driver. For instructions, refer to the documentation for your scanner.
Optional Scanning Configurations

You can configure several scanner properties to produce the scanning results that you want. The following topics describe how to configure each aspect of scanning:

- “Scan Feeder Options” on page 217
- “Automatic Enhancement” on page 218
- “Auto OCR” on page 218
- “Resolution Settings” on page 219
- “Mode Settings” on page 219
- “Page Size Settings” on page 220
- “Source Setting” on page 220
- “Auto Rotation” on page 221
- “Scanner Driver Configuration” on page 221

You can use either the Scan menu or the Scan toolbar to perform each of these configurations. For information on the Scan toolbar buttons, refer to “AppXtender Document Manager Toolbars” on page 74. For information on hiding or customizing the Scan toolbar, refer to “Configuring Toolbars, Title Bar, and Status Bar” on page 90.
AppXtender provides three different options for operating the scanner feeder: single feed, manual feed, and automatic feed. These options are mutually exclusive; only one of the options can be activated.

### Automatic Feed

In automatic feed mode, AppXtender scans all of the pages in the feeder. When the feeder is empty, the scan session ends. After all of the pages in the feeder have been scanned, if you put more pages in the feeder, you must click the Scan button again to scan the new pages.

**Note:** The Synchronized Scan option in the Configuration dialog box allows you to slow down automatic feed and view each page as it is scanned. For information on configuring synchronized scan, refer to “Synchronized Scan” on page 123.

To enable auto feed:

- From the Scan menu, select Feed and then Auto.

### Manual Feed

In manual feed mode, AppXtender scans all of the pages in the feeder, then waits for you to add more pages before the scan session times out. After the time runs out, if you put more pages in the feeder, you must click the Scan button again to scan the new pages.

The time-out is configurable, and is set in the AppXtender Configuration dialog box. The default is 20 seconds. For information on configuring the Scanner Manual Feed Timeout, refer to “Scanner Manual Feed Timeout” on page 123.

**Note:** The Synchronized Scan option in the Configuration dialog box allows you to slow down manual feed and view each page as it is scanned. For information on configuring synchronized scan, refer to “Synchronized Scan” on page 123.

To enable manual feed:

- From the Scan menu, select Feed and then Manual.

### Single Feed

In single feed mode, AppXtender scans only one page at a time. After each page is scanned, you must click the Scan button again to scan the next page.

To enable single feed mode:

- From the Scan menu, select Feed and then Single.
Auto Enhancement is a licensed feature that allows you to automatically enhance pages as they are scanned. If the pages will be processed using optical character recognition (OCR), this feature makes the OCR more accurate. Automatic enhancement applies all settings configured in the ScanFix Configuration dialog box and the ScanFix Advanced Settings dialog box. Auto enhancement applies to bi-tonal (black and white) images only. Refer to “Enabling Image Processing Options” on page 121 for information on configuring Document Manager for image processing.

To configure auto enhancement:

- From the Scan menu, select Configuration and then Auto Enhancement. The auto enhancement feature toggles on or off.

Enhancement Settings

When the licensed auto enhancement feature is enabled, all bi-tonal images added to AppXtender are enhanced using the configured enhancement settings. The effectiveness of this feature for improving OCR processing of scanned images in AppXtender depends entirely on how you configure image enhancement settings. Refer to “Enabling Image Processing Options” on page 121 for information on configuring Document Manager for image processing.

To configure image enhancement settings:

- From the Scan menu, select Configuration and then Enhancement Configuration.

The ScanFix Configuration dialog box appears. You may configure the settings to produce the desired results. For details on image enhancement settings, refer to “Configuring Image Enhancement” on page 542.

Auto OCR

AppXtender allows you to automatically process color and bi-tonal (black and white) pages using optical character recognition (OCR) as they are scanned. The Auto OCR feature automatically uses OCR to process all documents as they are scanned.

You can also manually process documents and pages using OCR. For more information, refer to “Document and Page OCR” on page 403.

Note: Make sure that the image is oriented correctly when you scan it to ensure accurate OCR results. Setting the scanner at 300 DPI provides the most accurate results.
To configure Auto OCR:

- From the Scan menu, select Configuration and then Auto OCR.

The Auto OCR feature toggles on or off. If you enable Auto OCR and scan an image, AppXtender displays the page in text view. You can use the Show Text button to switch between the text view and the image view of this page. For information, refer to “Viewing Image Pages” on page 332.

**Resolution Settings**

The Resolution drop-down list is located on the scan toolbar and can be used to change the dots per inch (DPI) resolution setting. The DPI options available to you will vary depending on your scanner. Higher DPI settings produce larger file sizes, however higher settings also produce greater image clarity. A recommended setting is 200 DPI. If you require higher quality, you can select another option.

To configure resolution settings:

- From the Scan menu, select Resolution and then the DPI setting that you want to use.

**Mode Settings**

The Mode drop-down list is located on the Scan toolbar and can be used to change the scanning mode. Some scanning mode examples are bi-tonal, 16-Level Gray, 256-Level Gray, and 24-Bit Color, and vary depending on your scanner. When selecting a scanner mode, remember that the 256-Level Gray option will roughly double the size of your file, while increasing clarity of the scanned page. The recommended setting for efficient scanning is bi-tonal.

**Table 24 Example File Sizes When Using Different Modes for Same Image**

<table>
<thead>
<tr>
<th>Mode</th>
<th>File Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bi-tonal</td>
<td>12 KB</td>
</tr>
<tr>
<td>256-Level Gray</td>
<td>3,367 KB</td>
</tr>
<tr>
<td>24-Bit Color</td>
<td>10,040 KB</td>
</tr>
</tbody>
</table>

To configure mode settings:

- From the Scan menu, select Mode and then the mode setting you want to use.
Scanning

Page Size Settings

The Page Size drop-down list is located on the Scan toolbar and can be used to change the page size and orientation. The Page Size option sets the size of the page that you are scanning. The options listed for you vary depending on your scanner. Some page size examples are Legal, Letter, and B5.

To configure page size settings:

◆ From the Scan menu, select Page Size, the size, and if available, the orientation you want to use.

If you scan a page that is larger than the current page size setting, part of the image does not get scanned. If you scan a page that is smaller than the current page size setting, black areas are added to the edges of the scanned image, which means that the file size is larger than it needs to be.

Source Setting

The Source drop-down list allows you to choose a scanner source. Options available for you may include Flatbed, ADF Simplex and ADF Duplex, although the options vary depending on your scanner. The following table demonstrates the typical source settings and what they mean:

Table 25 Typical Source Settings

<table>
<thead>
<tr>
<th>Source Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flatbed</td>
<td>Flatbed refers to using the scanner's top paper bed, similar to a copy machine.</td>
</tr>
<tr>
<td>ADF Simplex</td>
<td>Automatic Document Feeder (ADF) Simplex refers to using the automatic document feeder to scan only the front side of the document.</td>
</tr>
<tr>
<td>ADF Duplex</td>
<td>ADF Duplex refers to using the automatic document feeder to scan both sides of the document.</td>
</tr>
</tbody>
</table>

To configure source settings:

◆ From the Scan menu, select Source and then the source you want to use.
Optional Scanning Configurations

Auto Rotation

AppXtender allows you to automatically rotate pages as they are being scanned. If you have configured your source as duplex, separate options are provided to set the rotation of front and back pages being scanned. If you have configured your source as something other than duplex, you only need to configure the front page rotation.

Rotation can be set to 90, 180 and 270 degrees. When you click the Front Rotation and Back Rotation buttons on the Scan toolbar, the setting toggles from None to 90 Degrees, to 180 Degrees, to 270 Degrees.

Front Rotation Button and Back Rotation Button

Front Page Rotation

To configure automatic rotation for all front pages:

- From the Scan menu, select Rotation (Front) and then the desired rotation setting (None, 90 Degrees, 180 Degrees, or 270 Degrees).

Back Page Rotation

To configure automatic rotation for all back pages:

- From the Scan menu, select Rotation (Back) and then the desired rotation setting (None, 90 Degrees, 180 Degrees, or 270 Degrees).

Note: You do not need to configure Back Rotation if your scanner is not a duplex scanner.

Scanner Driver Configuration

The Scanner Settings dialog box provides advanced features that relate to your scanner. The options vary depending on the scanner that you are using. Some examples of settings that may be included are brightness, dither, and contrast.

To access your scanner’s advanced settings:

- From the Scan menu, select Configuration and then Driver Configuration.
The Scanner Settings dialog box for your scanner appears. The options and buttons that appear on the Scanner Settings dialog box vary according to the scanner. For more information on configuring this dialog box, refer to the documentation provided with your scanner.

![Sample Scanner Settings Dialog Box](image)

Figure 101   Sample Scanner Settings Dialog Box

Any changes made in this dialog box are reflected in the Scan toolbar. Additionally, any settings you change remain as the scanner settings until you change them.
This topic provides steps for scanning documents into AppXtender. Refer to the ApplicationXtender Release Notes for information on supported scanner drivers.

Note: To use the Scan input method to add documents to either the _RSTAMP or _FORMS application, you must access the New Document command using the right-click/shortcut menu method (described in the following procedure).

To scan a document into AppXtender:

1. Select the appropriate settings on the Scan toolbar, the Scan menu, or the Scan tab of the Configuration dialog box.

   You can customize several scanner properties to produce the desired scanning results. DPI settings, scanner feeder settings, automatic rotation, automatic image enhancement, brightness, dither, and other settings can be configured. Advanced settings available for each scanner are driver-specific and change from scanner to scanner. The Scanner Settings dialog box allows you to set additional parameters. For instructions, refer to “Optional Scanning Configurations” on page 216.

   The following configurable options may also affect the scanning process:

   - The Remove Blank Pages option discards pages from the scanning process that do not meet the threshold you choose on the sliding Threshold bar.
   - The Synchronized Scan option allows you to slow down manual and automatic feed and view each page as it is scanned.

   These options can be set on the Scan tab in the Configuration dialog box. For more information, refer to “Scan Tab” on page 121.

2. Close any currently displayed documents.
3. Prepare the paper documents for scanning. Document preparation requirements depend on the standards set for your company. Consult your AppXtender system administrator for guidelines. Some document preparation suggestions include:
   - Remove sticky notes, paper clips, and staples (if appropriate).
   - Make sure the documents are stacked with the correct orientation.
   - If you are using an automatic document feeder, make sure the pages to be scanned are in good enough condition to run through the feeder.

4. Feed to your scanner the paper that you want to scan.

5. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Scan. AppXtender scans the document.

6. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

7. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)
The document appears in the Document Display view.

**Note:** While pages are being scanned, a Cancel button appears on the AppXtender status bar. Click the Cancel button at any time to stop scanning. Also, 30 seconds after each image has been fully scanned, it is automatically saved as a BIN file to the document write path for the application.

8. If necessary, you can rescan the page just scanned. Make sure the page is displayed in the Document Display view.

**CAUTION**

The Rescan feature will not replace the most recently scanned page if the page is not displayed in the Document Display view or if 30 seconds have passed since the image was scanned. To replace pages after the document has been saved, select the Replace option from the Page menu. For more details refer to “Replacing Pages” on page 367.

From the Scan menu, select Rescan.

9. Enter the appropriate index data for this document in the Index view.
The index information can be entered for the document at any time. You can enter it after the first page is scanned or the last.

10. Click Save.
Scanning Pages

Additional pages can be added from any scanner certified for use with AppXtender. The following topics describe the addition of a single page by scanner. Scanned pages can be inserted before or after a displayed page, or appended to the end of a document.

- “Inserting a Scanned Page before the Current Page” on page 227
- “Inserting a Scanned Page after the Current Page” on page 228
- “Appending a Scanned Page to a Document” on page 228

**Note:** The following configurable options may affect the scanning process:

- The Remove Blank Pages option discards pages from the scanning process that do not meet the threshold you choose on the sliding Threshold bar.
- The Synchronized Scan option allows you to slow down manual and automatic feed and view each page as it is scanned.

These options can be set on the Scan tab in the Configuration dialog box. For more information, refer to “Scan Tab” on page 121.

### Inserting a Scanned Page before the Current Page

You can scan a new page into a document and add it as the previous page in the document (before the currently displayed page).

**Note:** The number of pages inserted depends on the current feed mode and the number of pages in the scanner. For information on feed modes, refer to “Scan Feeder Options” on page 217.

To add a page before the current page by scanning:

1. Make sure that the appropriate document is currently displayed. For instructions, refer to “Displaying AppXtender Documents” on page 276.
2. From the Page menu, select New and then Scan. From the shortcut menu that appears, select Insert Before. AppXtender automatically scans the page and it appears as a new page in the Document Display view.
Inserting a Scanned Page after the Current Page

You can scan a new page into a document and add it as the next page in the document (after the currently displayed page).

Note: The number of pages inserted depends on the current feed mode and the number of pages in the scanner. For information on feed modes, refer to “Scan Feeder Options” on page 217.

To add a page after the current page by scanning:

1. Make sure that the appropriate document is currently displayed. For instructions, refer to “Displaying AppXtender Documents” on page 276.

2. From the Page menu, select New and then Scan. From the shortcut menu that appears, select Insert After. AppXtender automatically scans the page and it appears as a new page in the Document Display view.

Appending a Scanned Page to a Document

You can scan a new page into a document and add it as the last page in the currently displayed document.

Note: The number of pages appended depends on the current feed mode and the number of pages in the scanner. For information on feed modes, refer to “Scan Feeder Options” on page 217.

To add a page to the end of the current document by scanning:

1. Make sure that the appropriate document is currently displayed.

2. From the Scan menu, select Scan Page. AppXtender automatically scans the page and it appears as a new page in the Document Display view.
Integrating QuickScan Pro with ApplicationXtender

Document Manager allows you to create profiles that are stored in QuickScan Pro. QuickScan Pro uses the profiles to export documents to applications in ApplicationXtender. For more information, refer to:

- “Creating QuickScan Pro Export Profiles in Document Manager” on page 229
- “Exporting QuickScan Pro Documents to ApplicationXtender” on page 230
- “Creating Profiles in QuickScan Pro” on page 232

For information on installing and using QuickScan Pro, refer to QuickScan Pro online help and the following documentation: QuickScan Pro Release Notes, QuickScan Pro Quick Start Guide, QuickScan Pro Overview, and QuickScan Pro Exporter Software Development Kit.

Note: You need to have one QuickScan Pro license per installation of AppXtender Desktop.

Creating QuickScan Pro Export Profiles in Document Manager

To create QuickScan Pro export profiles in Document Manager:

1. Select File > Export QSP Indexer from the Document Manager menu bar. Document Manager displays the Select Applications dialog box.
2. Select the ApplicationXtender target application. QuickScan Pro will export documents to the selected application.

3. Type a profile name.

4. Click OK. ApplicationXtender creates an export profile and an index profile that are stored in QuickScan Pro.

Refer to QuickScan Pro documentation for information on how to create export profiles and index profiles in QuickScan Pro.

To export documents from QuickScan Pro to ApplicationXtender:

1. Open the document in QuickScan Pro.

2. Select File > Index from the QuickScan Pro menu bar. QuickScan Pro displays the Index dialog box.
Integrating QuickScan Pro with ApplicationXtender

3. Select the index profile that was created in Document Manager. Refer to “Creating QuickScan Pro Export Profiles in Document Manager” on page 229 for more information.

4. Click Index. QuickScan Pro displays the Index pane, which lists the index fields for the ApplicationXtender target application.

5. Index the document. Refer to QuickScan Pro documentation for more information on indexing documents.

6. Select File > Export from the QuickScan Pro menu bar. QuickScan Pro displays the Export dialog box.

Figure 106  QuickScan Pro Index Dialog Box
Creating Profiles in QuickScan Pro

The ApplicationXtender Exporter Wizard allows you to configure an export profile that was created in QuickScan Pro. For more information, refer to:

◆ “Creating a Profile for Single-Document Processing” on page 232
◆ “Creating a Profile for Batch Processing” on page 237

Creating a Profile for Single-Document Processing

To create a profile for single-document processing:

1. Open the QuickScan Pro application.
2. Select File > Export from the QuickScan Pro menu bar. QuickScan Pro displays the Export dialog box.
3. Select New exporter configuration.
4. Click Add. The Select an Exporter dialog box appears.
5. Select EMC ApplicationXtender Exporter.
6. Click OK. QuickScan Pro displays the Export Profile Editor.
7. Select the Configuration tab. The ApplicationXtender Exporter Wizard appears.

8. Select the ApplicationXtender data source that contains the target ApplicationXtender application.

9. Click Next.

10. Type your ApplicationXtender user name and password.
11. Click Next. The Setup Options page of the ApplicationXtender Exporter Wizard appears.

13. Select single-document processing options. The following table describes the options.

Table 26 Single-Document Processing Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integrate with AppXtender Workflow</td>
<td>Enables you to export QuickScan Pro documents to an ApplicationXtender Workflow content management system.</td>
</tr>
<tr>
<td>Merging Options</td>
<td></td>
</tr>
<tr>
<td>Merge With Existing Documents</td>
<td>Appends the existing ApplicationXtender document with the pages exported from QuickScan Pro if the ApplicationXtender document has the same index fields defined in the profile.</td>
</tr>
<tr>
<td>Ignore 'Unique Key' fields restriction</td>
<td>Enabling the Ignore 'Unique Key' fields restriction and Merge With Existing Documents options allows the Exporter Wizard to override the Part of Unique Key field in AppGen, if it is enabled for any of the fields in the target ApplicationXtender application.</td>
</tr>
<tr>
<td>Full-Text Processing Queue</td>
<td>Sends the pages exported from QuickScan Pro to the selected ApplicationXtender full-text engine.</td>
</tr>
<tr>
<td>OCR Settings</td>
<td>Specifies the ApplicationXtender version number for OCR documents exported from QuickScan Pro. To save the OCR documents as the first version of the ApplicationXtender document, select Version 1. To save the OCR documents as the second version of the ApplicationXtender document, select Version 2.</td>
</tr>
</tbody>
</table>

14. Click Next.

Continue with step 15 if you selected Integrate with AppXtender Workflow.

Skip to step 17 if you did not select Integrate with AppXtender Workflow.
15. Specify Workflow login information:
   - To log in to AppXtender Workflow with your AppXtender user name and password, select Same Login As AppXtender. Type your database server and database name.
   - To log in to AppXtender Workflow with different login information, select Different Login Than AppXtender. Type your Workflow user name, password, database server, and database name.

16. Click Next.

17. Map QuickScan Pro index fields to ApplicationXtender index fields:
   a. Select the QuickScan Pro index profile from the QuickScan Pro Indexer list box.
   b. Select the target ApplicationXtender application from the ApplicationXtender Application list box.
   c. Select an index field from the Indexer Fields window.
   d. Select the corresponding ApplicationXtender index field from the Application Fields window.
   e. Click Add. The wizard adds the mapped index fields to the Links section of the wizard dialog box.
   f. Repeat steps a through e to map additional index fields.

Figure 110 Mapping Index Fields for Single-Document Processing
18. Click Finish. QuickScan Pro displays a profile summary on the Export Profile Editor dialog box. Refer to QuickScan Pro documentation for procedures on exporting documents.

Creating a Profile for Batch Processing

To create a profile for batch processing:

1. Open the QuickScan Pro application.
2. Select File > Export from the QuickScan Pro menu bar. QuickScan Pro displays the Export dialog box.
3. Select New exporter configuration.
4. Click Add. The Select an Exporter dialog box appears.
5. Select EMC ApplicationXtender Exporter.
6. Click OK. QuickScan Pro displays the Export Profile Editor.
7. Select the Configuration tab. The ApplicationXtender Exporter Wizard appears.

![ApplicationXtender Exporter Wizard - Select Data Source](image)

Figure 112 ApplicationXtender Exporter Wizard

8. Select the ApplicationXtender data source that contains the target ApplicationXtender application.

9. Click Next.

10. Type your ApplicationXtender user name and password.

11. Click Next. The Setup Options page of the ApplicationXtender Exporter Wizard appears.

13. Click Next. The Setup Field Links page of the ApplicationXtender Exporter Wizard appears.

14. Map QuickScan Pro index fields to an ApplicationXtender batch:
   a. Select an index field from the Indexer Fields window.
   b. Select the target ApplicationXtender application from the ApplicationXtender Application list box.
   c. Select Batch Name from the Application Fields window.
   d. Click Add. The wizard adds the mapped batch to the Links section of the wizard dialog box.
   e. To include a batch memo, select a remaining index value from the Indexer Fields window, select Batch Memo from the Application Fields window, and then click Add.
15. Click Finish. QuickScan Pro displays a profile summary on the Export Profile Editor dialog box.
Figure 115  **Export Profile Summary - Batch**

Refer to QuickScan Pro documentation for procedures on exporting batches.

Refer to “Indexing Batches” on page 200 for procedures on how to index the batch.
This section describes how to perform a search and retrieve a document in ApplicationXtender.

- Introduction to Document Retrieval ............................................. 244
- What is a Query? .............................................................................. 246
- Searching a Single Application ...................................................... 248
- Searching Multiple Applications ................................................... 265
- Displaying Documents from the Result Set ................................. 275
- Document Text Searches ................................................................. 298
- Managing Queries............................................................................ 303
Introduction to Document Retrieval

Because index information is attached to each document when it is stored using ApplicationXtender (AppXtender), documents can be retrieved by searching for information contained in the index. By requiring index information for every document, AppXtender ensures that a document can be retrieved quickly and easily. ApplicationXtender provides search capabilities that are both flexible and powerful. The following topics describe these capabilities:

- "What is a Query?" on page 246 defines and explains the AppXtender concept of a query.
- "Searching a Single Application" on page 248 describes how to retrieve documents using many of the AppXtender search capabilities such as basic queries, wildcard queries, expression range queries, list of values queries, ODMA attributes searching, compound queries, and full-text searching. If the optional Centera retention for AppXtender licensed feature is installed and enabled for the application, and you have the appropriate privileges, you can also search for documents that are under Centera retention or retention hold.

The AppXtender Index Server, an AppXtender add-on module, provides AppXtender with full-text indexing capabilities for text and image documents. Text documents can be submitted directly to the AppXtender Index Server for indexing. Image documents can be submitted to the AppXtender Index Server, which can process the document using optical character recognition (OCR) and index the resultant text. AppXtender offers you a wide range of options for performing full-text (or keyword) searches on indexed document pages.

- "Searching Multiple Applications" on page 265 describes how to create and run queries that search multiple AppXtender applications for selected index and/or full-text information.
- "Displaying Documents from the Result Set" on page 275 describes many of the options that may be available to you when you display a document from the result set (the list of results of your searches for documents). This topic describes checking in and checking out documents, displaying ApplicationXtender Reports Management (AppXtender Reports Mgmt) reports, and viewing full-text search results.
When you retrieve a document, AppXtender provides immediate access to a wide variety of other functions such as display, print, fax, delete, and save. These capabilities are available for one document or a selected range of documents. For information, refer to Chapter 7, “Managing Documents”.

For information on configuring the query result set, refer to “Managing the Query View Result Set” on page 104.

- “Document Text Searches” on page 298 describes how to search for strings of text in text documents.
- “Managing Queries” on page 303 describes how to save, run, edit, rename, and delete queries. This topic also describes how to make saved queries private or public.
What is a Query?

A query is a search that you use to retrieve stored documents in AppXtender. ApplicationXtender allows you to search one application at a time or search across multiple applications at once.

You perform a query in the Query view. The Query view has one or more tabs, starting with the Search tab.

![New Query Search Tab](image)

The Query view Search tab has two parts:

- The top part allows you to perform queries based on the information stored in the document index fields. This is considered a query by index. For more information, refer to “Entering Index Values as Search Criteria” on page 250.

- The bottom part allows you to perform queries based on the text within the documents. This is considered a full-text query. For more information, refer to “Entering Full-Text Values as Search Criteria” on page 260.
If the optional Centera retention for AppXtender licensed feature is installed and enabled for the application, and you have the Retention User privilege, the bottom part also displays a Retention Options section that allows you to search for documents under Centera retention or retention hold. For more information, refer to “Working with Centera Retention” on page 583.

You can also perform queries based on both the index information and the full-text information. For more information, refer to “Combination (Index and Full-Text) Queries” on page 264.

If you want to perform queries that search across multiple applications, refer to “Searching Multiple Applications” on page 265.
Searching a Single Application

You can create a new query to search for documents or AppXtender Reports Mgmt reports in one application.

To create a new query:

1. You have the following choices:
   - Right-click the name of the application you want to query in the Application view. From the shortcut menu that appears, select New Query.
   - To query for an AppXtender Reports Mgmt generated report only, right-click the name of the application you want to query in the Application view. From the shortcut menu that appears, select Reports. (This option is only available if you have the Report View privilege.)

   The Search tab of the Query view appears.

   Figure 117  New Query Search Tab

2. Enter search criteria for the query to locate the documents you want to retrieve. To perform the simplest type of query, enter index values in the Values column.
For more information on entering criteria for more advanced searches, refer to the following topics:

- “Entering Index Values as Search Criteria” on page 250
- “Entering Full-Text Values as Search Criteria” on page 260
- “Combination (Index and Full-Text) Queries” on page 264

3. To filter query results for documents that have been filed for Centera retention, select one of the following options from the Show list box in the Query Options section of the tab:

- All documents excluding documents on retention
- Only documents on retention
- Only documents on retention hold
- Only documents on retention not on retention hold

**Note:** Retention options do not appear in the list box if the application is not configured for Centera retention.

Refer to “Working with Centera Retention for ApplicationXtender” on page 375 for more information.

4. Click Search.

A Result Set tab appears in the Query view containing the documents or AppXtender Reports Mgmt reports that meet the search criteria.

- If no documents or AppXtender Reports Mgmt reports are found meeting the specified search criteria, a No documents found message appears.

- If one match is found, AppXtender displays that document. You may be prompted to check out the document or open it in read-only mode.

As soon as you have opened the document, if you performed a full-text search, the Full Text Search Results dialog box appears. For information, refer to “Viewing Full-Text Search Results” on page 293.

- If more than one match is found, the Result Set tab appears, allowing you to select a document for processing. The Result Set tab also appears when querying for AppXtender Reports Mgmt reports, regardless of whether one or many reports are found.
Entering Index Values as Search Criteria

AppXtender provides flexible options for searching for documents by index values. Exact index information can be entered as search criteria, or lists of values and ranges can be entered. When queries are executed, a Result Set tab appears listing document index records that met the search criteria you entered. If only one document met the criteria, AppXtender automatically displays it.

“Query by Index” on page 251, describes entering single index values in the index field Values column in the Search tab. There are several ways you can insert more complicated index value search criteria. Insertion of advanced index value search criteria is described in the following topics:

- “Pasting Index Values from the Document Index View” on page 251
- “Wildcard Query” on page 251
- “Expression Range Query” on page 253
- “List of Values Query” on page 255
- “Searching by ODMA Attributes” on page 257
- “Compound Queries” on page 258

For more information, refer to:

- “Displaying Documents from the Result Set”
- “Displaying AppXtender Reports Mgmt Reports”
- “Saving a Query”
Query by Index

The simplest form of query is an index value search. You can enter index values by typing the values in the Values column of the Search tab.

To enter index values:

- Under Values, next to any or all of the field names, enter the index information that you want to search for. You can type in an index value for some or all of the fields.

**Note:** If you want more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to “Displaying Documents from the Result Set” on page 275.

Pasting Index Values from the Document Index View

If you have a document displayed, you can copy index values from the Document Index view and paste them into the Query view Search tab. This feature allows you to find documents related to the displayed document. This feature is generally used with ApplicationXtender Workflow (AppXtender Workflow). For information on AppXtender Workflow, refer to the ApplicationXtender Workflow User’s Guide.

To paste index values from the Document Index view:

1. Right-click in the Document Index view. From the shortcut menu that appears, select Copy Form.
2. Right-click in a gray area of the Query view Search tab. From the shortcut menu that appears, select Paste Form. The index values from the displayed document are pasted in the Values column.
3. If necessary, edit the pasted values.

Wildcard Query

The asterisk (*) is a wildcard that matches any character or number of characters. A wildcard performs beginning with, ending with, and pattern searches. For example, MA* finds all the names beginning with the letters MA. The wildcard character can be used to narrow a search, controlling the number of documents returned in the Result Set tab.
To use a wildcard in an index value:

- Under Values, next to any or all of the field names, enter the index information that you want to search for, using the wildcard character to represent part of the index value.

**Note:** If you want more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to “Displaying Documents from the Result Set” on page 275.

**Note:** Wildcards are valid for index fields with the data types Text, Time Stamp, SSN, Telephone, Zip Code, Boolean Choice, and User-defined List. Search expressions, such as an expression range or a list of values, should be used for all other data types. For information on performing searches with an expression range, refer to “Expression Range Query” on page 253. For information on performing searches with a list of values, refer to “List of Values Query” on page 255. For information on the types of index fields in your AppXtender application, consult your AppXtender system administrator or refer to the “Creating an Application” section of the ApplicationXtender Core Components Administrator’s Guide.

The following table shows how the wildcard character works.

<table>
<thead>
<tr>
<th>Search Specifications</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMITH</td>
<td>Returns all documents with a Name of SMITH.</td>
</tr>
<tr>
<td>SM*</td>
<td>Returns all documents with a Name that begins with the characters SM.</td>
</tr>
<tr>
<td>*ITH</td>
<td>Returns all documents with a Name that ends with the characters ITH.</td>
</tr>
<tr>
<td>S*H</td>
<td>Returns all documents with a Name that begins with the character S and ends with the character H.</td>
</tr>
<tr>
<td><em>ITH</em></td>
<td>Returns all documents with a Name that contains the character pattern ITH.</td>
</tr>
</tbody>
</table>

**CAUTION**

Avoid the following search strategies:

- Specifying the wildcard character by itself in a field
- Performing a search when all fields are left blank
Both of these approaches result in a search on all documents and negatively impact system performance on multi-user, networked systems.

You can also find documents by entering a range of possibilities for each index field using the Search Expression dialog box. This feature gives you more options for narrowing your search within an index field.

**Note:** Expression range queries cannot be performed on fields with the Boolean Choice or User-defined List data types.

To insert a search expression as search criteria:

1. Select the index field you want to query. Press the [F8] key. The Search Expression dialog box appears. AppXtender displays the name of the field you are searching in the dialog box's title bar.

2. Designate the type of search you want to perform by selecting an option from the Type of Comparison drop-down list. Available options are Between, Greater than, Greater than or equal, Less than, Less than or equal, or Not equal to.

3. In the Value text box, enter the appropriate Search Expression values. If you selected the Between type of comparison, also enter a value in the And text box.

4. Click OK. AppXtender adds the expression you created in the Search tab.
Retrieving Documents

Figure 120 Search with Expression

Note: If you want more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to “Displaying Documents from the Result Set” on page 275.

The following table provides an example of each type of comparison.

Table 28 Examples of Search Expressions

<table>
<thead>
<tr>
<th>Comparison</th>
<th>Example</th>
<th>AppXtender Finds Documents With</th>
</tr>
</thead>
<tbody>
<tr>
<td>Between [ ]</td>
<td>Expression: ['925279','925308']</td>
<td>Account numbers from 925279 through 925308</td>
</tr>
<tr>
<td>Greater than &gt;</td>
<td>Expression: &gt; 925279</td>
<td>Account numbers greater than 925279</td>
</tr>
<tr>
<td>Greater than or equal &gt;=</td>
<td>Expression: &gt;= 925279</td>
<td>Account numbers greater than or equal to 925279</td>
</tr>
<tr>
<td>Less than &lt;</td>
<td>Expression: &lt; 925279</td>
<td>Account numbers less than 925279</td>
</tr>
<tr>
<td>Less than or equal &lt;=</td>
<td>Expression: &lt;= 925279</td>
<td>Account numbers less than or equal to 925279</td>
</tr>
<tr>
<td>Not equal to &lt;&gt;</td>
<td>Expression: &lt;&gt; 925279</td>
<td>Account numbers other than 925279</td>
</tr>
</tbody>
</table>

Note: You can add search expressions (F8) to queries after they have been created by right-clicking the query and selecting Edit.
List of Values Query

List of Values logic allows you to define as many alternatives for every search field as you wish. In the List of Values dialog box, for example, you could enter "123-45-6789", "111-11-1111", and other Social Security numbers (SSN) to search for multiple values.

ApplicationXtender locates all documents that contain any entry in that field. In the example above, all documents with "123-45-6789" in the SSN field and all documents with "111-11-1111" (as well as any others you added) are located and listed in the Result Set tab. By allowing you to specify more alternatives, the List of Values operation provides for more inclusive searches that retrieve a larger set of documents.

To insert a list of values as search criteria:

1. Select the index field you want to query. Press [F5]. The List of Values dialog box appears.
2. In the Field Value text box, enter one of the field values that you want to query. AppXtender allows you to add as many values for the selected field as you want. The following table explains each of the buttons in the dialog box.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds each value entered into the Field Value text box.</td>
</tr>
<tr>
<td>Replace</td>
<td>Overwrites the selected value with a corrected value.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes an unwanted value.</td>
</tr>
<tr>
<td>Delete All</td>
<td>Removes all values in the Field Value list.</td>
</tr>
</tbody>
</table>

3. When all values have been entered, click OK. AppXtender adds the list you created to the Search tab.

For more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to “Displaying Documents from the Result Set” on page 275.

Note: You can add lists of values (F5) to queries after they have been created by right-clicking the query and selecting Edit.
Searching by ODMA Attributes

ApplicationXtender uses Open Document Management API (ODMA) to let you create AppXtender documents and check them into AppXtender from ODMA-compliant Application. When you create an AppXtender document from an ODMA-compliant application, you have the opportunity to enter the following optional information about the document: title, subject, author, keywords, and comment. These pieces of information, plus the user name (and domain, if the Windows security provider is used) under which the document was created, are considered to be ODMA attributes of the document. After such a document is created, you have the opportunity to change the title, subject, author, keywords, and comment. These changes can be performed from either within the ODMA-compliant application or within AppXtender.

If your AppXtender workstation has been configured to allow searching by ODMA attributes, you can search for documents by title, subject, author, keywords, comment, and the user name under which the document was created. ODMA attributes in the Query View’s Search tab are identified by brackets [ ].
Retrieving Documents

The following table refers you to other documentation for more information.

<table>
<thead>
<tr>
<th>Table 30</th>
<th>More Information on ODMA Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For Information On</strong></td>
<td><strong>Refer To</strong></td>
</tr>
<tr>
<td>Configuring your workstation to allow searching by ODMA attributes</td>
<td>&quot;Configuring ApplicationXtender Workstations&quot; section of the ApplicationXtender Installation Guide</td>
</tr>
<tr>
<td>Using ODMA-compliant applications to create and modify AppXtender documents</td>
<td>Chapter 8, &quot;Using ODMA With AppXtender Documents,&quot;</td>
</tr>
<tr>
<td>Modifying the ODMA attributes of a document from within AppXtender</td>
<td>Chapter 7, &quot;Managing Documents,&quot;</td>
</tr>
</tbody>
</table>

**Compound Queries**

By combining multiple search expressions, you can find a wide range of AppXtender documents with a single query. At its simplest, you can create a compound search expression with two sets of search criteria. For example, if you enter index data to search for all documents with Sarah and SSN 111-11-1111 or Ruth and SSN 222-22-2222, the Result Set can return index records in any of the following combinations: Sarah and SSN 111-11-1111, Ruth and SSN 222-22-2222, or both.

For more complex search expressions, you can create a single query with up to four sets of search criteria. When executed, the Result Set can return index records that match a set of search criteria or any combination of search criteria. For examples, refer to "Compound Query Examples" on page 260.

To insert additional columns to create a compound query:

1. To add columns to the Query view Search tab, right-click in the heading of the Values column. From the shortcut menu that appears, select Add Column.

A new Values column is added to the Query view Search tab.
2. Repeat step 1 until you have added the appropriate number of columns.

   **Note:** If you want to delete a column from the Query view Search tab, right-click in the Values column. From the shortcut menu that appears, select Delete Column.

3. Under each Values column and next to any or all of the field names, enter the index information that you want to use as search criteria.

   **Note:** If an index field contains an asterisk, you can select search criteria from a pre-defined list of values.

![Query View Search Tab with Compound Query](image)

**Figure 125** Query View Search Tab with Compound Query

**Note:** If you want more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to “Displaying Documents from the Result Set” on page 275.
Retrieving Documents

**Compound Query Examples**

The following table shows how the compound search expression works.

<table>
<thead>
<tr>
<th>Search Specification</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark and SSN 444-44-4444 &lt;br&gt; Neil and SSN 555-55-5555</td>
<td>Could return any of the following combinations: &lt;br&gt;- Document index records with &quot;Mark and SSN 444-44-4444&quot; &lt;br&gt;- Document index records with &quot;Neil and SSN 555-55-5555&quot; &lt;br&gt;- Document index records with &quot;Mark and SSN 444-44-4444&quot; and document index records with &quot;Neil and SSN 555-55-5555&quot;</td>
</tr>
</tbody>
</table>

**Entering Full-Text Values as Search Criteria**

If you have submitted documents to the AppXtender Index Server, you can search the full text of those documents using the bottom portion of the Search tab.

You can select one of the full-text search options for your query. The options include All Words, Any Words, Exact Phrase, or Expression. The following table details the function of each.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Words</td>
<td>Finds documents that contain ALL of the words you enter.</td>
</tr>
<tr>
<td>Any Words</td>
<td>Finds documents that contain ANY of the words you enter.</td>
</tr>
<tr>
<td>Exact Phrase</td>
<td>Finds documents that contain the exact phrase you enter.</td>
</tr>
<tr>
<td>Expression</td>
<td>Finds documents using a Search Expression.</td>
</tr>
</tbody>
</table>
Note: A full-text search retrieves only documents that have been submitted to the AppXtender Index Server. If none of your documents have been submitted, the full-text searching features are not available. For more information, refer to “Submitting Documents to a Full-text Queue” on page 411. If your documents have been submitted to the AppXtender Index Server and full-text searching is still not available, refer to “Troubleshooting” on page 209.

To enter full-text values as search criteria:

- In the full-text search text box at the bottom of the Query view Search tab, enter the text string for which you want to search.
  - To search for multiple words and use the All Words or Any Words options, enter the words with spaces between them (for example, AEX Simon).
  - To search for a phrase and use the Exact Phrase option, enter the words exactly as you want to find them, including spaces.
  - To search for an expression and use the Expression option, refer to “Building Full-Text Search Expressions” on page 262.
Keep in mind the following points:

- The AND and OR options in the Search tab can be used to combine a full-text search statement with an index value search statement. For more information on combination searches, refer to “Combination (Index and Full-Text) Queries” on page 264.

- If the application is configured to use the K2 full-text engine, a Thesaurus check box becomes available in the full-text search criteria area. The thesaurus feature allows you to search for words that are related to your search criteria. It contains a list of synonyms or keys for possible words to be used in a search. When the Thesaurus check box is enabled and a full-text search is performed, AppXtender also searches for words that are listed as synonyms or keys for that word in the thesaurus control file. The thesaurus control file (*.ctl) is installed when you install K2 servers. For more information on the thesaurus control file and its configuration, refer to the K2 Collection Reference Guide.

- When you index a document’s full text content using the AppXtender Index Server, a text view of the document is included with the document. The next time you retrieve the document, the text view of the document is available. For foreign files, RTF files, HTML files, and PDF files, if the application is using the ProIndex full-text engine, only the first 256 lines of each document page are included in the text view for that page. The entire document page is full-text indexed, but only the first 256 lines are returned as a text view.

For more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to “Displaying Documents from the Result Set” on page 275.

The Expression option allows you to find documents using a Search Expression. You build a Search Expression by combining the words or text strings that you want to search for with expression operators such as and or. You can combine operators for a more complex search. AppXtender interprets the search expression from left to right.

The information in this topic applies only when the full-text engine is ProIndex. For information on building full-text search expressions when the full-text engine is K2, refer to the K2 Query Language Quick Reference, which is available on the AppXtender/Web Access setup CD.
The following table describes each of the expression operators.

<table>
<thead>
<tr>
<th>Table 33</th>
<th>Expression Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>Description</td>
</tr>
<tr>
<td>And</td>
<td>When you use the <em>and</em> operator between two words, AppXtender searches for documents that contain both words.</td>
</tr>
<tr>
<td>Or</td>
<td>When you use the <em>or</em> operator between two words, AppXtender searches for documents that contain at least one of the words.</td>
</tr>
<tr>
<td>And Not</td>
<td>When you use the <em>and not</em> operator between two words, AppXtender searches for documents that contain the first word, but not the second.</td>
</tr>
<tr>
<td>Near ()</td>
<td>When you use the <em>near ()</em> operator after two words, AppXtender searches for documents in which both words occur in any order, within a range that you specify between the parentheses.</td>
</tr>
<tr>
<td>Character wildcard</td>
<td>When you use a question mark (?) in a string of text, AppXtender searches for documents that contain that string of text, except that AppXtender allows any single character to take the place of the question mark. (If you are searching for multiple words, make sure that another operator is used between each word.)</td>
</tr>
<tr>
<td>String wildcard</td>
<td>When you use an asterisk (*) in a string of text, AppXtender searches for documents that contain that string of text, except that AppXtender allows any number of characters or even the lack of a character to take the place of the asterisk. (If you are searching for multiple words, make sure that another operator is used between each word.)</td>
</tr>
<tr>
<td>Parentheses</td>
<td>By default, AppXtender interprets a search expression from left to right, interpreting each search operator one at a time, and narrowing the results with each subsequent search. You can use parentheses to group search expressions to control the order in which AppXtender performs these searches. When you use parentheses in an expression, AppXtender searches first for documents that contain the expression in parentheses.</td>
</tr>
</tbody>
</table>

The following table provides an example for each of these operators.

<table>
<thead>
<tr>
<th>Table 34</th>
<th>Examples of Expression Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>Example</td>
</tr>
<tr>
<td>And</td>
<td>AEX and Simon</td>
</tr>
<tr>
<td>Or</td>
<td>AEX or Simon</td>
</tr>
<tr>
<td>And Not</td>
<td>AEX and not Simon</td>
</tr>
<tr>
<td>Near ()</td>
<td>AEX near (10) Simon</td>
</tr>
</tbody>
</table>
Combination (Index and Full-Text) Queries

You can perform a query that searches for documents using both index data and full text. This combination query combines the searching power of an index value query and a full-text query.

To insert index values and full-text values as search criteria:

1. Enter values in the index portion of the Search tab, as if you were performing a query by index. For information, refer to “Query by Index” on page 251.
2. Enter text in the full-text text box and select options at the bottom of the Search tab, as if you were performing a full-text query. For information, refer to “Entering Full-Text Values as Search Criteria” on page 260.
3. You have the following choices:
   - If you want to query for documents that include both the index value and the full-text value, click the AND option button.
   - If you want to query for documents that include either the index value or the full-text value, click the OR option button.

For more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to “Displaying Documents from the Result Set” on page 275.
Searching Multiple Applications

In AppXtender, regular queries are restricted to a single application. With the Cross Application Query feature, you can create and run queries that search multiple AppXtender applications for selected index and/or full-text information. For example, you could search three different applications for information on the Social Security number "111-22-3333" or you could search for all documents containing the text "software releases."

For more information on Cross Application Queries, refer to the following topics:

- “Creating a New Cross Application Query” on page 265
- “Performing a Cross Application Query” on page 270
- “Modifying a Cross Application Query” on page 273

**Note:** The Reports query, accessible from the application right-click menu, can be used to retrieve an entire AppXtender Reports Mgmt report, but you can only query one application at a time using that feature. For instructions, refer to “Searching a Single Application” on page 248. Cross application queries for documents generated through AppXtender Reports Mgmt, however, are supported.

Creating a New Cross Application Query

You can configure your Cross Application Query with the New Cross Application Query feature. Using the New Cross Application Query Configuration tab, you set query parameters, including which applications you want to include in the query, and, within the applications, which fields you want to use. Further, you define the fields used as search fields for querying, and which fields display in the result set. When configuring queries, the index fields chosen should be common across the selected applications for maximum effectiveness.

For example, a query can be performed across multiple applications to search for specific employee information. This query could include two applications (for example, PAYROLL and HR) and the fields NAME and SSN. A query called EMP INFO could be created using the Configuration tab that defines these parameters. A search can then be performed to find specific employee data from these two applications using the Cross App Query feature.
When you create a new query, you must perform the following steps:

- Selecting the applications to be included in the Cross Application Query
- Selecting the application fields to be included in the Cross Application Query

The following procedure describes these steps in more detail.

To create a new Cross Application Query:

1. Right-click the name of the application you want to query in the Application view. From the shortcut menu that appears, select New Cross App Query. The New Cross Application Query Configuration tab appears.

![New Cross Application Query Configuration Tab](image)

2. Under Applications, select one of the applications that you want to include in the query. Click Add. The application you selected is added to the Query Applications list. Repeat this step for each additional application that you want to include.

   **Note:** More than one item can be added at a time. To select more than one item in sequence, select the first item, then press and hold the [SHIFT] key while selecting the last item in the group. To select two or more items out of sequence, press and hold the [CTRL] key while selecting each item.
3. The applications you added should appear beneath Query Applications, along with associated index fields. If you want to delete an application from the query, select the application name from beneath Query Applications, and click Remove.

![Diagram of Cross Application Query with Applications Added]

**Figure 128** New Cross Application Query with Applications Added

4. Note the red icon next to each field name. This icon indicates the Cross Application Query status for each field. For an explanation of each icon, click Legend. The following table also provides an explanation of each icon.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Red Not Allowed Icon]</td>
<td><a href="#">Field will not be used in the query (this is the default setting for application fields in Cross Application Query).</a></td>
</tr>
<tr>
<td>![Red Question Mark Icon]</td>
<td>Field is used as a search criterion.</td>
</tr>
<tr>
<td>![Green Check Mark Icon]</td>
<td>Field will display in query result set, but will not be used as a search criterion.</td>
</tr>
</tbody>
</table>
5. Configure the fields for the Cross Application Query. You have the following choices for each field:

- To make a field searchable, click the icon until it becomes a question mark. At least one search criteria index field must be common to at least two of the included applications. Each application must share a searchable field with at least one other included application. For example, if you are searching three applications, the first and second applications could have the Name field in common and the second and third applications could have the Social Security Number field in common.

If a selected application does not have any fields in common with any of the other selected applications, you will receive an error, which states “Application X does not share any searchable fields with other applications” and will not be able to use the query.

- To allow a field to appear in Result Set view, click the icon until it becomes a check mark.

- To exclude a field from both the Search tab and the Result Set tab, click the icon until it becomes a red "forbidden" icon.

**Note:** Keep in mind that at least one searchable index field must be common to all included applications to use Cross Application Query. All search criteria index fields should be common to all included applications to ensure relevancy of returned documents.

**CAUTION**

Most Cross Application Query search field formats should match exactly across applications. Exceptions include phone number and date fields. While formatting can differ between phone number fields, the number of digits must match. For example, a phone number field with the format (nnn)nnn-nnnn can be used with a phone number field using the nnn-nnn-nnnn format, but neither format could be used with an nnn-nnnn phone number format.
Note: When using a date field as a Cross Application Query search field, it is not necessary that the date format match exactly. However, the date fields’ month, date, and year components must be in the same order. For example, if one application index field uses a dd-mmm-yy format and another application field uses the format dd-mm-yyyy, a successful Cross Application Query can be created, but a date field with the format yy-mm-dd cannot be used with a dd-mm-yy format.

Figure 129 New Cross Application Query Configuration: Designating Query Fields

Note: If an index field has been configured to display in the Result Set and is not common to all applications, it displays in the Result Set, but shows no information for documents whose applications do not contain the index field.

6. After fields have been configured, you have the following choices:
   - Click OK to save the query configuration for the current session and return to AppXtender.
   - Click Apply to apply changes and return to the Cross Application Query Configuration tab.
   - Click Cancel to close the Cross Application Query Configuration tab without saving the query.
Retrieving Documents

Note: Clicking OK only saves the query for the current AppXtender user session. To save the query for future use, refer to “Saving a Query” on page 303.

If you click OK, you return to AppXtender. Your query appears on the Application View pane beneath each application that you have configured it to use. By default, it is entitled New Query [1], where [1] contains the number that corresponds to the query’s order of creation (in other words, if you have already created three regular or cross application queries during an AppXtender session, the query is titled New Query [4]).

![Cross App Query: Application Display View](image)

**Figure 130** Cross App Query: Application Display View

Note: In the Application View, the icon located to the left of a query signifies the type of query created. Regular queries use a question mark icon (?). Cross application queries are preceded by the Cross App Query icon ().

**Performing a Cross Application Query**

As soon as a Cross Application Query has been created, you can perform a Cross Application Query. For more information about configuring cross application queries, refer to “Creating a New Cross Application Query” on page 265.

Pre-configured cross application queries appear on the Application View pane beneath each application they have been configured to search. The icon located to the left of the query signifies whether it is a regular query (question mark icon) or a Cross Application Query (Cross App Query icon).
To run a Cross Application Query:

1. Select the Cross Application Query you want to run and right-click. From the shortcut menu that appears, select Edit Query. The Query View pane appears with the Search tab active. The fields that have been configured for searching appear within the Search tab.

2. Under Values, type the values that you want to search for next to the appropriate fields. For example, next to the INVOICE # field, type the number of the invoice that you want to find. Repeat this step for each field that you want to search. Just as in a regular query, you can use expressions, wildcards, full-text, and combination queries.

For more information on entering criteria for more advanced searches, refer to the following topics:

- “Entering Index Values as Search Criteria” on page 250
- “Entering Full-Text Values as Search Criteria” on page 260
- “Combination (Index and Full-Text) Queries” on page 264
Retrieving Documents

Note: To display all information for the applications chosen, leave the fields blank.

3. If the optional Centera retention for AppXtender licensed feature is installed and enabled for the application, and you have the Retention User privilege, a Retention Options section displays on the Search tab of the Query view. For procedures on searching for documents under Centera retention or retention hold using these options, refer to “Working with Centera Retention for ApplicationXtender” on page 375.

4. Click Search. Cross App Query runs the selected query and searches for documents that match the search criteria.

The Result Set tab appears in the Query View pane and displays the results of the search. The number of hits (a hit is a document that matches the search criteria) displays at the top of the Result Set tab, next to Result Set. Each hit is listed, by application, with the fields that were specified as searchable or displayable on the Cross Application Query Configuration tab. (For information about configuring fields to appear in the Cross Application Query Result Set, refer to “Creating a New Cross Application Query” on page 265.) For each item listed, the number of pages in the document is also listed.

Figure 133 Cross Application Query Result Set Tab

As soon as you have retrieved the documents you need, you can open those documents or process them from the result set.
If you only retrieve one document, depending on the configuration of the AppXtender system, you may be prompted to check out the document. For more information on checking out AppXtender documents, refer to “Selecting a Document Display Mode” on page 280.

**Note:** The maximum number of results displayed in the Result Set query does not exceed the number of Maximum Query Results configured on the Display tab within Configuration multiplied by the number of applications included in the Cross Application Query. For example, a Cross Application Query that applies to three applications run in an AppXtender session that allows for 50 maximum query results returns the first 50 results from each application, and yields a maximum of 150 query results in the Result Set.

**Note:** AppXtender security affects Cross Application Queries on an application and document security level. For example, if you have been restricted from viewing an application that is included in a Cross Application Query, only those documents from visible applications appear in the Result Set. In addition, if you have been restricted from viewing documents using AppXtender’s Document Level Security, restricted documents are not retrieved during a Cross Application Query. If you have questions about your security privileges, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

---

**Modifying a Cross Application Query**

After a Cross Application Query has been created, you can modify it by accessing the Edit Cross Application Query Configuration tab to change its parameters, if necessary.

To modify a Cross Application query:

1. In the Application view, right-click the Cross Application Query that you want to modify.
2. From the shortcut menu that appears, select Configure. The Edit Cross Application Query dialog box appears.
3. Make the necessary changes to the query information. For detailed instructions, refer to “Creating a New Cross Application Query” on page 265.
4. When you have completed changes, you have the following choices:
   - Click OK to save the query for the current session and return to AppXtender.
   - Click Apply to apply changes and return to the Cross Application Query Configuration tab.
   - Click Cancel to close the Cross Application Query Configuration tab without saving your changes.

Note: If your query has not yet been named and saved, clicking OK only saves the query for the current AppXtender user session. To save the query for future use, refer to “Saving a Query” on page 303.
Displaying Documents from the Result Set

As soon as a query is executed, the Result Set tab appears in the Query view. If only one document matches the specified search criteria, AppXtender automatically displays that document.

When multiple documents match the specified search criteria, or if you ran an AppXtender Reports Mgmt report query, the results are listed in the Result Set tab.

Note: In order to display a document or its properties in AppXtender, you must have the Display privilege enabled. For more information, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

You can adjust the way that results and columns appear in the Result Set tab. For more information, refer to “Managing the Query View Result Set” on page 104.

You can also save the result set as a text file. For more information, refer to “Saving the Result Set as a Text File” on page 424.

In addition to searching applications for and viewing documents, AppXtender contains a feature called Reports view that allows you to search applications and view AppXtender Reports Mgmt generated reports, open the document associated with the section of the report currently being viewed, or view the report associated with the active document. This function is available to users who have the Report View privilege.

Retrieving AppXtender Reports Mgmt reports uses the same index querying functions as retrieving AppXtender documents, and like AppXtender documents, you can print, export, and delete pages, and delete reports as appropriate.

More information on the Report view function in AppXtender can be found in “Displaying AppXtender Reports Mgmt Reports” on page 288.
Displaying AppXtender Documents

You can display a document or AppXtender Reports Mgmt report directly from the Result Set tab in AppXtender, whether you retrieved it from a single application or multiple applications. More information on viewing AppXtender Reports Mgmt reports and associated documents can be found in “Displaying AppXtender Reports Mgmt Reports” on page 288.

Figure 134 Result Set Tab

The page icons in the Result Set indicate a document’s status, as described in the following table.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue page</td>
<td>This document is available. You can choose to open it in normal document</td>
<td>This document is available. You can choose to open it in normal document display mode (if</td>
</tr>
<tr>
<td></td>
<td>display mode (if AppXtender is in normal mode) or you can choose whether</td>
<td>AppXtender is in normal mode) or you can choose whether to check it out or open it in</td>
</tr>
<tr>
<td></td>
<td>to check it out or open it in read-only mode (if AppXtender is in check</td>
<td>read-only mode (if AppXtender is in check in/check out mode).</td>
</tr>
<tr>
<td></td>
<td>in/check out mode).</td>
<td></td>
</tr>
<tr>
<td>Blue page with red</td>
<td>This document is currently checked out. Unless you were the one who</td>
<td>This document is currently checked out. Unless you were the one who checked it out, you can</td>
</tr>
<tr>
<td>check mark</td>
<td>checked it out, you can only open it in read-only mode. If you checked it</td>
<td>only open it in read-only mode. If you checked it out, you can only open it in read-only mode.</td>
</tr>
<tr>
<td></td>
<td>out, you can open it to edit it or you can open it in read-only mode.</td>
<td></td>
</tr>
</tbody>
</table>
Retrieving Documents

If you want to find out who has a document checked out or would like to view document summary or index information for a document, you can access a document’s properties from the result set. You can also open documents from the Result Set.

To view document properties from the Result Set:

1. Right-click a document in the Result Set tab. From the shortcut menu that appears, select Properties. The AppXtender Document Properties dialog box for that document appears, with the General tab active.

   For more information on AppXtender document properties, refer to “AppXtender Document Properties” on page 421.

2. When you are finished viewing the document properties, click OK to return to the Result Set tab.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Gray page" /></td>
<td>Gray page</td>
<td>This document is a previous revision of a document. You can open it only in read-only mode.</td>
</tr>
<tr>
<td><img src="image" alt="Blue page with clock on lower right corner" /></td>
<td>Blue page with clock on lower right corner</td>
<td>This document has been filed for either Centera retention or Records Manager retention. You cannot modify a document under Centera retention; however, you can check out the document and create a new version of the document. For information on filing a document for Centera retention, refer to “Filing Documents for Centera Retention” on page 378. Before you can modify a document that is filed for Records Manager retention, you must check the document out. For information on filing a document for Records Manager retention, refer to Appendix B, “Working with Records Manager for ApplicationXtender.”</td>
</tr>
<tr>
<td><img src="image" alt="Clock face and lock on page" /></td>
<td>Clock face and lock on page</td>
<td>Indicates a retention hold has been applied to the document.</td>
</tr>
</tbody>
</table>
Retrieving Documents

Figure 135  Query View Result Set Tab

Note: If your search retrieved a single document, AppXtender automatically displays that document. If you have been prompted to check out the document, refer to “Selecting a Document Display Mode” on page 280 for information on checking out a document on display.

To display a document from the Result Set:

* Double-click the document in the Result Set. The behavior of the document after you choose to display it (or AppXtender automatically displays it) depends on the following factors:
  * Whether the Reason Code option is enabled for the current application.
  * Whether the Prompt for checkout on open document option is enabled in AppXtender AppGen for the current application.
  * Whether the Prompt for check out on open option is enabled in the Data tab of the AppXtender Configuration dialog box for your AppXtender workstation.
  * Whether the document has been checked out (by you or another user).

If the Reason Code option is enabled for the current application, the Reason Code Required dialog box appears first. To allow printing, e-mailing, or export of the displayed document, enable the Print, Email, or Export check boxes, respectively. Any options you do not enable will not be available for the displayed document. In the text box, you must add a comment explaining the reason for opening the document. Once you enable the appropriate actions and enter a comment, click OK to continue opening the document.
Figure 136  **Reason Code Required Dialog Box**

The following table describes the behavior of the displayed document.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>Neither of the options for Prompt for check out is enabled and the document is not checked out.</td>
<td>The document opens and appears immediately in the Document Display view. If you would like to modify the document, you can make edits without checking the document out, or you can check out the document using a command from the Document menu. This prevents other users from being able to access the document until you check it back in – useful for edits that may take more than the current AppXtender session.</td>
</tr>
<tr>
<td>Either of the options for Prompt for check out is enabled, and the document is not checked out.</td>
<td>The Check Out dialog box appears. You can choose to check out the document or open it in read-only mode.</td>
</tr>
<tr>
<td>Either of the options for Prompt for check out is enabled, and you have already checked out the document.</td>
<td>The Open AppXtender Document dialog box appears. You can choose to open your checked out copy of the document or open a read-only copy of the document in the AppXtender repository (the version originally checked out prior to any revisions you made).</td>
</tr>
</tbody>
</table>
For details on the display modes for AppXtender documents, refer to the “Selecting a Document Display Mode” on page 280.

Table 37  Behavior of the Displayed Document (continued)

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>The application Prompt for check out on open option is enabled.</td>
<td>The document opens in read-only mode and cannot be checked out.</td>
</tr>
<tr>
<td>The application Prompt for check out on open option is enabled.</td>
<td>The document opens in read-only mode and cannot be checked out.</td>
</tr>
<tr>
<td>Another user has checked the document out (regardless of the status of the Prompt for check out on open option).</td>
<td>The document opens automatically in read-only mode. You may not make edits to the document until the other user checks the document back in.</td>
</tr>
</tbody>
</table>

The steps that are necessary to display an AppXtender document depend on whether your workstation is configured to use AppXtender in its normal operational mode or whether it is configured to use check in/check out mode.

If your workstation is in normal AppXtender mode, you can display a document and make changes to it without checking it out, as long as it has not been checked out by another user. You can also choose to check out an open document, open a read-only copy of a document that is checked out by you or someone else, or open your checked out version of a document.

If your workstation is configured to use check in/check out mode, documents in AppXtender can be opened in read-only mode or checked out so that they can be modified.

What is Check In/Check Out Mode?

Your AppXtender workstation is in check in/check out mode when the Prompt for check out when open option for your workstation is enabled. This option can be found on the Data tab of the AppXtender Configuration dialog box. An AppXtender application is in check in/check out mode when the Prompt for checkout when open documents option of the application configuration is enabled in AppXtender AppGen. Check in/check out mode is enabled for you if it is enabled for either your workstation or the current application.
When AppXtender is in check in/check out mode, use of revision control with AppXtender documents is mandatory. If you select to open a document that is not checked out by another user, you are prompted to choose whether to check the document out or view it in read-only mode. Documents in read-only mode cannot be modified. To modify a document, you must check it out.

**Note:** The final revision option on check-in is only available when the AppXtender application is in check in/check out mode.

The application may also be configured so that comments are required when you check in or check out documents.

**What is the Normal AppXtender Mode?**

Your AppXtender workstation is in normal mode when the Prompt for check out when open option for your workstation is not enabled. This option can be found on the Data tab of the AppXtender Configuration dialog box. An AppXtender application is in normal mode when the Prompt for checkout when open documents option of the application configuration is not enabled in AppXtender AppGen. Normal mode is enabled for you if it is enabled for both your workstation and the current application.

When AppXtender is in normal mode, use of revision control with AppXtender documents is optional. You can open and modify documents, and when you close them, the modifications are automatically saved to the AppXtender document repository.

You can check out documents while AppXtender is in normal mode, if you want to prevent other users from making modifications while you are working on a document. This is useful if modifications to a document may extend through more than the current AppXtender session. However, you are not required to check out a document to modify it.

When AppXtender is in normal mode, if you open a document that is checked out by someone else, it automatically opens as read-only and you cannot modify the document until it is checked back in. If you select to open a document that is checked out by you, you are prompted to choose whether to open your checked out copy of the document or a read-only copy of the document.
Retrieving Documents

What is the Normal Document Display Mode?

The normal document display mode opens a document and allows you to make changes to it without checking the document out. The normal document display is only available when opening a document that is not checked out by anyone while AppXtender is in normal mode.

What is the Read-only Document Display Mode?

The Read-only display mode opens a document that cannot be modified. Read-only mode for a document is indicated by a ‘(RO)’ notation in the title bar. A document can be opened in read-only mode in several circumstances.

In AppXtender normal mode, if you have already checked a document out and you attempt to open the document, you can select to open the document in read-only mode. If someone else has a document checked out and you attempt to open the document, the document automatically displays in read-only mode. In either case, opening the document in read-only mode opens the AppXtender repository copy of the document – in other words, the copy of the document that was originally checked out before any changes were made to it (by you or anyone else).

When AppXtender is in check in/check out mode, you can choose to open a document in read-only mode if it is not checked out, or if it is already checked out by you. If a document is checked out by someone else, you can only open it in read-only mode.

AppXtender displays the read-only document in the Document Display view and allows you to perform export functions on the document (as long as you have the user rights to perform those functions in AppXtender).

However, you cannot make permanent modifications to a document if you open the document in read-only mode. You cannot add new pages or page versions to the document, add annotations or redactions, modify the document index, or use the Enhance Image feature for document pages. You can launch foreign files or edit inserted objects and make changes, but the changes are not saved.

If you open a document in read-only mode and decide that you want to make changes, as long as the document has not been checked out by another user, you can check it out using the Check Out command from the Document menu.
What is the Check Out Document Display Mode?

Documents can be checked out so that other users cannot access the document. When you check out a document, AppXtender saves a copy of the document to a temporary storage location. That copy becomes your working copy of the document. The original document remains in the AppXtender repository and is the version that users will receive if they open the document in read-only mode.

When you make changes to the checked out document, the changes are made to the working copy. When you are done making changes, you can check in the new revision of the document and AppXtender saves the document revision (keeping the older revision if you choose to do so).

If you decide that you would rather not check in the modified document, you can cancel the check out. When you cancel the check out, AppXtender deletes the working copy that it stored temporarily and treats the AppXtender repository copy (original version) of the document as the most recent revision.

Opening a Document in Normal Document Display Mode

You can only open a document in normal document display mode if your AppXtender workstation is configured to use the normal AppXtender mode of operation and the document you select to open is not checked out by another user.

If the document appears in the Document Display view without any additional messages or dialog boxes, and you can make changes to it without checking it out, you have opened the document in normal document display mode.

You can make changes to the document and close it to save the changes, or you can check out the document to lock the document so that only you have access to it, then work on it and check it back in.

Note: Two options determine whether AppXtender is in normal document display mode or check in/check out mode. One determines the mode for the workstation and the other determines the mode for the application. Check in/check out mode is enabled for you if it is enabled for your workstation or for the current application. For details, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

For more information on document display, refer to Chapter 6, “Viewing Documents,”. For more information on processing options for documents, refer to Chapter 7, “Managing Documents.”.
Opening a Document in Read-Only Mode

You can open a document in read-only mode to view the document without modifying it.

You have several choices (depending on the behavior of AppXtender when you attempt to display a document):

- If the Check Out dialog box appears, the document has not been checked out by anyone and AppXtender is in check in/check out mode. Select Open as Read-Only and click OK to open the document in read-only mode.

  ![Check Out Dialog Box (Check in/Check out Mode)](image)

  The document opens in read-only mode and cannot be modified unless you check it out manually by selecting Check Out from the Document menu.

  For more information on document display, refer to Chapter 6, "Viewing Documents,". For more information on processing options for documents, refer to Chapter 7, "Managing Documents,\".

- If the application has Prompt for checkout on open enabled and the document has been finalized, the document opens automatically in read-only mode and cannot be checked out.

- If the document appears in the Document Display view without any messages or dialog boxes, but document modification commands (such as annotations or add page options) are grayed out, you have opened the document in read-only mode.

  Read-only mode is indicated by (RO) in the title bar. Documents checked out by another user automatically open in read-only mode, regardless of whether your workstation is configured for normal or check in/check out mode.
You may notice that the Check Out option in the Document menu is active. However, if you try to check out a read-only document that is checked out by someone else, the following message appears saying that the document will be opened in read-only mode.

You cannot check out the document or modify it until the person who has it checked out checks it back in.

For more information on document display, refer to Chapter 6, “Viewing Documents,”. For more information on processing options for documents, refer to Chapter 7, “Managing Documents.”.

◆ If the Open AppXtender Document dialog box appears, it means you already have the document checked out. In this case, the Open AppXtender Document dialog box appears regardless of whether your workstation is in normal or check in/check out mode. Despite the fact that you have the document checked out, you can still open the document in read-only mode rather than checking it out. Click Read Only to open the document in read-only mode.

If you open the document in read-only mode, AppXtender keeps the document checked out by you, but opens a read-only copy of the document that was originally checked out by you – before any changes were made. If you then choose to manually check the document out again, the document copy that you have checked out, with changes made since the original check out, opens in place of the read-only copy.

For more information on document display, refer to Chapter 6, “Viewing Documents,”. For more information on processing options for documents, refer to Chapter 7, “Managing Documents.”.

---

**Note:** Two options determine whether AppXtender is in normal document display mode or check in/check out mode. One determines the mode for the workstation and the other determines the mode for the application. Check in/check out mode is enabled for you if it is enabled for your workstation or for the current application. For details, consult your AppXtender system administrator or refer to the *ApplicationXtender Core Components Administrator’s Guide.*
Opening a Document in Check Out Mode

As long as a document is not checked out by another user (and as long as you have the appropriate user privileges), you can check it out to work on it. (Checking out a document requires the Display, Delete Doc, Delete Page, and Add Page privileges.) You can then make changes to the document.

After you check out a document, you must eventually check it back in if you want your changes to be saved to the AppXtender document repository. Until you check the document in, any other user retrieving the document retrieves a read-only copy of the document, and the version they receive is the version you checked out before you made changes.

In addition, other users cannot check the document out or make modifications until you check it back in. In order to release the document for check out or modification by other users, you must either check the document in or cancel the check out.

Note: Your system administrator has the ability to cancel the check out of a document from ApplicationXtender Application Generator (AppXtender Admin) and may cancel check out if a document remains checked out when other users need that document. For information on checking in documents or canceling a document check-out, refer to “Working with Checked Out AppXtender Documents” on page 469. For instructions on canceling the check out of a document from AppXtender AppGen, refer to the “Managing Applications” section of the ApplicationXtender Core Components Administrator’s Guide.

You have several choices for document check out (depending on the behavior of AppXtender when you attempt to display a document):

- If the document appears in the Document Display view without any additional messages or dialog boxes, and the document modification commands (such as annotations and add page options) are active, you have opened the document in normal document display mode.

From the Document menu, select Check Out to check out the document. The Check Out dialog box appears. You can add a comment regarding the reason for check out or other information. (This comment appears in the AppXtender Document Properties dialog box for the document until the document is checked in or the check in is canceled. For instructions on viewing this dialog box, refer to “AppXtender Document Properties” on page 421.) Click OK to check out the document.
Note: Comments can have up to 250 characters.

For more information on document display, refer to Chapter 6, "Viewing Documents,". For more information on processing options for documents, refer to Chapter 7, "Managing Documents,"

◆ If the Check Out dialog box appears, the document has not been checked out by anyone and your workstation is configured for check in/check out mode. Select the Check Out option. You can add a comment regarding the reason for check out. (This comment appears in the AppXtender Document Properties dialog box for the document until the document is checked in or the check in is canceled. For instructions on viewing this dialog box, refer to “AppXtender Document Properties” on page 421.) Click OK to check the document out.

Note: Comments can have up to 250 characters.
Retrieving Documents

For more information on document display, refer to Chapter 6, "Viewing Documents.". For more information on processing options for documents, refer to Chapter 7, "Managing Documents."

- If the Open AppXtender Document dialog box appears, you already have the document checked out. The Open AppXtender Document dialog box appears regardless of whether your workstation is configured for normal or check in/check out mode. Click OK to re-open the document.

**Note:** When you re-open a checked out document, AppXtender opens the currently checked out copy of the document, complete with any changes you have made since you checked it out. Remember that the changes are not saved to AppXtender until you check the document back in.

For more information on document display, refer to Chapter 6, "Viewing Documents.". For more information on processing options for documents, refer to Chapter 7, "Managing Documents."

**Note:** Two options determine whether AppXtender is in normal document display mode or check in/check out mode. One determines the mode for the workstation and the other determines the mode for the application. Check in/check out mode is enabled for you if it is enabled for your workstation or for the current application. For details, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

Displaying AppXtender Reports Mgmt Reports

AppXtender Reports Mgmt reports consist of multiple documents and multiple pages and may exist in either Adobe PDF or ASCII (text) format. Because AppXtender Reports Mgmt reports are generated for existing AppXtender applications that may already contain multiple documents, AppXtender allows you to search an application specifically for AppXtender Reports Mgmt reports. In addition, AppXtender allows you to view associated AppXtender Reports Mgmt reports for a displayed document, or conversely, the associated AppXtender document for the displayed page of the AppXtender Reports Mgmt report.
For more information, refer to the following topics:

- “Requirements for Displaying AppXtender Reports Mgmt Reports” on page 289
- “Searching for an AppXtender Reports Mgmt Report” on page 290
- “Displaying the AppXtender Reports Mgmt Report for the Current Document” on page 292

The following requirements must be met for you to query an AppXtender application for an AppXtender Reports Mgmt report or to view an AppXtender Reports Mgmt report associated with a displayed document.

- The AppXtender Reports Mgmt report type that was used to generate the AppXtender documents must have been configured to enable report view in AppXtender.
- You must have logged into AppXtender with the CX/AppXtender Reports Mgmt option.
- You must have the Report View privilege (as set by the system administrator in ApplicationXtender Application Generator (AppXtender AppGen)).

If you do not have the Report View privilege, the menu options discussed here for accessing the AppXtender Reports Mgmt reports are not available to you.

In addition, if you want to make modifications to the AppXtender Reports Mgmt report, you must have the proper document operation privileges. For example, you must have Print privilege to print and export a report and Delete Doc and Delete Page privileges to delete a report or report pages respectively.

**Note:** For more information on generating AppXtender Reports Mgmt reports and processing the reports so that they can be viewed in AppXtender, consult your AppXtender system administrator or refer to your ApplicationXtender Reports Management Administrator’s Guide.
The following procedure describes how to search for an AppXtender Reports Mgmt report.

To query an application for an AppXtender Reports Mgmt report:

1. Right-click the application you want to query. A shortcut menu appears.

2. Select the Reports option from the shortcut menu. The Query view Search tab appears.

3. Enter the search criteria for the AppXtender Reports Mgmt report you want to find. For information on running queries in AppXtender, refer to “Searching a Single Application” on page 248.

4. Click Search. If any reports are found matching your search criteria, the Result Set tab appears, listing those reports. If no reports are found, a No documents found message appears.
From the Result Set tab, you may choose to open or delete the listed reports.

Displaying AppXtender Reports Mgmt reports from the Result Set functions identically to displaying other AppXtender documents from the Result Set. For instructions, refer to “Displaying Documents from the Result Set” on page 275.

When the report is open, notice that the Document and Page menu options have completely changed to reflect available AppXtender functionality for the open report. The functionality of those commands are outlined in the following table.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
<td>New</td>
<td>Adds a new document to the application. Methods available for adding a document are the same as for any AppXtender document. For more information on the available input methods, refer to Chapter 3, “Creating Documents.”</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Deletes the entire report from the application.</td>
</tr>
<tr>
<td>Page</td>
<td>Next Page</td>
<td>Displays the next page of the report.</td>
</tr>
<tr>
<td></td>
<td>Previous Page</td>
<td>Displays the previous page of the report.</td>
</tr>
<tr>
<td></td>
<td>Goto Page</td>
<td>Allows you to navigate to a specific page of the report.</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>Allows you to print the currently displayed page or the entire report.</td>
</tr>
<tr>
<td></td>
<td>Export</td>
<td>Allows you to export the report using the formatting set in the Export tab of your AppXtender Configuration.</td>
</tr>
<tr>
<td></td>
<td>Goto Document</td>
<td>Opens the AppXtender document associated with the currently displayed page of the report.</td>
</tr>
</tbody>
</table>

Notice that the main difference in menu commands when an AppXtender Reports Mgmt report is displayed is that the navigation between pages has moved from the Document menu to the Page menu.

For more information on document display and navigation, refer to Chapter 6, “Viewing Documents.” For more information on processing options for documents, refer to Chapter 7, “Managing Documents.”
In addition to the standard navigation commands, when the report is open, the Page menu includes a Goto Document command. Since AppXtender Reports Mgmt reports consist of multiple documents, you may wish to view a specific document separately from the report. This can be done using the Goto Document command that is available when an AppXtender Reports Mgmt report is displayed.

The following procedure describes how to display the AppXtender document associated with the currently displayed AppXtender Reports Mgmt report page.

To view the document for the current AppXtender Reports Mgmt report page:

1. Query for and display the appropriate AppXtender Reports Mgmt report.
2. Navigate to a report page that coincides with a page in the AppXtender document you want to view.
3. Select the Goto Document option from the Page menu.

The associated document appears in the Document Display view. As soon as the document is displayed, the menu commands appear as they usually do whenever a similar AppXtender document is open.

For more information on document display and navigation, refer to Chapter 6, "Viewing Documents." For more information on processing options for documents, refer to Chapter 7, "Managing Documents."

In addition to the standard AppXtender document commands, whenever a document that is part of an AppXtender Reports Mgmt report is open, AppXtender allows you to open the associated report without having to query the application for the report.

If you open a document that has an associated AppXtender Reports Mgmt report, and you have the Report View privilege, the Document menu has a Show Report option active. Selecting this option opens the AppXtender Reports Mgmt report associated with the open document.
To open an AppXtender Reports Mgmt report for an associated AppXtender document:

1. Query for and display the appropriate AppXtender document.
2. Select the Show Report option from the Document menu.
3. The associated report appears in the Document Display view.

For information on available report functions and navigation, refer to “AppXtender Reports Mgmt Report Function Commands” on page 291.

For more information on document display and navigation, refer to Chapter 6, “Viewing Documents,”. For more information on processing options for documents, refer to Chapter 7, “Managing Documents,”.

**Viewing Full-Text Search Results**

If you performed a full-text search, the Result Set includes a Hits column.

![Query View Result Set with Full-Text Hits](image-url)

*Figure 142 Query View Result Set with Full-Text Hits*
The following table compares the results of full-text searching, depending on which full-text engine (ProIndex or K2) the application is configured to use.

<table>
<thead>
<tr>
<th></th>
<th>ProlIndex</th>
<th>K2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hits Column</strong></td>
<td>Displays the number of &quot;hits&quot; for each document. A hit is an occurrence of the word or words you specified in the full-text search.</td>
<td>Displays the word &quot;Found&quot; instead of the number of hits.</td>
</tr>
<tr>
<td><strong>Highlighting</strong></td>
<td>The string of text that you searched for is highlighted everywhere that it occurs in the document. No other text is highlighted.</td>
<td>The string of text that you searched for is highlighted everywhere that it occurs in the document. In addition, text that matches individual words in your search string are also highlighted.</td>
</tr>
</tbody>
</table>

If you retrieved a document using full-text index values, as soon as you display a document (and check it out if necessary), the Full Text Search Results dialog box appears. When the dialog box appears, the text of the document also appears in the Document Display view and the first occurrence of the text you searched for is highlighted.
To view the full-text search results:

- If the application is configured to use a ProIndex full-text engine, you have the following choices:
  - To find the previous occurrence of the text, click Previous.
  - To find the next occurrence, click Next.
  - To show all occurrences, click Show All Hits on this Page.

- If the application is configured to use a K2 full-text engine, you have the following choices:
  - To show all occurrences of the text on the previous page, click Previous.
  - To show all occurrences of the text on the next page, click Next.

**Viewing Documents from Unknown Data Sources**

If you attempt to open an AppXtender document from an external source (for example, an AppXtender document that has been saved on your computer desktop, or a document/document reference that has been e-mailed to you), and the data source it resides on is not recognized (which can happen if a data source is named differently on different computers), the Pick a Data Source dialog box may appear. This dialog box will appear if you have enabled the Allow map of unknown data sources to existing data sources check box on the Configuration View tab. If the Allow map of unknown data sources to existing data sources check box is not enabled, you receive an error message that states that the data source is not found.
To choose a data source from the Pick a Data Source dialog box:

- When the Pick a Data Source dialog box appears after opening an AppXtender document from an unknown data source, select the correct data source from the Data Source Name list and click OK.

![Pick a Data Source Dialog Box](image)

**Figure 144** Pick a Data Source Dialog Box

**Note:** If the correct data source does not appear within the Pick a Data Source dialog box, the AppXtender system administrator should add it using AppXtender Admin. For more information about adding a data source, consult your AppXtender system administrator or refer to the “AppXtender Data Sources” section of the *ApplicationXtender Core Components Administrator’s Guide.*
If you attempt to open an AppXtender document which has been stored to a volume label search drive, the Volume Label Search Drives dialog box appears.

To display the document:

1. Select the drive in which the document is stored.
2. Click OK. The document is displayed.
AppXtender allows you to search for strings of text in text and PDF documents. Document text searches do not rely on the ApplicationXtender Index Server (AppXtender Index Server), so they can be executed on documents that have not been indexed for full-text retrieval.

**Note:** The AppXtender Index Server provides far more efficient full-text search capabilities than the document text search feature.

Document text searches can be performed on the displayed document, or on multiple documents at once from the Result Set tab. For more information, refer to the following topics:

- “Text Search from the Document Display View” on page 298
- “Text Search from the Result Set” on page 300
- “Special Search Characters” on page 301

### Text Search from the Document Display View

You can perform text searches from the Document Display view. This feature is useful if you know which document has the text you need to find because it saves you the trouble of reading through the entire document to find the text.

To find text within a displayed document or page:

1. Display a text document or page. From the Edit menu, select Text Search. The Search dialog box appears.
2. Enter the text you are searching for in the Find Text box.

3. If you want to find any combination of upper or lowercase text that matches the criteria, select Ignore Case.

4. If you want AppXtender to use fuzzy logic when searching for a match, select Fuzzy.

   When the Fuzzy check box is selected, AppXtender also finds matches that are not perfect, not just letter-for-letter matches. For example, when searching for "safe" with Fuzzy selected, AppXtender also finds "sale", "café", and "same" because the last or first two letters in each word match the reference. It does not find "case" or "fame" because the spelling of these words differs too much from the search term.

5. Under Scope, indicate whether you want to search the displayed page or all pages in the document.
   • To search the displayed page, select Page.
   • To search all pages, select Doc.

6. Under Direction, indicate which way you want AppXtender to search on the page.
   • To find the next occurrence, select Next.
   • To find the previous occurrence, select Previous.

7. Under Origin, indicate where on the page you want AppXtender to start searching.
   • To search from the previous search match, select Last Match.
   • To start at the top of the page, select Top.

8. Click OK. AppXtender processes the search.
   • If AppXtender finds any text that matches the criteria, AppXtender highlights the first text match located.
   • If no match is found for the criteria, a No Match Found message appears.

9. If a match was found and you want to locate another match in the selected direction, from the Edit menu, select Text Search Again.
Retrieving Documents

Text Search from the Result Set

You can perform document text searches directly from the Result Set tab. Using the Result Set, you can perform text searches without displaying documents, and perform searches across multiple documents.

To find text within documents in the Result Set:

1. Select the documents you want to search from the Result Set.
2. Right-click the Result Set. From the shortcut menu that appears, select Text Search. The Result Set Text Search dialog box appears.

![Figure 147 Result Set Text Search Dialog Box](image)

3. Enter the text string you want to find in the Search String text box. Use the drop-down list to select one of your previous text searches.

4. If you want AppXtender to use fuzzy logic when searching for a match, select Fuzzy search.

   When the Fuzzy search check box is selected, AppXtender also finds matches that are not perfect, not only letter-for-letter matches. For example, when searching for "safe" with Fuzzy search selected, AppXtender also finds "sale", "café", and "same" because the first two or last two letters in each word match the reference. It does not find "case" or "fame" because the spelling of these words differs too much from the search term.

5. If you want to find any combination of upper or lowercase text that matches the criteria, select Ignore case.

6. Click OK. A new Text Search tab appears in the Query view, displaying the results.
The Text Search tab contains a line report with all located matches. The entire line containing the matched text string is shown on the report, with the text string appearing as a hyperlink in blue text with an underline. To view the document page containing the text string, click the text string. AppXtender displays that document page with the text match highlighted.

If you open a new document from the Text Search tab, depending on the configuration of the AppXtender system, you may be prompted to check out the document. For more information on checking out AppXtender documents, refer to “Selecting a Document Display Mode” on page 280.

After a successful text search, the Result Set tab contains only the documents that you had selected, and of those, only the ones that matched your search criteria.

You can use special characters as search operators when performing text searches. Unlike the asterisk, which can be used to locate strings of characters, these operators all find only a single character. For example, the search string “wildcart!” would locate the word “wildcard” but not the word “wildcards” because the exclamation point represents only one character.
The following table describes the special search characters.

### Table 40 Wildcard Character Results

<table>
<thead>
<tr>
<th>Wildcard Character</th>
<th>Finds</th>
</tr>
</thead>
<tbody>
<tr>
<td>@</td>
<td>Any single alphabetic character. For example, the search string &quot;Wa@hington&quot; would find the word &quot;Washington.&quot;</td>
</tr>
<tr>
<td>#</td>
<td>Any single numeric character. For example, the search string &quot;30#&quot; would find the number &quot;301.&quot;</td>
</tr>
<tr>
<td>!</td>
<td>Any single non-space character. For example, &quot;batc!&quot; would find &quot;batch&quot;</td>
</tr>
<tr>
<td>?</td>
<td>Any single character including the search wildcard characters. For example, the search string &quot;neil?mycompany.com&quot; would find &quot;<a href="mailto:neil@mycompany.com">neil@mycompany.com</a>&quot;</td>
</tr>
</tbody>
</table>

**Note:** These special search characters can only be used for text search.
Managing Queries

Common AppXtender queries that you may perform frequently can be saved. This allows you to execute the query in a few short steps. Saved queries can be made public, so that all users can run them; or kept private, so that they only appear on your AppXtender desktop. For information on query management functions, refer to the following topics:

- “Saving a Query” on page 303
- “Running a Query” on page 304
- “Editing a Query” on page 304
- “Making a Query Public or Private” on page 305
- “Renaming a Saved Query” on page 306
- “Deleting a Query” on page 306

Your AppXtender system administrator may have decided to give you access to preconfigured groups of documents through the use of saved queries.

Saving a Query

You can save any query that you have created, whether the query is a standard AppXtender query or a Cross Application Query.

To save a query:

1. You have the following choices:
   - Click Save in the Search tab.
   - If you have already run the query, right-click the name of the query in the Applications view. From the shortcut menu that appears, select Save As.

   The Save Query dialog box appears.

   ![Save Query Dialog Box](image)
Retrieving Documents

2. Enter a name in the Query Name text box.
3. You have the following choices:
   - If you want the query to be public, click the Available to all users check box to enable it.
   - If you want the query to be private, click the Available to all users check box to disable it.
4. Click OK.

Running a Query

You can run an existing query from the Application view at any time.

To execute a saved query:

- Right-click the Query Name in the Application view. From the shortcut menu that appears, select Run Query.

Editing a Query

If you have saved queries, or if you have existing queries that you created earlier in your current AppXtender session, you can edit the contents of the query.

Note: If you would like to make changes to the application selection and index field selection for a Cross Application Query, you can do so. For more information, refer to “Modifying a Cross Application Query” on page 273.

To edit a saved query:

1. Right-click the Query Name in the Application view. From the shortcut menu that appears, select Edit Query.
2. The Query view Search tab appears with the contents of the query.
3. Make the appropriate changes and click Save.
Making a Query
Public or Private

You can share any saved query with all users or restrict its usage to your sessions only. The padlock icon located next to the query name indicates whether it is public or private.

In the following figure, the locked padlock next to "My Cross App Query" indicates that the query is for private use. The unlocked padlock next to "Everyone’s Cross App Query" indicates that all AppXtender users have access to the query, if they have been granted access to at least one of the applications in the Cross Application Query.

Figure 150 Public and Private Queries

Note: If you do not have access to all applications within a Cross Application Query, the results from the restricted applications do not appear in the Result Set. If you have questions about your security privileges, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator's Guide.

To change a private query to a public query:

◆ Right-click the Query Name in the Application view. From the shortcut menu that appears, select Make Public.

Note: If Make Public is disabled, the saved query is currently public.

To change a public query to a private query:

◆ Right-click the Query Name in the Application view. From the shortcut menu that appears, select Make Private.

Note: If Make Private is disabled, the saved query is currently private.
Renaming a Saved Query

You can rename a saved query.
To rename a saved query:
1. Make sure that the appropriate application is active.
2. Expand the application node. Click the plus sign to the left of the application name. The application node expands and a list of all saved or unsaved queries for that application appears.

Deleting a Query

If necessary, you can delete saved queries.
To delete a saved query:
- Right-click the Query Name in the Application view. From the shortcut menu that appears, select Delete Query.
This section explains all document view functions including display of subsequent pages in a multiple-page document, version viewing, rotation, scaling, zoom (both in and out), and sticky view.

**Note:** For instructions on viewing documents listed in the Result Set, refer to “Displaying Documents from the Result Set” on page 275.

- Introduction to Viewing Documents................................. 308
- Selecting Pages to View within a Document........................ 309
- Viewing Multiple Documents and Pages............................. 316
- Page View Functions Available for Multiple Page Types........ 318
- Viewing Specific Page Types........................................... 332
- Document View Properties.............................................. 344
- Page Information......................................................... 353
Introduction to Viewing Documents

An effective mechanism for storage and retrieval of data is one of the most important features of a useful document imaging system. As soon as a document is retrieved from storage, however, the focus shifts from your ability to access data to your ability to manipulate data. The flexibility to display a retrieved document in a way that highlights the important data in the document aids in efficient data processing.

ApplicationXtender (AppXtender) offers a wide variety of display options. For example, you can easily switch from page to page, alter the display of a page’s size and position, focus on one part of a page, or return to a desired page display format by default.
Selecting Pages to View within a Document

When you view an AppXtender document with multiple pages or page versions, you can use AppXtender page navigation commands to move from page to page and to view different parts of a page. You can use toolbar buttons, menu commands, keystroke combinations or hot keys, and thumbnails in the Thumbnail view to display specific pages in a document. You can use keystroke combinations or hot keys, toolbar buttons, and menu commands to switch between different versions of a displayed page.

Next, Previous, and Go To Page

When you display a document, AppXtender always displays the first page in the Document Display view. If the document has more than one page, the Next Page, Previous Page, and Go To Page functions can be used to move from page to page. You may choose from several different methods of accessing subsequent pages or page versions: the Document menu, the keyboard, or the Image toolbar.

As you navigate from one page to another, or from one version to another, the title bar and status bar indicate the page and version number of the currently displayed page.

Note: If you are using Split View, the behavior of the Next Page and Previous Page commands depends on the current configuration of the PgUp/PgDn in Dual-Page View option in the Configuration dialog box. For information on this option, refer to “PgUp/PgDn in Dual-Page View” on page 114. For information on Split View, refer to “Split View” on page 317.

Next Page

To move forward one page:

- While any page of the document is displayed, from the Document menu, select Next Page.

Note: If the last page of the document is currently displayed, the Next Page menu command displays the first page of the document.

Previous Page

To move back one page:

- While any page of the document is displayed, from the Document menu, select Previous Page.
Viewing Documents

Note: If the first page of the document is currently displayed, the Previous Page menu command displays the last page of the document.

**Go To Page**

If there is more than one page in the document, you can use the Go To Page dialog box to display a particular page.

To display a specific page within a multiple-page document:

1. From the Document menu, select Go To Page. The Go To dialog box appears.

![Go To Dialog Box](image)

2. In the Page text box, enter the page number of the page that you want to display. You can either type the number or use the arrow buttons to specify a page number.

3. Click OK. The page appears.

**Viewing Thumbnails**

Thumbnails are a series of miniature images or icons, representing the pages of the currently displayed document. You can use thumbnails to view many pages of a single document simultaneously. For more information on what you can do with thumbnails, refer to the following topics:

- “Displaying the Thumbnail View” on page 311
- “Displaying Thumbnails” on page 311
- “Displaying a Page from the Thumbnail View” on page 312
- “Creating an AppXtender Document Shortcut” on page 312

You can also delete pages from Thumbnail view. For more information, refer to “Deleting Pages from Thumbnail View” on page 431.

Note: All AppXtender-supported foreign files are displayed as images in the Thumbnail view. Enabling the AppXtender Web KeyView Viewer to display foreign files has no effect on the display of these files in the Thumbnail view.
To show or hide the Thumbnail view:

- From the View menu, select Thumbnail.

**Note:** Depending on the configuration of your AppXtender workstation, thumbnails do not always appear when the Thumbnail view appears. For information on displaying thumbnails in the Thumbnail view, refer to “Displaying Thumbnails” on page 311.

**Displaying Thumbnails**

You can display thumbnails in a variety of ways.

**Displaying Thumbnails for a Displayed Document**

When you already have a document displayed in the Document Display view, you can choose to view thumbnails for the document.

To display thumbnails for the displayed document:

1. Display the document for which you want to view thumbnails. (For instructions on displaying a document, refer to Chapter 5, “Retrieving Documents.”)

2. From the Document menu, select Thumbnails. (If the Thumbnails option is not available, display the Thumbnail view. For instructions, refer to “Displaying the Thumbnail View” on page 311.) Thumbnails for the displayed document appear.

**Note:** Your workstation may be configured to automatically display the Thumbnail view when you open a document. The Always display the thumbnail of the active document option on the Thumbnail tab of the Configuration dialog box allows this configuration. For more information, consult your system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the *ApplicationXtender Installation Guide*.

**Displaying only Thumbnails**

You can also choose to only display thumbnails when you select a document from the result set. You can then click one of the thumbnails to display a particular page.
Viewing Documents

**Note:** Your AppXtender workstation may be configured to automatically display only thumbnails when you double-click a record in the result set. The Display thumbnail of the document when double-click on a query result option on the Thumbnail tab of the Configuration dialog box allows this configuration. For information, consult your system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

If your workstation is not configured to automatically display only thumbnails when you double-click a record in the result set, you can use the following procedure:

To display only thumbnails:

1. Perform a query to generate the Result Set. (For information on generating the Result Set, refer to Chapter 5, “Retrieving Documents.”)
2. From the Result Set, select the record for the document for which you want to view thumbnails.
3. Right-click your selection. From the shortcut menu that appears, select Thumbnail. Thumbnails for the selected document appear.

After you display the thumbnails for a document in the Thumbnail view, you can select a thumbnail to display that document page.

To display a page using the Thumbnail view:

- Double-click the thumbnail of the page you want to display. Depending on your system settings, you may be prompted to check out the document. For more information, refer to “Opening a Document in Check Out Mode” on page 286.

You can create a shortcut on your Windows desktop by dragging a thumbnail to the desktop. You can then use this thumbnail to open AppXtender and immediately retrieve and display that page.

To create an AppXtender document shortcut on your desktop:

- Drag a thumbnail from the AppXtender window to your desktop. An icon appears on your desktop.
Note: When you select the thumbnail on your desktop to open the document, AppXtender will prompt you to log in if you are not already logged in. Depending on your system settings, you also may be prompted to check out the document. For more information, refer to “Opening a Document in Check Out Mode” on page 286.

Viewing Versions of a Page

If more than one version of a page exists, the newest version is displayed by default. You can access all other versions through the Page menu, the Page version toolbar buttons, or hot key combinations.

AppXtender orders page versions as they are created. The original page becomes version 1; the next variation of that page is version 2; and so on. System-generated version numbers are displayed in the status bar and the title bar.

Figure 153  Page Version in Status Bar

The following topics describe the commands you can use to navigate from one version of a page to another:

◆ “Previous Version” on page 314
◆ “Next Version” on page 314
◆ “Newest Version” on page 314
◆ “Oldest Version” on page 314

Note: The PgUp/PgDn in Dual-Page View option in the AppXtender Configuration dialog box has no effect on the behavior of these version navigation commands.

Note: For information on page versions and ODMA, refer to Chapter 8, “Using ODMA With AppXtender Documents,”.
Viewing Documents

Previous Version
To display the previous version of the page:
- From the Page menu, select Show Version and then Previous.

*Note:* If the first version is displayed, the Previous menu command displays the most recent (last) version of the page.

Next Version
To display the next version of the page:
- From the Page menu, select Show Version and then Next.

*Note:* If the most recent (last) version is displayed, the Next menu command displays the first version of the page.

Newest Version
To display the newest page version:
- From the Page menu, select Show Version and then Newest.

Oldest Version
To display the oldest page version:
- From the Page menu, select Show Version and then Oldest.

Viewing Subpages
If there is more than one subpage in a page (for example, in an ICE, TIFF, DCX, or PDF format page), you can use the Next Subpage, Previous Subpage, and Go To Subpage functions to move from subpage to subpage. As you navigate from one subpage to another, the status bar indicates the subpage number of the currently displayed subpage. For instructions on printing a range of subpages, refer to “Printing or Faxing Documents and Pages” on page 373. For instructions on converting subpages to pages, refer to “Converting Subpages to Pages” on page 420.

To move forward one subpage:
- From the Page menu, select Next Subpage.

To move back one subpage:
- From the Page menu, select Previous Subpage.

*Note:* You can add a Next Subpage button or a Previous Subpage button to the Image toolbar. For instructions on customizing a toolbar, refer to “Customizing Toolbars” on page 92.
To display a specific subpage:

1. From the Page menu, select Go To Subpage. The Go To dialog box appears.
2. In the Subpage text box, enter the number of the subpage that you want to display. You can either type the number or use the arrow buttons to specify a number.
3. Click OK. The subpage appears.
Viewing Multiple Documents and Pages

ApplicationXtender can display multiple documents simultaneously. Using the Windows Tile and Cascade features, AppXtender shows all open documents side-by-side or neatly stacked. These tools are accessed from the Windows menu or the toolbar on AppXtender’s main screen. You can also configure the Document Display view to show multiple pages of the same document simultaneously or view an opened document in a supplementary window.

Cascade

The Cascade command cascades, or stacks, all displayed document windows from the top left corner to the bottom right corner. The active document is displayed on the top.

To cascade all open document pages:

- From the Window menu, select Cascade.

Tile

The Tile command shows all open documents side-by-side in the Document Display view.

To tile open documents:

- From the Window menu, select Tile. AppXtender tiles all open windows. If there are less than four windows open, they are tiled horizontally. Otherwise, the windows are tiled horizontally and vertically.
**Split View**

Split View splits the Document Display view so that multiple pages of the same document are displayed.

*Note:* When you use Split View, the behavior of the Next Page and Previous Page commands depends on the current configuration of the PgUp/PgDn in Dual-Page View option in the Configuration dialog box. For information on this option, refer to “PgUp/PgDn in Dual-Page View” on page 114. For information on the Next Page and Previous Page commands, refer to “Next, Previous, and Go To Page” on page 309.

To enable split view:

- From the View menu, select Split Horizontally or Split Vertically.

To disable split view:

- From the View menu, select No Split.

**Displaying Documents in a Duplicate Window**

The Duplicate Document feature allows you to view an opened document in a supplementary window.

To open a duplicate document window:

1. Display a document from the Result Set. (For instructions on displaying a document, refer to “Displaying Documents from the Result Set” on page 275.)

2. From the Document menu, select Duplicate Document (or press [CTRL] + [F5]). The document appears in another window (in read-only mode).
Page View Functions Available for Multiple Page Types

The way pages appear in AppXtender and the viewing options available depend on the file type of the page. When you add a page or a document, you use a specific method to bring the document or page into AppXtender. The file type of each document page depends on the method used to add the document page and the native file format of the file that you brought in to create the document page.

The following topics describe functions that can be used with multiple page types:

- “Using Sticky View” on page 318
- “Using Zoom” on page 321
- “Using Rotate” on page 324
- “Using the Magnifier” on page 324
- “Using Scale-to-Gray” on page 326
- “Using Regions” on page 326

The page types that allow each of these functions are listed at the beginning of each of these topics.

Note: You can determine the page type of most AppXtender document pages by looking at the Type value on the Information tab of the Image Information dialog box for the page. For details on viewing information for a page, refer to “Page Information” on page 353.

Using Sticky View

Sticky View means that ApplicationXtender can “remember” display settings (zoom, rotation, scale-to-gray, etc.) for similar page types. For example, bi-tonal (black and white) pages can be “stuck” to open with certain zoom and rotation settings. A different Sticky View could be set for bitmaps. Sticky View can be helpful when scanning similar paper documents, by displaying the page at its actual size to facilitate monitoring the quality of the scan. AppXtender automatically discerns which page type is displayed and responds with the appropriate settings.
You can use Sticky View with the following page types:

- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay
- Text (as defined in the File Types tab of the Configuration dialog box)
- OLE Objects

**Note:** For more information on the File Types tab of the Configuration dialog box, consult your system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the *ApplicationXtender Installation Guide*.

Sticky View is different from the default display configuration in that the pages are not stored with the sticky settings; the pages appear in Sticky View simply for document creation and retrieval. The sticky settings are in effect until Sticky View is turned off.

Sticky View applies the following settings:

- Zoom, as described in “Using Zoom” on page 321
- Rotation, as described in “Using Rotate” on page 324
- Scale-to-gray, as described in “Using Scale-to-Gray” on page 326
- Form overlay, as described in “Viewing Documents with Form Overlay” on page 333

You can also save multiple sticky view settings for each image type and switch between each of the saved sticky view settings. For more information, refer to “Saving Sticky View Settings” on page 98 and “Switching Sticky View Settings” on page 319.

As soon as you have saved a sticky view setting, you can use the Switch View command to display a document using a Save Settings view, or the Sticky View button to cycle through each of the saved sticky view settings. Depending on the number of views saved, you can display a document with up to five different view settings. For information on saving views, refer to “Saving Sticky View Settings” on page 98.
To switch between sticky views from the View menu:

1. Display a document.

2. From the View menu, select Sticky View and then Switch View. The Switch View menu appears. Highlight the appropriate view (for example, View 1).

![Switch View Menu]

A check mark appears next to the selected view and the document appears with the selected sticky view setting.

![Switch View Menu with the Selected View]

To switch between sticky views from the Image toolbar:

1. Display the document.

2. Click the arrow next to the Next Sticky View button on the Image toolbar.

![Next Sticky View Button]
The Sticky View drop-down menu appears with the currently saved sticky view settings enabled.

3. Select a sticky view setting. AppXtender displays the document using the selected sticky view setting.

**Note:** You can cycle through each of the sticky view settings by clicking the Next Sticky View button. If the last sticky view setting is displayed, clicking the Next Sticky View button displays the first available sticky view setting in the Sticky View menu.

**Using Zoom**

Zoom allows you to either focus precisely on a specific region of the page or view an entire page on the screen at one time. The Zoom feature enlarges or reduces the selected page to the next size in the zoom cycle. As soon as the largest size is reached, both the menu command for Zoom In and the Zoom In toolbar button are grayed to indicate that further enlargement is not possible. Similarly, if the smallest size is reached, the Zoom Out menu command and toolbar button are grayed.

You can set the default display scale in the Configuration dialog box. (For information on changing the default display scale in the Configuration dialog box, refer to “View Tab” on page 110.) When a document is displayed in AppXtender, the document appears in this default scale. You can also change the scale for the currently displayed page only, without affecting the default display parameters. AppXtender provides a wide variety of scaling options.
You can use the Zoom feature with the following page types:

- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay
- Text (as defined in the File Types tab of the Configuration dialog box)
- OLE Objects
- PDFs

Note: The zoom features can be used on text documents if Allow Zoom is selected and a variable size text font is configured for your workstation. The COLD tab and Fonts tab of the AppXtender Configuration dialog box allow these configurations. For information on the Allow Zoom option, consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide. For information on choosing text fonts, refer to “Fonts Tab” on page 117.

**Zoom In**

This option enlarges (or zooms in on) the displayed document by cycling through pre-set magnification levels.

To zoom in or enlarge the displayed document:

- From the View menu, select Zoom and then Zoom In.

**Zoom Out**

This option reduces the displayed size of (or zooms out on) the displayed document by cycling through pre-set magnification levels.

To zoom out or decrease the size of the displayed document:

- From the View menu, select Zoom and then Zoom Out.

**Zoom To Percent**

Like other Windows applications, AppXtender allows you to select how big or how small you want the displayed page to appear. Zooming to 100%, for example, shows the displayed page at actual size. You can use this option to view varying amounts of detail on different pages.

To zoom the displayed page to a specific ratio:

- Right-click the document. From the shortcut menu that appears, select a zoom ratio. The pre-set options range from 25% to 400%.
**Zoom Percent**

You can also apply a specific zoom percent to a displayed document. When this feature is accessed from the View menu, any changes to the zoom parameters apply to the displayed document only. (For information on setting the zoom percent default for all images, refer to “View Tab” on page 110.)

To define the zoom percentage for a document:

1. From the View menu, select Zoom and then Zoom Percent. The Zoom Percent dialog box appears. The zoom percent range is from 1% to 1600%.

![Zoom Percent Dialog Box](image)

2. In the Zoom % text box, enter the zoom percentage that you want to apply. You can type in a value or you can use the up and down arrows to select the percentage.

3. Click OK. The selected zoom percent is applied to the document.

**Fit to Window**

The selected page can be scaled so that the entire page fits in the Document Display view.

To fit the entire displayed page within the window:

- From the View menu, select Zoom and then Fit To Window. The page adjusts so that its entire height and width fit in the window.

**Fit to Window Width**

The selected page can be scaled so that its entire width is visible in the Document Display view.

To fit the displayed page’s entire width within the window:

- From the View menu, select Zoom and then Fit To Window Width. The page adjusts so that it fits the window left to right.

**Fit to Window Height**

The selected page can be scaled so that its entire height is visible in the Document Display view.

To fit the displayed page’s entire height within the window:

- From the View menu, select Zoom and then Fit To Window Height. The page adjusts so that it fits the window top to bottom.
**Viewing Documents**

**Actual Size**
The selected page can be scaled to its actual size. This means that each stored pixel is represented by a monitor pixel.

To display a page in its actual size:
- From the View menu, select Zoom and then Actual Size.

The page adjusts so that it appears in the window at actual size.

**Using Rotate**
The Rotate feature allows you to rotate pages and is especially useful when documents and images were not saved in the proper orientation. You can use rotation with the following page types:

- Images
- COLD/ERM with Image Overlay

**Rotate Left**
This command rotates the displayed page 90° to the left.

To rotate a displayed document page to the left:
- From the View menu, select Rotate Left.

**Rotate Right**
This command rotates the displayed page 90° to the right.

To rotate a displayed document page to the right:
- From the View menu, select Rotate Right.

**Using the Magnifier**
AppXtender provides a Magnifier feature that allows you to pinpoint an area of an image to zoom. When the Magnifier button is selected, the mouse pointer becomes a magnifier, and a click of the mouse displays the selected document region in the Magnifier dialog box.

You can use the Magnifier with the following page types:

- Images
- COLD/ERM with Image Overlay

To use the Magnifier:

1. From the View menu, select Zoom and then Magnifier. The Magnifier dialog box appears, and the mouse pointer changes to a magnifying glass.
Page View Functions Available for Multiple Page Types

Figure 159  Magnifier Dialog Box

2. You have the following choices:
   - Click the image in the area that you want to magnify. A dotted rectangle appears where you clicked and the image within that rectangle is magnified in the Magnifier dialog box.
   - Drag the mouse pointer over the image. The mouse pointer changes to include a dotted rectangle. As you drag the pointer, the image within the dotted rectangle is magnified in the Magnifier dialog box. When you release the mouse button, the dotted rectangle remains on the image and the image within that rectangle remains magnified in the Magnifier dialog box.

Figure 160  Document Display View with Magnified Area

3. You can change the zoom percent in the Magnifier dialog box.
   - To increase the magnification, slide the arrow to the right.
   - To decrease the magnification, slide the arrow to the left.
   The display in the Magnifier window changes to reflect the new magnification.
**Using Scale-to-Gray**

A selected bi-tonal (black and white) document can be scaled to gray to increase readability. You can use Scale-To-Gray with the following page types:
- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay

To increase readability:
- From the View menu, select the Scale-to-Gray option.

**Using Regions**

You can select regions of an image or text page and process those regions in many ways. You can also print a region or process it with OCR. For more information, refer to "Printing or Faxing a Region" on page 381 and "Document and Page OCR" on page 403.

You can use regions with the following page types:
- Images
- ERM with Image Overlay
- ERM with Text Overlay
- ERM/Text with no overlay
- Text (as defined in the File Types tab of the Configuration dialog box)

**Note:** For more information on defining file types in the Configuration dialog box, consult your system administrator or refer to the "Configuring AppXtender Workstations" section of the ApplicationXtender Installation Guide.
Enabling Select Mode

When pages are first displayed in AppXtender, the view mode is defaulted to Pan mode. Pan mode viewing is identified by the AppXtender cursor appearing as a hand in the interface. In order to select a region of a page for processing, you must change the AppXtender page viewing mode from Pan to Select.

To change page view mode from Pan to Select:

- If the page currently displayed is in Pan mode, click the Pan Mode button in the toolbar.

![Pan Mode Button](image)

Figure 161 Pan Mode Button

The button is "disabled" and the cursor, when placed over the displayed page, changes to an arrow.

To return page view mode from Select to Pan:

- If the page currently displayed is in Select mode, click the Pan Mode button in the toolbar. The button is "enabled" and the cursor, when placed over the displayed page, changes to a hand.

Drawing a Region

When you draw a region, you are selecting a region for processing. You can draw a region on the following page types:

- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay
- Text (as defined in the File Types tab of the Configuration dialog box)

Note: For more information on defining file types in the Configuration dialog box, consult your system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.
To draw a region:
1. Make sure that Pan Mode is disabled. For information, refer to “Enabling Select Mode” on page 327.
2. Drag the pointer over the region you want to select. As you drag the pointer, it draws a rectangle and highlights the area within the rectangle in green. This rectangle is the selected region.

**Magnifying a Region**

The Magnify Region feature allows you to focus on one region of an image and enlarge it for better viewing or manipulation.

You can magnify a region on the following page types:
- Images
- COLD/ERM with Image Overlay

To magnify a region:
- Right-click the highlighted region. From the shortcut menu that appears, select Magnify.
If Magnify is selected, the region appears with its enlarged view in a Magnify window. The Magnify window has its own menu bar, with File and Edit commands.

![Magnify Window](image)

**Figure 163** Magnify Window

You have several choices. The following table describes commands that you can use in the File menu and Edit menu of the Magnify window:

<table>
<thead>
<tr>
<th>To Do This</th>
<th>From This Magnify Menu</th>
<th>Select This Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the magnified region to a separate file. (Print privilege is required.)</td>
<td>File</td>
<td>Save As</td>
</tr>
<tr>
<td>Print the magnified region. (Print privilege is required.)</td>
<td>File</td>
<td>Print</td>
</tr>
<tr>
<td>Exit the Magnify window.</td>
<td>File</td>
<td>Exit</td>
</tr>
<tr>
<td>Copy the region to the Windows Clipboard. (Print privilege is required.)</td>
<td>Edit</td>
<td>Copy</td>
</tr>
<tr>
<td>Preserve the magnified region’s original height/width ratio.</td>
<td>Edit</td>
<td>Keep Aspect Ratio</td>
</tr>
<tr>
<td>Display information about the magnified region, such as size, width, and height.</td>
<td>Edit</td>
<td>Information</td>
</tr>
</tbody>
</table>

**Note:** Only users with the Print privilege can perform operations that result in information “exported” from the AppXtender system. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.
If you have the Print privilege, you can copy a region on the following page types:

- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay
- Text (as defined in the File Types tab of the Configuration dialog box)

**Note:** For more information on defining file types in the Configuration dialog box, consult your system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the *ApplicationXtender Installation Guide*.

When you copy a region to the Windows Clipboard, you copy the data in that region in its native format.

To copy a region to the Windows Clipboard:

1. Right-click the highlighted region.
2. You have the following choices:
   - From the shortcut menu that appears, select Copy. The image in the selected region is copied to the Windows Clipboard.
   - From the shortcut menu that appears, select Cut. The image in the selected region is copied to the Windows Clipboard and the region is cleared.

For information on using the contents of the Windows Clipboard to create new documents and pages in AppXtender, refer to “Adding a Document from the Windows Clipboard” on page 150.

**Note:** Only users with the Print privilege can perform operations that result in information “exported” from the AppXtender system. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” section of the *ApplicationXtender Core Components Administrator’s Guide*. 
Clearing Regions

When you clear a region, you clear the selection of that region. When you clear all regions, you clear the selection of any regions selected on the document page. You can clear a region on the following page types:

- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay
- Text (as defined in the File Types tab of the Configuration dialog box)

**Note:** For more information on defining file types in the Configuration dialog box, consult your system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

To clear regions:

1. Right-click the highlighted region.
2. You have the following choices:
   - From the shortcut menu that appears, select Clear All Region(s). All of the regions on the page are cleared.
   - From the shortcut menu that appears, select Delete. The region is cleared.

**Note:** The Delete command does not change or remove pixels from the image.
Viewing Specific Page Types

Each of the specific page types has functionality that is exclusively available with that page type. For information on viewing options that are only available for specific page types, refer to the following topics:

◆ “Viewing Image Pages” on page 332
◆ “Viewing Text Pages” on page 333
◆ “Viewing PDF Files” on page 338
◆ “Viewing Foreign Files” on page 338
◆ “Viewing OLE Objects” on page 342

Viewing Image Pages

When you are viewing a page that is an image, you can OCR the contents of the image and then switch between the image view and the OCR text view as needed. For more information on processing a document, page, or page region using OCR, refer to “Document and Page OCR” on page 403.

When image documents or pages have been processed using OCR, you can view them in either text or image format. Using the View menu or the Show OCR Text button on the Image toolbar, you can toggle between text or image view.

To switch views:

◆ From the View menu, select OCR Text.

If you have FineReader 7.0 installed and selected as the AppXtender OCR engine, and if you have AppXtender configured to use a forms template during OCR processing, the text view contains only the text specified by the FineReader template. Otherwise, the text view contains all of the text on the image. For information on selecting an OCR engine, and for information on configuring AppXtender to use a forms template during OCR processing, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

For information on processing a document or page using OCR, refer to “Document and Page OCR” on page 403.
Viewing Documents

Viewing Text Pages

For more information, refer to the following topics:

- “Viewing Documents with Form Overlay” on page 333
- “Title Locking on Text Pages” on page 335
- “Customizing Color Bar Settings for an Application” on page 335

Viewing Documents with Form Overlay

Depending on your AppXtender configuration, you can display text documents with an image form overlay, with a text overlay, or in a plain text view without an overlay. When text documents are displayed in plain text or using a text form overlay, they appear as text documents. When text documents are displayed using an image form overlay, they appear as images. Using the View menu or the Form Overlay button on the Image toolbar, you can toggle between text or image view. (Form overlays cannot be added to PDF documents.)

COLD/ERM Display as Image Only

The Display as Image Only option in the AppXtender Configuration dialog box restricts you from viewing a text document with a text form overlay or in plain text view without form overlay. If your AppXtender workstation is configured to Display as Image Only, you can only view COLD/ERM documents with form overlay using an image form overlay. For information on configuring Display as Image Only on your AppXtender workstation, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

**Note:** Only users with the Configure WS privilege can configure the Display as Image Only option. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

To switch views:

- From the View menu, select Form Overlay and then Image.

For information on creating a form overlay, refer to the ApplicationXtender Reports Management Administrator’s Guide.
Modifying the Form Overlay
You can make changes to the layout of form overlays from within AppXtender. The modifications can be applied and viewed while the text document is displayed. Both image and ASCII form overlays can be modified.

Note: Only the SYSOP user or users with the Configure WS privilege can change the position of a form overlay. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

To change the settings for an overlay:

1. To display a document with a form, from the View menu, select Form Overlay and then Position. AppXtender displays the COLD Form Position dialog box. The text is displayed in a grayed out region on the form.

2. Make changes to the text positioning, and click Update at any time to apply the changes without exiting. The following table describes some different methods to change each aspect of the text positioning:

<table>
<thead>
<tr>
<th>To Change This</th>
<th>Enter a New Value in This Text Box</th>
<th>Click This Button</th>
<th>Drag This to a New Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>The left offset</td>
<td>Left</td>
<td>Left or Right</td>
<td>The text region</td>
</tr>
<tr>
<td>The top offset</td>
<td>Top</td>
<td>Up or Down</td>
<td>The text region</td>
</tr>
<tr>
<td>The characters per inch (CPI)</td>
<td>CPI</td>
<td></td>
<td>The left or right border of the text region</td>
</tr>
<tr>
<td>The lines per inch (LPI)</td>
<td>LPI</td>
<td></td>
<td>The top or bottom border of the text region</td>
</tr>
</tbody>
</table>

3. Click OK. The COLD Form Position dialog box closes and the changes you made are applied.
Title Locking on Text Pages

AppXtender allows you to partition a text page vertically or horizontally, creating a non-scrollable title region. Data above a horizontal title and data to the left of a vertical title becomes stationary, while the data below or to the right of the title can still be browsed.

Using this feature, a line of existing text can be transformed into a title (or heading) for the text below. This feature can be useful in cases where the headings for lengthy columns normally scroll off the screen as you move down the page. Setting a title directly below those headings keeps them in place even when displaying data several screens below.

To lock a title on a document:

1. Display the appropriate document.
2. Enable Pan Mode (if necessary) by clicking the Pan Mode button on the toolbar. When Pan Mode is enabled, this button should appear pushed in, and your cursor, when placed over the displayed page, turns into a hand.
3. Right-click the area where you want to apply the title lock.
4. From the shortcut menu that appears, select either Set Horizontal Title, Set Vertical Title, or Set Horizontal and Vertical Title. AppXtender adds a blue line indicating the location of the title.
   Text to the left of vertical titles or above horizontal titles does not scroll.

To clear a title lock:

- Right-click the page. From the shortcut menu that appears, select Clear Title.

Note: Titles remain in place if the document is minimized, but clear when you navigate to another page or when you close the document.

Customizing Color Bar Settings for an Application

The COLD tab of an application’s Properties dialog box allows you to view text documents with a “color” bar background. When a document is displayed with the Color Bar enabled, the background is composed of alternating bars of a selected color and white. Each band is the width of three lines (in the default setting). You can change the color and the width of the bands.
Viewing Documents

This feature applies primarily to documents generated by ApplicationXtender Reports Management. If your AppXtender workstation has any file extensions associated with the Text file type, the color bar feature also applies to files with these extensions. For instructions on configuring file types, consult your system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

The default color bar settings for all applications are configured in the COLD tab of the AppXtender Configuration dialog box. For instructions, consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide. You can customize the color bar settings for the text documents in an application.

To customize color bar settings for an application:

1. Right-click an application. From the shortcut menu that appears, select Properties. The Properties dialog box for the selected application appears.
2. Click the COLD tab.

![Application Properties Dialog Box: COLD Tab](image)
3. Click the Use default color bar settings check box to clear it. The color bar settings for the selected application are now controlled by the Properties dialog box for the application, rather than the AppXtender Configuration dialog box for the workstation.

![Application Properties Dialog Box: COLD Tab](image)

4. Click the Show color bar check box to specify whether you want the color bar to appear for text documents. A check mark indicates that color bar is on. No check mark indicates that color view is off.

5. Specify the width of the color bar. In the Lines box, type the number of lines that you want to use or select the number by using the up or down arrow.

6. Specify the color to be used in the color bar. In the Color list, click the color of your choice. (If the color that you want to use is not listed, select Custom. The standard Windows Color dialog box appears, allowing you to create a color for the color bar.)

7. When all desired settings have been selected, choose one of the following options:
   - Click OK to save changes and close the dialog box.
   - Click Cancel to close the dialog box without saving changes.
   - Click Apply to save changes and keep the dialog box open.
Viewing Documents

**Viewing PDF Files**

AppXtender uses Adobe PDF Library to display Portable Document Format (PDF) files. The PDF file appears in PDF format in the Document Display view.

**Viewing Foreign Files**

Typically, AppXtender-supported foreign files are displayed in the Document Display view as icons. However, when you enable the ApplicationXtender Web Access Verity KeyView (AppXtender Web KeyView Viewer) feature, AppXtender can display the contents of a foreign file. This feature allows you to access the contents of the file without a third-party viewer. If you want to view the contents of a Microsoft Word file, for example, you do not need to have a native application, such as Microsoft Word, installed on your workstation. The appearance of a foreign file in ApplicationXtender Web Access Verity KeyView is similar to its appearance in its native viewer, but not exactly the same.

When the content of an AppXtender-supported foreign file is displayed, you can launch the foreign file in its native application. For more information, refer to “Launching Foreign Files” on page 339.

You can also access page information for a foreign file from a shortcut menu (if it is displayed as an icon). For details on viewing information for a document page, refer to “Page Information” on page 353.

For a list of the foreign files that can be viewed using the AppXtender Web KeyView Viewer Viewer feature, refer to “Creating _RSTAMP and _FORMS Documents” on page 170.

**Configuring a Viewer for Foreign Files**

The Use AppXtender Web KeyView Viewer to display foreign files option on the View tab of the AppXtender Configuration dialog box controls whether the AppXtender Web KeyView Viewer is used to display foreign files in the Document Display view. You can enable the Use KeyView to display foreign files option to cause AppXtender to display foreign files using the AppXtender Web KeyView Viewer. If you disable the option, AppXtender displays foreign files as icons.

To configure foreign file display:

1. From the File menu in ApplicationXtender, select Configuration. The AppXtender Configuration dialog box appears.
2. Click the View tab to activate it.
3. You have the following choices:

- To use the AppXtender Web KeyView Viewer to view foreign files, enable the Use KeyView to display foreign files option. For additional information about viewing foreign files with AppXtender Web KeyView Viewer, refer to “Viewing Foreign Files with the AppXtender Web KeyView Viewer” on page 339.

- To view foreign files as icons, disable the Use AppXtender Web KeyView Viewer to display foreign files option. For additional information about viewing foreign files as icons, refer to “Viewing Foreign Files as Icons” on page 339.

**Viewing Foreign Files with the AppXtender Web KeyView Viewer**

When you view a foreign file using the AppXtender Web KeyView Viewer, the contents of the file display in the Document Display view.

When you display a foreign file with the AppXtender Web KeyView Viewer, they are read-only. However, you can also launch the foreign file in its native application for editing, even when it is displayed using the AppXtender Web KeyView Viewer. For instructions, refer to “Launching Foreign Files” on page 339.

**Viewing Foreign Files as Icons**

When you do not enable use of the AppXtender Web KeyView Viewer with foreign files, an icon represents the file in the Document Display view.

When foreign files are displayed as icons, you can access page information or document view properties from the Document Display view. You can also launch the foreign file in its native application. For instructions, refer to the following topics:

- “Launching Foreign Files” on page 339
- “Page Information” on page 353
- “Document View Properties” on page 344

**Launching Foreign Files**

You can launch a foreign file to edit it in the source application for the foreign file as long as you have the source application installed on your workstation. When you finish working in the application, you exit the application. You can then choose to save the revised file as a new page version of the page from which you launched the file, replace the original page version with the new page version, or cancel changes to the file (depending on your user privileges).
User privileges affect your ability to edit foreign files. If your user profile does not include the Add Page privilege, the changes that you make while editing the object are not saved in AppXtender. If your user profile does not include the Delete Page privilege, you are only allowed to save the edited foreign file as a new page version or discard changes.

If you are running AppXtender in check in/check out mode and you opened the displayed document in read-only display mode, you can still launch the foreign file and edit it, but changes to the file are not saved when you close it. If a document is in read-only mode, the document name in the title bar should have “-RO” after it.

To launch a foreign file and edit it:

◆ From the Page menu, select Launch Foreign File.

The source application for the foreign file opens. For information on editing the object, refer to the documentation for the source application.

![Foreign File in Source Application](image)
Closing a Foreign File  
To close the foreign file and return to the Document Display view:
1. From the File menu for the source application, select Exit.
2. The behavior of AppXtender after you close the source application depends on your user permissions.
   • If the Update Foreign File dialog box appears, refer to “Updating a Foreign File” on page 341.

Figure 167 Update Foreign File Dialog Box

- If a message asking whether you would like to save the file as a new page version appears, refer to “Saving a Foreign File” on page 342.

Updating a Foreign File
To update a foreign file:
- If the Update Foreign File dialog box appears, you have the following choices:
  • To save the updated file as a new page version in the page from which you launched the file, select Save this file as a new page version and click OK.
  • To replace the page version from which you launched the file with the updated file, select Replace existing page version with this file and click OK.
  • To discard any changes you made to the foreign file and revert to the version of the file before you edited it, select Discard the changes made to this file and click OK.
  • To discard any changes you made to the foreign file and revert to the version of the file before you edited it, click Cancel.
Viewing Documents

Saving a Foreign File
To save the foreign file as a new page version or cancel changes:

- If a message appears asking whether you would like to save the file as a new page version, you have the following choices:
  - To save the updated file as a new page version in the page from which you launched the file, click Yes.
  - To discard any changes you made to the foreign file and revert to the version of the file before you edited it, click No.

Viewing OLE Objects

You can activate an OLE Object and edit it in the AppXtender Document Display view as long as the source application for the OLE Object is installed on your AppXtender workstation.

User privileges affect your ability to edit foreign files. If your user profile does not include the Add Page privilege, the changes you make while editing the object are not saved in AppXtender.

If you are running AppXtender in check in/check out mode and you opened the displayed document in read-only display mode, you can still activate the OLE Object and edit it, but changes to the file are not saved when you close it. If a document is in read-only mode, the document name in the title bar should have “-RO” after it.

OLE embeddable objects can be displayed and edited in AppXtender either as an icon or as the object content. The following table describes each display method.

<table>
<thead>
<tr>
<th>Display Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td>The object is embedded (stored) in the document, and a graphic representation of the object appears in the Document Display view. By double-clicking the page, you can view or edit the object in its native format. Any changes to the object are immediately reflected in the AppXtender document.</td>
</tr>
<tr>
<td>Content</td>
<td>The content of the object appears in the Document Display view. By double-clicking the page, you can edit the object in its native format. Any changes to the object are immediately reflected in the AppXtender document.</td>
</tr>
</tbody>
</table>
For an example of each of these display methods, refer to the following figures.

To edit an OLE Object:

- Double-click the icon or image. The source application menus replace the AppXtender menus. For information on editing the object, refer to the documentation for the source application.

To close the object and return to the Document Display view:

- From the File menu, select Close.

To return to the Document Display view without saving changes:

- From the File menu, select Cancel.
Document View Properties

ApplicationXtender (AppXtender) allows you to modify the view properties of a displayed page. The AppXtender Configuration dialog box allows you to set default parameters that are used when displaying a document or page in AppXtender. However, you can use the Properties dialog box to customize your page display for only the displayed page. There are four tabs in the Properties dialog box – General, Image, Text, and OCR. Each tab has options that allow you to customize the view for the displayed document. The following topics detail each tab:

◆ “General Tab” on page 344
◆ “Image Tab” on page 346
◆ “Text Tab” on page 348
◆ “OCR Tab” on page 350

Note: This feature is available for foreign files displayed as icons, but not for foreign files displayed with KeyView. For instructions on displaying foreign files as icons, refer to “Configuring a Viewer for Foreign Files” on page 338.

General Tab

The General tab allows you to configure mouse action and document display options.

To configure mouse action and document display for a page:

1. Right-click the document. (If you are using the Acrobat Viewer to display a PDF file within the Document Display view, right-click the Acrobat Viewer toolbar.)

2. From the shortcut menu that appears, select Properties. The Properties dialog box appears. Click the General tab.
3. Enable the options you want to use. The following table provides details on each option.

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Do This</th>
<th>Default Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make the mouse pointer into a scrolling device so that you can drag the</td>
<td>Enable the Scroll image option.</td>
<td>Enabled</td>
</tr>
<tr>
<td>image in Document Display view to a new position.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Make the mouse a selection tool so that you can draw regions around all</td>
<td>Enable the Select image option.</td>
<td>Disabled</td>
</tr>
<tr>
<td>or a part of the image in Document Display view for processing.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Make the mouse a selection tool so that you can select annotations for</td>
<td>Enable the Select annotation option.</td>
<td>Disabled</td>
</tr>
<tr>
<td>processing.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Do not allow the shortcut menu to appear when you right-click a document</td>
<td>Uncheck the Right-click context menu option.</td>
<td>Disabled</td>
</tr>
<tr>
<td>in the display view (default).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow the shortcut menu to appear when you right-click a document in the</td>
<td>Close the displayed document and re-open.</td>
<td>Enabled</td>
</tr>
<tr>
<td>display view (after it has been disabled).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow the horizontal or vertical scrollbars to display in Document</td>
<td>Enable the Display scrollbars option.</td>
<td>Enabled</td>
</tr>
<tr>
<td>Display view.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specify the zoom ratio for the document image in Document Display view.</td>
<td>In the Zoom ratio text box, enter a value.</td>
<td>(Depends on</td>
</tr>
<tr>
<td></td>
<td></td>
<td>settings in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AppXtender</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>dialog box,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display tab)</td>
</tr>
</tbody>
</table>
Some of these options can be implemented more easily with toolbar buttons. The following table lists these options and their corresponding toolbar buttons:

<table>
<thead>
<tr>
<th>Option</th>
<th>Toolbar Button</th>
<th>For More Information, Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll image</td>
<td>![Scroll image icon]</td>
<td>“Document Display View” on page 67</td>
</tr>
<tr>
<td>Select image</td>
<td>![Select image icon]</td>
<td>“Using Regions” on page 326</td>
</tr>
<tr>
<td>Select annotation</td>
<td>![Select annotation icon]</td>
<td>Chapter 9, “Annotations,”</td>
</tr>
<tr>
<td>Zoom ratio</td>
<td>![Zoom ratio icons]</td>
<td>“Using Zoom” on page 321</td>
</tr>
</tbody>
</table>

4. When all desired options have been configured, you have the following choices:
   - Click OK to save changes and exit the dialog box.
   - Click Cancel to exit without saving changes.
   - Click Apply to save any changes you have made without exiting the dialog box.

**Image Tab**

The Image tab provides display and screen resolution options for the current page, if it is an image.

To configure display and screen resolution for an image:

1. Right-click the document. From the shortcut menu that appears, select Properties. The Properties dialog box appears. Click the Image tab.
2. Enable the options you want to use. The following topics describe each option:
   - “Display Palette” on page 347
   - “Display Image in its Actual Scale” on page 348
   - “Screen Resolution” on page 348
3. When all desired options have been configured, you have the following choices:
   - Click OK to save changes and exit the dialog box.
   - Click Cancel to exit without saving changes.
   - Click Apply to save any changes you have made without exiting the dialog box.

**Display Palette**

The Display palette drop-down list provides options for viewing the image in a variety of palettes. Keep in mind that image size, image clarity, and file size increase with the number of colors in a palette. Also, keep in mind that file processing slows as file size increases.
For a color image, you have the following choices:

- Median Cut Palette
- Fixed Palette
- 3-3-2 Palette
- Thumbnail Palette
- 1-1-1 Palette
- Monochrome Palette
- 16 Gray Shades Palette
- 256 Gray Shades Palette
- Bayer - Monochrome
- Bayer - 4 Gray Shades
- Bayer - 16 Gray Shades
- Bayer - Fixed Palette
- Bayer - 3-3-2 Palette
- Bayer - 1-1-1 Palette
- Floyd/Steinberg - Monochrome
- Floyd/Steinberg - 4 Gray Shades
- Floyd/Steinberg - 16 Gray Shades

For a bi-tonal (black and white) image, you have the following choices:

- Monochrome Palette
- Scale to Gray - 16 Shades
- Scale to Gray - 256 Shades

**Display Image in its Actual Scale**

A check mark in this box allows the image to be scaled to its actual size. (This option can be implemented more easily with a menu command. For information, refer to “Actual Size” on page 324.)

**Screen Resolution**

This option is available only when you enable the Display image in its actual scale check box. If you enable the Use customized screen display resolution (DPI) check box, AppXtender allows you to designate customized horizontal or vertical settings. (The default values in the Horizontal and Vertical boxes depend on the settings in the Display tab of the AppXtender Configuration dialog box. For more information, refer to “Screen DPI” on page 114.)

**Text Tab**

The Text tab provides various display options for currently displayed text documents.

To configure display options for a text document:

1. Right-click the document. From the shortcut menu that appears, select Properties. The Properties dialog box appears. Click the Text tab.
2. Enable the options you want to use. The following table provides information on each option.

### Table 46  AppXtender View Control Properties - Text Tab Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Select this option to display the text document with a color bar background (helps make documents with information in columns more readable).</td>
</tr>
<tr>
<td>Height (Lines)</td>
<td>To configure the height of each color bar, enter the number of lines to display with the selected color.</td>
</tr>
<tr>
<td>Select Font</td>
<td>Select the font type for text document display.</td>
</tr>
<tr>
<td>Bold</td>
<td>Select this option to display font in bold.</td>
</tr>
<tr>
<td>Italic</td>
<td>Select this option to display font in italics.</td>
</tr>
<tr>
<td>Tab Size</td>
<td>Type in a number or use the arrows to enter the number of characters for tab settings within a text document. Tabs are automatically set at intervals of that length within the text document.</td>
</tr>
<tr>
<td>Form Overlay</td>
<td>Select the type of form overlay for this document: No overlay, ASCII overlay, or Image overlay.</td>
</tr>
<tr>
<td>Overlay Font</td>
<td>Select the font type for form overlay display.</td>
</tr>
</tbody>
</table>

**Note:** The Form Overlay option can be implemented more easily with the Form Overlay toolbar button. For more information, refer to “Viewing Documents with Form Overlay” on page 333.
Viewing Documents

3. When all desired options have been configured, you have the following choices:
   - Click OK to save changes and exit the dialog box.
   - Click Cancel to exit without saving changes.
   - Click Apply to save any changes you have made without exiting the dialog box.

---

OCR Tab

The OCR tab provides options for optical character recognition (OCR) output.

To display the Properties dialog box:

1. Right-click the document. From the shortcut menu that appears, select Properties. The Properties dialog box appears. Click the OCR tab.

---

Figure 171 AppXtender View Control Properties: OCR Tab
2. Enable the options you want to use. The following table provides basic information on each option. For more detailed information, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

Table 47  AppXtender View Control Properties - OCR Tab Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCR Engine</td>
<td>This option allows you to select the OCR engine for AppXtender to use. Your choices are:</td>
</tr>
<tr>
<td></td>
<td>• FineReader OCR Engine</td>
</tr>
<tr>
<td></td>
<td>• FineReader (available only if FineReader 7.0 Professional has been installed on the AppXtender workstation)</td>
</tr>
<tr>
<td></td>
<td>When you select FineReader as the OCR Engine, the Enable Proofing, Use Forms, and Setup Form Templates options become available.</td>
</tr>
<tr>
<td>OCR Language</td>
<td>This option allows you to select a language for OCR processing.</td>
</tr>
<tr>
<td>OCR Result Format</td>
<td>This option allows you to select the file format for output from the OCR engine. Options include Plain text and Rich Text Format (RTF).</td>
</tr>
<tr>
<td>Enable Proofing</td>
<td>If you have installed FineReader 7.0 and have selected FineReader as the OCR engine, this option allows you to perform OCR proofing when you process the document with OCR.</td>
</tr>
<tr>
<td>Use Forms</td>
<td>If you have installed FineReader 7.0 and have selected FineReader as the OCR engine, this option allows you to use FineReader forms when you process the document with OCR.</td>
</tr>
<tr>
<td>Setup Form Templates</td>
<td>If you have installed FineReader 7.0 and have selected FineReader as the OCR engine, this option allows you to configure the FineReader template that AppXtender uses when you process an image with OCR.</td>
</tr>
</tbody>
</table>

An explanation of the OCR Result Formats is provided in the following table.
**Note:** If Rich Text Format is selected, documents processed using OCR cannot be indexed using OCR Proofing. Only plain text documents can be indexed using OCR Proofing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain text</td>
<td>The plain text format is an ASCII text format, readable on MS-DOS/Windows operating systems. Plain text format retains formatting options that are available in MS-DOS text format, such as bold and italics.</td>
</tr>
<tr>
<td>Rich Text Format (RTF)</td>
<td>Rich Text Format is a format that can be read on all platforms. This format should be used if the document text is exported for use on non-MS-DOS/Windows systems. Rich Text Format retains most formatting.</td>
</tr>
</tbody>
</table>

3. When all desired options have been configured, you have the following choices:
   - Click OK to save changes and exit the dialog box.
   - Click Cancel to exit without saving changes.
   - Click Apply to save any changes you have made without exiting the dialog box.
Page Information

AppXtender supplies valuable information for every page of a document. This can be useful in determining the size of a particular image, for example, or the path location.

Note: This feature is available for foreign files displayed as icons, but not for foreign files displayed with KeyView. For instructions on displaying foreign files as icons, refer to “Configuring a Viewer for Foreign Files” on page 338.

To view information for a document page:

1. Display the page in AppXtender.
2. Right-click the page. (If you are using the Acrobat Viewer to display a PDF file within the Document Display view, right-click the Acrobat Viewer toolbar.)
3. From the shortcut menu that appears, select Information. The Image Information dialog box appears, open to the Information Tab.

The Information tab provides the following details:

<table>
<thead>
<tr>
<th>Info</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Number of pixels or characters being used for width of page.</td>
</tr>
<tr>
<td>Height</td>
<td>Number of pixels or lines being used for height of page.</td>
</tr>
<tr>
<td>Bits Per Pixel</td>
<td>Number of bits for each pixel.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Resolution of the page.</td>
</tr>
</tbody>
</table>

Figure 172  Information Tab

Table 49  Image Information - Information Tab Options
4. To view information specific to the files associated with the document, click the Files tab.

![Image Information Dialog Box: Files Tab](image)

The Files tab provides the following details:

<table>
<thead>
<tr>
<th>Info</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Filename</td>
<td>Path location and file name of the stored page.</td>
</tr>
<tr>
<td>Annotation Filename</td>
<td>Path location and file name of the page's annotations, if any.</td>
</tr>
</tbody>
</table>
A full range of document management functionality is available in ApplicationXtender, including the ability to print, fax, e-mail, delete, and export documents and pages. AppXtender supports standard interfaces, so special print or fax drivers are not necessary to use the print and fax functions. Users may also modify a document’s index.

Note: Only users with the Print privilege can perform operations that result in information “exported” from the AppXtender system. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.
Managing Documents

Adding Pages to Documents

As soon as a document has been created, additional pages can be attached as you require. Subsequent pages can be the same file type as the first page or any other file type. Pages can be inserted before or after the displayed page, or appended to the end of the active document.

ApplicationXtender has safeguards in place to prevent mismanagement of document pages. Additional pages cannot be added to the wrong document, because the desired document must be displayed to add pages. The document’s title bar always shows the active page and total number of pages. Different versions of a single page can also be created, allowing users to structure closer associations between one object and another.

Before attaching a new page to a document, make sure that the desired document is displayed and, if necessary, checked out by you. For more information on checking out and displaying a document, refer to Chapter 5, “Retrieving Documents,”. All commands for page management are located in the Page menu on the main screen.

ApplicationXtender allows for various methods of input, such as scanning, using the Windows Clipboard, inserting an object, or importing a file, so there is no restriction on a document’s structure or content. The input methods are discussed here in detail.

Adding a Page by Scanning

Additional pages can be added from any scanner supported or certified for use with ApplicationXtender. For detailed scanning procedures, refer to “Scanning Pages” on page 227. For a list of supported and certified scanners, refer to “Selecting a Scanner” on page 214.

Adding a Page from the Windows Clipboard

ApplicationXtender allows for the sharing of data between programs using the Windows Clipboard. The contents of the Clipboard can be pasted into AppXtender as a new page. Because the Clipboard holds any type of data, the new page can be an image, data from another application (such as Microsoft Word or PowerPoint), or even a page from a different AppXtender application.
Your ability to view the resulting page depends on the type of file you have copied and pasted. If AppXtender supports the file type that you copy and paste, the content of the file appears in the Document Display view. Unsupported file types, or foreign file types, are represented in the Document Display view by an icon (unless the KeyView Viewer is enabled). AppXtender stores foreign file types in their native file format. For more information, refer to “Support for Viewing of Imported Files in AppXtender” on page 143.

Pages can be pasted before or after a displayed page, or appended to the end of a document. For more information, refer to:

◆ “Adding a Page by Pasting” on page 357
◆ “Adding a Page in a Selected Format” on page 358

Adding a Page by Pasting

To add a page from the Windows Clipboard:

1. Move the desired data to the Windows Clipboard. Typically, this is performed through a program’s Edit menu, and some programs have shortcuts to accomplish this function.

2. Make sure that the appropriate document is currently displayed. For instructions, refer to “Displaying AppXtender Documents” on page 276.

3. From the Page menu, select New and then Clipboard Paste. A shortcut menu appears.

Note: If there is not a valid page in the Windows Clipboard, ApplicationXtender dims the Insert After, Insert Before, and Append menu options, meaning they are not available for selection. If this is the case, verify that the data has been moved to the Clipboard successfully. The Clipboard viewer (supplied with Windows) can be used to view the contents of the Clipboard at any time.
4. You have the following choices:
   • If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   • If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   • If you want the new page to be added as the last page in the document, select Append.

   The content of the Clipboard appears in the Document Display view as a new page.

Adding a Page in a Selected Format

To paste a page in a different format:
1. Move the desired data to the Windows Clipboard. Typically, this is performed through a program’s Edit menu, and some programs have shortcuts to accomplish this function.
2. Make sure that the appropriate document is currently displayed. For instructions, refer to “Displaying AppXtender Documents” on page 276.
3. From the Page menu, select New and then Clipboard Paste Special. A shortcut menu appears.
4. You have the following choices:
   • If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   • If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   • If you want the new page to be added as the last page in the document, select Append.
The Paste Special dialog box appears.

![Paste Special Dialog Box](image)

5. Under As, select a format.

6. If the Display As Icon check box is available, indicate how you want the new page to be displayed and edited. You have the following choices:
   - To display the object as an icon, enable the Display As Icon check box.
   - To display the object as its content, disable the Display As Icon check box.

   For information, refer to “Viewing OLE Objects” on page 342.

7. Click OK. The content of the Clipboard appears in AppXtender as a new page.

**Adding a Page by Inserting an Object**

Data from other applications that support ActiveX embeddable objects can be added as pages in existing documents. The object is embedded (stored) in the document, and a graphic representation of the object appears in the Document Display view. To view the page in its native format, double-click the page’s graphic representation. AppXtender starts the source application.
Create New Object

To add a page as a new object:

1. Make sure that the appropriate document is currently displayed. For instructions, refer to "Displaying AppXtender Documents" on page 276.

2. From the Page menu, select New and then Insert Object. A shortcut menu appears.

3. You have the following choices:
   - If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   - If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   - If you want the new page to be added as the last page in the document, select Append.

   An Insert Object dialog box appears, listing all ActiveX server applications on the workstation.

4. Select Create New.

5. Under Object Type, select the name of the application that you want to use to create the new page.
6. Indicate how you want the new page to be displayed and edited. You have the following choices:
   - To display the object as an icon, enable the Display As Icon check box.
   - To display the object as its content, disable the Display As Icon check box.
   For information, refer to “Viewing OLE Objects” on page 342.

7. Click OK.
   - If you enabled the Display As Icon check box, AppXtender starts the source application.
   - If you disabled the Display As Icon check box, the source application menus replace the AppXtender menus.

8. Complete the ActiveX object and return to the AppXtender Document Display view.
   - If you are editing the object in the source application, select Close & Return from the File menu.
   - If you are editing the object in AppXtender, select Close from the File menu.
   AppXtender displays the object as a new page in the Document Display view.

### Insert Object from File
To add a page as an object from an existing file:

1. Make sure that the appropriate document is currently displayed. For instructions, refer to “Displaying AppXtender Documents” on page 276.

2. From the Page menu, select New and then Insert Object. A shortcut menu appears.

3. You have the following choices:
   - If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   - If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   - If you want the new page to be added as the last page in the document, select Append.
An Insert Object dialog box appears, listing all ActiveX server applications on the workstation.

4. Select Create from File to insert the contents of a file into the AppXtender document.

![Insert Object Dialog Box](image)

**Figure 176** Insert Object Dialog Box

5. Enter the path and file name to insert, or click Browse to find the file.

6. Indicate how you want the new page to be displayed and edited. You have the following choices:
   - To display the object as an icon, enable the Display As Icon check box.
   - To display the object as its content, disable the Display As Icon check box.

   For information, refer to “Viewing OLE Objects” on page 342.

7. Click OK.
   - If you enabled the Display As Icon check box, AppXtender starts the source application.
   - If you disabled the Display As Icon check box, the source application menus replace the AppXtender menus.
8. Edit the ActiveX object (if necessary) and return to the AppXtender Document Display view.
   - If you are editing the object in the source application, select Close & Return from the File menu.
   - If you are editing the object in AppXtender, select Close from the File menu.

   AppXtender displays the object as a new page in the Document Display view.

---

**Adding a Page by Importing a File**

You can create a new page by importing an existing file. You can import any file type. Your ability to view the resulting page depends on the type of file you have imported. If AppXtender supports the file type that you import, the content of the file appears in the Document Display view. Unsupported file types, or foreign file types, are represented in the Document Display view by an icon (unless the KeyView Viewer is enabled). AppXtender stores foreign file types in their native file format. For more information, refer to “Support for Viewing of Imported Files in AppXtender” on page 143.

To add a page by importing a file:

1. Make sure that the appropriate document is currently displayed. For instructions, refer to “Displaying AppXtender Documents” on page 276.

2. From the Page menu, select New and then Import File. A shortcut menu appears.

3. You have the following choices:
   - If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   - If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   - If you want the new page to be added as the last page in the document, select Append.
The Import File dialog box appears, allowing selection of any file.

![Import File Dialog Box](image)

**Figure 177 Import File Dialog Box**

4. Navigate to and select the file that you want to import and click Open. AppXtender displays the new page in the Document Display view.

---

**Adding a Page by Dragging a File**

You can create a new page by dragging a file from another program, such as Microsoft Outlook, Microsoft Word, or Windows Explorer. You can drag any file type into AppXtender. Your ability to view the resulting page depends on the type of file you have imported. If AppXtender supports the file type that you import, the content of the file appears in the Document Display view. Unsupported file types, or foreign file types, are represented in the Document Display view by an icon (unless the KeyView Viewer is enabled). AppXtender stores foreign file types in their native file format. For more information, refer to “Support for Viewing of Imported Files in AppXtender” on page 143.

To add a new page by dragging a file:

1. Make sure that the appropriate document is currently displayed. For instructions, refer to “Displaying AppXtender Documents” on page 276.

2. Drag the file from Windows Explorer and drop it in the AppXtender Document Display view. AppXtender adds the page before the currently displayed page, and the new page appears in the Document Display view.
Adding a Page from the Fax-in Queue

This topic describes the addition of a single page by fax-in queue. To add a page by fax-in queue:

1. Make sure that the appropriate document is currently displayed.
2. From the Page menu, select New and then Fax-in Queue. A shortcut menu appears.
3. You have the following choices:
   - If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   - If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   - If you want the new page to be added as the last page in the document, select Append.
4. If the Login to Fax Server dialog box appears, enter the name of the fax server, your user name, and your password.

Figure 178 Login to Fax Server Dialog Box

5. If you are using Castelle FAX Press for your Fax In Server, you have the following choices:
   - If you want to import faxes from your personal queue, enable the Import from personal queue check box.
   - If you want to import faxes from the unassigned queue, disable the Import from personal queue check box.
Managing Documents

Note: The Import from personal queue check box does not appear on the Login to Fax Server dialog box if you are using RightFax for your fax-in server.

6. Click Login. The FAX Server Import dialog box appears, listing each of the incoming faxes from the selected queue (personal or unassigned).

![FAX Server Import Dialog Box](image)

**Figure 179 FAX Server Import Dialog Box**

Note: If you are using RightFax for your fax-in server, you can customize the way columns display in the FAX Server Import dialog box. Customizable options include column title, column order, which columns appear, and the type of faxes that appear. For more information, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

7. If you want to preview faxes in the list, click the Preview check box. The faxes in the currently selected queue appear in AppXtender. Use the Prev and Next buttons to navigate through the fax-in queue, page by page.

8. If you want to delete a fax, select the fax that you want to delete and click Delete.

9. If you do not want the selected fax to be deleted after you import it, click the Delete after import option to disable the option.
10. If you want to copy the fax’s index information to replace the index information for the document to which you are adding the page, right-click on the fax. From the shortcut menu that appears, select Copy.

**Note:** In order to copy and paste index information, the columns in the FAX Server Import dialog box must have the same labels and appear in the same order as the fields in the Index view once the fax has been imported.


---

## Replacing Pages

ApplicationXtender can replace an unwanted page with a new page in one function. Separate add and delete commands are not necessary.

To replace a page:

1. Display the page that you want to replace.
2. From the Page menu, select Replace and then the appropriate source for adding the new page. A message appears requesting confirmation that you want to proceed with the page replacement.

![Replace Page Confirmation Message](Figure 180)

3. Click Yes. AppXtender automatically deletes the displayed page. Depending on the type of page you selected, a dialog box may appear, just as if you were simply adding a page. For instructions, refer to “Adding Pages to Documents” on page 356.
Page Versions

ApplicationXtender provides page versioning as a flexible way to organize and group document pages. Several variations or versions can be created but still contained as one page. For example, one page could hold an original image, a de-skewed version of the image, and a completely enhanced version of the image. You can add up to 255 versions for a page. The most recent version of the page is displayed with the document.

The AppXtender status bar and the AppXtender title bar both indicate the version number of the currently displayed version and the total number of versions in the page. For example, if a page has three versions and the second version is displayed in the Document Display view, the title bar indicates "Version 2 of 3" and the status bar indicates "Ver 2/3".

A version can be any object type. Even though the original page contains an object, for instance, other versions of the page could be an image or an import file.

A new version of a page can be an altered version of the original page, or it can be completely different.

To create a new version of a page:
1. Display the original page.
2. From the Page menu, select New Version and then select the appropriate source for adding the new page version. AppXtender displays the new page version in the Document Display view. The status bar and title bar indicate the new number of versions.

For information on viewing page versions, refer to “Viewing Versions of a Page” on page 313. For information on deleting page versions, refer to “Deleting Versions” on page 428 and “Purging Versions” on page 429.
Index information is used to identify and organize documents. Data in a document’s index may require modification if a data entry error occurred or if the index information changes. You can modify indexes in the AppXtender Document Index view.

If the index to be modified utilizes the Key Reference feature, changing the data changes the underlying index record in the Key Reference table. If the field where the modification occurs is a data field, the modification is automatically reflected in the indexes for any documents indexed with the same key field value as the active document. If the key field value is modified, the change affects only the key field value for the current document.

To modify a document's index:
1. Display the document that you want to modify.
2. From the View menu, select Document Index and a location for the view to appear relative to the Document Display view (Left, Right, Top, or Bottom). The Document Index view appears.
3. Edit the contents of the desired index fields.
4. Click Save. The changes to the document index are saved.
Applying Digital Signatures

If digital signatures have been enabled for an AppXtender application, you can electronically sign any page version in that application. Like a written signature, the purpose of a digital signature is to guarantee that the individual signing the page really is who he or she claims to be and that the document has not changed since the date of the signature. When a page of a document is signed, the signature is applied to the BIN file for the currently displayed version of the page.

For information on digital signature configuration, refer to your AppXtender system administrator or refer to the ApplicationXtender Installation Guide.

To sign a page version:

1. Display the page version that you want to sign. If it has not already been signed, the icon on the right end of the AppXtender status bar indicates that the page version security is invalid.

2. From the Page menu, select Apply Digital Signature. (If a signature already exists for the displayed page, a message asks whether you want to apply another signature. Click Yes.) Depending on your workstation configuration, the Signature Properties dialog box may appear.

![Page Security Invalid Icon](image1)

![Signature Properties Dialog Box](image2)
3. If a default certificate has not been designated, you can select a certificate.

4. If a default comment has not been provided, you can enter a comment so that others may later understand why you are signing this page at this time.

5. Click OK. Depending on the configuration of the selected certificate, you may be asked to provide a password.

6. Enter your password and click OK.

When the process of applying a signature is complete, the icon on the right end of the AppXtender status bar indicates that the page version has been secured.

**Figure 184 Signing Data with Key Dialog Box**

You can view the history of signatures for a page version.

To view signature history:

1. Display the page version for which you want to view the signature history.

2. From the Page menu, select Signature History. The Signature History dialog box appears, listing the date, user name, computer name, and comment for each signature.
Managing Documents

Figure 185  Signature History Dialog Box
ApplicationXtender (AppXtender) allows you to print or fax documents, pages, or regions of an image. For information, refer to the following topics:

◆ “Printing or Faxing Documents” on page 374
◆ “Printing or Faxing Pages” on page 379
◆ “Printing or Faxing a Region” on page 381
◆ “Changing AppXtender Printer Fonts” on page 382

Note: AppXtender uses Windows print drivers to perform faxing operations. In order to fax pages in AppXtender, you must install Windows-compliant fax software.

Note: Only users with the Print privilege can perform operations that result in information "exported" from the AppXtender system. These operations include printing or faxing documents and pages. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

Note: For information on configuring print options, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.
There are three ways to print or fax a document in ApplicationXtender: from the Result Set tab, from the Document menu, or from the Main toolbar. When printing or faxing from the Document menu or toolbar, the document must be displayed first. The Result Set tab allows you to print or fax without displaying the document.

Documents can be faxed directly from AppXtender using standard Windows fax devices like fax servers and local fax hardware and software. Any fax device installed as a standard printer port can be used to fax AppXtender documents. If your fax device is listed in the Name drop-down list on a standard Print dialog box, you can fax AppXtender documents to it. The method to fax documents is similar to printing, except that AppXtender starts your fax software application and allows you to enter identifying information for the fax destination (such as phone number, name, and so on).

You can add an identifying text string called an endorsement to documents that you print or fax in ApplicationXtender. You can configure endorsements to print in one of the four corners of the document.

For information, refer to the following topics:
- “Printing or Faxing from the Result Set” on page 374
- “Printing or Faxing a Displayed Document” on page 377
- “Endorsing Printed or Faxed Pages” on page 379

Documents listed in the Result Set can be printed or faxed without first being displayed.

Note: AppXtender uses Windows print drivers to perform faxing operations. In order to fax pages in AppXtender, you must install Windows-compliant fax software.

To print or fax a document from the Result Set:
1. Select the document or documents to be printed or faxed on the Result Set tab, and right-click your selection.
2. From the shortcut menu that appears, select Print.
3. If the Reason Code Required dialog box appears, enter a comment in the text box and click OK. (The appropriate task option check box is selected automatically and cannot be cleared.)
The standard Windows Print dialog box appears.

4. Choose the printer or fax device from the Name list and the number of copies you want.
5. Specify the pages to be printed or faxed. You have the following choices:

- To print or fax all pages of each selected document, under Print Range, select All.
- To specify page ranges or individual pages of each selected document, under Print Range, select Pages and type comma-delimited page numbers in the Range text box. Use a dash to indicate a page range. For example, to print or fax pages 2, 3, 4, and 7 of a document, type "2-4, 7" in the text box. If a selected page contains subpages, every subpage in that page is printed or faxed.

6. If you do not want the AppXtender annotations to be included on the documents that you are printing or faxing, click the Hide annotations check box.

Note: The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

7. If you want to print or fax the text of text annotations displayed as icons on a separate page, click Print text note. The document prints or faxes along with a separate page containing the text from the annotations displayed as icons.

8. Click OK. The selected documents are sent to the printer or fax device and a message appears, containing the status of the operation. This message is displayed until all pages of all documents have been sent to the printer or fax device. Click Cancel at any time to cancel the print or fax operation. (If you selected a fax device, AppXtender starts your fax software, so that you can enter information to complete the fax operation.)
Printing or Faxing a Displayed Document

You can choose to print or fax every page or a range of pages of the displayed document using the Document menu or the Print toolbar button.

Note: If a PDF document does not contain annotations, the Print PDF Document command may provide better performance than the regular Print command. However, if any page or version of the document is a file type other than PDF, you must use the regular Print command to print or fax the document.

Note: AppXtender uses Windows print drivers to perform faxing operations. In order to fax pages in AppXtender, you must install Windows-compliant fax software.

To print or fax a displayed document:
1. Display the document that you want to print or fax.
2. From the Document menu, select Print or Print PDF Document. The standard Windows Print dialog box appears.

3. Select the printer or fax device from the Name list and the number of copies you want.
4. Specify the pages to be printed or faxed. You have the following choices:

- To print or fax all pages of the displayed document, under Print Range, select All.
- To specify page ranges or individual pages of the displayed document, under Print Range, select Pages and type comma-delimited page numbers in the text box. Use a dash to indicate a page range. For example, to print or fax pages 2, 3, 4, and 7 of a document, type "2-4, 7" in the text box.

If a selected page contains subpages, every subpage in that page is printed or faxed.

5. If you do not want AppXtender annotations to be included on the documents you are printing or faxing, click the Hide annotations check box.

**Note:** The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

6. If you want to print or fax the text of text annotations displayed as icons on a separate page, click Print text note. (This option is not available when using the Print PDF Document command.) The document prints or faxes along with a separate page containing the text from the annotations displayed as icons.

7. Click OK. The selected pages of the displayed document are sent to the printer or fax device. If the Print PDF Document command was used and if the document contains annotations, each page of the document is converted to an image with the annotations before printing or faxing.

A message appears containing the status of the print or fax operation. This message is displayed until all pages of the document have been sent to the printer or fax device. Click Cancel at any time to cancel the operation.
Printing or Faxing Documents and Pages

Managing Documents

Note: The Print button on the Main toolbar can be configured to print or fax either the currently displayed document or the currently displayed page. It can also be configured to open the standard Windows Print dialog box for the currently displayed page so that you can select what you want to print or fax. This option appears on the Print tab of the Configuration dialog box. For more information, consult your system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

Endorsing Printed or Faxed Pages

This feature allows users to print or fax documents with an identifying text message in one corner. You can print or fax up to 10 lines of text, with up to 80 characters per line. Endorsements print on all pages as long as the option is enabled. This feature can be configured on the Print tab of the Configuration dialog box. For more information, consult your system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

Note: Endorsements cannot be printed or faxed for HTML documents.

Printing or Faxing Pages

You can print or fax a displayed page using the Page menu or the Print toolbar button.

Note: If a PDF page does not contain annotations, the Print PDF Page command may provide better performance than the regular Print command. However, if the page is not in PDF format, the Print PDF Page command is not available.

Note: AppXtender uses Windows print drivers to perform faxing operations. In order to fax pages in AppXtender, you must install Windows-compliant fax software.

To print or fax a page:

1. Within AppXtender, display the desired page.
2. From the Page menu, select Print or Print PDF Page. The standard Windows Print dialog box appears.

![Print Dialog Box](image.png)

Figure 189 Print Dialog Box

3. If the Print dialog box appears, select the printer or fax device from the Name drop-down list and the number of copies you want.

4. If the displayed page contains subpages, you have the following choices:

   - To print or fax all subpages of the displayed page, under Print Range, select All.
   - To specify a range of subpages or individual subpages of the displayed page, under Print Range, select Pages and type comma-delimited subpage numbers in the text box. Use a dash to indicate a range. For example, to print or fax subpages 2, 3, 4, and 7 of a page, type "2-4, 7" in the text box.
   - To print or fax only the currently displayed subpage, under Print Range, select Selection.

5. If you do not want AppXtender annotations to be included on the documents you are printing or faxing, click the Hide annotations check box.

   **Note:** The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.
6. If you want to print or fax the text of text annotations displayed as icons on a separate page, click Print text note. (This option is not available when using the Print PDF Page command.) The document prints or faxes along with a separate page containing the text from the annotations displayed as icons.

7. Click OK. The displayed page is printed or faxed. If the Print PDF Page command was used and if the page contains annotations, the page is converted to an image with the annotations before printing or faxing.

The printing message box appears with the status of the job. Click Cancel to quit the job at any time.

Note: The Print button can be configured to print or fax either the currently displayed document or the currently displayed page. It can also be configured to open the standard Windows Print dialog box for the currently displayed page so that you can select what you want to print or fax. This option appears on the Print tab of the Configuration dialog box. For more information, consult your system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

Printing or Faxing a Region

You can print or fax a specific region of an AppXtender page.

Note: AppXtender uses Windows print drivers to perform faxing operations. In order to fax pages in AppXtender, you must install Windows-compliant fax software.

To print or fax a region:

1. Make sure that Pan Mode is disabled. For information, refer to “Document Display View” on page 67.

2. Drag the pointer over the region that you want to select. As you drag the pointer, it draws a rectangle and highlights the area within the rectangle in green. This rectangle is the selected region.

3. Right-click the highlighted region.

4. From the shortcut menu that appears, select Print. The image in the selected region is sent to the workstation’s default printer (which may actually be a fax device).

For more information on using regions, refer to “Using Regions” on page 326.
Changing AppXtender Printer Fonts

You can set the font for printing or faxing text pages. Various font types, font styles, and font sizes are available when printing or faxing text pages. Each workstation can configure a different font setting. Fonts can be set for text pages, text form overlays, and fixed and variable font sizes.

To set the print fonts:

1. From the File menu, select Configuration to open the AppXtender Configuration dialog box.
2. Click the Fonts tab to activate it.
3. Select the font to configure from the Printer Fonts list, and then click Change.
4. Select the appropriate font and style.
5. Click OK to save the settings.

Note: For more information on configuring the Fonts tab, refer to “Fonts Tab” on page 117.
E-Mailing Documents and Pages

You can e-mail multiple AppXtender documents, an individual AppXtender document, an AppXtender document reference, or a specific AppXtender page. You can e-mail an AppXtender page or document to anyone, even if the recipient does not have AppXtender.

Depending on the number of pages in the document, e-mailing an entire document may consume valuable time and space. Two available alternatives are document references and combining pages.

For more information, refer to the following topics:

◆ “E-Mailing from the Result Set” on page 384
◆ “E-Mailing Displayed Documents” on page 387
◆ “E-Mailing Document References” on page 389
◆ “E-Mailing Pages” on page 391

For information on configuring AppXtender to combine pages for e-mail, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

Note: To e-mail documents, document references, or pages, you must have the Add Page privilege in your user profile. Also, only users with the Print privilege can perform e-mail functions that result in information being exported from AppXtender. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.
You can send multiple AppXtender documents through electronic mail. The delivered mail message contains each page as an attachment.

There are two ways to send a document by e-mail. One method creates as many files as there are pages in the document, each file containing a single page of the document. The other method, using multi-page files, combines sequential pages of the same page type, reducing the number of files sent. These files can then be opened in any application that supports the file type. For more information on the Use multi-page files option, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

When AppXtender documents are e-mailed, the recipient does not have to be an AppXtender user. Documents are sent in the format selected in the E-Mail tab of the Configuration dialog box. For information on selecting a format, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

To e-mail an AppXtender document:

1. Select the document or documents to be mailed on the Result Set tab, and right-click your selection.
2. From the shortcut menu that appears, select Mail. The Email Document Pages dialog box appears.
3. Specify the pages to be mailed. You have the following choices:
   - To mail all pages of each selected document, under Page Range, select All Pages.
   - To specify page ranges or individual pages of each selected document, under Page Range, select Pages and type comma-delimited page numbers in the Range text box. Use a dash to indicate a page range. For example, to mail pages 2, 3, 4, and 7 of a document, type "2-4, 7" in the text box.

   If a selected page contains subpages, every subpage in that page is mailed.

4. If you do not want the AppXtender annotations to be included on the documents that you are mailing, click the Hide annotations check box.

   Note: The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

5. Click OK.

6. If the Reason Code Required dialog box appears, enter a comment in the text box and click OK. (The appropriate task option check box is selected automatically and cannot be cleared.)

   AppXtender displays the processing request message for each document and then a mail dialog box corresponding to your e-mail system appears.
Figure 191 Mail Message with AppXtender Document Attachments

Note that the name of each attachment corresponds to the text that appears in the Document Display view title bar when the page is displayed. For more information on configuring the title bar, refer to “Configuring the Title Bar” on page 93.

Also note that all specified pages are attached to the message. If the Use multi-page files option is enabled, however, certain files are combined into one file. For more information on which file types are combined, consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

7. If you want to reduce the size of the message, you can delete attachments, leaving behind only the pages that you want to send.

8. Address the message to the desired user.

9. Complete the message by adding any other comments, and send it using your e-mail program’s Send command. When the user receives the message, he or she can open the attachments, provided the appropriate application for opening the attached file has been installed.
E-Mailing Displayed Documents

You can route entire documents to other AppXtender users through electronic mail. The delivered mail message contains the document as a set of attachments.

There are two ways to send a document by e-mail. One method creates as many files as there are pages in the document, each file containing a single page of the document. The other method, using multi-page files, combines sequential pages of the same page type, reducing the number of files sent. These files can then be opened in any application that supports the file type. For more information on the Use multi-page files option, consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

Note: Depending on the number of pages in the document, you can also save valuable time and space by sending a document reference. For more information, refer to “E-Mailing Document References” on page 389.

When AppXtender documents are e-mailed, the recipient does not have to be an AppXtender user. Documents are sent in the format selected in the E-Mail tab of the Configuration dialog box. For information on selecting a format, consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

To e-mail an AppXtender document:
1. Perform a query and display the document to be mailed.
2. From the Document menu, select Mail Document Pages. The Email Document Pages dialog box appears.

Figure 192 Email Document Pages Dialog Box
Managing Documents

3. Specify the pages to be mailed. You have the following choices:
   - To mail all pages of each selected document, under Page Range, select All Pages.
   - To specify page ranges or individual pages of each selected document, under Page Range, select Pages and type comma-delimited page numbers in the Range text box. Use a dash to indicate a page range. For example, to mail pages 2, 3, 4, and 7 of a document, type "2-4, 7" in the text box.

   If a selected page contains subpages, every subpage in that page is mailed.

4. If you do not want the AppXtender annotations to be included on the documents that you are mailing, click the Hide annotations check box.

   Note: The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

5. Click OK. AppXtender displays the processing request message for each document and then a mail dialog box corresponding to your e-mail system appears.

Figure 193  Mail Message with AppXtender Document Attachments
Note that the subject of the message corresponds to the Document Display view title bar. For more information on configuring the title bar, refer to “Configuring the Title Bar” on page 93.

Also note that all specified pages of the document are attached to the message. If the Use multi-page files option is enabled, however, certain files are combined into one file. For more information on which file types are combined, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

6. If you want to reduce the size of the message, you can delete attachments, leaving behind only the pages that you want to send.

7. Address the message to the desired user.

8. Complete the message by adding any other comments, and send it using your e-mail program’s Send command. When the user receives the message, he or she can open the attachments, provided the appropriate application for opening the attached file has been installed.

ApplicationXtender allows you to route document references to other AppXtender users through electronic mail. The delivered mail message contains an icon representing the sent information. The recipient double-clicks on that icon to display the documents in AppXtender.

The following requirements apply when e-mailing a document reference:

- The recipient must be using AppXtender.
- The recipient must have access to the same AppXtender database as the sender.
- The data source accessing that database must have the same name on the recipient’s workstation as it is on the sender’s workstation.
- The recipient must have access to the same document storage location as the sender.
To e-mail an AppXtender document reference to another AppXtender user:

1. Display the document to be mailed.
2. From the Document menu, select Mail Reference. A mail dialog box corresponding to your e-mail system appears.

![Figure 194 Mail Message with AppXtender Document Reference Attachment](image)

Notice that the message contains an icon representing the AppXtender document and that the subject of the message corresponds to the Document Display view title bar. For more information on configuring the title bar, refer to “Configuring the Title Bar” on page 93.

3. Address the message to the desired user.
4. Complete the message by adding any other comments, and send it using your e-mail program’s Send command. When the user receives the message, he or she can double-click the icon to display the document in AppXtender.
E-Mailing Pages

AppXtender pages can be routed to other users through electronic mail. When AppXtender pages are e-mailed, the recipient does not have to be an AppXtender user. Pages are sent in the format selected in the E-Mail tab of the Configuration dialog box. For information on selecting a format, consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

To send an AppXtender page to another user via e-mail:

1. Display the page to be mailed.
2. Select Mail from the Page menu. A dialog box corresponding to your e-mail system appears.

Figure 195 Mail Message with AppXtender Page Attachment

Notice that the AppXtender page appears as an icon in the mail message window and that the subject of the message corresponds to the Document Display view title bar. For more information on configuring the title bar, refer to “Configuring the Title Bar” on page 93.

3. Address the mail to the desired user.
4. Complete the message by adding any other comments, and send it using your e-mail program’s Send command. When the user receives the message, he or she can open the attachment, provided the appropriate application for opening the attached file has been installed.
You can export an entire AppXtender document or a specific AppXtender page to any available file location. For more information, refer to the following topics:

- “Exporting Displayed Documents” on page 392
- “Exporting Documents from the Result Set” on page 397
- “Exporting Pages” on page 400

Depending on the number of pages in the document, exporting an entire document may consume valuable time and space. An alternative is combining pages and exporting them as a single file using the Use multi-page files option on the Export tab of the Configuration dialog box. For more information, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

**Note:** Only users with the Print privilege can perform operations that result in information exported from the AppXtender system. These operations include exporting documents, pages, and COLD/ERM. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

**Exporting Displayed Documents**

ApplicationXtender makes documents available to other software applications through the Export feature on the Document menu. The document to export must be displayed to begin the procedure.

**Note:** Document pages containing embedded objects cannot be exported. You may be able to use Save As in the native application to export the contents of the document page.

For more information, refer to the following topics:

- “Exporting a Displayed Document to a File” on page 393
- “Exporting a Displayed Document to an XPS File” on page 395
- “Exporting OCR Output from a Displayed Document” on page 395
There are two ways to export a document. One method creates as many files as there are pages in the document, each file containing a single page of the document. The other method, using multi-page files, combines sequential pages of the same page type, reducing the number of files exported. These files can then be opened in any application that supports the file type of the exported file. For more information on the Use multi-page files option, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

When documents are exported, AppXtender adds a page number representation to the end of whatever file name is specified. If, for example, the name of the file to be exported is TEST.BMP, the first page of the exported document is TEST-P0001.BMP, the second page TEST-P0002.BMP, etc. If pages are compressed with the Use multi-page file option, the new format is TEST-P0001-P0002.TIF.

When a document containing subpages is exported, the subpages for each page are consolidated into one page.

Document pages are exported in the file formats specified in the Export tab of the AppXtender Configuration dialog box. For information on configuring the exported file formats, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

To export an AppXtender document to a file:

1. Perform a query and display the document you want to export.
2. From the Document menu, select Export and then Images. An Export Document Pages dialog box appears.

3. Enter the name and path of the files to be exported.
4. Specify the pages to be exported. You have the following choices:
   - To export all pages of the document, under Page Range, select All Pages.
   - To specify page ranges or individual pages, under Page Range, select Pages and type comma-delimited page numbers in the text box. Use a dash to indicate a page range. For example, to export pages 2, 3, 4, and 7 of a document, type "2-4, 7" in the text box.

   If a selected page contains subpages, every subpage in that page is exported.

5. If you do not want AppXtender annotations to be included on the documents you are exporting, click the Hide annotations check box.

   **Note:** The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator's Guide.

6. Click Save. The document is exported.

   **Note:** If the Use multi-page files option is enabled, certain files are combined into one file. For more information on which file types are combined, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

7. When AppXtender has finished exporting the documents, you can look in Windows Explorer to view the exported files.

   ![Figure 197 Windows Explorer with Sample Exported Document](394)
AppXtender allows you to export a displayed document to an XPS file by using the Microsoft XPS Document Writer to print the document.

To print a displayed document to an XPS file, select Microsoft XPS Document Writer from the Name list box on the Print dialog box. Refer to “Printing or Faxing a Displayed Document” on page 377 for more information.

**Note:** Contact your system administrator or refer to the Microsoft Web site for more information on generating and viewing XPS files.

You can export the displayed document to Text, Rich Text Format, or HTML using AppXtender’s optical character recognition (OCR) feature.

When documents are exported, AppXtender adds a page number representation to the end of whatever file name is specified. If, for example, the name of the file to be exported is TEST.TXT, the first page of the exported document is TEST-P0001.TXT, the second page TEST-P0002.TXT, etc. The Use multi-page files option does not combine pages exported and processed using OCR.

AppXtender uses OCR to process the displayed document pages and exports them to the selected file format.

**Note:** This feature is available for both bi-tonal (black and white) and color images.

**Note:** Before you process an image with OCR, make sure that the image is oriented correctly. You may need to rotate the image so that it is not upside-down or sideways. For information on rotating an image, refer to “Using Rotate” on page 324.

**Note:** To improve the OCR output, consider enhancing images before exporting. For more information, refer to Chapter 10, “Image Enhancement.”
Managing Documents

To process (using OCR) and export the displayed document:

1. From the Document menu, select Export and then OCR. An OCR Export Document Pages dialog box appears.

![OCR Export Document Pages Dialog Box](image)

2. Enter the name and path for the files to be exported. Choose the desired file type from the Save as type drop-down list. Your available options are Text Document, Rich Text Format Document, HTML Document, CSV Document, and Excel Spreadsheet.

3. From the Language drop-down list, select the language that is most appropriate for the document that you are exporting.

4. Specify the pages to be exported. You have the following choices:
   - To export all pages of the document, under Page Range, select All Pages.
   - To specify page ranges or individual pages, under Page Range, select Pages and type comma-delimited page numbers in the text box. Use a dash to indicate a page range. For example, to export pages 2, 3, 4, and 7 of a document, type "2-4, 7" in the text box.
     - If a selected page contains subpages, every subpage in that page is exported.

5. Click Save.
6. If the Enable proofing option is enabled for exporting OCR results, the FineReader OCR preview page appears so that you can edit the OCR results (if necessary). To continue the export, click the button with an AppXtender icon in the small Done window. The document is exported.

![Done Icon](image)

**Figure 199 Icon in Done Window**

*Note:* If FineReader 7.0 has been installed and selected as the AppXtender OCR engine and if the Use form templates option is enabled for exporting OCR results, the exported file contains only the text specified by the FineReader template. Otherwise, the exported file contains all of the text on the image. For information on selecting an OCR engine and for information on configuring exported OCR results, consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

---

### Exporting Documents from the Result Set

Multiple text and PDF documents can be exported from the AppXtender Result Set to a single text or PDF document. When exporting multiple documents, AppXtender adds a page break to the end of each document. The documents are exported in the default format selected in the Export COLD Document Pages(s) dialog box.

*Note:* This procedure applies only to text and PDF documents, including documents created by CX and AppXtender Reports Mgmt.

To export text/PDF documents to a file:

1. Perform a query to find the desired text or PDF files. AppXtender displays the results of the search in the Result Set tab. Highlight the documents to include in the export to a single document.
2. Right-click the selected documents in the Result Set.
3. From the shortcut menu that appears, select Export COLD Document(s). AppXtender displays the processing request message and then the Export COLD Document Page(s) dialog box appears.

![Image](image.png)

**Figure 200 Export COLD Document Page(s) Dialog Box**

4. Enter a name for the new text or PDF document.

5. From the Files of type drop-down list, select the default file format. You have the following options:
   - Text Files
   - PDF Files
   - COLD Files

   *Note:* If both PDF and TXT files are selected from the result set, selecting COLD Files from the Save as type drop-down list will tell the system to take the first document in the selected files and only export that file type, either PDF or TXT respectively.

6. Click Save.

7. If the Reason Code Required dialog box appears, enter a comment in the text box and click OK. (The appropriate task option check box is selected automatically and cannot be cleared.)
All selected documents in the result set are exported as a single document with the selected file name. A message appears indicating that the export request is being processed.

8. When AppXtender has finished exporting the document, you can look in Windows Explorer to view the file.

ApplicationXtender allows you to export a document from the result set to an XPS file by using the Microsoft XPS Document Writer to print the document.

To print a document from the result set to an XPS file, select Microsoft XPS Document Writer from the Name list box on the Print dialog box. Refer to “Printing or Faxing from the Result Set” on page 374 for more information.

Note: Contact your system administrator or refer to the Microsoft Web site for more information on generating and viewing XPS files.
**Exporting Pages**

A document page may be useful in another application. Through the Export feature on the Page menu, AppXtender provides two options for exporting AppXtender pages: to a file or to text through optical character recognition (OCR). For more information, refer to the following topics:

- “Exporting a Page to a File” on page 400
- “Exporting a Page to an XPS File” on page 401
- “Exporting Page OCR Output” on page 401

**Exporting a Page to a File**

Exporting a page to a file creates a single file that can then be opened in any application that supports the file type of the exported file. The page to be exported must be displayed. Pages are exported in the default format selected on the Export tab in the AppXtender Configuration dialog box. For more information, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

**Note:** You must have the Configure WS privilege to access the Export tab.

When a page containing subpages is exported, the subpages are consolidated into one page.

To export the displayed page to a file:

1. From the Page menu, select Export and then Image. The Export Page dialog box appears.

![Export Page Dialog Box](image)

2. Enter the name and path of the file to be exported.
3. Click Save. The page is exported.

ApplicationXtender allows you to export a page to an XPS file by using the Microsoft XPS Document Writer to print the page.

To print a page to an XPS file, select Microsoft XPS Document Writer from the Name list box on the Print dialog box. Refer to “Printing or Faxing Pages” on page 379 for more information.

**Note:** Contact your system administrator or refer to the Microsoft Web site for more information on generating and viewing XPS files.

**Exporting Page OCR Output**

You can export the currently displayed page to Text, Rich Text Format, or HTML using AppXtender’s OCR feature. AppXtender processes the displayed page using OCR and exports it to the selected file format.

**Note:** Before you process an image with OCR, make sure that the image is oriented correctly. You may need to rotate the image so that it is not upside-down or sideways. For information on rotating an image, refer to “Using Rotate” on page 324.

**Note:** To improve the OCR output, consider enhancing images before exporting. For more information, refer to Chapter 10, “Image Enhancement,”.

To process (using OCR) and export the displayed page:

1. From the Page menu, select Export and then OCR. The OCR Export Page dialog box appears.
2. Enter the name and path of the file to be exported. Select the desired format from the Save as drop-down list. Your available options are Text Document, Rich Text Format Document, HTML Document, CSV Document, and Excel Spreadsheet.

3. From the Language drop-down list, select the language that is most appropriate for the page that you are exporting.

4. Click Save.

   If the Enable proofing option is enabled for exporting OCR results, the FineReader OCR preview page appears. If the FineReader OCR preview page appears, edit the OCR results (if necessary), and click AppXtender (the button with an ApplicationXtender icon in a small Done window).

   The page is exported.

**Note:** If FineReader 7.0 has been installed and selected as the AppXtender OCR engine, and if the Use form templates option is enabled for exporting OCR results, the exported file contains only the text specified by the FineReader template. Otherwise, the exported file contains all of the text on the image. For information on selecting an OCR engine, and for information on configuring exported OCR results, consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.
Managing Documents

You can use optical character recognition (OCR) to process documents, individual pages, and page regions.

ApplicationXtender supports basic document OCR through its integrated FineReader 6.0 OCR engine. Any displayed document image can be processed using OCR to produce a text version of the document.

**Note:** The specific OCR functionality available at each AppXtender Document Manager workstation is set up when the AppXtender system administrator configures the workstation. For information on configuring for OCR, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

**Note:** Before you process an image with OCR, make sure that the image is oriented correctly. You may need to rotate the image so that it is not upside-down or sideways. For information on rotating an image, refer to “Using Rotate” on page 324.

**Note:** To improve the OCR performance, consider enhancing images before processing. For more information, refer to Chapter 10, “Image Enhancement.”

If you use OCR to process a document that has text hidden under a redaction, the hidden text is not included in the text view of the document.

For more information, refer to the following topics:
- “Processing a Document Using OCR” on page 404
- “Processing a Page Using OCR” on page 405
- “Processing a Region Using OCR” on page 406
- “Submitting Documents to an OCR Queue” on page 407
AppXtender supports document OCR through its integrated FineReader 6.0 OCR engine. All bi-tonal and color image pages in the document are OCR processed. (Other page types are ignored.)

To OCR an AppXtender document:

1. Display the document to be processed in Document Display view.
2. To begin processing, from the Document menu, select OCR.
   
   When OCR processing starts, a small window containing a representation of the first page of the document opens. The window refreshes to show each page in the document as it is being processed. (You can click Cancel at any time to abort the process.)

   
   **Figure 205  OCR Processing Window**

   When processing finishes, the OCR processing window closes automatically. In AppXtender Document Manager, Document Display view refreshes to show the text generated during the OCR process. You can use the Show Text button to switch between the text view and the image view of each page in the document. For information, refer to “Viewing Image Pages” on page 332.
AppXtender supports OCR of individual document pages through its integrated FineReader 6.0 OCR engine. Both bi-tonal and color image pages can be OCR processed.

To process a page with OCR:

1. Display the page that you want to process.
2. From the Page menu, select OCR Page.

When OCR processing starts, a small window containing a representation of the selected page of the document opens. (You can select Cancel at any time to cancel the process.)
When processing finishes, the OCR processing window closes automatically. In AppXtender Document Manager, Document Display view refreshes to show the text page generated during the OCR process. You can use the Show Text button to switch between the text view and the image view of each page in the document. For information, refer to “Viewing Image Pages” on page 332.

In addition to using OCR to process a page or an entire document, you can also select a region of a page and OCR only that region.

To process a region using OCR:

1. Make sure that Pan Mode is disabled. For information refer to “Document Display View” on page 67.

2. Drag the pointer over the region that you want to select. As you drag the pointer, it draws a rectangle and highlights the area within the rectangle in green. This rectangle is the selected region.

3. Right-click the highlighted region.

4. From the shortcut menu that appears, select OCR this Region. The region is processed using OCR. A text editor appears with the results of the OCR.

For more information on using regions, refer to “Using Regions” on page 326.
Submitting Documents to an OCR Queue

You can submit a document to an OCR queue. For information on creating an OCR queue in the AppXtender Index Server, or for information on managing queues, refer to the ApplicationXtender Index Server Administrator’s Guide. For information on configuring your workstation to automatically use a particular queue, consult your AppXtender system administrator or refer to the ApplicationXtender Installation Guide.

**Note:** Documents in the OCR queue are processed by the OCR engine on the AppXtender Index Server, not the OCR engine on your AppXtender workstation. Therefore, the options under Text View on the OCR tab of the Configuration dialog box do not apply when you submit a document to an OCR queue.

To submit a document to an OCR Queue:

1. Display the document that you want to submit to the OCR queue.
2. From the Document menu, select Submit OCR Job.
3. If the Submit OCR Job dialog box appears, select a queue from the Processing Queue list, select a language from the OCR Language list, and click OK.

The job is submitted to the OCR queue for OCR processing, and a confirmation message appears.
Managing Documents

OCR Indexing Documents

ApplicationXtender can be configured so that after importing image documents, you can use OCR to process specified areas on the document and then add the resulting text data to the corresponding application index fields in ApplicationXtender.

ApplicationXtender supports OCR Indexing through FineReader 7.0 Scripting Edition and FormReader 6.5 as separate installations.

- For FineReader 7.0 Scripting Edition, the AppXtender system administrator creates template blocks marking the location of index information on the document image for OCR processing. Each template block is mapped to an application index field in AppXtender. When the imported image is processed using OCR Index, the text resulting from the OCR process is used to automatically index the document in AppXtender.

- With FormReader 6.5, the AppXtender system administrator creates form templates for processing standard forms, such as invoices, claim forms, and contracts. The areas marked on the form template are mapped to application index fields in AppXtender. When the imported image is processed using OCR Index, the text resulting from the OCR process is used to automatically index the document in AppXtender.

Both FineReader 7.0 and FormReader 6.5 can also be set up for text proofing during the OCR process.

Note: The specific OCR Indexing functionality available at each AppXtender Document Manager workstation is set up when the AppXtender system administrator configures the workstation. For information on configuring for OCR, consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

Note: Before you process an image with OCR, make sure that the image is oriented correctly. You may need to rotate the image so that it is not upside-down or sideways. For information on rotating an image, refer to “Using Rotate” on page 324.
To index an imported document using OCR Import:

1. In AppXtender, import the image file into the selected application. (For information on importing documents, refer to “Adding a Document by Importing a File” on page 160.)

   The document image appears in Document Display view, and a blank document index appears in Index view.

2. Press [F6] or, from the Document menu, select Index>OCR Index. ApplicationXtender launches the configured OCR engine (FineReader 7.0 Scripting Edition or FormReader 6.5) and OCR processing begins.

   The OCR Form Templates dialog box appears.

3. Select the required template and then click OK. AppXtender launches the ABBYY Software program associated with the selected template (FineReader 7.0 Scripting Edition or FormReader 6.5).

4. If the OCR engine is configured for text proofing, when OCR processing finishes, the FineReader 7.0 (or FormReader 6.5) program window opens. The document image and specified template block appear in the pane to the left within the window. The text from the OCR indexing process appears in the Text pane to the right within the window. An ApplicationXtender button appears in the Done window.
5. Select the button in the Done window. The FineReader 7.0 (or FormReader 6.5) program window closes.

On the AppXtender Document Manager desktop, the OCR text appears in Document Display view and the index data is automatically added to the fields in Index view.

6. In Index view, click Save to save the index data and create an AppXtender document.

Note: For information on importing and indexing documents, consult with your AppXtender system administrator or refer to Chapter 3, “Creating Documents.”
AppXtender allows you to submit documents to the ApplicationXtender Index Server for full-text indexing. By adding documents to the AppXtender Index Server, you can expand your queries for AppXtender documents to include keywords contained within the document. Text documents can be submitted directly to the AppXtender Index Server for indexing. Bi-tonal images must first be processed using OCR, and then the resultant text submitted for indexing. PDFs with text can be submitted directly, and PDFs containing images only are first processed using OCR. (For information on OCR, refer to “Document and Page OCR” on page 403.)

You can submit a displayed document from the Document menu, or you can submit multiple documents from the Result Page without first displaying them. For more information, refer to the following topics:

◆ “Submitting from the Result Set” on page 412
◆ “Submitting a Displayed Document” on page 413

Your AppXtender workstation may be configured so that the AppXtender Index Server automatically uses optical character recognition (OCR) to process any image documents submitted for indexing. The Full Text tab of the Configuration dialog box allows this configuration. For information, consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

Note: The ProIndex full-text engine cannot process documents of more than 2000 pages. However, the K2 full-text engine can process documents of up to 250,000 pages.

If you submit for full-text indexing a document that has text hidden under a redaction, the hidden text is not included in the full-text index of the document.
Managing Documents

Submitting from the Result Set

Documents can be submitted to the AppXtender Index Server for full-text indexing from the Result Set tab of the Query view. Multiple documents can be selected and processed together.

To submit documents to the AppXtender Index Server from the Result Set:

1. Perform a query for the documents you want to submit to the AppXtender Index Server. The results appear in the Query view Result Set tab.
2. From the Result Set, select the index records for the documents that you want to submit to the AppXtender Index Server.
3. Right-click the Result Set. From the shortcut menu that appears, select Submit Full Text Index Job.

Note: If the Submit Full Text Index Job command is not available, refer to “Troubleshooting” on page 209.

If your workstation is configured to prompt you for queue selection upon submission of full-text index jobs, the Submit Full-Text Index Job dialog box appears. (The Full Text tab of the Configuration dialog box allows this configuration. For information, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.)

![Submit Full-text Index Job Dialog Box](image)
4. If the Submit Full-Text Index Job dialog box appears, select the appropriate queue, enable Convert to text (if necessary) to process (using OCR) any bi-tonal pages that are submitted, select a language, and click OK.

AppXtender submits the job to the configured full-text queue. The AppXtender Index Server processes all of the pages in all of the selected documents. When the AppXtender Index Server has finished processing the documents, a message appears.

5. Click OK to clear the message. You now have the ability to find these documents by performing a full-text query that searches for text in these documents.

**Note:** When you index a document’s full text using the AppXtender Index Server, a text view of the document is added to the document and is available the next time you retrieve the document. For foreign files, RTF files, HTML files, and PDF files, if the application is using the ProIndex full-text engine, only the first 256 lines of each document page are included in the text view for that page. The entire document page is full-text indexed, but only the first 256 lines are returned as a text view.

**Note:** If you encounter any problems submitting a document to the AppXtender Index Server, refer to “Troubleshooting” on page 209.

**Submitting a Displayed Document**

Displayed documents can be submitted to the AppXtender Index Server for full-text indexing from the Document menu. Only the document displayed is processed.

To submit a displayed document to the AppXtender Index Server:

1. Display the document that you want to submit for full-text indexing.

2. From the Document menu, select Submit Full Text Index Job.

**Note:** If the Submit Full Text Index Job command is not available, refer to “Troubleshooting” on page 209.
Managing Documents

If your workstation is configured to prompt you for queue selection upon submission of full-text index jobs, the Submit Full-Text Index Job dialog box appears. (The Full Text tab of the Configuration dialog box allows this configuration. For information, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.)

![Submit Full-text Index Job Dialog Box](image)

3. If the Submit Full-Text Index Job dialog box appears, select the appropriate queue, enable Convert to text (if necessary) to process (using OCR) any bi-tonal pages that are submitted, select a language, and click OK.

AppXtender submits the job to the configured full-text queue. The AppXtender Index Server processes all of the pages in the displayed document. When the AppXtender Index Server has finished processing the document, a message appears.

4. Click OK. You now have the ability to find this document by performing a full-text query that searches for text in this document.

**Note:** When you index a document’s full text using the AppXtender Index Server, a text view of the document is added to the document. The next time you retrieve the document, a text view of the document is available. For foreign files, RTF files, HTML files, and PDF files, if the application is using the ProIndex full-text engine, only the first 256 lines of each document page are included in the text view for that page. The entire document page is full-text indexed, but only the first 256 lines are returned as a text view.

**Note:** If you have trouble submitting a document to the AppXtender Index Server for full-text indexing, refer to “Troubleshooting” on page 209.
Business intelligence solutions allow users to perform one or more of the following tasks:

- Access and analyze data
- Identify patterns and correlations within their set of data
- Create predictive models that anticipate behavior based on historic trends in the data

Business intelligence applications generally extract data only from ASCII files in which the data has already been organized into rows (records) and columns (fields). If your AppXtender Reports Mgmt license supports the business intelligence gateway (B.I. gateway) feature, you can use AppXtender Reports Mgmt to extract data from your reports and export this data in a format that can be used in business intelligence applications. By default, this export is performed simultaneously with the upload of indexed documents to AppXtender.

In addition, if you have already used AppXtender Reports Mgmt to generate indexed AppXtender documents from reports, you can submit those reports from AppXtender to AppXtender Reports Mgmt and use AppXtender Reports Mgmt to process those reports again.

To configure AppXtender for business intelligence:

1. In ApplicationXtender Reports Management (AppXtender Reports Mgmt), you must:
   - Specify a data export path
   - Configure the B.I. Gateway tab for the report type

AppXtender Reports Mgmt creates an ERMX.INI file, which is placed in the data export path configured. The information in the ERMX.INI file includes all of the report types for the data source selected, the applications for the data source selected, and each report type associated with the specified applications.
Managing Documents

Figure 214  Sample ERMX.INI File

For specific instructions on completing these tasks, refer to the ApplicationXtender Reports Management Administrator’s Guide.

2. From the Paths tab of the ApplicationXtender (AppXtender) Configuration dialog box, enter the path where the ERMX.INI file is stored in the Business Intelligence Gateway path text box. This path should be equivalent to the B.I. gateway path configured in AppXtender Reports Mgmt.
CAUTION

If the path entered on the Paths tab of the Configuration dialog box does not match that of the location of the ERMX.INI file, an error message appears indicating that the ERMX.INI file could not be found. You will not be able to proceed with any submissions if this is not resolved.

Once you have configured the appropriate information in AppXtender Reports Mgmt and configured the Business Intelligence Gateway path in AppXtender, you are ready to begin submitting your documents and reports to BI Gateway.

To submit documents/reports to BI Gateway:

1. You have the following options:
   - From the result set tab, right-click on the documents or reports you want to submit to BI Gateway. From the shortcut menu that appears, select Submit to BI Gateway.
   - With a report displayed in the Document Display, you can select Submit to BI Gateway from the Document menu.
2. If there is more than one report type associated with the application the Select ERMX Report Type dialog box is displayed. Select the report type that you want to use.

3. A progress indicator dialog box is displayed. Click Cancel if you want to cancel the submission.

Once the submission is complete, two files are placed in the directory with the ERMX.INI file. One is an .INI file and the other is either a .PDF or .TXT file, depending on the type of document that was submitted. Both files use a naming convention that includes the workstation name as well as a time and date stamp. For example, WSMREED_01_11_13_143840.INI means that the file was submitted from the WSMREED workstation at 2:38 p.m. on November 13, 2001.
Submitting Documents to ApplicationXtender Workflow

If you have ApplicationXtender Workflow (AppXtender Workflow) installed, business processes can be initiated from the Result Set singly or in batches. This feature is useful to start business process instances for documents that have previously been added to AppXtender, or have been erroneously added by a user who has forgotten to log in to AppXtender Workflow.

To submit a document or documents to AppXtender Workflow:

1. Select the document or documents you would like to submit to AppXtender Workflow from the Result Set window. For more information on running a query, refer to “Running a Query” on page 304.

2. Right-click the selection. From the shortcut menu that appears, select Submit to AppXtender Workflow.

3. Submission of the documents causes AppXtender Workflow to initiate new business processes as appropriate for your AppXtender Workflow system configuration.
Converting Subpages to Pages

If your documents contain subpages (for example, in an ICE, TIFF, DCX, or PDF format page), you can convert the subpages to pages. Conversion allows easier navigation and manipulation of data within a document. The conversion is allowed only when the following conditions are all met:

- The displayed page is neither Minolta ICE nor Minolta COLD.
- The displayed page is the latest version of the page.
- There is no annotation on the page.
- The number of pages in the document does not exceed 32,000.

To convert subpages to pages:

1. Display the page that contains subpages.
2. From the Page menu, select Convert Subpages to Pages. The status bar and Document Display view title bar change to reflect the conversion, but the underlying storage of data to BIN files does not change.

For example, consider a document that contains one page, which itself contains three subpages. This page is stored as one BIN file in the write path for the application. Before conversion, no page information appears in the Document Display view title bar, but "Page 1/1 Subpage 1/3" appears in the status bar. After conversion, "Page 1 of 3" appears in the Document Display view title bar and "Page 1/3" appears in the status bar. The document now contains three pages, each of which contains one subpage. These three pages continue to be stored as one BIN file.
AppXtender Document Properties

The AppXtender Document Properties dialog box is most useful to you if you check out documents and check them in as new revisions, or if you are using ODMA. (For information on checking documents in and out, refer to “Selecting a Document Display Mode” on page 280. For information on ODMA, refer to Chapter 8, “Using ODMA With AppXtender Documents.”)

To view the properties for an AppXtender document:

1. In the Result Set, right-click the document for which you want to view information.
2. From the shortcut menu that appears, select Properties. The Document Properties dialog box appears, displaying the General tab.
3. Review the information in the General tab. The following table describes each field on the General tab:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>App Name</td>
<td>Name of the application where the document is stored.</td>
</tr>
<tr>
<td>Revision</td>
<td>The major and minor revision numbers for the existing AppXtender document.</td>
</tr>
<tr>
<td></td>
<td>Each time you check in a document, you have the opportunity to check it in</td>
</tr>
<tr>
<td></td>
<td>as a new major revision or minor revision. If this is a new AppXtender</td>
</tr>
<tr>
<td></td>
<td>document, this field contains a no revisions message. If the document has</td>
</tr>
<tr>
<td></td>
<td>been finalized, the word “Final” follows the version number.</td>
</tr>
<tr>
<td>Created By</td>
<td>User name of the person who initially created the document. If the Windows</td>
</tr>
<tr>
<td></td>
<td>security provider is used, the domain name also appears.</td>
</tr>
<tr>
<td>Created On</td>
<td>Date and time the document was created.</td>
</tr>
<tr>
<td>Modified By</td>
<td>User name of the person who last modified the document. If the Windows</td>
</tr>
<tr>
<td></td>
<td>security provider is used, the domain name also appears.</td>
</tr>
<tr>
<td>Modified On</td>
<td>Date and time the document was last modified.</td>
</tr>
<tr>
<td>Check Out By</td>
<td>User name of the person who last checked out the document (if the document</td>
</tr>
<tr>
<td></td>
<td>is currently checked out). If the Windows security provider is used, the</td>
</tr>
<tr>
<td></td>
<td>domain name also appears.</td>
</tr>
<tr>
<td>Check Out On</td>
<td>Date and time the document was last checked out (if the document is currently</td>
</tr>
<tr>
<td></td>
<td>checked out).</td>
</tr>
</tbody>
</table>
Managing Documents

Table 51  General Tab Fields (continued)

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Out Comment</td>
<td>The most recent comment entered when the AppXtender document was checked out. (Each time you check out a document, you have the opportunity to enter a comment.)</td>
</tr>
<tr>
<td>Under Retention Until</td>
<td>The retention period end date (if the document is filed for retention).</td>
</tr>
<tr>
<td>Retention Hold Label</td>
<td>The name of the retention hold label that was applied to the document (if the document is on retention hold).</td>
</tr>
</tbody>
</table>

Note: The Created By, Created On, Modified By, and Modified On fields are populated only if the document was created in an ODMA-compliant application.

4. Click the Summary tab.

5. You can enter information in the Title, Subject, Author, Keywords, and Comment text boxes. In AppXtender or in ODMA, you can search for the information that you have entered in these text boxes in order to find and open the document. For more information, refer to “Searching by ODMA Attributes” on page 257. The following table describes each field on the Summary tab:

Table 52  Summary Tab Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Suggested text to display in the document window's title bar. The title can be up to 127 characters long.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject matter of the document. The subject can be up to 127 characters long.</td>
</tr>
<tr>
<td>Author</td>
<td>Author of the document. The author's name can be up to 127 characters long.</td>
</tr>
<tr>
<td>Keywords</td>
<td>A list of keywords assigned to the document. AppXtender treats each line that you enter as a keyword, regardless of whether spaces, commas, or other delimiters are included in the line. To start a new keyword, press [ENTER] to go to the next line in the Keywords text box. Each keyword can be up to 99 characters long.</td>
</tr>
<tr>
<td>Comment</td>
<td>Comments can be up to 250 characters long.</td>
</tr>
</tbody>
</table>
6. If the document has been checked out and revised or if the document was created in an ODMA-compliant application, click the Revision History tab to refer to a list of all revisions made to the document.

The Revision History tab contains the revision number, the user name (and domain, if the Windows security provider is used) of the person who made the revision, and the date the revision was made.

**Note:** A major revision is indicated by a change in the first number, such as 2.0 or 3.0. Changes in the second number, such as 1.1, 1.2, and 1.3, identify minor revisions.

7. You can perform any one of the following tasks when working with the list of revisions:

- To view comments entered when the document was checked in, select the revision and then click Detail. The revision History Detail dialog box appears.

![History Detail Dialog Box](image)

Click Close when you are finished to return to the Revision History tab.

- To view the selected revision, click Open. The AppXtender Document Properties dialog box closes and the document appears in the Document Display view.
- To delete the selected revision, click Delete.

**Note:** The Delete button is available only when the selected document is not open in the Document Display view.

8. If you have made any changes that you want to save on the AppXtender Document Properties dialog box, click OK.
Saving the Result Set as a Text File

You can save the index records listed in the Result Set to a text file. To save the contents of the Result Set to a text file:

1. Right-click the Result Set.

2. From the shortcut menu that appears, select Save As. The Save As dialog box appears.

3. Enter a file name and path, and then click Save. The index records listed in the Result Set are saved to a text file.
Checking in and Canceling Changes

When AppXtender is in check in/check out mode, you must check out a document in order to modify it. When AppXtender is in normal mode, you can open and modify documents without checking them out, which saves changes to the AppXtender document repository upon closing. However, normal mode also allows you to check out documents to prevent other users from making modifications.

A checked out document is a “working copy” of an AppXtender document that remains a working copy until it is checked back in and is separate from the AppXtender document repository copy. When you finish modifying the document, you must then decide how (or whether) to resave the working copy of the document to the AppXtender document repository.

The original version (the version that was originally checked out) of the document remains in the AppXtender database as the current version until the working copy is checked in. This allows you to either check in the working copy of a document as a new revision or cancel all changes made and revert to the original version of the document.

**Note:** If the application has the Prompt for check out on open option enabled, you also have the option to save the document as a final revision. Final document revisions can be accessed only in read-only mode and cannot be modified. For more information, refer to “Creating an Application” in the ApplicationXtender Core Components Administrator’s Guide.

For more information on checking out a document, refer to “Selecting a Document Display Mode” on page 280.
Managing Documents

Checking in a Document in AppXtender

This topic describes how to check in a document in AppXtender.

Note: AppXtender documents accessed using the ODMA function can be checked in to AppXtender through the ODMA interface. For more information on checking documents in through ODMA, refer to Chapter 8, "Using ODMA With AppXtender Documents."

To check in a document in AppXtender:

1. Make sure the checked out document is open in AppXtender.

2. From the Document menu, select Check In. The Check In AX Document dialog box appears.

   If the application is set up with final revision functionality, the dialog box includes a Final Revision check box.

Note: For information on enabling final revision functionality by enabling the Prompt for checkout on open option when setting up a new application, refer to "Entering Application Information" in the ApplicationXtender Core Components Administrator’s Guide.

3. You have the following choices:
   - Select New Document Revision to check the document in as a new revision of the document.
   - Select Replace Current Revision to replace the current revision of the document.

4. If you want to finalize the document and you check the document in as a New Document Revision, you may also select whether to check it in as a Major Revision or a Minor Revision.

5. If the dialog box includes a Final Revision check box, select the check box.

Note: You can open final revisions of documents only in read-only mode and cannot make changes to them. Depending on your user privileges, you may be able to delete final revision documents from the repository.

6. Enter any comments about the revision in the Comment text box. You can enter up to 250 characters.

7. Click OK. The document is checked in and is now available for revision by other users (unless it has been finalized, in which case, it is available only in read-only mode).
Canceling the Check Out of a Document

You may also decide after making modifications to a checked out document that you do not want to save the changes you made. However, as long as the document is checked out by you, other users cannot make modifications to the document until you check it back in.

AppXtender provides you with the Cancel Check Out function, which allows you to check a document back into AppXtender for use by other users without saving any modifications. Essentially what the command does is remove the "checked out" property from the document.

To cancel the check out of a document:

1. Open the checked out document in AppXtender.
2. From the Document menu, select Cancel Check Out. A warning message appears.
3. If you want to check the document back into AppXtender without saving any of the modifications you made to the document, click OK.

The document is checked back in and is now available to other AppXtender users. Any modifications you made to the document are discarded and AppXtender reverts to the document version that you originally checked out.
Deleting Documents, Pages, Versions, and Batches

ApplicationXtender (AppXtender) allows you to delete documents, pages, versions, or batches. For more information, refer to the following topics:

- “Deleting Versions” on page 428
- “Purging Versions” on page 429
- “Deleting Pages” on page 430
- “Cutting Pages” on page 431
- “Deleting Documents” on page 432
- “Deleting Batches” on page 433

You can also replace pages. For information on replacing pages, refer to “Replacing Pages” on page 367.

Note: In order to delete documents, pages, versions, or batches, you must have the correct privileges associated with your user profile. For more information, consult your system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

Deleting Versions

A single version can be deleted using the Delete Version command in the Page menu.

CAUTION

As soon as the deletion is confirmed, the version is permanently lost. Caution should be exercised because recovery of the version is not possible.

To delete one version of a page:

1. Display the page version you want to delete.
2. From the Page menu, select Delete Version. A delete page version confirmation message appears.
3. Click Yes to delete the version. Click No to exit without deleting the version.
The AppXtender status bar and title bar reflect the version changes. When the version is deleted, AppXtender deletes the object (*.BIN) file associated with it.

**Purging Versions**

The Purge version feature allows you to delete several versions of a page with one command. AppXtender deletes all versions created before the displayed version. If there are six versions of a page, for example, and version four is displayed, purge version would delete versions one, two, and three. Versions four, five, and six are preserved and renumbered to one, two, and three. This is useful when only the most recent version of a page is required.

**CAUTION**

As soon as the purge is confirmed, the older versions are permanently lost. Caution should be exercised because recovery of the versions is not possible.

To purge a version:

1. Display the page version you want to keep.
2. From the Page menu, select Purge Version. AppXtender displays a purge version confirmation message.
3. Click Yes to delete all versions created before the displayed version. Click No to exit without purging versions. The AppXtender status bar and title bar reflect the changes. When each version is deleted, AppXtender deletes the object (*.BIN) file associated with it.
Managing Documents

Deleting Pages

You can delete pages from an AppXtender document at any time. When a page is deleted, AppXtender also deletes the object file (*.BIN). You can perform this deletion from the Document Display view or from the Thumbnail view. For more information, refer to the following topics:

- “Deleting a Page from the Document Display View” on page 430
- “Deleting Pages from Thumbnail View” on page 431

Note: The delete function deletes all versions of the currently displayed page.

CAUTION

As soon as the deletion is confirmed, the page is permanently lost. Caution should be exercised because recovery of the page is not possible.

Deleting a Page from the Document Display View

You can delete a single page from an AppXtender document in the Document Display View.

To delete a page:

1. Within AppXtender, display the page that you want to delete.
2. From the Page menu, select Delete. A delete confirmation message appears.
3. Click Yes to delete the displayed page. Click No to quit.
Deleting Documents, Pages, Versions, and Batches

Managing Documents

Deleting Pages from Thumbnail View

You can delete a page or multiple pages from an AppXtender document at any time. When a page is deleted, AppXtender also deletes the object file (*.BIN) associated with the object.

To delete pages from a document, using the Thumbnail view:

1. Select all of the thumbnails that represent pages you want to delete. You have the following choices:
   - To select one thumbnail, click the thumbnail.
   - To select multiple consecutive thumbnails, click the first thumbnail, then click the last while holding down the [SHIFT] key.
   - To select multiple non-consecutive thumbnails, hold down the [CTRL] key while clicking thumbnails.

2. Right-click the selection. From the shortcut menu that appears, select Delete. A delete confirmation message appears.

3. Click Yes to delete the selected pages. Click No to quit.

Cutting Pages

You can cut pages from an AppXtender document. When a page is cut, AppXtender deletes the object file (*.BIN) and moves the page to the Windows Clipboard.

CAUTION

As soon as the deletion is confirmed, the page exists only in the Clipboard. Caution should be exercised because recovery of the page is not possible unless you paste the page back into an AppXtender document.

To cut a page:

1. Within AppXtender, display the page that you want to cut.

2. From the Edit menu, select Cut. A delete confirmation message appears.

3. Click Yes to delete the displayed page. Click No to quit. The page is copied to the Windows Clipboard.
Deleting Documents

There are two places from which you can delete documents in AppXtender: the Result Set tab and the Document Display view. As with other types of AppXtender functionality, you must have the necessary privileges to delete documents.

**Note:** Read-only documents cannot be deleted in the Document Display view.

When a document is deleted, the index information for the document and the document pages (*.BIN files) are deleted. If multiple index records reference a single document, deleting the document removes that document and all of the index records referencing it. To delete only one of the index records referencing a document, you must perform that deletion from the Result Set. (For information on allowing multiple index records to reference a single document in an application, consult your AppXtender system administrator or refer to the ‘Creating an Application’ section of the ApplicationXtender Installation Guide.)

For more information, refer to the following topics:

- “Deleting Documents from a Result Set” on page 432
- “Deleting Displayed Documents” on page 433

**CAUTION**

As soon as the deletion is confirmed, the document is permanently lost. Caution should be exercised because recovery of the document is not possible.

Deleting Documents from a Result Set

You can delete a single document or multiple documents from the Result Set tab.

To delete documents from a result set:

1. On the Result Set tab, select the documents that you want to delete.
2. Right-click to access a shortcut menu. When the shortcut menu appears, select Delete. A delete confirmation message appears.
3. To delete the selected document, click Yes. To quit, click No.
Deleting Displayed Documents

With the exception of read-only documents, you can delete displayed documents from the Document Display view.

**CAUTION**

As soon as the deletion is confirmed, the document is permanently lost. Caution should be exercised because recovery of the document is not possible.

To delete a displayed document:
1. Display the document that you want to delete.
2. From the Document menu, select Delete. A delete confirmation message appears.
3. To delete the displayed document, click Yes. To quit, click No.

Deleting Batches

You can delete a batch from the Batch Index list.

**CAUTION**

As soon as the deletion is confirmed, the batch is permanently lost. Caution should be exercised because recovery of the batch is not possible.

To delete a batch from the Batch Index list:
1. From the Utilities menu, select Batch Index (List). The Batch Index (List) dialog box appears.
2. In the Batches for application drop-down list, select the application that contains the batch that you want to delete. A list of batches appears in the table.
3. Select the batch that you want to delete.
4. Click Delete. A delete confirmation message appears.
5. To delete the batch, click Yes. To quit, click No.
This section contains information on the different ways in which you can use ODMA-compliant applications to work with ApplicationXtender documents.

- Introduction to ODMA .......................................................... 436
- ApplicationXtender ODMA Support ..................................... 439
- Configuring ODMA Support in ApplicationXtender ............. 440
- Creating New AppXtender Documents through ODMA ...... 442
- Retrieving AppXtender Documents through ODMA .......... 453
- Working with Checked Out AppXtender Documents .......... 469
- Using Non-AppXtender Documents in ODMA-Compliant Applications ......................................................... 482
Introduction to ODMA

The Open Document Management API (ODMA) is the standard method for desktop applications to integrate with a Document Management System (DMS), such as ApplicationXtender. ODMA provides a set of interfaces that applications can use to perform a subset of the content management functionality in ApplicationXtender (AppXtender). ODMA support also provides direct access to AppXtender functions from within other applications. If the applications you typically use are ODMA-compliant, you can use ODMA support to create, modify, and retrieve AppXtender documents from those applications – without having to open AppXtender.

ApplicationXtender uses ODMA to let you create AppXtender documents and check them into AppXtender from ODMA-compliant applications. You can also retrieve and check out AppXtender documents, modify them, and then check them back in as new document revisions or page versions. If you want to open a document as a read-only document (open it without checking it out), you can choose to do that through ODMA. When you have an existing AppXtender document checked out, you can modify the content of the document, the document summary information, or the AppXtender index information for the document. If you create a new document, you may enter the index information when you save the document to AppXtender.
This section contains information on the different ways in which you can use ODMA-compliant applications to work with AppXtender documents.

- Several commonly used applications are ODMA-compliant and are supported for use with AppXtender.
  
  For more information on the ODMA-compliant applications that can be used to work with AppXtender documents, refer to “ApplicationXtender ODMA Support” on page 439.

- To use the ApplicationXtender ODMA feature, ODMA support must be enabled in AppXtender.
  
  For more information on enabling ODMA support in AppXtender, refer to “Configuring ODMA Support in ApplicationXtender” on page 440.

- You can create new AppXtender documents from supported ODMA-compliant applications.
  
  For more information on creating new AppXtender documents from ODMA-compliant applications, refer to “Creating New AppXtender Documents through ODMA” on page 442.

- You can open existing AppXtender documents in supported ODMA-compliant applications. You can open a document in read-only mode, so that you can view it and modify it. However, you cannot save modifications back as a new document revision of the same AppXtender document or as new or replacement page version within the same AppXtender document. You can also choose to check the document out so you can make modifications to it.
  
  For more information on opening existing AppXtender documents in ODMA-compliant applications, refer to “Retrieving AppXtender Documents through ODMA” on page 453.

- If you checked out a document and made modifications to it, you can check those changes back into AppXtender in the form of a new document revision, a new page version, or a replacement page version. If you want to close the document but you are not ready to check it back in, you can choose to keep it checked out. If you decide that you do not want to keep the changes you have made at all and would like the document to remain as it was when you checked it out, you can choose to cancel the check out of the document.
For more information on saving, closing, and checking in modified existing AppXtender documents, refer to “Working with Checked Out AppXtender Documents” on page 469.

- If you have ODMA support enabled in AppXtender and would like to open or save documents that are not AppXtender documents, you can still do so using the File Selection button.

For more information on opening and saving non-AppXtender documents, refer to “Using Non-AppXtender Documents in ODMA-Compliant Applications” on page 482.
ApplicationXtender ODMA Support

The following table lists the AppXtender-supported applications that are ODMA-compliant:

Table 53  AppXtender-Supported Applications for ODMA

<table>
<thead>
<tr>
<th>Format</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Processing</td>
<td>Microsoft Word 2000</td>
</tr>
<tr>
<td></td>
<td>Microsoft Word 2002 (XP)</td>
</tr>
<tr>
<td></td>
<td>Microsoft Word 2003</td>
</tr>
<tr>
<td></td>
<td>WordPerfect 12</td>
</tr>
<tr>
<td>Standard Graphic</td>
<td>Visio 2000</td>
</tr>
<tr>
<td></td>
<td>Visio 2002 (XP)</td>
</tr>
<tr>
<td></td>
<td>Visio 2003</td>
</tr>
<tr>
<td>Presentation</td>
<td>Microsoft PowerPoint 2000</td>
</tr>
<tr>
<td></td>
<td>Microsoft PowerPoint 2002 (XP)</td>
</tr>
<tr>
<td></td>
<td>Microsoft PowerPoint 2003</td>
</tr>
<tr>
<td>Other</td>
<td>Microsoft Project 2000</td>
</tr>
</tbody>
</table>

CAUTION

Use of ODMA with any of the Corel Office 2000 suite of products causes system failure and is not supported with AppXtender.
Using ODMA With AppXtender Documents

Configuring ODMA Support in ApplicationXtender

Your workstation may be configured so that you can enable or disable ODMA support using the Data tab in the Configuration dialog box.

To configure ODMA support:

1. From the File menu, click Configuration. The Configuration dialog box appears.
2. Click the Data tab to activate it.

**Note:** If the Data tab does not display in your Configuration dialog box, consult your AppXtender system administrator for assistance in enabling this feature, or refer to the ApplicationXtender Core Components Administrator’s Guide.

3. You have the following choices:
   - If you would like to enable ODMA support, click the ODMA support check box to select the option if it is not already selected.
   - If you would like to disable ODMA support, click the ODMA support check box to clear the option if it is selected.
4. To save changes to ODMA support configuration, click OK.
5. If any ODMA-compliant applications are open, you must close and reopen them for the change to take effect.

If you have enabled ODMA support, the Save as a New AX Document dialog box appears in any AppXtender-supported ODMA-compliant applications when you choose to save a document and the Open AX Document dialog box appears when you choose to open a document. If you have disabled ODMA support, these dialog boxes do not appear.

**Note:** To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the “Appendix D: Import Wizards” section of the ApplicationXtender Core Components Administrator’s Guide.
Creating New AppXtender Documents through ODMA

When ODMA support is enabled in AppXtender and you save a document for the first time or close a document in an ODMA-compliant application, you are prompted to enter AppXtender index information. You can also enter additional identifying information for the document by filling in document properties information. An AppXtender dialog box opens within the interface of the ODMA-compliant application, allowing you to log into AppXtender and select an AppXtender application. You can then save the document as an AppXtender document.

For example, you can create a Microsoft Word document just as you normally would. The first time you save the document, if ODMA support is enabled in AppXtender, you can then index and store the document to AppXtender without leaving the Microsoft Word interface or even starting AppXtender.

The following procedure provides an overview of creating an AppXtender document through ODMA:

1. **Enable ODMA support on the Data tab of the Configuration dialog box in ApplicationXtender.**
   
   For details on configuring ODMA support, refer to “Configuring ODMA Support in ApplicationXtender” on page 440 or consult your AppXtender system administrator.

2. **Edit a blank file or open a file in an ODMA-compliant application.**
   
   For more information on opening existing files when ODMA support is enabled, refer to “Opening Non-AppXtender Documents with ODMA” on page 443.

3. **Save the document to AppXtender.**
   
   If the document is a new document, the first time you save it you are prompted to save the document as a new AppXtender document. If you are working on a document that you have saved outside of AppXtender previously, you can save the document as an AppXtender document. For more information on saving new documents to AppXtender, refer to “Saving New ODMA Documents to AppXtender” on page 445.
4. Enter document properties for the new AppXtender document. You can enter the information into the index fields by typing, by using automated indexing features, or both. You can enter document summary information into summary fields by typing. For more information on indexing new AppXtender documents through ODMA, refer to “Entering AppXtender Document Properties” on page 448.

5. Check the new document into AppXtender. When you have entered document properties for the document, the Check In New AX document dialog box appears. You can then check the document in and store it in AppXtender with the index information as a new AppXtender document. For more information, refer to “Checking a New Document into AppXtender” on page 452.

Opening Non-AppXtender Documents with ODMA

When you enable ODMA support in AppXtender, AppXtender causes any ODMA-compliant applications to display an AppXtender dialog box when you open a document. You can use the File Selection button in this dialog box to open existing, non-AppXtender documents. As soon as you have opened a document, you can edit it and save it to AppXtender.

To open a document from an ODMA-compliant application when ODMA is enabled in AppXtender:

1. From the Windows Start menu, select Programs. From the Programs menu, select an ODMA-compliant application, such as Microsoft Word. A blank document appears.
Using ODMA With AppXtender Documents

2. You have the following choices:
   
   - If you want to create a new document in the ODMA-compliant application, you can make changes to the displayed document. When you are ready to save the document to AppXtender, refer to “Saving New ODMA Documents to AppXtender” on page 445.
   
   - If you want to save an existing document to AppXtender, from the File menu, select Open. The Open ApplicationXtender Document dialog box appears.

   ![](image)

   **Figure 219 Open ApplicationXtender Document Dialog Box: Application Tab**

3. Click File Selection. A standard Open dialog box appears. Navigate to the drive or folder and select the file you want to open.
Creating New AppXtender Documents through ODMA

Using ODMA With AppXtender Documents

Figure 220 Open Dialog Box

The selected document is opened in the ODMA-compliant application. You can then make changes to the displayed document if needed. When you are ready to save the document to AppXtender, refer to “Saving New ODMA Documents to AppXtender” on page 445.

Saving New ODMA Documents to AppXtender

As soon as you create a new document or open an existing document in an ODMA-compliant application, you can save the document into AppXtender, thereby creating a new AppXtender document. During the process, you can add document summary attributes to the document to further identify the document. You must enter AppXtender index information for the document in order to save it to AppXtender.

Note: If you are working with a document that you have already saved outside of AppXtender, you must select Save As to save it as an AppXtender document. Selecting Save only saves modifications back to the location where you originally saved and does not create a document in AppXtender.
Note: To perform most ODMA functions, including checking in, saving, or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator's Guide.

To save documents to AppXtender:

1. Select Save As from the File menu. The Save As dialog box appears.

2. From the Select the AppXtender data source drop-down list, select the AppXtender data source that you want to access.

   Note: You can log into only those data sources for which you have a user account.

3. Click Login. One of the following events occurs:

   - If you are using the CM security provider and you did not select Remember password or if that option was not available to you, the Login dialog box appears. Type an AppXtender user name that is valid for the selected data source. Type a password and click Login to log into the AppXtender data source.

   - If you selected the Remember password option, or if you are using the Windows security provider, AppXtender remembers your user name and password and bypasses the Login dialog box. A list of applications for the selected data source appears in the Select the AppXtender application view. If you want to disable the Remember password option, click the Login button again. The Login dialog box appears. Disable Remember Password or make whatever changes you would like and then click Login to log into the AppXtender data source.

4. In the Select the AppXtender application list, double-click an application name.
5. If the Reason Code Required dialog box appears, enter a comment in the text box explaining the reason for opening the document and click OK.

Figure 221  Reason Code Required Dialog Box

6. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

Figure 222  Signature Properties Dialog Box

When you have logged into an AppXtender data source and selected an AppXtender application from the data source, the AX Document Properties dialog box appears. The General tab is active by default.

You can use this dialog box to view general properties for the document, to enter document summary information, and to enter AppXtender index values. The following topics describe each of the tabs in the dialog box:

- For more information on viewing the general properties for the new AppXtender document, refer to “AppXtender Document Properties: the General Tab” on page 448.
- For more information on entering document summary attributes for the new document, refer to “AppXtender Document Properties: the Summary Tab” on page 450. These attributes are saved with the document and can be used to search for the document later.
- For more information on entering AppXtender index information, refer to “AX Document Properties: the Index Tab” on page 451. The index values you enter are saved with the document and can be used to search for the document later, both through ODMA and through the AppXtender interface.

**Note:** When you have finished entering document properties, the document remains open and you can continue to work in it. You check out the document at that point. Any changes you save using the Save command are saved to a temporary copy of the document in the AppXtender repository. When you close a document that you have saved to AppXtender, the Check in New AX Document dialog box appears and you check the document into AppXtender. For more information on the document check-in process, refer to “Checking a New Document into AppXtender” on page 452.

The General tab of the AX Document Properties dialog box provides general information about the document you are adding to AppXtender. The information on the General tab is dimmed to indicate that you cannot modify it. This tab is active by default when the AppXtender Document Properties dialog box displays.

To view the General tab:

1. If the General tab is not active, click it to activate it. The General tab appears.
2. Review the information in the General tab. The following table describes each field on the General tab:

### Table 54: General Tab Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>App Name</td>
<td>Name of the application where the document is stored.</td>
</tr>
<tr>
<td>Revision</td>
<td>Revision information for the existing AppXtender document. If this is a new AppXtender document, this field contains a no revisions message. If the document has been finalized, the word “Final” follows the version number.</td>
</tr>
<tr>
<td>Created By</td>
<td>User name of the person who initially created the document in AppXtender. If the Windows security provider is used, the domain name also appears.</td>
</tr>
<tr>
<td>Created On</td>
<td>Date and time the document was created in AppXtender.</td>
</tr>
<tr>
<td>Modified By</td>
<td>User name of the person who modified the document in AppXtender. If the Windows security provider is used, the domain name also appears.</td>
</tr>
<tr>
<td>Modified On</td>
<td>Date and time the document was last modified.</td>
</tr>
<tr>
<td>Check Out By</td>
<td>User name of the person who checked out the document in AppXtender. If the Windows security provider is used, the domain name also appears.</td>
</tr>
<tr>
<td>Check Out On</td>
<td>Date and time the document was checked out.</td>
</tr>
<tr>
<td>Check Out Comment</td>
<td>Comments left before the AppXtender document was checked out.</td>
</tr>
</tbody>
</table>

3. You have the following choices:

- Activate one of the other two tabs by clicking on the appropriate tab. For more information, refer to “AX Document Properties: the Index Tab” on page 451 or “AppXtender Document Properties: the Summary Tab” on page 450.

- Click OK if you have finished viewing and entering AppXtender document properties for the new document.

Clicking OK from the Document Properties dialog box saves the document to an AppXtender repository temporarily until you are ready to check in. At this point, you must close the file to prompt the Check In New AX Document dialog box.

**Note:** Clicking OK on the AppXtender Document Properties dialog box before entering index information automatically displays the Index tab. If you click OK again without entering index information or if you enter invalid index information, a message appears indicating that the index failed. Click OK on the message, and re-enter the index information on the Index tab.
To add ODMA document summary attributes:

1. Click the Summary tab. The Summary tab appears.
2. Enter information in the desired fields. All fields in the Summary tab are optional.

The following table describes each field on the Summary tab:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Suggested text to display in the document window’s title bar. The title can be up to 127 characters long.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject matter of the document. The subject can be up to 127 characters long.</td>
</tr>
<tr>
<td>Author</td>
<td>Author of the document. The author’s name can be up to 127 characters long.</td>
</tr>
<tr>
<td>Keywords</td>
<td>A list of keywords assigned to the document. AppXtender treats each line that you enter as a keyword, regardless of whether spaces, commas, or other delimiters are included in the line. To start a new keyword, press [ENTER] to go to the next line in the Keywords text box. Each keyword can be up to 99 characters long.</td>
</tr>
<tr>
<td>Comment</td>
<td>Comments can be up to 250 characters long.</td>
</tr>
</tbody>
</table>

3. You have the following choices:
   - Activate one of the other two tabs by clicking on the appropriate tab. For more information, refer to “AppXtender Document Properties: the General Tab” on page 448 or “AX Document Properties: the Index Tab” on page 451.
   - When you have finished viewing and entering AppXtender document properties for the new document, click OK.

As soon as you click OK, you are returned to the document that you have been working on. The document is now a document in AppXtender that you have checked out. If you continue to make changes, those changes are saved whenever you select Save. When you close the document, the Check In New AppXtender Document dialog box appears with New Document Revision and Major Revision options enabled. For more information on checking a new document into AppXtender, refer to “Checking a New Document into AppXtender” on page 452.
Creating New AppXtender Documents through ODMA

Using ODMA With AppXtender Documents

Note: If you do not fill in AppXtender index information, the Document Properties dialog box still displays and the Index tab automatically becomes active. If you click OK again without entering index information or if you enter invalid index information, a message appears indicating that the index failed. Click OK on the message, and re-enter index information on the Index tab.

The Index tab of the AX Document Properties dialog box is the equivalent of the Index View in AppXtender. You enter index field values on this tab to identify the document for later retrieval. You must enter AppXtender index information in order to successfully create a new AppXtender document.

To index a document:

1. Click the Index tab. The Index tab appears.
2. Enter the information in the fields by typing or by using automated indexing features, or both. For more information on AppXtender indexing features, refer to “Indexing New Documents” on page 187.

   Note: All fields displayed in bold are required fields. You must enter information into these fields.

3. You can activate one of the other two tabs by clicking on the appropriate tab. For more information, refer to “AppXtender Document Properties: the General Tab” on page 448 or “AppXtender Document Properties: the Summary Tab” on page 450.

4. When you have finished viewing and entering AppXtender document properties for the new document, click OK.

As soon as you click OK, you are returned to the document that you have been working on. The document is now a document in AppXtender that you have checked out. If you continue to make changes, those changes are saved whenever you select Save. When you close the document, the Check In New AX Document dialog box appears with New Document Revision and Major Revision options enabled. For more information on checking a new document into AppXtender, refer to “Checking a New Document into AppXtender” on page 452.
Note: If you do not fill in AppXtender index information, the AX Document Properties dialog box will still display and the Index tab will automatically become active. If you click OK again without entering index information or if you enter invalid index information, a message appears indicating that the index failed. Click OK. Re-enter the index information on the Index tab.

Checking a New Document into AppXtender

When you have finished entering document properties for the new AppXtender document and have also finished editing it, the final step is checking the document into AppXtender.

To check a new document into AppXtender:

   When you are checking a new document in, the only option that is available is New Document Revision – Major Revision. This is because no previous revisions of the document exist, so saving as a minor revision or a new or replacement page version is not possible.

2. Type any comments about the new document into the Comment text box.

3. If AppXtender Workflow has been installed and you want to check the document into AppXtender Workflow, click Login. For further instructions, refer to the ApplicationXtender Workflow User’s Guide.

4. Click OK.
Retrieving AppXtender Documents through ODMA

When you open a document using ODMA, you access an AppXtender dialog box that allows you to search for AppXtender documents. Searching for documents from an ODMA-compliant application is very similar to searching for documents in AppXtender. You enter AppXtender index information or full-text search criteria to retrieve documents, and the results display on a separate result set tab. When you are retrieving documents from an ODMA-compliant application, you can also search using document attribute information.

In Microsoft Word, for example, when you open a document while ODMA support is enabled, a dialog box containing document information, a Search tab, and a Result Set tab appears. You can enter search criteria, perform a query, and then open a document from the Result Set tab (if this document was originally in AppXtender as a Microsoft Word document). The document then displays in Microsoft Word and can be edited like any Microsoft Word document.

When a document is stored to AppXtender using ODMA, the file is stored as a foreign file in AppXtender. You can retrieve any AppXtender document that was saved as a foreign file in AppXtender (or was saved through ODMA-compliant applications) into an ODMA-compliant application that can read that file type. For example, if you imported a Microsoft Word file into AppXtender through the AppXtender interface, that document page is a foreign file and you can open it in Microsoft Word using ODMA.

To retrieve a document through ODMA:

1. When retrieving AppXtender documents from an ODMA-compliant application, you first select a data source and log into that data source. You can then select an AppXtender application to search.

For more information on logging into a data source, refer to “Logging into Multiple Data Sources” on page 55. For more information on opening an AppXtender application to search, refer to “Opening an AppXtender Application to Search” on page 454.
2. You can use the ODMA and AppXtender functionality to perform a query, such as a keyword or wildcard query, to search for a document. After you enter the search criteria, the documents that met the search criteria appear in the Result Set tab.

   For more information on opening an AppXtender application to search, refer to “Searching for Documents” on page 456.

3. You can then select the document that you want to open from the Result Set list tab.

   For more information on opening an AppXtender application to search, refer to “Opening a Document from the Result Set” on page 458.

4. When you open the document, you are prompted to either check out the document or open it in read-only mode.

   For more information on opening an AppXtender application to search, refer to “Choosing a Viewing Mode for an AppXtender Document” on page 461.

To retrieve a document from AppXtender, you must log into an AppXtender Data Source and select the AppXtender application where the document is stored.

To open a document in AppXtender using an ODMA-compliant application:

1. From the Windows Start menu, select Programs. From the Programs menu, select an ODMA-compliant application, such as Microsoft Word. A blank Microsoft Word document opens.

2. From the File menu, select Open. The Open ApplicationXtender Document dialog box appears.
3. From the Select the AppXtender data source drop-down list, select the AppXtender data source that you want to access.

**Note:** You can log into only those data sources for which you have a user account.

4. Click Login. One of the following events occurs:

- If you are using the CM security provider and you did not select Remember password or if that option was not available to you, the Login dialog box appears. Type an AppXtender user name that is valid for the selected data source. Type a password and click Login to log into the AppXtender data source. A list of applications for the selected data source appears in the Select the AppXtender application view.

- If you selected the Remember password option, or if you are using the Windows security provider, AppXtender remembers your user name and password and bypasses the Login dialog box. A list of applications for the selected data source appears in the Select the AppXtender application view. If you want to disable the Remember password option, click the Login button again. The Login dialog box appears. Disable Remember Password or make whatever changes you would like and then click Login to log into the AppXtender data source.
5. Double-click the name of the AppXtender application that you would like to search in the Select AppXtender application list.

Searching for Documents

After you select an application and open it, the Search tab of the Open ApplicationXtender Document dialog box appears.

![Open ApplicationXtender Document Dialog Box: Search Tab](image)

**Figure 224 Open ApplicationXtender Document Dialog Box: Search Tab**

To search for an AppXtender document in an ODMA-compliant application:

1. You have several choices:
   - If you want to search for documents using known ODMA attributes, enter information in the document properties fields. These fields appear in brackets in the Fields column.
   - To search using AppXtender index values, enter information in the index fields. These fields appear in all capital letters in the Fields column.
   - To search using full-text information, enter keywords in the text box at the bottom of the screen.
You can search using any combination of information. When you enter both document properties and application properties, AppXtender assumes that you want documents with both the entered document properties AND the application properties. All forms of AppXtender search functionality, including wildcards, lists of values, and search expressions, can be used to search both the document properties and the application properties.

If you are using full-text criteria, you have the following choices:

- You can search for the document properties and application properties AND the full-text criteria by selecting the AND option.
- You can search for the document properties and application properties OR the full-text criteria by selecting the OR option.
- If the application is configured to use a K2 full-text engine, you can search for words that are related to your search criteria by selecting the Thesaurus option.

**Note:** For more information on advanced and full-text search options, refer to Chapter 5, “Retrieving Documents.”

2. If you want to search for previous document revisions, click the Include Previous Document Revision check box.

**Note:** If an asterisk appears in a Values text box in the Application Properties window, you can select search criteria from a user-defined list. To do so, highlight the Values text box that has an asterisk in it and double-click. From the drop-down list that appears, select a value.

3. Click Search. The result of your search is displayed in the Result Set view of the Open ApplicationXtender Document dialog box.

**Note:** If no documents met the search criteria, a message appears indicating that no documents were found. Click OK. The Result Set view appears empty. To run another query, click the Search tab; otherwise, click Cancel to exit.
Opening a Document from the Result Set

When your search is complete, the results appear in the Result Set tab. You can choose to open a document listed in the Result Set and check it out or you can open it as a read-only document.

- When you check out a document, you take possession of that document and other users can only open it in read-only mode until you check it back in.
- When you open a document as a read-only document, the document is not checked out by you and could be checked out and modified by another user while you have it open. If someone else has already checked out a document, you can only open it in read-only mode.

The folder icons in the Result Set indicate a document’s status.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Yellow folder with red check mark" /></td>
<td>Yellow folder with red check mark</td>
<td>This document is currently checked out. Unless you are the one who has checked it out, you can only open it in read-only mode. If you check it out, you can open it to edit it, or you can open it in read-only mode.</td>
</tr>
<tr>
<td><img src="image2" alt="Yellow folder" /></td>
<td>Yellow folder</td>
<td>This document is not checked out. You can choose to check it out or to open it in read-only mode.</td>
</tr>
<tr>
<td><img src="image3" alt="Dimmed folder" /></td>
<td>Dimmed folder</td>
<td>This document is a previous revision of a document. This folder appears only if you have selected the Include Previous Document Revision check box. You can only open it in read-only mode.</td>
</tr>
</tbody>
</table>
Using ODMA With AppXtender Documents

If you want to find out who has a document checked out, or view the document summary or index information for a document, you can access a document’s properties from the result set. For instructions, refer to “Viewing Properties from the ODMA Result Set” on page 461.

You can also open documents from the Result Set.

Note: To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

To open a document from the Result Set:
1. Double-click the document in the Result Set.
2. If the Reason Code Required dialog box appears, enter a comment in the text box explaining the reason for opening the document and click OK.
3. What appears next depends on the status of the document. You have the following choices:

- If the Check out dialog box appears, you can either check out the document or open it in read-only mode. For information on checking out a document, refer to “Opening a Document that is Checked In” on page 462. For information on opening a document in read-only mode, refer to “Opening a Document in Read-Only Mode” on page 465.

- If the Open AX Document dialog box appears, you can choose to open the document in check out mode or in read-only mode. If you open the document in check out mode, the document opens with the latest modifications that you made since checking it out. If you open the document in read-only mode, the document opens using the version that was originally checked out (prior to any changes you made). For information on checking out a document, refer to “Opening a Document that is Checked Out by You” on page 464. For information on opening a document in read-only mode, refer to “Opening a Document in Read-Only Mode” on page 465.

- If a message appears stating that someone else has the document open, or that you do not have the privileges to check out the document, you can only open the document in read-only mode. When you open the document in read-only mode, the document opens in the form that it was in when it was checked out. For information on opening a document in read-only mode, refer to “Opening a Document in Read-Only Mode” on page 465.
For information on opening AppXtender documents in check out mode or in read-only mode, refer to “Choosing a Viewing Mode for an AppXtender Document” on page 461.

If you want to find out who has a document checked out, or would like to view document summary or index information for a document, you can access a document’s properties from the result set.

To view document properties from the Result Set:

1. Right-click a document in the Result Set tab.
2. From the shortcut menu that appears, select Properties. The AX Document Properties dialog box for that document appears, with the General tab active.

   For more information on AppXtender document properties, refer to “AppXtender Document Properties” on page 421.
3. When you are finished viewing the document properties, click OK to return to the Result Set tab.

When you open an AppXtender document through ODMA, you choose whether to open the document in check out mode or in read-only mode.

Note: To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

Read-only mode displays the document in the ODMA-compliant application. You can make modifications to the document, but to save the modified document to AppXtender, you must save it as a new document.
What is Check Out Mode?

Documents can also be "checked out" so modifications can be made. When you check out a document, AppXtender makes a copy of the document in the AppXtender repository. This becomes your "working copy" of the document. The original version of the document remains the current version in AppXtender until you check the document back in.

When you make changes to the checked-out document, the changes are made to the working copy. When you are done making changes, you can check the document back in AppXtender as either a New Revision (Major or Minor), New Page Version or Replace Page Version. To keep track of previous changes you must select New Document Revision.

If you decide that you would rather not check in the modified document, you can cancel the check out. When you cancel the check out, AppXtender deletes the copy that it stored temporarily and treats the revision at checkout as the most recent revision.

---

Note: The final revision option on check-in is not available when checking in documents through ODMA.

---

For more information on opening documents in the different modes, refer to the following topics:

- “Opening a Document that is Checked In” on page 462.
- “Opening a Document that is Checked out by You” on page 464
- “Opening a Document in Read-Only Mode” on page 465

Opening a Document that is Checked In

When you open a document that is checked in, the Check Out dialog box appears. When you check out this document, AppXtender makes a working copy of the document. When you make changes to the document that you checked out, you save those changes to the working copy of the document.
When you are done making changes, you can decide whether you want to check the document back into AppXtender, saving the document permanently to the AppXtender repository. If you decide that you do not want to check the document in, you can cancel the check out. Canceling a check out discards the working copy of the document that was created when you checked out the document. When you cancel the check out, all changes made since checking out the document are discarded and AppXtender treats the document revision that you originally checked out as the latest document revision.

**Note:** To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the "Managing Security" section of the *ApplicationXtender Core Components Administrator’s Guide*.

**Note:** For more information on reopening a document that you have checked out, refer to “Opening a Document that is Checked out by You” on page 464.

To check out a document:

1. When you open the document, the Check Out dialog box appears with the Check Out option selected. Leave Check Out selected if you intend to modify the document.

2. If you want to add a comment in the Comment text box, enter the desired information. If you check out the document, your comments can be viewed by other users in the General tab of the AX Document Properties dialog box. The Comments feature is not available if you open the document in Read-Only mode.

   **Note:** Comments can be up to 250 characters long.

3. Click OK. ODMA opens the document in the ODMA-compliant application.
Opening a Document that is Checked out by You

When you open a document that you checked out and have not yet checked back in, the Open AX Document dialog box appears. When you check out a document that is checked in, AppXtender makes a working copy of the document. When you reopen the document after choosing to Save Changes and Keep Checked Out, you reopen that working copy. Any changes you made since checking it out are reflected in the document.

When you are done making changes, you can decide whether you want to check the document back into AppXtender, saving the document permanently to the AppXtender repository. If you decide that you do not want to check the document in, you can cancel the check out. Canceling a check out discards the working copy of the document that was created when you checked out the document. When you cancel the check out, all changes made since checking out the document are discarded and AppXtender treats the document revision that you originally checked out as the latest document revision.

To open a document checked out by you:

- When you open the document, the Open AX Document dialog box appears. Click OK to reopen the working copy of the document created when you checked the document out.

ODMA opens the document in the ODMA-compliant application.

Note: If you open a document that was saved as a foreign file in AppXtender through ODMA, a message appears indicating that you might not be able to open the file. As long as the file is of a type supported by the currently open ODMA-compliant application, it should open successfully in the application. Click OK to continue the operation, or click Cancel to exit.
Opening a Document in Read-Only Mode

When you open a document in read-only mode, you can make changes to the document, but you cannot save those changes back to AppXtender as a revision or page version of the same AppXtender document.

There are three circumstances in which you can open a document in read-only mode:

◆ If the document is not checked out, you can choose to open it in read-only mode rather than checking it out.
  For more information on opening in read-only mode a document that is not checked out, refer to “Opening a Document that is not Checked Out in Read-only Mode” on page 465.

◆ If you have the document checked out, but you do not want to reopen the checked out copy, you can open the original revision of the document at check out in read-only mode.
  For more information on opening in read-only mode a document that you have checked out, refer to “Opening a Document that is Checked out by You in Read-only Mode” on page 466.

◆ If someone else has the document checked out, you can only open the document in read-only mode.
  For more information on opening in read-only mode a document that someone else has checked out, refer to “Opening a Document that is Checked out by Someone Else in Read-only Mode” on page 467.

Note: You must have the Display privilege enabled to view a document in read-only mode. For more information, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

Opening a Document that is not Checked Out in Read-only Mode

When you open in read-only mode a document that is not checked out, you make a copy of the current revision of the document. You can make changes to that copy; however, there is no way to check that copy back in as a document revision or new or replacement page version related to the original document.
In addition, someone else can check out the document that you opened while you have it open. The changes that they make are not reflected in the copy you have open, and you do not receive any notification that changes have occurred.

**Note:** You can check the document properties for a document from the result set before you open it. On the General tab, the revision number for the document is listed. If you are opening the same document in read-only mode on an ongoing basis, you may want to check the document properties and note the revision number each time to see whether any new revisions are checked in since you last viewed the document. For more information on viewing document properties from the Result Set, refer to “Opening a Document from the Result Set” on page 458.

To open a document in read-only mode:

1. When you open the document, the Check Out dialog box appears with the Check Out option selected. Select Open as Read-Only to open the document in read-only mode.

   **Note:** Comments are not available when you select Open as Read-Only.

2. Click OK. ODMA opens the document in the ODMA-compliant application in read-only mode.

   **Note:** If you open a document that was saved as a foreign file in AppXtender through ODMA, a message appears indicating that you might not be able to open the file. As long as the file is of a type supported by the currently open ODMA-compliant application, it should open successfully in the application. Click OK to continue the operation, or click Cancel to exit.

**Opening a Document that is Checked out by You in Read-only Mode**

When you open a document that is already checked out by you in read-only mode, you make a copy of the current revision of the document in AppXtender. This is the document as it was before you checked it out and made any changes. The working copy of the document is not opened. Instead, you view the document as it is currently in AppXtender. Any changes you may have made to the copy you checked out are not reflected in the read-only copy.
You can make changes to the read-only copy; however, there is no way to check that copy back in as a document revision or new or replacement page version related to the original document.

**Note:** If you want to open the copy that you checked out to continue making modifications to it and to check it back in, refer to “Opening a Document that is Checked out by You” on page 464.

To open a document that is checked out by you in read-only mode:

- When you open the document, the Open AX Document dialog box appears. Click Read-Only to open the document in read-only mode.

ODMA opens the document in the ODMA-compliant application in read-only mode.

**Note:** If you open a document that was saved as a foreign file in AppXtender through ODMA, a message appears indicating that you might not be able to open the file. As long as the file is of a type supported by the currently open ODMA-compliant application, it should open successfully in the application. Click OK to continue the operation, or click Cancel to exit.

**Opening a Document that is Checked out by Someone Else in Read-only Mode**

If someone else has a document checked out, you can only open it in read-only mode. When you open a document that is checked out by someone else in read-only mode, you make a read-only copy of the current revision of the document in AppXtender. This is the document as it was when it was checked out. The copy does not reflect any changes that may have been made to it by the person who checked it out.

You can make changes to the read-only copy; however, there is no way to check that copy back in as a document revision or new or replacement page version related to the original document.

**Note:** You can check the document properties for a document from the result set before you open it to see who has checked the document out. On the General tab, the person to whom the document is checked out is listed. For more information on viewing document properties from the Result Set, refer to “Opening a Document from the Result Set” on page 458.
To open a document that is checked out by someone else in read-only mode:

- When you open the document, a message box appears. Click OK to open the document in read-only mode or click Cancel to return to the Result Set tab without opening the document.

Figure 227  ApplicationXtender Message Box

If you click OK, ODMA opens the document in the ODMA-compliant application in read-only mode.

**Note:** If you open a document that was saved as a foreign file in AppXtender through ODMA, a message appears indicating that you might not be able to open the file. As long as the file is of a type supported by the currently open ODMA-compliant application, it should open successfully in the application. Click OK to continue the operation, or click Cancel to exit.
Working with Checked Out AppXtender Documents

You can make changes to an AppXtender document that you have checked out through ODMA. AppXtender allows you to save changes to a temporary location and then decide what to do with the modified document when you close it. When you close the document, you can choose to check it back in, to save changes to the document and keep it checked out, or to cancel check out of the document.

Note: To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

When you check the document in, you can choose to save it as a new document revision, creating a new revision document and saving the document that you originally checked out as a previous revision. You can also choose to add the revised document as a new page version within the document page you checked out, or as a replacement page version for the page that you originally checked out.

If you are not yet ready to check the document in, you can save changes to the copy of the document that AppXtender made when you checked the document out, and keep the document checked out. When you reopen the document, you reopen the modified copy. For more information on reopening a document that you have checked out, refer to “Opening a Document that is Checked out by You” on page 464.

If you decide that you do not want to check the document in, you can cancel the check out. Canceling a check out discards the temporary copy of the document that was created when you checked out the document. When you cancel the check out, all changes that you made since checking out the document are discarded and AppXtender treats the document revision that you originally checked out as the latest document revision.
For information on saving changes to checked out AppXtender documents while you work, refer to “Saving Checked Out AppXtender Documents” on page 470.

For information on closing checked out AppXtender documents from ODMA-compliant applications, refer to “Closing a Checked Out AppXtender Document” on page 471.

Note: If you open a document in read-only mode and make changes to it, you can only save the modified document as a new AppXtender document, not as a new document revision or a new or replacement page version. For more information on creating new AppXtender documents through ODMA, refer to “Creating New AppXtender Documents through ODMA” on page 442.

Saving Checked Out AppXtender Documents

When you check out a document from AppXtender into an ODMA-compliant application, you can make modifications to that document and save them as you go. Every time you save a change, AppXtender temporarily saves the document to the AppXtender document repository, but does not make any changes to the original document that you checked out. By keeping a temporary copy of the document until you are ready to check it in, AppXtender allows you to work on the document as you normally would. You can save as frequently as you want, but you do not have to decide whether to permanently commit those changes to the document until you check the document in (or cancel the document checkout).

To save changes to a checked out document in an ODMA-compliant application:

From the File menu in the ODMA-compliant application, select Save. Any changes you have made since the last save are saved to the temporary copy of the document.

CAUTION

Do not use the Save As command to save changes to a document. Selecting Save As prompts AppXtender to save the document as a new AppXtender document, rather than saving changes to a temporary copy. If you accidentally select Save As instead of Save, click Cancel to return to the document, then select Save to save your changes.
Using ODMA With AppXtender Documents

Note: In the event that you decide to check the changed document back into AppXtender, all of the changes you made to the document are saved as a new permanent AppXtender revision document or as a new or replaced page version in the AppXtender document you originally checked out. You chose how the modified document is saved when you check it in.

Note: In the event that you decide to cancel checkout of the document, the modified document that has been temporarily saved to the AppXtender document is discarded (and the original document that you checked out is not changed).

Note: To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

Closing a Checked Out AppXtender Document

When you close a document that you have checked out from AppXtender, AppXtender prompts you to choose whether to check the document back in, save changes and keep the document checked out, or cancel the document check out.

Note: If you close a document that has not yet been saved at all or that was opened as a read-only document from AppXtender, you must save that document as a new AppXtender document to add the modified document to AppXtender. For more information on saving new documents to AppXtender, refer to “Creating New AppXtender Documents through ODMA” on page 442.

The following table summarizes the effect of each of the choices available to you when you close a checked out AppXtender document:
### Closing a Checked Out AppXtender Document

<table>
<thead>
<tr>
<th>Command in ODMA</th>
<th>Result</th>
</tr>
</thead>
</table>
| Close > Check In | **Result in AppXtender:** Saves a new revision of the AppXtender document (in the form of a new revision, or a new or replacement page version), keeping the previous revision in AppXtender, and checks in the document. Uses the same document index information as the previous revision unless you change it.  
**Result in Document in ODMA Application:** Document in ODMA application closes and is checked in. You can open the document again by searching for the index information you entered. When you open the document, the page that you saved appears.  
For more information, refer to “Checking In an AppXtender Document” on page 473. |
| Close > Save Changes and Keep Checked Out | **Result in AppXtender:** Saves your changes to the AppXtender document repository without yet creating a new AppXtender document, keeping the previous revision in AppXtender, and keeps the document checked out in your name.  
**Result in Document in ODMA Application:** Document in ODMA application closes, but remains checked out. You can open the document again by searching for the index information you entered. When you open the document, you are given a choice to open and edit it as a checked out document, or to open it in read-only mode (which opens the current revision of the document in AppXtender).  
For more information, refer to “Saving Changes to an AppXtender Document and Keeping It Checked Out” on page 479 |
| Close > Cancel Check Out | **Result in AppXtender:** Reverts to the state of the document when you checked it out, and discards any changes (even if you have selected Save Changes and Keep Checked Out in the interim).  
**Result in Document in ODMA Application:** Document in ODMA application closes and the copy that you had open is deleted. You can open the original version of the document by searching for the index information you entered. When you open the document, the page that displayed when you last checked out the document appears.  
For more information, refer to “Canceling the Check Out of an AppXtender Document” on page 480. |
Checking In an AppXtender Document

When you check in a document, you save a new revision of the AppXtender document to the AppXtender repository, either in the form of a new major or minor document revision or in the form of a new or replacement page version. If you choose to check the document in as a new document revision, AppXtender keeps the previous document revision but marks it as a previous revision. If you choose to check the document in as a new page version, AppXtender adds the document as a new page version in the AppXtender document that you originally checked out. If you choose to check the document in as a replacement page version, AppXtender replaces the page version in the AppXtender document that you originally checked out with the new document. When you check in a document, AppXtender uses the same document index information as the previous revision unless you change it after you choose to check it in.

Note: To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

Understanding Document Revisions

Using ODMA allows AppXtender to perform revision control on AppXtender documents created or accessed through ODMA. When you store a document in AppXtender using ODMA, you can check that document into AppXtender. “Checking in” and “checking out” documents allows AppXtender to track the revisions of a document in the AppXtender system. When you check a document in, you release the document from your control and put it back into the AppXtender system. If you want to modify the document again, you need to check it back out before doing so. Whenever a document is checked in, AppXtender saves the new revision of the document in the way that you indicate: as a new document, as a major revision, or as a minor revision.
Note: When you save a document to AppXtender for the first time, you are only given the option to save the document as a major new document revision because the document did not exist previously. For more information on creating new AppXtender documents through ODMA, refer to “Creating New AppXtender Documents through ODMA” on page 442.

When you open a document from the result set using ODMA, you must choose whether to check that document out or open it read-only. Checking the document out ensures that while you are working on the document, other users are not able to make modifications to the same document.

Note: If you open a document in read-only mode and attempt to save changes to it, AppXtender makes you save the document as a new AppXtender document. For more information on creating new AppXtender documents through ODMA, refer to “Creating New AppXtender Documents through ODMA” on page 442.

If you modify a checked-out document, you can check it back into AppXtender. Because AppXtender allows you to check documents in through ODMA, you can control how the document is resaved.

If you want to save iterations of a document chronologically, you can do so using ODMA. If every time you save a document, you save it as a major revision or minor revision, when you search for a document, you can choose to retrieve previous document revisions through ODMA. You then enter the AppXtender index information for the document through ODMA to retrieve all revisions of the document. The Include Previous Document Revision check box must be selected in order to retrieve all revisions of the document. Document revisions allow you to further categorize your AppXtender documents by saving entire revisions of a document in a chronological order and yet associating all of the revisions with the same AppXtender document index information.
When you choose to save an ODMA document as a page version, it has the same effect as adding a foreign file as a page version through the AppXtender interface. You can access the most recent page version of the first page in a document through ODMA support. However, you cannot view earlier page versions from an ODMA-compliant application. To do so, you must use ApplicationXtender. For this reason, if you primarily access documents from the ODMA interface and wish to access the previous drafts of a document, you should save the document as a major or minor document revision rather than a page version.

The following table explains what the possible choices are when you are checking in a document through ODMA:

<table>
<thead>
<tr>
<th>Check In Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>New document revision – Major revision</td>
<td><strong>Result in AppXtender:</strong> Saves a new revision of the AppXtender document, keeping the previous version, and checks in the document. Uses the same document index information as the previous version unless you change it. Each major revision augments the version number for the document by 1. (For example, version 1 becomes version 2.) <strong>Result in Document in ODMA Application:</strong> Document in ODMA application closes and is checked in. You can open the document again by searching for the index information you entered. When you open the document, the latest document revision appears. In order to access previous revisions of the document, the Include Previous Document Revision check box must be checked when searching. For more information, refer to “Checking in a New Document - Major Revision” on page 476.</td>
</tr>
<tr>
<td>New document revision – Minor revision</td>
<td><strong>Result in AppXtender:</strong> Creates a new AppXtender document, keeping the previous version, and checks in the document. Uses the same document index information as the previous version unless you change it. Each minor revision augments the version number for the document by .1. (For example, version 1 becomes version 1.1.) <strong>Result in Document in ODMA Application:</strong> Document in ODMA application closes and is checked in. You can open the document again by searching for the index information you entered. When you open the document, the page that you saved will display. You can access the previous versions of the document by checking the Include Previous Document Revision check box when searching. For more information, refer to “Checking in a New Document - Minor Revision” on page 477.</td>
</tr>
</tbody>
</table>
Using ODMA With AppXtender Documents

Table 58 Checking In a Document Through ODMA (continued)

<table>
<thead>
<tr>
<th>Check In Option</th>
<th>Result</th>
</tr>
</thead>
</table>
| New page version      | **Result in AppXtender:** Adds the current document as a new page version in the checked out AppXtender document and checks in the document. Uses the same document index information as the previous version unless you change it. You can view older page versions by opening the document in AppXtender. This is the default setting when you save a document to AppXtender through ODMA.  
**Result in Document in ODMA Application:** Document in ODMA application closes and is checked in. You can open the document again by searching for the index information you entered. When you open the document, the page that you saved will display.  
For more information, refer to “Checking in a New Page Version” on page 478. |
| Replace page version  | **Result in AppXtender:** Replaces the page version that was retrieved when the AppXtender document was checked out and checks in the document. Uses the same document index information as the previous version unless you change it. The page version that you modified has been replaced and cannot be retrieved through AppXtender.  
**Result in Document in ODMA Application:** Document in ODMA application closes and is checked in. You can open the document again by searching for the index information you entered. When you open the document, the page that you saved will display.  
For more information, refer to “Checking in a Replacement Page Version” on page 479. |

**Checking in a New Document - Major Revision**

When you save a document to AppXtender for the first time, you are only given the option to save the document as a New Document Revision – Major Revision. You can check a document into AppXtender as a New Document Revision – Major Revision. When you choose to check a document in as a new document revision, AppXtender creates a new document with the same index information and marks the previous revision of the document as a previous revision. When you select Major Revision, AppXtender increments the document revision number by 1. For example, if the document you opened was revision 1.0, the new revision number is 2.0.

When you check the document out again, information about the revision number of the document can be viewed in the AppXtender Document Properties dialog box. You can retrieve read-only copies of previous versions of the document when you search for documents (and save them as new documents if needed). If you are only accessing documents through ODMA, use the New Document Revision options to be able to track separate revisions.
To check a document into AppXtender as a New Document Revision - Major Revision:

1. The Check In AX Document dialog box appears with the New Page Version option selected.
2. Select New Document Revision. The Major Revision and Minor Revision options become available.
3. Select Major Revision.
4. If you want to add a comment to the document, type the information in the Comment text box.
5. If a AppXtender Workflow client has been installed and you want to check the document into AppXtender Workflow, click Login. For further instructions, refer to the ApplicationXtender Workflow User’s Guide.
6. Click OK. The document is saved to AppXtender again as a New Document - Major Revision.

**Checking in a New Document - Minor Revision**

You can check a document into AppXtender as a minor new document revision. When you choose to check a document in as a New Document – Minor Revision, AppXtender creates a new document with the same index information and marks the previous revision of the document as a previous revision. When you select New Document - Minor Revision, AppXtender increments the document revision number by .1. For example, if the document you opened was revision 1.0, the new revision number is 1.1.

When you check the document out again, information about the revision number of the document can be viewed in the AX Document Properties dialog box. You can retrieve read-only copies of previous revisions of the document when you search for documents (and save them as new documents if needed). If you are only accessing documents through ODMA, use the New Document Revision options to be able to track separate revisions.

To check a document into AppXtender as a minor new document revision:

1. The Check In AX Document dialog box appears with the New Page Version option selected.
2. Select New Document Revision. The Major Revision and Minor Revision options become available.
3. Select Minor Revision.
4. If you want to add a comment to the document, type the information in the Comment text box.
5. If an AppXtender Workflow client has been installed and you want to check the document into AppXtender Workflow, click Login. For further instructions, refer to the ApplicationXtender Workflow User’s Guide.
6. Click OK. The document is saved to AppXtender again as a minor new document revision.

**Checking in a New Page Version**

You can check a document back into AppXtender as a new page version in order to replace the document that you opened from AppXtender. ODMA displays only the newest version page of a document, so when you check your current revision in as a new page version, you see only that version when you next open the document. You can, however, access earlier page versions through AppXtender. Use of this option is recommended only if you access documents through both AppXtender and ODMA. If you are only accessing documents through ODMA, use the New Document Revision options to track separate revisions.

To check a document into AppXtender as a new page version:

1. The Check In AX Document dialog box appears with the New Page Version option selected.
2. If you want to add a comment to the document, type the information in the Comment text box.
3. If an AppXtender Workflow client has been installed and you want to check the document into AppXtender Workflow, click Login. For further instructions, refer to the AppXtender Workflow User’s Guide.
4. Click OK. The document is saved to AppXtender again as a new page version.
Checking in a Replacement Page Version

You can check a document back into AppXtender as a new page version to replace the document that you opened from AppXtender. ODMA displays only the newest version page of a document, so after you check your current revision in as a new page version, you see only that version when you next open the document. You can, however, access earlier page versions through AppXtender. Use of this option is recommended only if you are accessing documents through both AppXtender and ODMA. If you are only accessing documents through ODMA, use the New Document Revision options to be able to track separate revisions.

To check in a document to AppXtender by replacing the current page version:

1. The Check In AX Document dialog box appears with the New Page Version option selected.
2. Click Replace Current Page Version to replace the page that you originally opened with the edited ODMA document.
3. If you want to add a comment to the document, type the information in the Comment text box.
4. If a AppXtender Workflow client has been installed and you want to check the document into AppXtender Workflow, click Login. For further instructions, refer to the ApplicationXtender Workflow User’s Guide.
5. Click OK. The document is saved to AppXtender again with the current page version replaced.

When you close an AppXtender document, you do not have to check it in or discard the work that you have already done. If you reach a point where you need to close the document you have checked out from AppXtender but you are not yet ready to check the document in, you can save a temporary copy of the document to the AppXtender repository and keep the document checked out. You can then reopen the document and continue to work on it. This option allows you the freedom to work on a document until you are ready to check it in, without forcing you to commit your changes until you decide that a changed document is ready to be checked in and saved as a permanent AppXtender document revision or page version. This feature also prevents other users from overwriting your changes as you modify the document.
Note: To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

To close a document, save changes, and keep the document checked out:

1. From the File menu in the ODMA-compliant application, select Close. If there are unsaved changes in the document, the ODMA-compliant application prompts you to save changes. The dialog box that appears depends on the application that you are working in.

2. You may have the following choices:
   - To continue closing the document and save changes to the temporary document copy, select Yes.
   - To continue closing the document without saving changes to the temporary document copy, select No. (Only the changes that have been saved already are saved in the temporary document copy.)
   - To cancel and keep the document open, select Cancel.

3. If you selected Yes or No, the Close Checked Out Document dialog box appears.

4. To save changes to the temporary copy of the document saved to the AppXtender repository and keep the document checked out by you, select Save Changes and Keep Checked Out and click OK.

For more information on reopening a document that you have checked out, refer to “Opening a Document that is Checked out by You” on page 464.

When you close a checked out AppXtender document, you are prompted to choose what to do with the document. If you decide that you do not want to keep any of the changes that you have made since you checked out the document, you can decide to cancel the document check out. By canceling the document check out, you put the document back in check in mode. The document revision remains the same.
CAUTION

Canceling document checkout discards all changes made since the
document was checked out, even if you have saved changes while
you worked. Canceling document checkout discards the temporary
copy of the document where working changes were saved.

To close a document and cancel the document checkout:

1. From the File menu in the ODMA-compliant application, select
   Close. If there are unsaved changes in the document, the
   ODMA-compliant application prompts you to save changes. The
dialog box that appears depends on the application that you are
working in

2. You probably have the following choices:

   • To continue closing the document and save changes to the
temporary document copy (which are deleted if you cancel
document checkout), select Yes.

   • To continue closing the document without saving changes to
   the temporary document copy (which are deleted if you cancel
document checkout), select No.

   • To cancel and keep the document open, select Cancel.

3. If you selected Yes or No, the Close Checked Out Document
dialog box appears.

4. To cancel the document checkout and discard the temporary copy
   of the document saved to the AppXtender document repository,
   select Cancel Checkout and click OK.
Using ODMA With AppXtender Documents

Using Non-AppXtender Documents in ODMA-Compliant Applications

When you enable ODMA support in ApplicationXtender, AppXtender causes any ODMA-compliant applications to display an AX dialog box when you open or close a document. You can use the File Selection button in this dialog box to open and save non-AppXtender documents. The File Selection button allows you to save non-AppXtender documents to other storage devices such as a local hard drive, network drive, or a floppy disk.

To open a Non-AppXtender document from an ODMA-compliant application when ODMA is enabled in AppXtender:

1. From the Windows Start menu, select Programs. From the Programs menu, select an ODMA-compliant application, such as Microsoft Word. A blank document appears.
2. To open an existing non-AppXtender document, select Open from the File menu. The Open ApplicationXtender Document dialog box appears.
3. To open a non-AppXtender document, click File Selection. A standard Open dialog box appears. Navigate to the drive or folder and select the file you want to open.

The selected document is opened in the ODMA-compliant application.
This section describes how to attach annotations to a document or a batch page to highlight important information. You can also add annotations to images, text, and Portable Document Format (PDF) files.

- Introduction to Annotations ........................................................... 484
- Annotation Types ............................................................................. 486
- Saving Annotations ......................................................................... 487
- Creating Line and Shape Annotations .......................................... 488
- Creating Text Annotations .............................................................. 499
- Working with Rubber Stamp Annotations ................................... 503
- Overlapping Annotations ............................................................... 515
- Assigning an Annotation to an Annotation Group .................... 516
- Assigning a Default Annotation Group ..................................... 517
- Showing or Hiding Annotations .................................................... 518
- Modifying Annotation Settings ...................................................... 525
- Printing Text Annotations ............................................................... 535
- Removing Annotations ................................................................... 536
Introduction to Annotations

Assuming you have been granted the appropriate user privileges, several types of annotations are available to you when viewing documents. You can add manual marks, such as lines, arrows, and highlights, to a page to emphasize information. You can use the polyline annotation feature to add lines with multiple nodes. You can also add shapes, such as ovals, rectangles, and rounded rectangles, and use polygons to emphasize asymmetrically shaped areas. You can add comments in the form of text annotations, and display them as either actual text or sticky note icons. You may also be able to apply preconfigured rubber stamps, such as Confidential or Draft, to documents.

When creating annotations, you can customize annotation properties such as line width and color to create desired effects. To make a line or shape annotation opaque, you can apply redaction to the annotation. You can also overlap annotations by moving one annotation in front of or behind another annotation. When printing and e-mailing documents, you can use the show/hide feature to hide the annotations with a single click.

There is no limit to the number of annotations you can place on a page; however, a large number of annotations could slow down or distort page rendering.

Annotations can easily be deleted or saved. In addition, using the Cancel Changes function, you can remove changes made to annotations since the last save.
Only users who have appropriate privileges can create, modify, move, hide, or delete annotations and redactions. For example, to hide a redaction that you created, you must have the Edit Redaction privilege. To hide a redaction another user created, in addition to having the Edit Redaction privilege, you must also have the Global Annotations privilege.

**Note:** Contact your ApplicationXtender administrator if you have any questions about your annotation privileges.
Annotations

Annotation Types

You can annotate pages with the following types of annotations:

- Line annotations including straight lines, freehand lines, arrows, and polylines.
- Shape annotations including rectangles, rounded rectangles, ovals, and polygons. Shape annotations have an outline and a fill color, both of which are configurable.
- Highlight annotations are similar to rectangle annotations except that they have no outline and the default color is not configurable.
- Text annotations have both outline and fill color configuration options. They can be displayed as icons or text.
- Rubber Stamp annotations are pre-defined annotations created by the system administrator (for example, Draft, Final, Paid In Full, Confidential). In addition to standard annotation attributes, rubber stamp annotations have attributes such as type (text or image) and content (text string or embedded bitmap).

Annotations can be transparent or non-transparent (opaque). Lines, shapes, highlights, and rubber stamps are transparent by default. Text annotations, on the other hand, are non-transparent by default. You must have redaction privileges to create or modify non-transparent annotations.
Saving Annotations

You have these options for saving an annotation to a document page:

- Select Annotate > Save from the Document Manager menu bar.
- Press w.
- Close the document or batch.

Refer to “Modifying Annotation Settings” on page 525 for information on modifying annotations after they have been saved to a page.
Creating Line and Shape Annotations

The process to create line and shape annotations involves configuring annotation properties and then creating the annotation on the page.

For information on these tasks, refer to the following sections:
- “Configuring Annotation Settings” on page 488
- “Creating a Line or Shape Annotation” on page 492

Configuring Annotation Settings

The first step in creating a line or shape annotation is to check the current annotation properties and, if necessary, change the defaults. For example, all annotation have default color settings that you can change. You can select a different line color, fill color, or both before adding an annotation to a document. Another property you may want to modify is the default line width, making the line broader or more narrow.

Note: Default colors for text annotations are set separately from line and shape annotation settings. For information on configuring text annotations, refer to “Creating Text Annotations” on page 499.

For information on configuring annotation properties, refer to the following sections:
- “Default Line Width” on page 489
- “Default Color for Highlight Annotations” on page 490
- “Default Color for Line and Shape Annotations” on page 489
- “Default Filled or Hollow Setting” on page 490
- “Default Redaction Setting” on page 491

Note: Only users with appropriate privileges can control the annotation features. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the ApplicationXtender Core Components Administrator’s Guide.
Creating Line and Shape Annotations

**Default Line Width**

The line width of lines and shapes added as annotations is configurable. Line width settings are used for line annotations and the outlines of shape annotations. You can change the default line width from the Annotation menu or from the Annotation toolbar.

To set the width of lines and arcs:

1. From the Annotate menu, select Settings and then Line Width. The Line Width drop-down box appears.
2. Select the new line width.

Any new annotations you create will have the line width setting you selected. You can change the line width setting of an existing annotation in the Annotation Properties dialog box. For more information, refer to “Modifying Annotation Settings” on page 525.

**Default Color for Line and Shape Annotations**

Color is used for all annotations. Color settings for line and shape annotations are separate from color settings for text or highlight annotations.

You can set the default color settings for line or shape annotations from the Annotation menu or from the Annotation toolbar.

To set the color of lines and shapes:

1. From the Annotate menu, select Settings and then Colors. The Color drop-down box appears.

   ![Color Drop-Down Box](image)

   **Figure 230 Color Drop-Down Box**

   Under the grid of colors, notice the two overlapping rectangles. The color in the top rectangle represents the color of shape outlines and lines. The color in the bottom rectangle represents the fill color for all shape annotations.

2. To set the fill color, right-click a color in the grid of colors. The color you selected appears in the bottom rectangle, indicating the fill color for all shape annotations.
3. To set the outline color, click a color in the grid of colors. The color you selected appears in the top rectangle, indicating the color of shape outlines and lines. Any line or shape annotations created from now on appear with the colors you selected.

You can change the color of an existing line or shape annotation in the Properties dialog box. For more information, refer to “Modifying Annotation Settings” on page 525.

Default Color for Highlight Annotations

The default color for highlight annotations is yellow and cannot be changed.

After creating a highlight annotation, you can change the highlight color from the Annotation Properties dialog box. For more information, refer to “Modifying Annotation Settings” on page 525.

Default Filled or Hollow Setting

The filled/hollow setting is used for annotation shapes. You can fill an annotation shape with the default fill color or you can make a shape hollow. You can change the default filled/hollow setting from the Annotation menu or from the Annotation toolbar.

Note: Highlight annotations are similar to shape annotations, except that they are always filled, regardless of the filled/hollow setting.

Generally, this feature is used with redaction to block large areas of the page from view. When both fill and redaction are enabled, both the outline and fill of the annotation are applied as opaque. For information on redaction, refer to “Default Redaction Setting” on page 491.

To toggle the fill setting on and off, choose one of the following options:

◆ Select Annotate > Settings > Filled.
◆ Press i.

If the button is active (lighter in color), new shape annotations have a fill of the default fill color. If the button is not active (same color as the other toolbar buttons) new shape annotations are added without a fill color.

Any annotations created from now on appear with the filled/hollow setting you selected. You can change the filled/hollow setting of an existing annotation in the Properties dialog box. For more information, refer to “Modifying Annotation Settings” on page 525.
Redaction is a security feature that enables you to block certain areas of an image or text page from view. You can change the default redaction setting from the Annotation menu or from the Annotation toolbar.

When enabled, the outline of the annotation is applied as opaque; underlying parts of the image are not visible. When disabled, the outline of the annotation is applied as transparent.

Redaction can be used in conjunction with the filled/hollow feature to make the entire shape of the annotation opaque (not just the outline). For information on filled and hollow annotations, refer to “Default Filled or Hollow Setting” on page 490.

To toggle redaction on and off, choose one of the following options:

- Select Annotate > Settings > Redaction.
- Press d.

If the button is active (lighter in color), the outline of any new annotation is opaque. If the Fill button is also active, both the outline and the fill of new annotations are opaque. If the Redaction button is not active (same color as other toolbar buttons), both the outline and the fill (if one is configured) of new annotations are transparent.

Any annotations created from now on appear with the redaction setting you selected. You can change the redaction setting of an existing annotation in the Properties dialog box. For more information, refer to “Modifying Annotation Settings” on page 525.

When applying redaction to annotations, keep the following points in mind:

- If you process with OCR a document that has text hidden under a redaction, the hidden text is not included in the text view of the document.
- If you full-text index a document that has text hidden under a redaction, the hidden text is not included in the full-text index of the document.
- If you use an annotation with redaction to hide text in a document that has been processed with OCR and then save the annotation change, the text view is deleted.
Annotations

- If you use an annotation with redaction to hide text in a document that has been full-text indexed and then save the annotation change, the text view is deleted and the document is automatically resubmitted to the Index Server.

- If you use an annotation with redaction to hide text in a PDF file, the text is still considered a hit by a text search. When users display a PDF document and perform a text search with a word that is hidden under a redaction as search criteria, the search stops, but the highlighted word remains hidden.

- If you use an annotation with redaction to hide text in a PDF file, and if the PDF file is later submitted to the Index Server for full-text indexing, the text hidden behind the redaction is not removed. This means that even users who do not have the appropriate privileges to hide a redaction can find the document by performing a full-text search with the hidden text as search criteria.

Creating a Line or Shape Annotation

After configuring the properties of the annotation, you can add any one of several different types of annotations to the AppXtender page. You can apply any text, line, shape, or highlight annotation that best emphasizes the desired area of the image. Lines include straight lines, freehand lines, arrows, or polylines. Shapes include rectangles, rounded rectangles, ovals, or polygons. You can apply annotation text in a desired color and font format. ApplicationXtender also allows you to create "rubber stamp" annotations, which can be a custom text string or embedded bitmap.

Note: Only users with appropriate privileges can control the annotation features. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the ApplicationXtender Core Components Administrator’s Guide.

Note: If your user account has been configured with annotation group options, but does not have any annotation privileges, you must set your annotation group as default to use annotation features. For instructions on setting an annotation group as default, refer to “Assigning a Default Annotation Group” on page 517.
Creating Line and Shape Annotations

For more information, refer to the following sections:
- “Creating a Line Annotation” on page 493
- “Creating a Shape Annotation” on page 496
- “Creating a Highlight Annotation” on page 498
- “Working with Rubber Stamp Annotations” on page 503

Creating a Line Annotation

You can add basic line annotations and polyline annotations to AppXtender pages. Basic line annotations are straight lines, freehand lines, and arrows. A polyline annotation is a series of connected straight lines.

For more information, refer to the following sections:
- “Creating a Basic Line Annotation” on page 493
- “Creating a Polyline Annotation” on page 494

Creating a Basic Line Annotation

You can add straight lines, freehand lines, and arrows (basic line annotations) to AppXtender pages.

To add a basic line annotation to a page:

1. Display the page to which you want to add a basic line annotation.

2. Choose one of these options to select a type of line annotation:
   - Select Annotate > New from the Document Manager menu bar, and then select the annotation from the shortcut menu.
   - Click the appropriate button on the Annotation toolbar.
   - Press the keyboard shortcut.
The following table describes the available line annotations.

<table>
<thead>
<tr>
<th>Table 59 Creating Basic Lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Create</td>
</tr>
<tr>
<td>A straight line</td>
</tr>
<tr>
<td>A freehand line</td>
</tr>
<tr>
<td>An arrow</td>
</tr>
</tbody>
</table>

The mouse pointer changes shape to reflect your selection.

3. Drag the mouse pointer from a starting point to an end point. As you drag the pointer, a new line annotation appears on the image.

4. Save the annotation. Refer to “Saving Annotations” on page 487 for more information.

Creating a Polyline Annotation
You can add polyline annotations to AppXtender pages. A polyline is a line that connects more than one point, or node. The nodes defining the polyline do not have to be aligned. With the polyline feature, you can create line annotations that are not straight lines. Polyline annotations can contain angles and can even delineate shapes.

Note: A shape created with the polyline feature cannot be filled with color. You can use the polygon feature to create polygon shapes, which can be filled with color. For information on polygon annotations, refer to “Creating a Polyline Annotation” on page 494.

Each point in a polyline annotation is specified by a single left mouse click. You draw the line point by point, stretching each straight-line segment from the endpoint of the last.

To add a polyline annotation to a page:
1. Display the page to which you want to add a polyline annotation.
2. Choose one of these options to activate the polyline annotation symbol:
   - Select Annotate > New > Polyline from the Document Manager menu bar.
   - Press p.

3. Click where you want the polyline to start. This creates the first node in the line.

4. Move the pointer and click again to set the endpoint for the first segment of the polyline. This endpoint is the next node in the line.

5. Continue to draw line segments by moving the pointer and clicking wherever you want each segment to end. Each of these endpoints becomes a new node in the line. Each segment created is connected to the previous segment.

6. When the polyline is complete, double-click where you want the last node to appear. The annotation is added to the page.

7. Save the annotation. Refer to “Saving Annotations” on page 487 for more information.
Creating a Shape Annotation

You can add basic shape annotations and polygon annotations to AppXtender pages. Basic shape annotations are rectangles, rounded rectangles, and ovals. A polygon annotation is a closed shape, composed of a series of connected, straight lines that can be filled with color like any other shape.

For more information, refer to the following topics:
◆ “Creating a Basic Shape Annotation” on page 496
◆ “Creating a Polygon Annotation” on page 497

Creating a Basic Shape Annotation

You can add rectangles, rounded rectangles, and ovals (basic shape annotations) to AppXtender pages.

To add a basic shape annotation to a page:
1. Display the page to which you want to add a basic shape annotation.
2. Choose one of these options to select a shape annotation:
   - Select Annotate > New from the Document Manager menu bar, then select the annotation from the shortcut menu.
   - Click the appropriate button on the Annotation toolbar.
   - Press the keyboard shortcut.

The following table describes the available shape annotations.

<table>
<thead>
<tr>
<th>To Create</th>
<th>Shortcut Menu Option</th>
<th>Button</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>A rectangle</td>
<td>Rectangle</td>
<td>![Rectangle]</td>
<td>R</td>
</tr>
<tr>
<td>A rounded rectangle</td>
<td>Rounded Rectangle</td>
<td>![Rounded Rectangle]</td>
<td>N</td>
</tr>
<tr>
<td>An oval</td>
<td>Oval</td>
<td>![Oval]</td>
<td>O</td>
</tr>
</tbody>
</table>

The mouse pointer changes shape to reflect the selection.

3. Drag the mouse pointer from a starting point to an end point. As you drag the pointer, a new shape annotation appears on the image.
4. Save the annotation. Refer to “Saving Annotations” on page 487 for more information.

Creating a Polygon Annotation
You can add polygon annotations to AppXtender pages. A polygon is a shape that does not have to be symmetrical, with sides comprised of straight lines. Each left mouse click defines the point of a corner (or node) of the polygon. AppXtender draws a figure by connecting each point created by a left mouse click from the first point created to the last point created and back to the first point. The nodes defining the polygon do not have to be in alignment. With the polygon feature, you can create asymmetrical shape annotations with many sides.

To add a polygon annotation to a page:
1. Display the page to which you want to add a polygon annotation.
2. Choose one of these options to activate the polygon annotation symbol:
   - Select Annotate > New > Polygon from the Document Manager menu bar.
   - Press g.
3. Click where you want the polygon to start. This action creates the first node in the shape.
4. Move the pointer and click again where you want to set the endpoint for the first side of the polygon. This endpoint is the next node in the shape. At this point, the shape appears as a line between the two points.
5. Draw the next node in the polygon by moving the pointer and clicking the left mouse button wherever the next node in the shape should be located. Lines stretch to this node from each of the two existing nodes, creating a triangle. Continue to add nodes in the shape as needed. When a new node is added, lines stretch from that node to the last node created and to the first node created for the shape.

Note: To erase the polygon without adding it, you can right-click anywhere.

6. When the polygon is complete, double-click to add the annotation to the page.

7. Save the annotation. Refer to “Saving Annotations” on page 487 for more information.

Creating a Highlight Annotation

A highlight annotation allows you to emphasize or bring attention to a particular area of an AppXtender page.

To add a highlight annotation to a page:

1. Display the page to which you want to add a highlight annotation.

2. Choose one of these options to activate the highlighter annotation symbol:
   - Select Annotate > New > Highlight from the Document Manager menu bar.
   - Press h.

3. Drag the mouse pointer from a starting point to an end point. As you drag the pointer, a new highlight annotation appears on the image.

4. Save the annotation. Refer to “Saving Annotations” on page 487 for more information.
Creating Text Annotations

ApplicationXtender Document Manager has two tools for creating text annotations. For more information, refer to the following sections:

◆ “Using the Annotation Text Editor” on page 499
◆ “Using the In-place Text Editor” on page 501

Using the Annotation Text Editor

The Annotation Text Editor is a dialog box text annotation tool. To use the Annotation Text Editor to create a text annotation:

1. Display the page to which you want to add a text annotation.
2. Choose one of these options to activate the text annotation symbol:
   - Select Annotate > New > Text from the Document Manager menu bar.
   - Press t.

Note: You must have redaction privileges to create and modify non-transparent text annotations.

3. Click the location on the AppXtender page where you want to place the text annotation. The Annotation Text Editor dialog box appears.

Figure 233 Annotation Text Editor Dialog Box
4. Under Annotation Text, type the text that you want to use as the annotation. Press Enter to start a new line in the editor.

5. Click Sp to check the spelling of the text annotation. The Check Spelling dialog box appears.

6. Correct or confirm the spelling of any questionable words.

   Note: Click Help on the Check Spelling dialog box for more information on spell-checker options.

7. Click OK to close the ApplicationXtender message box after all words have been checked.

8. Specify how you want Document Manager to display the text annotation:
   - To display this annotation as an icon, select Display As Icon.
   - To display the text as the annotation, clear the Display As Icon check box.

   Note: You must have the Global Annotations privilege to view or modify the text of a text annotation icon created by another user. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the ApplicationXtender Core Components Administrator's Guide.

9. If you want to define the font and color features for the annotation text, click Advanced. The advanced options appear.
10. Select the desired color and font size, and select the check boxes for any other desired font properties. Select the Set as Default check box to save the current settings as the default.

**Note:** Any color selection in the text annotation editor applies only to text annotations and does not affect shape, line, or highlight annotations.

**Note:** To modify the size of a text annotation, you must modify the text font.

11. Click OK to apply the text annotation to the image.

12. Save the annotation. Refer to “Saving Annotations” on page 487 for more information.

---

**Using the In-place Text Editor**

The in-place text editor is a What You See Is What You Get (WYSIWYG) text annotation tool.

To use the in-place text editor to create a text annotation:

1. Display the page to which you want to add a text annotation.

2. Choose one of these options to activate the text editor:
   - Press Shift-t.
   - Press and hold down Alt, left-click the Text button on the Annotation toolbar, release Alt.

   The cursor becomes a pushpin.

3. Left-click and drag the pushpin over the page to define the border of the text editor.

---

**Figure 235 In-place Text Editor**
4. Type the text annotation. Press Ctrl-Enter to start a new line in the editor.

5. Click Sp to check the spelling of the text annotation. The Check Spelling dialog box appears.

6. Correct or confirm the spelling of any questionable words.

   **Note:** Click Help on the Check Spelling dialog box for more information on spell-checker options.

7. Click OK to close the ApplicationXtender message box after all words have been checked.

8. Click the green check mark to apply the text annotation to the image.

9. Save the annotation. Refer to “Saving Annotations” on page 487 for more information.
Working with Rubber Stamp Annotations

Rubber Stamps are pre-defined annotations that can be used to describe certain events. For example, you could have a rubber stamp that says “Added by Username on Date”, where Username and Date are populated by your name and the date you added the annotation. Some rubber stamps can be composed of an image, so that you can place a signature or other relevant graphic on a page. When you select a rubber stamp, AppXtender places it on the AppXtender page wherever you click your mouse. You can move or delete a rubber stamp annotation, just as you can other types of annotations, but cannot edit its properties.

Note: Rubber stamps must be added and configured by the AppXtender system administrator before they are available for use. Also, only users with appropriate privileges can control the annotation features. If rubber stamps have not been configured, or if you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator.

Creating a New Text Rubber Stamp Annotation

You can specify display properties for a text rubber stamp. You can also configure security so that a rubber stamp is used for a single application by a single user and/or group. If the AppXtender system is using the Windows security provider, you can also specify a domain.

To create a new text rubber stamp annotation:

1. From the Application view tree structure, right-click the _RSTAMP application. From the shortcut menu that appears, select New Text Rubber Stamp. The New Text Rubber Stamp dialog box appears.
2. The Rubber Stamp Text text box allows you to designate what text should be displayed when the rubber stamp is added to a page. You can add this information in two ways:

   • Type the text you would like to use for the rubber stamp in the Rubber Stamp Text text box. Type `%crlf%` to insert a carriage return. The text that follows `%crlf%` appears on a new line.
   
   You can also use format strings within the text you add to insert the user name and date. For a list of format strings that can be used, refer to the following table.

   • Select a pre-configured rubber stamp from the Rubber Stamp Text drop-down list. For a list of format strings that you can use, as well as pre-configured rubber stamps available from the drop-down list, refer to the following table.

   **Note:** You can enter up to 255 characters in a text rubber stamp annotation.
### Table 61: Rubber Stamp Format Strings

<table>
<thead>
<tr>
<th>Format String</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>%username%</code></td>
<td>Places the current user name as part of the stamp text. This format string identifies the user who created the rubber stamp annotation for the page.</td>
</tr>
<tr>
<td><code>%datestamp%</code></td>
<td>Places a short form of date stamp (for example 6/15/00), as part of the stamp text. This format string indicates the date when the rubber stamp annotation was created for the page.</td>
</tr>
<tr>
<td><code>%DATESTAMP%</code></td>
<td>Places a long form for date stamp (for example, &quot;Thursday, June 15, 2000&quot;), as part of the stamp text. This format string indicates the date when the rubber stamp annotation was created for the page.</td>
</tr>
<tr>
<td><code>%timestamp%</code></td>
<td>Places a time stamp as part of the stamp text. This format string indicates the time when the rubber stamp annotation was created for the page.</td>
</tr>
<tr>
<td>Approved</td>
<td>Places the text &quot;Approved&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>Not Approved</td>
<td>Places the text &quot;Not Approved&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>Confidential</td>
<td>Places the text &quot;Confidential&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>Do Not Duplicate</td>
<td>Places the text &quot;Do Not Duplicate&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>For Internal Distribution Only</td>
<td>Places the text &quot;For Internal Distribution Only&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>Draft</td>
<td>Places the text &quot;Draft&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>Reviewed by</td>
<td>Places the text &quot;Reviewed by&quot; and the current user name as part of the stamp text. This format string identifies the user who created the rubber stamp annotation for the page.</td>
</tr>
</tbody>
</table>
3. Select any of the following options to further customize the rubber stamp:

- To make the rubber stamp transparent, select the Transparent check box. The default setting is checked but dimmed. This indicates that the local workstation redaction setting will be used. If the Transparent option is cleared, the rubber stamp is set to redacted.

- In the Orientation drop-down list, choose the angle at which you would like the text to appear. Available options are 0, 90, 180, and 270. The default setting is 0.

- In the Border drop-down list, select the type of border you would like to surround the rubber stamp text. Available options are None, Rectangle, and Round Rectangle. The default setting is Round Rectangle.

- If a border is defined in the Border Size drop-down list, select the line width of the border in pixels from the Border Size spin box. Available options range from 0 to 20. If 0 is selected, the border is set to the line width set in the local workstation. The default setting is 0.

- To change any font attribute, click Font. The Font dialog box appears. For further instructions, refer to “Changing the Font of a Rubber Stamp” on page 508.

- To change the background color of the rubber stamp, click Back Color. The standard windows Color dialog appears. Choose a color or create a custom color to use for the text rubber stamp background color. (For further instructions, refer to your Windows documentation.) In the Color dialog box, click OK. The New Text Rubber Stamp dialog box reappears.

4. Consider resetting or saving default settings:

- To reset rubber stamp properties to their default settings, click Restore Default in the New Text Rubber Stamp dialog box. All settings are restored to the default settings.

- To save the current settings as the default rubber stamp settings, click Set As Default. The properties that you have assigned to the current rubber stamp will be used as the default settings for any new rubber stamp that you create.
5. When you have made all of the changes to the rubber stamp that you want to make, click OK.

The index for the rubber stamp appears, along with the rubber stamp itself in XML format (XML is the underlying data structure used by rubber stamps to define the rubber stamp properties used for rendering the stamp on the page). The rubber stamp index has the following fields: NAME, DESC, APP, USER, and DOMAIN.

6. In the NAME index field, enter the name of the rubber stamp (this is the name that users will see when selecting a rubber stamp).

7. You have the following options:
   - In the DESC index field, you can enter a description of the rubber stamp.
   - To restrict the rubber stamp to a single application, enter the name of the application in the APP index field. If the APP field is left blank, the rubber stamp will be accessible in all applications.
   - To restrict the rubber stamp to a single user or group, enter the user or group name in the USER index field. If you leave the USER field blank, the rubber stamp is accessible to all users with Edit Annotations privileges.

   **Note:** If you assign a rubber stamp to a user name that is used by both a user and a group, the user and all members of the group will have access to the rubber stamp.

   **Note:** If the data source is using a directory service security provider, in order to restrict the rubber stamp to a single user or group, you must enter the name exactly as it appears in ApplicationXtender Application Generator.

   - In the DOMAIN index field, if the AppXtender system is using the Windows security provider, you must enter a domain name for the user or group specified in the USER index field.

8. Click Save to save the rubber stamp.
Changing the Font of a Rubber Stamp

The Font dialog box allows you to change any font attribute of a rubber stamp.

![Font Dialog Box for Rubber Stamps](image)

To change font attributes of a rubber stamp:

1. In the Font dialog box, change the font properties of the text rubber stamp annotation as described in the following table:

<table>
<thead>
<tr>
<th>To change</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font format</td>
<td>Under Font, select a font type.</td>
</tr>
<tr>
<td>Font style</td>
<td>Under Font style, select the font attributes you would like to use.</td>
</tr>
<tr>
<td></td>
<td>Available options are Regular, Italic, Bold, and BoldItalic.</td>
</tr>
<tr>
<td>Point size</td>
<td>Under Size, select the point size for the specified font.</td>
</tr>
<tr>
<td>Font appearance</td>
<td>Under Effects, enable Strikeout if you want the text to appear with a</td>
</tr>
<tr>
<td></td>
<td>line through it, or Underline, if you want the text to appear</td>
</tr>
<tr>
<td></td>
<td>underlined.</td>
</tr>
<tr>
<td>Color for the specified font</td>
<td>Under Color, select a font color from the list.</td>
</tr>
<tr>
<td>Language scripts for the specified</td>
<td>The Script box is not currently enabled (reserved for future use).</td>
</tr>
<tr>
<td>font</td>
<td></td>
</tr>
</tbody>
</table>

The Sample box shows how the text will appear when the settings you choose are applied.

2. In the Font dialog box, click OK. The New Text Rubber Stamp dialog box reappears.
Creating a Text Rubber Stamp Annotation from an Existing File

You can import a rubber stamp directly into the _RSTAMP application using an Extensible Markup Language (XML) text file. The rubber stamp tag encapsulates the entire rubber stamp data structure. Anything outside the data structure is ignored. Once a rubber stamp is imported into the _RSTAMP application, you can then add the rubber stamp to an AppXtender page.

The following sample XML file defines a data structure for importing a rubber stamp, including the font, font size, border, and bold.

```xml
<xml version="1.0">
  <rubberstamp>
    <username>Logged in user: username1</username>
    <border>0</border>
    <fontsize>5</fontsize>
    <forecolor>000000</forecolor>
    <backcolor>00000000</backcolor>
    <bold>1</bold>
  </rubberstamp>
</xml>
```

Figure 238  **Sample Text Rubber Stamp XML Text File**

To create a text rubber stamp annotation from an existing file:

1. Right-click the _RSTAMP application.
2. From the shortcut menu that appears, select Import File. The Import File dialog box appears.

Figure 239  **Import File Dialog Box**
Note: You must configure the file types so that the file is imported as plain text. For more information on configuring file types, consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" chapter of the ApplicationXtender Core Components Administrator’s Guide.

3. Select the file that you want to import and click Open. AppXtender displays the new document in the Document Display view and the Index view.

4. Enter the index information for the new document as described in the following table:

<table>
<thead>
<tr>
<th>Index Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>Name of the rubber stamp.</td>
</tr>
<tr>
<td>DESC</td>
<td>Description of the rubber stamp.</td>
</tr>
</tbody>
</table>
5. Click Save. The new document is added to the list of available rubber stamps in the _RSTAMP application.

Creating an Image Rubber Stamp Annotation from an Existing File

You can create an image rubber stamp by importing it directly into the _RSTAMP application. Image rubber stamps allow you to use images in place of rubber stamp text. You can use an image rubber stamp to place signatures or other customized images on AppXtender pages.

To create an image rubber stamp annotation:
1. Right-click the _RSTAMP application.
2. From the shortcut menu that appears, select Import File. The Import File dialog box appears.

   Note: AppXtender supports the following extensions: BMP, TIFF, DCX, GIF, JPG, and PCX.

4. Enter the index information for the new document as described in the previous table.
5. Click Save. The new document is added to the list of available rubber stamps in the _RSTAMP application.
Annotations

Adding Rubber Stamp Annotations to Pages

You can add rubber stamp annotations to AppXtender pages in a variety of ways. For information, refer to the following sections:

◆ “Adding a Rubber Stamp from the List of Most Recently Used Rubber Stamps” on page 512
◆ “Adding a Rubber Stamp from the Select Rubber Stamp Dialog Box” on page 513
◆ “Applying a Rubber Stamp with the Rubber Stamp Shortcut Key” on page 514

Adding a Rubber Stamp from the List of Most Recently Used Rubber Stamps

You can select a rubber stamp from the Rubber Stamp drop-down menu. This menu contains a list of up to 10 of the most recently used rubber stamps for the current application. Each menu item has an icon displayed to its left to identify the type of stamp (text or image).

To add a rubber stamp annotation using the Rubber Stamp drop-down menu:

1. Display the page to which you want to add a rubber stamp annotation.

2. Click the arrow next to the Rubber Stamp Annotation button on the Annotation toolbar.

Figure 241 Rubber Stamp Annotation Button

The Rubber Stamp Annotation menu appears with up to 10 of the most recently used rubber stamps for the current application and the More Rubber Stamps option.

Figure 242 Rubber Stamp Annotation Drop-Down Menu
3. Select the rubber stamp from the menu. The Rubber Stamp annotation button is then activated (the button appears in a lighter gray color), and the cursor changes to Rubber Stamp mode.

![Figure 243 Cursor in Rubber Stamp Mode](image)

4. Place your cursor where you want the rubber stamp to appear and click once. To add additional copies of the rubber stamp, click wherever you want the rubber stamp to appear.

5. To deactivate the rubber stamp, click once on the Rubber Stamp button. The cursor returns to its normal state.

The Select Rubber Stamp dialog box contains a list of up to 256 rubber stamps. You can create more than 256 rubber stamps, but only 256 are returned and displayed in the dialog box. Each menu item has an icon displayed to its left to identify the type of stamp (text or image).

To add a rubber stamp annotation using the Select Rubber Stamp dialog box:

1. Display the page to which you want to add a rubber stamp annotation.

2. Select Annotate > New > Rubber Stamp from the Document Manager menu bar. The Select Rubber Stamp dialog box appears.

![Figure 244 Select Rubber Stamp Dialog Box](image)

3. Select a rubber stamp.
4. Click OK. (To cancel the rubber stamp selection, click Cancel.)

5. The Rubber Stamp annotation button is then activated (the button appears in a lighter gray color), and the cursor changes to Rubber Stamp mode.

6. Place your cursor where you want the rubber stamp to appear and click once. To add additional copies of the rubber stamp, click wherever you want the rubber stamp to appear.

7. To deactivate the rubber stamp, click once on the Rubber Stamp button. The cursor returns to its normal state.

**Note:** Press s to apply the same rubber stamp to other images. To use the shortcut to apply a different rubber stamp, you must change the rubber stamp.

---

**Applying a Rubber Stamp with the Rubber Stamp Shortcut Key**

To apply a rubber stamp with the rubber stamp shortcut key:

1. Display the page to which you want to add a rubber stamp annotation.

2. Press s to activate the rubber stamp annotation symbol.

3. Left-click at the location where you want to apply the rubber stamp. Document Manager applies the most recently used rubber stamp.

**Note:** You must select a different rubber stamp if you want to link the shortcut key to the new rubber stamp.
Overlapping Annotations

ApplicationXtender allows you to place multiple annotations on one image. You can overlap these annotations, extending one over the other. When a new annotation is created, it is placed on the top "layer" of the page. Through tools on the Annotation toolbar, you can place an annotation behind another annotation.

**Note:** When you draw a freehand annotation around an existing annotation on an AppXtender page, you cannot select the other annotation. For example, if you attempt to select an annotation that is "inside" a freehand annotation, only the freehand annotation is selected. In addition, when a freehand annotation crosses over another annotation, AppXtender may not allow you to select the other annotation.

**Note:** AppXtender can accurately pinpoint the exact hit for a simple shape annotation. For example, if you click the lines or border of a line annotation or a non-fill rectangle, oval, or rounded-rectangle, AppXtender determines whether or not the mouse pointer hit the simple shape annotation. However, since a freehand annotation is not a simple shape annotation, AppXtender uses a minimum rectangular area, which covers all the nodes of a freehand annotation, to determine whether or not the mouse pointer hit the freehand annotation.

To move annotations to the front layer:

1. Select the annotations that you want to move to the front. For instructions, refer to “Selecting Annotations” on page 526.

2. Choose one of these options to move the annotations:
   - Click the To front button on the Annotation toolbar.
   - Press Shift-semicolon (;).

To move the annotation to the back layer:

1. Select the annotations that you want to move to the back. For instructions, refer to “Selecting Annotations” on page 526.

2. Choose one of these options to move the annotations:
   - Click the To back button on the Annotation toolbar.
   - Press semicolon (;).
Assigning an Annotation to an Annotation Group

If your user or group account is a member of an annotation group, you might be able to assign an annotation to that annotation group. For guidelines on which annotations should be assigned to each annotation group, consult your AppXtender administrator.

After you assign an annotation to an annotation group, users who are not members of the annotation group cannot view or modify the annotation. After you add a redaction to an annotation group, users who are not members of the annotation group cannot hide or modify the redaction. Depending on the options enabled for each user or group within the annotation group and depending on who created the annotation or redaction, users who are members of the annotation group may be able to view or view and modify annotations in the annotation group and hide or hide and modify redactions in the annotation group.

Note: Only users with appropriate annotation group options can assign annotations to annotation groups. If you have questions about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the ApplicationXtender Core Components Administrator’s Guide.

To assign an annotation to an annotation group:

1. Select the annotations that you want to assign to an annotation group. For instructions, refer to “Selecting Annotations” on page 526.
2. Right-click the selected annotations.
3. From the shortcut menu that appears, select Group Assignment. Another shortcut menu appears, listing the annotation groups to which you can assign the currently selected annotations. (The annotation groups that are listed depend on properties of the selected annotations.)
4. From the second shortcut menu, select the annotation group to which you want to assign the annotation.
Assigning a Default Annotation Group

If your user account is a member of an annotation group, you might be able to specify that particular annotation group as a default annotation group. When a new annotation is created or when current settings are applied to an annotation, the annotation is assigned to the default annotation group. If your AppXtender administrator instructs you that the annotations you create should be added to a specific annotation group, you can set that annotation group as a default to cause the annotations you create or modify to be automatically added to the group.

**Note:** Only users with appropriate annotation group options can specify an annotation group as default. If you have questions about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the ApplicationXtender Core Components Administrator's Guide.

To specify an annotation as a default annotation group:

1. From the Annotate menu, select Settings and then Default Annotation Group. The Select the Default Annotation Group dialog box appears.

   ![Select the Default Annotation Group Dialog Box](image)

   **Figure 246** Select the Default Annotation Group Dialog Box

2. Select the group that you want to use as the default group.
3. Click OK.
Showing or Hiding Annotations

It may be preferable for you to display, print, e-mail, or export AppXtender documents without annotations. The following sections describe how to do so:

- “Hiding Annotations When Viewing Documents” on page 518
- “Hiding Annotations When Printing” on page 520
- “Hiding Annotations When E-mailing” on page 521
- “Hiding Annotations When Exporting” on page 523

### Hiding Annotations When Viewing Documents

AppXtender provides an option to show or hide all annotations provided you have hide annotation privileges.

**Note:** Only users with appropriate privileges can hide annotations. Only users with appropriate annotation group options can hide annotations that have been assigned to annotation groups. If you have questions about the privileges assigned to your AppXtender user profile, or about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the *ApplicationXtender Core Components Administrator’s Guide*.

To show all displayed annotations:

- Select Show from the Annotate menu to place a check mark next to the Show option on the menu.

To hide all displayed annotations:

- Select Show from the Annotate menu to remove the check mark from the Show option on the menu.

### Hiding Annotations by Annotation Group

If your user or group account is a member of an annotation group, you might be able to hide all annotations on a displayed page that have been assigned to that annotation group. For example, if your user account has been configured with the View Annotations option in an annotation group called ACCOUNTING, you can hide all unredacted annotations on a purchase order that have been added to the ACCOUNTING annotation group.
**Note:** Only users with appropriate annotation group options can hide annotations that have been assigned to annotation groups. If you have questions about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the *ApplicationXtender Core Components Administrator’s Guide*.

To show or hide annotations by annotation group:

1. From the Annotate menu, select Show Groups. The Show/hide Annotation Groups dialog box appears.

2. Click the check box next to the name of the annotation group that you want to hide or show.

3. When each annotation group that you want to hide has no check mark and each annotation group that you want to show has a check mark, click OK. The annotations on the currently displayed page are shown or hidden according to your selections.
Hiding Annotations When Printing

You can print AppXtender documents, pages, or regions of an image without annotations. AppXtender provides an option on the Print dialog box to hide all annotations. The Print dialog box can be accessed from the Document menu, Page menu, or Result Set tab. In order to hide annotations when printing AppXtender documents from the Document menu or AppXtender pages or regions from the Page menu, the AppXtender document or page must be displayed. You can hide annotations when printing from the Result Set tab without displaying the AppXtender document or page.

Note: Only users with appropriate privileges (including the Print privilege) can hide annotations while printing. Only users with appropriate annotation group options can hide annotations that have been assigned to annotation groups. If you have questions about the privileges assigned to your AppXtender user profile, or about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the ApplicationXtender Core Components Administrator’s Guide.

To print a document with or without annotations:

1. Select and right-click the documents you want to print from the result set. Select Print. The Print dialog box appears.

![Print Dialog Box](image)
2. From the Print dialog box, you have the following options:
   - To print the documents without annotations, select the Hide annotations check box.
   - To print the documents with annotations, clear the Hide annotations check box.

3. Click OK to begin printing.

---

**Hiding Annotations When E-mailing**

You can send AppXtender documents or pages by e-mail without annotations. For instructions, refer to the following sections:

- “Hiding Annotations When E-mailing Documents” on page 521
- “Hiding Annotations When E-mailing Pages” on page 522

**Note:** Only users with appropriate privileges (including the Print privilege) can hide annotations while e-mailing. Only users with appropriate annotation group options can hide annotations that have been assigned to annotation groups. If you have questions about the privileges assigned to your AppXtender user profile, or about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the ApplicationXtender Core Components Administrator’s Guide.

---

**Hiding Annotations When E-mailing Documents**

The E-mail Document Pages dialog box allows you to hide all annotations when sending documents by e-mail.

To e-mail a document with or without annotations:

1. You have the following choices:
   - Select the document or documents to be mailed on the Result Set tab, and right-click your selection. From the shortcut menu that appears, select Mail.
   - Display the document you want to e-mail. From the Document menu, select Mail.
The E-mail Document Pages dialog box appears.

![Email Document Pages Dialog Box](image)

2. From the E-mail Document Pages dialog box, you have the following options:
   - To e-mail the document without annotations, select the Hide annotations check box.
   - To e-mail the document with annotations, clear the Hide annotations check box.

3. Click OK.

**Hiding Annotations When E-mailing Pages**

You can choose to hide or show all annotations on a page before e-mailing that page.

To e-mail a page with or without annotations:

1. Display the page you want to e-mail.
2. Show or hide annotations on the page as you want them to be e-mailed. For instructions, refer to “Hiding Annotations When Viewing Documents” on page 518.
3. From the Page menu, select Mail.
You can export AppXtender documents or pages without annotations. For instructions, refer to the following sections:

- “Hiding Annotations When Exporting Documents” on page 523
- “Hiding Annotations When Exporting Pages” on page 524

**Note:** Only users with appropriate privileges (including the Print privilege) can hide annotations while exporting. Only users with appropriate annotation group options can hide annotations that have been assigned to annotation groups. If you have questions about the privileges assigned to your AppXtender user profile, or about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the *ApplicationXtender Core Components Administrator’s Guide.*

The Export Document Pages dialog box allows you to hide all annotations during export.

To export a document with or without annotations:

1. Display the document you want to export.
2. From the Document menu, select Export and then Images. The Export Document Pages dialog box appears.
3. From the Export Document Pages dialog box, you have the following options:
   - To export the document without annotations, select the Hide annotations check box.
   - To export the document with annotations, clear the Hide annotations check box.
4. Click Save to begin exporting.
Annotations

Hiding Annotations When Exporting Pages

You can choose to hide or show all annotations on a page before exporting that page.

To export a page with or without annotations:

1. Display the page you want to export.
2. Show or hide annotations on the page as you want them to be exported. For instructions, refer to “Hiding Annotations When Viewing Documents” on page 518.
3. From the Page menu, select Export and then Images.
Modifying Annotation Settings

The properties of an annotation can be modified after it has been applied or saved to an image. You can alter the outline width, color, opacity, or fill of the annotation. For more information, refer to the following topics:

- “Selecting Annotations” on page 526
- “Moving Annotations” on page 527
- “Resizing an Annotation” on page 527
- “Modifying Shape Annotations” on page 527
- “Modifying Text Annotations” on page 529
- “Editing Text Rubber Stamp Annotations” on page 532

**Note:** Only users with appropriate privileges can modify annotations. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the ApplicationXtender Core Components Administrator’s Guide.

**Note:** If the AppXtender system has been converted from the CM security provider to the Windows security provider and you created and saved annotations while the CM security provider was in use, you must have both the Global Annotations and Edit Annotations privileges assigned to your profile in order to modify those annotations. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the ApplicationXtender Core Components Administrator’s Guide.
Selecting Annotations

The following table describes the methods you can use to select annotations:

<table>
<thead>
<tr>
<th>To Select</th>
<th>Do This</th>
<th>Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>One annotation</td>
<td>Enable the Annotation Selection button on the Annotation toolbar. Click the annotation that you want to modify.</td>
<td>![Image]</td>
</tr>
<tr>
<td>An annotation that is behind another annotation</td>
<td>Enable the Annotation Selection button on the Annotation toolbar. Click any annotation. Press the [TAB] key until the annotation that you want to modify is selected.</td>
<td>![Image]</td>
</tr>
<tr>
<td>Multiple annotations</td>
<td>Enable the Annotation Selection button on the Annotation toolbar. Click one of the annotations that you want to modify. While holding the [SHIFT] key, click each additional annotation that you want to modify.</td>
<td>![Image]</td>
</tr>
<tr>
<td>All annotations</td>
<td>Click the Select All button on the Annotation toolbar.</td>
<td>![Image]</td>
</tr>
</tbody>
</table>

**Note:** Press the spacebar to toggle between annotation selection mode and pan mode.

The appearance of each annotation changes to indicate that it is selected. For example, a selected text annotation is enclosed in a gray frame, a selected arrow has a handle on each end, and a selected oval is enclosed in both a gray frame and handles.

![Figure 251 Selected and Unselected Annotations](image)
Moving Annotations

You can use the mouse pointer to move a single annotation or multiple annotations together.

To move annotations:

1. Select the annotations that you want to move. For instructions, refer to “Selecting Annotations” on page 526.

2. Hold the pointer over the selected annotation or annotations. The pointer changes to crossed double arrows.

3. Drag the annotation or annotations to a new location. Changes to the selected annotation or annotations are reflected immediately.

4. Save your changes. Refer to “Saving Annotations” on page 487 for more information.

Resizing an Annotation

You can use the mouse pointer to resize any type of annotation, including text annotations created with the in-place text editor.

To resize a single annotation:

1. Select the annotation that you want to resize. For instructions, refer to “Selecting Annotations” on page 526.

2. Hold the pointer over one of the handles on the selected annotation. The pointer changes to a double arrow.

3. Drag the handle to a new location. Changes to the selected annotation are reflected immediately.

4. Save your changes. Refer to “Saving Annotations” on page 487 for more information.

Modifying Shape Annotations

To modify a shape annotation:

1. Select the annotation. For instructions, refer to “Selecting Annotations” on page 526.

2. Right-click and select Properties from the shortcut menu. The Annotation Properties dialog box appears.
The Annotation Properties dialog box provides information on the creation date, time, and user, and the latest modification date, time, and user for the annotation. If the AppXtender system is using the Windows security provider, the domain name is provided with each user name. If the annotation has been assigned to an annotation group, the name of that annotation group is also provided.

**Note:** There is no “fill” color for basic line annotations (for example, freehand, line, and arrow). When you select a basic line annotation, the two overlapping rectangles appear with the same color.

3. Change the properties of the annotation. The following table describes how to change each property in the Annotation Properties dialog box:

**Table 65 Modifying the Properties of a Shape Annotation**

<table>
<thead>
<tr>
<th>To Change</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opacity</td>
<td>Next to Options, click Redaction.</td>
</tr>
<tr>
<td>Fill status</td>
<td>Next to Options, click Filled.</td>
</tr>
</tbody>
</table>
Click Apply. Document Manager applies the new properties to the annotation.

5. Click OK to close the Annotation Properties dialog box.

6. Save your changes. Refer to "Saving Annotations" on page 487 for more information.

---

**Modifying Text Annotations**

Document Manager allows you to modify the properties of a text annotation and annotation text.

*Note:* You must have redaction privileges to create and modify non-transparent text annotations.

For more information, refer to:

- "Changing the Properties of a Text Annotation" on page 529
- "Modifying Annotation Text" on page 531

To change the properties of a text annotation:

1. Select the text annotation. For instructions, refer to "Selecting Annotations" on page 526.
2. Right-click and select Properties from the shortcut menu.

*Note:* Click the ellipses button (…) on the in-place text editor if it appears.
The Annotation Text Editor dialog box appears.

3. Click Advanced. The advanced options appear.
4. Change the properties of the annotation. The following table describes how to change each property in the Annotation Text Editor dialog box:

<table>
<thead>
<tr>
<th>To Change</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display status</td>
<td>Click the Display as icon check box.</td>
</tr>
<tr>
<td>Font size</td>
<td>Under Font, select a value from the Size list box.</td>
</tr>
<tr>
<td>Font appearance</td>
<td>Under Font, click the check boxes that you want to change (Bold, Underline, Italic, and Strike out).</td>
</tr>
<tr>
<td>Outline status</td>
<td>Under Font, click the Transparent check box.</td>
</tr>
<tr>
<td>Text color</td>
<td>Under Colors, click a new color for the text.</td>
</tr>
<tr>
<td>Fill color</td>
<td>Under Colors, right-click a new fill color.</td>
</tr>
</tbody>
</table>

Note: Refer to “Modifying Annotation Text” on page 531 for more information.

5. Click Apply. Document Manager applies the new properties to the text annotation.

6. Click OK to close the Annotation Text Editor dialog box.

7. Save your changes. Refer to “Saving Annotations” on page 487 for more information.

To modify annotation text:

1. Select the text annotation. For instructions, refer to “Selecting Annotations” on page 526.

2. Right-click and select Properties from the shortcut menu.

   The Annotation Text Editor appears if it was used to create the annotation.

   The in-place text editor appears if it was used to create the annotation.

Note: If the in-place text editor window is too small in the Document Display view, the Annotation Text Editor appears after you select Properties from the shortcut menu.
3. Change the text.
4. Apply the new text:
   • Click the green check mark if you changed the text in the in-place text editor.
   • Click Apply if you changed the text in the Annotation Text Editor, and then click OK to close the editor.
5. Save your changes. Refer to “Saving Annotations” on page 487 for more information.

Editing Text Rubber Stamp Annotations

After you display the contents of an existing rubber stamp page in the Document Display view, you can make the appropriate changes to the rubber stamp. As soon as you apply the changes, the content of the rubber stamp page is updated. When you select that rubber stamp from now on, the rubber stamp appears with the updated changes.

To edit an existing rubber stamp:

1. Right-click the _RSTAMP application in the Applications view. From the shortcut menu that appears, select New Query. The Search tab of the Query view appears.

![Figure 255 Query View Search Tab](image)

2. Under Values, next to any or all of the field names, enter the index information that you want to search for the document.
3. Click Search. The Result Set tab appears in the Query view containing the documents that met the search criteria. If only one document met the criteria, it automatically appears in the Document display view.

![Query View Result Set Tab](image)

**Figure 256** Query View Result Set Tab

4. In the Result Set view, double-click the document that you want to display. The document appears in the Document Display view.

5. From the Annotate menu, select Edit Rubber Stamp. The Edit Text Rubber Stamp dialog box appears with the Apply button disabled.

![Edit Text Rubber Stamp Dialog Box with Rubber Stamp Contents](image)

**Figure 257** Edit Text Rubber Stamp Dialog Box with Rubber Stamp Contents
6. Change the contents of the rubber stamp. The Apply button is enabled.

**Note:** In Rubber Stamp Text, the maximum number of characters that you can enter is 255.

7. You have the following choices:
   - Click Apply to save changes and leave the Edit Text Rubber Stamp dialog box open.
   - Click OK to save changes and close the Edit Text Rubber Stamp dialog box.

   The contents of the rubber stamp page displayed in the Document Display view are updated.
Printing Text Annotations

You can print the contents of one or more text annotations.

**Note:** Only users with appropriate privileges can print text annotations. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the *ApplicationXtender Core Components Administrator’s Guide*.

To print text annotations:

1. Select the text annotations that you want to print. For instructions, refer to “Selecting Annotations” on page 526.
2. Right-click the selected annotations.
3. From the shortcut menu that appears, select Print text. The standard Windows Print dialog box appears.
4. Click OK. The contents of the selected text annotations print.
Removing Annotations

You can remove annotations from a page by either erasing or deleting them.

Note: Only users with appropriate privileges can modify and delete annotations. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the ApplicationXtender Core Components Administrator's Guide.

Note: If the AppXtender system has been converted from the CM security provider to the Windows security provider and you created and saved annotations while the CM security provider was in use, you must have both the Global Annotations and Edit Annotations privileges assigned to your profile in order to modify and delete those annotations. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the ApplicationXtender Core Components Administrator's Guide.

For more information on removing annotations, refer to the following sections:

- “Erasing Annotations” on page 536
- “Deleting Annotations” on page 537

Erasing Annotations

Use the eraser tool to remove a single annotation from the displayed image.

To erase an annotation:

1. Choose one of these options to activate the eraser tool:
   - Click the Eraser button on the Annotation toolbar. The button is available only when the displayed page contains an annotation.
   - Press e.

2. Click the annotation that you want to remove. It is erased from the page.
You can delete one or more annotations from a displayed image.

To delete annotations:

1. Select the annotations that you want to delete. For instructions, refer to “Selecting Annotations” on page 526.

2. Choose one of these options:
   - Right-click, then select Delete from the shortcut menu.
   - Press x.
This section describes how to use ApplicationXtender to enhance bi-tonal (black and white) images.

- **Introduction to Image Enhancement** ............................................ 540
- **Enhancing an Image** ............................................................... 541
- **Configuring Image Enhancement** ........................................... 542
- **Performing Advanced Image Enhancement** ............................ 544
Introduction to Image Enhancement

ApplicationXtender provides licensed image enhancement features that allow you to enhance bi-tonal (black and white) images. With the image enhancement utility, you can remove lines, realign, de-skew, and remove shading on AppXtender documents. Many of these options (de-skew, and horizontal and vertical registration) can be used to make images more readable. Other options (line removal, and inverse text correction) can be used to prepare documents for optical character recognition (OCR). For more information, see the following topics:

- “Enhancing an Image” on page 541
- “Configuring Image Enhancement” on page 542
- “Performing Advanced Image Enhancement” on page 544
Enhancing an Image

Enhancing an Image

ApplicationXtender provides an array of bi-tonal image enhancement tools, including deskew, inverse and shade, speck and line removal.

To enhance a bi-tonal image:

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears.

![Image Enhancement Dialog Box](image)

3. Click Apply. The image is enhanced according to the current enhancement configurations. The enhanced image appears in the Enhance Image dialog box.

4. The enhanced image can now be saved as a new page version or discarded.

   - To save the enhanced page, click Done. AppXtender saves the enhanced page as a new version and inserts it before the original page in the document. AppXtender does not replace or delete the original page.
   - To discard the enhanced page, click Cancel.

Note: If annotations have been added to the image, the processed image appears without the annotations, unless they are redactions or non-transparent text annotations.
Configuring Image Enhancement

ApplicationXtender provides licensed image enhancement features for bi-tonal (black and white) images. Image enhancement allows you to de-skew, change the margin alignment, remove lines and specks, and convert inverse and shaded text to black on white. These functions can be used to prepare the images for OCR, display, print, or fax. Refer to “Enabling Image Processing Options” on page 121 for information on configuring Document Manager for image processing.

The settings for optimum bi-tonal image enhancement are built into AppXtender as defaults, but they can be changed to allow for exact specifications. The default parameters can be reset at any time in the Image Enhancement dialog box.

To configure image enhancement:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix Configuration dialog box appears.

![ScanFix Configuration Dialog Box](image)

Figure 260 ScanFix Configuration Dialog Box
Enable the check boxes of the image enhancement options that you want to use. All enhancement options that are checked are executed when the displayed document is processed. The following table explains each image enhancement option.

<table>
<thead>
<tr>
<th>Enhancement Options</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image de-skew</td>
<td>Straightens skewed (crooked) images.</td>
</tr>
<tr>
<td>Inverse text correction</td>
<td>Detects areas of inverse text and converts the text into normal text.</td>
</tr>
<tr>
<td>Dot shading removal</td>
<td>Removes speck or dot shading from an image.</td>
</tr>
<tr>
<td>Sub image</td>
<td>Processes only specified area of an image.</td>
</tr>
<tr>
<td>Horizontal registration</td>
<td>Aligns the image with a consistent left margin.</td>
</tr>
<tr>
<td>Vertical registration</td>
<td>Aligns the image with a consistent top margin.</td>
</tr>
<tr>
<td>Horizontal line removal</td>
<td>Removes horizontal lines from an image.</td>
</tr>
<tr>
<td>Vertical line removal</td>
<td>Removes vertical lines from an image.</td>
</tr>
</tbody>
</table>

**Note:** You can also view explanations for each option by moving the pointer over the options. As the mouse pointer moves over the options listed, explanatory messages appear as tool tips.

2. Click OK.

Each option in the Configuration dialog box corresponds to a tab in the Advanced Settings dialog box. The tabs with advanced distinctions with in the Advanced Settings dialog box allow you to perform more detailed configuration of image enhancement. For information on configuring image enhancement with advanced settings, refer to “Performing Advanced Image Enhancement” on page 544.

To configure image enhancement using system default settings:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The Configuration dialog box appears.
2. Click Reset.
Performing Advanced Image Enhancement

Additional settings for each enhancement option are available to produce the desired results. These settings are accessed by clicking the Advanced button in the ScanFix Configuration dialog box. Details on each page of the Advanced settings dialog box are provided in the following sections.

- “Using Advanced Deskew” on page 544
- “Using Advanced Registration” on page 548
- “Using Advanced Dot Shading Removal” on page 553
- “Using Speck Removal” on page 557
- “Using Advanced Line Removal” on page 561
- “Using Advanced Inverse Text Correction” on page 565
- “Smoothing Characters” on page 568
- “Using Manual Crop” on page 571
- “Resizing an Image” on page 573
- “Using Advanced Sub Image” on page 576
- “Using IntelligentCrop” on page 579

Using Advanced Deskew

Skew refers to how much rotation the text has in relation to a horizontal reference line. An image that is not perfectly square is considered “skewed.” This option handles a maximum skew of 20%. A character protection feature eliminates rotational distortion induced in the straightening process, using text and horizontal lines to automatically detect and remove skew from an image.

The de-skew text option automatically straightens images that were skewed when scanned in from the scanner. De-skew text can be an integral tool in preparation for optical character recognition (OCR) because a 1% or 2% skew may cause an increase in OCR errors as many OCR engines fail to recognize characters. Other applications for de-skew include document imaging, forms processing, digital copying, faxing and image file compression. The process is invaluable for applications that require precise and consistent placement of text, such as forms processing and the intelligent OCR of columnar data. De-skewing an image can also improve the performance of compression.
When enabled, the De-skew feature optimizes the other image enhancing functions. It is advised that you turn on this feature. Visually, an image with positive skew rises from left to right across a page. An image with negative skew slants downward from left to right across a page. The de-skew process changes the width and height of your image.

To perform advanced deskew on an image:

1. In AppXtender, display the document page that you want to enhance.

2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure is slightly skewed.

3. Click Configure. The ScanFix Configuration dialog box appears.

4. Enable the Image de-skew option.

5. Click Advanced. The ScanFix Advanced Settings dialog box appears.
6. Click the Deskew tab. If necessary, modify the settings on the Deskew tab. The following sections describe each setting:
   - “Minimum Detect Length” on page 547
   - “Maximum Acceptable Skew” on page 547
   - “Character Protection” on page 548
7. Click OK to save the settings. (Any settings saved become the defaults.)
8. In the Image Enhancement dialog box, click Apply. The image is de-skewed. The enhanced image appears in the Enhance Image dialog box. The example image in the following figure has been de-skewed.
Performing Advanced Image Enhancement

Minimum Detect Length

This parameter sets the shortest line (text or graphics) ApplicationXtender uses to detect skew. This measurement is in pixels. The default setting for Minimum Detect Length is 300 (1 inch at 300 DPI). This value should be at least 25% larger than Maximum Acceptable Skew. If a report of Failure to Detect Skew appears, decrease this value and reprocess the image.

Maximum Acceptable Skew

This parameter determines how much skew is acceptable. When AppXtender encounters an image skewed less than this value, it omits the De-Skew process. Using a higher value here causes AppXtender to process images with a lower percentage skew. If you set this to a lower value, lightly skewed images are accepted without de-skewing them. The default setting is 200. Lower numbers indicate greater skew.

Note: A setting of 100 corresponds to 1% skew, while a setting of 200 corresponds to 0.5% skew. Many OCR engines can handle a lightly skewed image, so very high values for Maximum Acceptable Skew may not improve performance.

Figure 263 After Using Deskew

1971 Cadillac

1986 Cadillac

1999 Cadillac

1976 Cadillac
**Image Enhancement**

**Character Protection**
This feature automatically removes rotational distortion from the de-skewed characters, because de-skewing an image often distorts text characters. Checking the box activates character protection. Character protection provides improved OCR results and a more attractive image, but is considerably slower than de-skew alone. It is a trade off between speed and OCR accuracy. Because this feature can dramatically increase processing time, it is recommended that the user leave it off unless OCR error rate is unacceptable.

**Using Advanced Registration**
Registration allows you to specify how far from the edge of an image you want the image data placed. AppXtender can automatically register an image in both the horizontal and vertical planes. The process is accurate and consistent to within 3 or 4 pixels. On a 300 DPI image, AppXtender can position your data within 1/100 of an inch. Registration automatically positions text horizontally and vertically on the page, providing a consistent left and top margin for documents. Registration control is helpful for document imaging and forms processing applications where accurate positioning is critical, because it makes OCR zoning of text fields in forms much more reliable.

To perform advanced registration on an image:

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has a narrow left margin and a slightly thicker top margin.
Performing Advanced Image Enhancement

3. Click Configure. The ScanFix Configuration dialog box appears.

4. Enable the Image de-skew option, unless you know the original is perfectly straight.

5. Enable the Horizontal registration option, the Vertical registration option, or both, depending on the level of precision that you need.

   You can activate and set the parameters for horizontal and vertical registration separately. For most operations where you require a consistent left margin, you should activate horizontal registration. In many cases, you can leave vertical registration deactivated. For applications where precise text location is important, you should activate both horizontal and vertical registration.

6. Click Advanced. The ScanFix Advanced Settings dialog box appears.
7. Click the Registration tab. If necessary, modify the settings on the Registration tab. The following sections describe each setting:

- “Horizontal/Vertical Registration” on page 551
- “Advanced Registration Settings” on page 552

8. Click OK to save the settings. (Any settings saved become the defaults.)

9. In the Image Enhancement dialog box, click Apply. The image is repositioned. The enhanced image appears in the Enhance Image dialog box window. The example image in the following figure has been repositioned. (Notice the thicker left and top margins.)
Using horizontal registration settings, AppXtender locates the left edge of the text and positions the left edge of the image a specified number of pixels from the left edge of text (or data). Using vertical registration settings, AppXtender locates the topmost edge of the text, and positions it a fixed distance from the top edge of the image.

**Note:** If you are designing a form for later processing, a black line 1/16" thick across the top and a 1/8" thick line down the left edge provides extremely reliable registration when you use Find Line for Register.

**Central Focus**
This feature causes AppXtender to register using only the middle portion of the image border. Central Focus is useful for ignoring edge noise, letterheads, and logos.

**Add Only**
This feature causes expansion of the current margin (if it is smaller than the specified amount) to the size specified in the resultant left or top margin parameters.
Image Enhancement

Ignore Holes
Check this box to ignore binder holes and other left-edge noise when analyzing the margin. Leave this feature off unless you have holes or similar noise to avoid. This feature applies only to horizontal registration.

Resultant Left/Top Margin
This parameter determines how many pixels remain as a left or top margin after processing. Setting this value to 0 places text flush with the left or top edge of the image. A negative value crops the specified number of pixels from the left or top edge of the text.

Find Line for Register
This is a powerful feature for precise registration on forms, especially on forms with edge noise. Instead of using what it believes to be the edge of the text, AppXtender instead positions the text in the image based on the position of a vertical line. This line should be significantly larger than any text characters (in particular, those characters to the left of this line). Therefore, set this parameter to a value larger than the height of characters but less than the length of this line. Setting the value to 0 deactivates this feature.

Advanced Registration Settings

Registration parameters for Horizontal and Vertical Registration are identical. The only difference is the orientation. Horizontal parameters refer to the left edge of an image, while vertical parameters deal with the top edge. The vertical adjustment features allow you to control alignment of the image in the vertical plane.

The advanced features of the Registration process are located in the lower left corner of the Registration tab. The Advanced settings give you finer control over image registration, augmenting the find line to register parameters previously described. The registration skip parameters apply to both normal registration and registration to line.

Line Gap
Line Gap values under 3 short gaps are simply ignored. However, setting these values over 3 reassembles broken lines into a whole line for registration purposes, and can dramatically improve success rate with the registration feature.

Line Thickness
AppXtender scans across or down your image looking for lines. In some cases, AppXtender can mistake dense text for a line. These parameters allow you to select the maximum line thickness as lower than the width of your text.
Registration Skip
Registration skip allows you to skip a number of scan lines before starting to look for valid information for registration. The skip feature is particularly valuable for dealing with unwanted data on the edge of an image. In some cases, you may want to skip over a form line or margin note that is seen as valid data. In other cases, this feature can be useful to skip over scanner artifacts that look like lines and data.

Using Advanced Dot Shading Removal

In order to simulate shades of gray, most black and white printers use dithering, also known as dot shading, to give the impression of gray shading. Some black and white scanners also use this technique when they scan color or grayscale images. AppXtender can automatically detect and remove dot shaded regions from your image, leaving any text inside the dot shaded regions intact. The noise removal features allow you to remove dot shading, or ‘dithered’ areas of an image, without degrading text.

Shade removal automatically removes dot shading from an image. This allows shaded text to be recognized as text (not as graphics), which increases OCR performance. Shade removal also enhances the compressibility of image files containing heavily shaded areas by 50% or more, handling a wide range of dot sizes.

To perform advanced dot shading removal on an image:
1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has dot shading (highlighting “1968 Cadillac,” “1969 Cadillac,” and “1970 Cadillac”) that needs to be removed.
Figure 267  Before Using Dot Shading Removal

3. Click Configure. The ScanFix Configuration dialog box appears. Enable the Dot shading removal option. Click Advanced. The ScanFix Advanced Settings dialog box appears.
4. Click the Noise Removal tab. If necessary, modify the Dot Shading Removal settings on the Noise Removal tab. The following section describe each setting:

- “Minimum Area Width” on page 556
- “Minimum Area Height” on page 556
- “Horizontal Size Adjust” on page 556
- “Vertical Size Adjust” on page 556
- “Maximum Dot Size” on page 557
- “Character Protection” on page 557

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. Dot shading is removed from the image. The enhanced image appears in the Enhance Image dialog box window. The dot shading in the example image has been removed.
Minimum Area Width

This parameter determines the smallest horizontal width of any shaded areas to be processed. The default setting is 100 pixels. Set this value higher to reduce errors.

Minimum Area Height

This parameter controls the smallest expected vertical thickness of any shaded area. The default setting is 50 pixels. Set this value higher to detect thicker shaded areas and decrease this value in order to detect shorter dot shaded zones.

Horizontal Size Adjust

This parameter controls the width of specks to be removed. The default setting is 0. Set the value to 1 if specks remain after automated processing; this removes specks that are 1 pixel wider than the size designated in the Maximum Dot setting. Set the value to -1 if the text is being degraded. This decreases the width of the specks being removed by 1 pixel, sparing small text.

Vertical Size Adjust

This parameter controls the height of specks to be removed. The default setting is 0. Set the value to 1 if specks remain after the automated process; this removes specks that are 1 pixel taller than the size set in Maximum Dot setting. Set the value to -1 if the text is being degraded. This decreases the height of the specks being removed by 1 pixel, sparing small text.
Maximum Dot Size
This setting determines the maximum size of individual dots that make up the dot shading. This determines the removal of dots up to and including this size. The default value is 5 pixels.

Character Protection
This feature automatically removes rotational distortion from the de-skewed characters, because de-skewing an image often distorts text characters. The options described in the following table allow you to select character protection with dot shading removal. You can protect against horizontal cuts, vertical cuts, or cuts in both directions. This feature is more effective on horizontal and vertical segments of characters than it is on their diagonal segments. This feature may also preserve dots that touch letters and improve OCR results.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Select none in most cases as this feature dramatically increases processing time.</td>
</tr>
<tr>
<td>Horizontal cuts</td>
<td>Select the horizontal cuts button to protect character segments horizontally.</td>
</tr>
<tr>
<td>Vertical cuts</td>
<td>Select the Vertical cuts button to protect character segments vertically.</td>
</tr>
<tr>
<td>All cuts</td>
<td>Select All cuts and character segments running both directions are protected.</td>
</tr>
</tbody>
</table>

Using Speck Removal
De-speck allows you to remove random horizontal and/or vertical specks (noise) from your image without degrading text.

To perform speck removal on an image:

1. In AppXtender, display the document page that you want to enhance.

2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has a speck (above and to the right of “Fleetwood”) that needs to be removed.
3. Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.

Figure 270   Before Using De-Speck

Figure 271   Noise Removal Tab
4. Click the Noise Removal tab. If necessary, modify the De-Speck settings on the Noise Removal tab. The following section describe each De-Speck setting:
   - “Horizontal De-Speck” on page 559
   - “Vertical De-Speck” on page 560
   - “Isolated De-Speck” on page 560
5. Click OK to save the settings. (Any settings saved become the defaults.)
6. In the Image Enhancement dialog box, click Apply. Specks are removed from the image. The enhanced image appears in the Enhance Image dialog box window. The speck above and to the right of "Fleetwood" in the example image has been removed.

![Image Enhancement](image.jpg)

**Figure 272 After Using De-Speck**

**Horizontal De-Speck**
This parameter sets the maximum horizontal size for de-speck, determining the width of specks to be removed. The default setting is 0. Slide the bar right to remove wider specks and slide the bar left to decrease erroneous text removal.

**Horizontal Protection**
Checking the Horizontal Protection box makes AppXtender check the horizontal plane to determine if the pixel group in question is part of a character.
**Vertical De-Speck**
This parameter controls the maximum vertical size for de-speck; the height of specks to be removed. Increase this value to remove larger (taller) specks and decrease to prevent erroneous text removal. Setting this value too high can remove small vertical sections of characters.

**Vertical Protection**
Checking the Vertical Protection box makes AppXtender check the vertical plane to determine if the pixel group in question is part of a character.

**Isolated De-Speck**
This feature removes specks that are not touching anything else in the image. Larger values can cause AppXtender to remove periods and the dots on the letters i and j. Isolated de-speck is faster than using both horizontal and vertical de-speck.

In the Isolated De-Speck text box, type a number. The value given sets the largest dimension for a speck in any direction. Press the [TAB] key and the advanced features become activated.

The Advanced Features area of the Noise Removal tab only applies to the Isolated De-Speck feature. The following table describes the options in the Advanced Features area:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>De-Speck Width</td>
<td>The width parameter allows you to set different values for the height and width of a speck. The value set in isolated de-speck becomes the height, and the value given here becomes the width. Essentially, this makes your box a rectangle and de-speck removes any speck that fits within the rectangle.</td>
</tr>
<tr>
<td>Diagonal Protection</td>
<td>In normal processing, the four pixels above, below, and to either side of a suspected speck are looked at. With this mode active, AppXtender looks at the four corners as well. Use this feature only when you find that the diagonal portion of text characters is being removed.</td>
</tr>
</tbody>
</table>
Using Advanced Line Removal

Line removal settings removes horizontal and/or vertical lines from an image. Removing lines increases the accuracy of an OCR process. AppXtender automatically detects and removes horizontal or vertical lines – even the most degraded lines (under the Maximum Line Gap parameter). With the Advanced Character Repair feature, the accuracy of OCR improves greatly with difficult documents, such as typed forms and those with underlined words. You can activate horizontal line management separately from vertical line settings with independent parameters. Other than orientation, these features are identical.

Note: If line removal removes large text, you have several options. You can estimate the thickness of the horizontal segments of the largest text characters in your image, and set maximum line thickness to some value lower than that thickness. Another option is to set horizontal minimum line values to larger than the length of the longest horizontal segments of the largest text characters. Conversely, set vertical line management values higher than the longest vertical segment.

To perform advanced line removal on an image:

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has a thick line along the right side that needs to be removed.
Figure 273  Before Using Vertical Line Removal

3. Click Configure. The ScanFix Configuration dialog box appears. Enable the Horizontal line removal option, the Vertical line removal option, or both. Click Advanced. The ScanFix Advanced Settings dialog box appears.
Performing Advanced Image Enhancement

4. Click the Line Removal tab. If necessary, modify the settings on the Line Removal tab. The following section describe each setting:
   
   - “Minimum Line Length” on page 564
   - “Maximum Line Thickness” on page 564
   - “Maximum Line Gap” on page 564
   - “Edge Cleaning” on page 565
   - “Character Repair” on page 565

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. Horizontal and vertical lines are removed from the image. The enhanced image appears in the Enhance Image dialog box window. The thick line along the right side of the example image has been removed.
Figure 275 After Using Vertical Line Removal

Minimum Line Length
This parameter sets the minimum length of a line to detect and remove from the image. The line removal system can identify and remove very short horizontal lines, such as the one across a large capital T. The default setting is 150 horizontal pixels (1/2 inch at 300 DPI) and 150 vertical pixels.

Maximum Line Thickness
This parameter sets the thickness of a line for the system to detect. Some images have short graphic lines that you want to remove and large text characters you want to preserve. Because extremely large text is usually thicker than the lines on forms, you can use this feature to keep AppXtender from removing very large text in titles. The horizontal and vertical default setting is 20 pixels.

Note: The capital 'T' in a large title or headline has horizontal and vertical components that could be mistaken for lines and that could be removed. To avoid unintentional line removal, set the maximum line thickness parameter to a smaller value (like 10). You may also set minimum line thickness to be longer than the widest text.

Maximum Line Gap
This parameter sets the maximum size of a gap allowed in a line. This assures complete removal of lines containing gaps. The default setting is 1 pixel for both horizontal and vertical and works well for most clean images.
Performing Advanced Image Enhancement

**Edge Cleaning**
Noise near a line is removed along with the line; this feature determines how far AppXtender looks for stray pixels near a line. The default setting is 2. Set this value to 3 or 4 if unwanted line shadow remnants remain, or 0 or 1 if adjacent text is degraded. The Character Repair feature can often repair text damaged by line removal.

**Character Repair**
This parameter sets the maximum width or height, in pixels, of characters to reconstruct after the line removal is performed. The default setting is 20 pixels. Set this parameter higher if text is not being adequately repaired and lower if unintentional reconstruction occurs. Setting this value to 0 disables character reconstruction.

*Note:* When you disable Character Repair, you may want to set your Edge Cleaning factor lower than 2 (the default) if line removal is damaging characters.

**Using Advanced Inverse Text Correction**
Inverse text detects white text with a black background (inverse text) and converts it to black text with a white background (normal text). This feature is especially useful in conjunction with OCR, which cannot read inverse text.

To perform advanced inverse text correction on an image:

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has inverse text that needs to be corrected.
3. Click Configure. The ScanFix Configuration dialog box appears. Enable the Inverse text correction option. Click Advanced. The ScanFix Advanced Settings dialog box appears.
4. Click the Inverse Text tab. If necessary, modify the settings on the Inverse Text tab. The following table describes each setting:

Table 70 Inverse Text Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Area Height</td>
<td>This parameter controls the smallest vertical thickness of inverse text areas. The default setting is 50 pixels. Decrease this value if small areas of inverse text are missed or increase this value if normal text is treated as inverse.</td>
</tr>
<tr>
<td>Minimum Area Width</td>
<td>This parameter controls the smallest horizontal width of inverse text areas. The default setting is 300 pixels. Decrease this value if small bands of inverse text are missed or increase this value if normal text is treated as inverse.</td>
</tr>
<tr>
<td>Minimum Black On Edges</td>
<td>This parameter controls the smallest horizontal distance between the edge of an inverse text area and the inverse text itself. The default setting is 10 pixels. Decrease this value if small areas of inverse text are missed or increase this value if normal text is treated as inverse.</td>
</tr>
</tbody>
</table>

5. Click OK to save the settings. (Any settings saved become the defaults.)
6. In the Image Enhancement dialog box, click Apply. Inverse text on the image is converted to normal text. The enhanced image appears in the Enhance Image dialog box window. The inverse text in the example image has been corrected.

![Image of enhanced text example](image)

**Figure 278 After Using Inverse Text Correction**

**Smoothing Characters**

Smoothing characters involves growing and eroding characters in an image and then using "sand" or "fill" operations to produce a finished look. Dot matrix print becomes readable using this setting. This feature allows for de-emphasizing bold text, bringing out faint text, and smoothing out the jagged edges of text.

To smooth characters in an image:

1. In AppXtender, display the document page that you want to enhance.

2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The following figure has an example image with text that needs to be smoothed.
3. Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.
4. Click the Smooth tab. If necessary, modify the settings on the Smooth tab. The following table describes each setting:

Table 71 Smooth Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grow</td>
<td>This feature makes single pixels &quot;grow&quot; into small dots, and expands the borders of text characters. It is very useful for making a font bolder and has the affect of &quot;connecting the dots&quot; of dot matrix print. Lower this value if characters start touching one another or integral spaces in letters close up.</td>
</tr>
<tr>
<td>Erode</td>
<td>This feature looks at groups of black pixels and removes the outer edges. This has the effect of making a speck or text character &quot;shrink&quot; by selected value. Setting this value to 2 erodes a 3 by 3 block of pixels to a single central pixel, or makes a 2 by 2 block of black pixels disappear entirely. Negative values are not allowed with this feature.</td>
</tr>
<tr>
<td>Sand and Fill</td>
<td>This feature improves an image's appearance by smoothing out the edges of characters. It does this by filling small pits and removing small bumps on the edges of characters. Sand and fill options reduces its compressed image file size. Use larger values (from 1 to 5) for larger type size, pits and bumps.</td>
</tr>
</tbody>
</table>

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. Characters on the image are smoothed. The enhanced image appears in the Enhance Image dialog box window. The text in the example image has been smoothed with the Grow option.

Figure 281 After Smoothing Characters
Using Manual Crop

Manual crop resizes an image by adding or removing a specified number of pixels from your image in the selected directions. This feature does not alter the image resolution. Only when values are entered into the crop text boxes do the pad text boxes become enabled.

To crop an image manually:

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The following figure has an example image with areas that need to be cropped out.

![Image Enhancement Dialog Box](image)

3. Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.

**Figure 282** Before Using Manual Crop

4. Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.
4. Click the Crop tab. If necessary, modify the Manual Crop settings on the Crop tab. The following table describes each setting:

**Table 72 Manual Crop Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Crop/Pad</td>
<td>Removes the specified number of pixels from the top edge of the image. The manual crop function starts at the edge of the image and ignores image data. Pad adds the specified number of pixels (the value in top crop) to the top edge of the image.</td>
</tr>
<tr>
<td>Bottom Crop/Pad</td>
<td>Removes the specified number of pixels from the bottom edge of the image. This parameter can help remove unwanted noise from an image, or unwanted footer information. The bottom pad adds the specified number (from the bottom crop value) of pixels to the bottom edge of the image.</td>
</tr>
<tr>
<td>Left Crop/Pad</td>
<td>Removes the specified number of pixels from the left edge of the image. Left pad adds the specified number of pixels (in left crop) to the left edge of the image.</td>
</tr>
<tr>
<td>Right Crop/Pad</td>
<td>Removes the specified number of pixels from the right edge of the image. Right pad adds the specified number (from the right crop setting) of pixels to the right edge of the image.</td>
</tr>
</tbody>
</table>

5. Click OK to save the settings. (Any settings saved become the defaults.)
6. In the Image Enhancement dialog box, click Apply. The specified areas are cropped from the image. The enhanced image appears in the Enhance Image dialog box window. The example image has been cropped in the following figure.

![Image Enhancement Dialog Box](image.png)

**Figure 284 After Using Manual Crop**

### Resizing an Image

AppXtender can alter the size of an image to user-defined dimensions. This feature does not change the resolution (DPI) of your image, but it compresses or expands the image data to match the new image size.

To resize an image:

1. In AppXtender, display the document page that you want to enhance.

2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure needs to be resized.
Figure 285  Before Resizing an Image

3. Click Configure. The ScanFix Configuration dialog box appears.
    Click Advanced. The ScanFix Advanced Settings dialog box appears.

Figure 286  Crop Tab
4. Click the Crop tab. If necessary, modify the Resize settings on the Crop tab. The following table describes each setting:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resultant Width</td>
<td>Sets the output width of your image and magnifies or shrinks your image to this width.</td>
</tr>
<tr>
<td>Resultant Height</td>
<td>Sets the output height of your image and magnifies or shrinks your image to this height.</td>
</tr>
</tbody>
</table>

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. The image is resized. The enhanced image appears in the Enhance Image dialog box window. The example image in the following figure has been resized.

![Image](image.png)

Figure 287 After Resizing an Image
Image Enhancement

Using Advanced Sub Image

This feature allows you to isolate a specified area from an image, called a Sub-Image. This extraction occurs after de-skew and register, but prior to any other processing. The sub-image is then processed with all other active features after discarding all remaining parts of the image.

To enhance a sub image of an image:

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears.

![Image](image.png)

Figure 288 Before Using Sub Image

3. Click Configure. The ScanFix Configuration dialog box appears. Enable the Image de-skew option and the registration options.
   - For information on the Image de-skew option, refer to “Using Advanced Deskew” on page 544.
   - For information on the registration options, refer to “Using Advanced Registration” on page 548.
4. Enable the Sub image option and any other options for enhancements that you want to perform on the sub-image.
Performing Advanced Image Enhancement

5. Click Advanced. The ScanFix Advanced Settings dialog box appears.

![Crop Tab](image)

6. Click the Crop tab. If necessary, modify the Sub-Image settings on the Crop tab. The following section describe each setting:
   - “Top Edge” on page 578
   - “Bottom Edge” on page 578
   - “Left Edge” on page 578
   - “Right Edge” on page 578

7. Configure other tabs, if necessary, to perform enhancements on the sub-image.

8. Click OK to save the settings. (Any settings saved become the defaults.)

9. In the Image Enhancement dialog box, click Apply. AppXtender performs deskew and registration on the whole image, and then performs all other configured enhancements on the sub-image. The enhanced image appears in the Enhance Image dialog box window.
Figure 290 After Using Sub Image

**Top Edge**
This value defines the top edge of sub-image to extract, measured in pixels from the top of the image after performing de-skew and registration. Use 0 to start from the very top of the image.

**Bottom Edge**
This value defines the bottom edge of the sub-image to extract, measured in pixels from the top of the image after de-skew and registration. Use 0 to signify the very bottom of the image.

**Left Edge**
This defines the left edge of the sub-image to extract, measured in pixels from the left edge of the image after processing de-skew and registration. Use 0 to start from the left edge of the image.

*Note: Try using 1275 (4.25 inches at 300 DPI) to crop the left half of a typical 8.5 inch by 11 inch page.*

**Right Edge**
This value sets the right edge of the sub-image to separate, measured in pixels from the left edge of the image after processing de-skew and registration. Use 0 to signify the image’s right edge.

*Note: Try using 1275 (4.25 inches at 300 DPI) to crop the right half of a typical 8.5 inch by 11 inch page.*
Performing Advanced Image Enhancement

Using IntelligentCrop

This option allows bleaching out black or shaded borders. Intelligent crop performs image analysis to determine where the edge of your data lies in relation to the edge of the image, automatically cropping the image to leave behind only the data you require.

To crop an image with IntelligentCrop:

1. In AppXtender, display the document page that you want to enhance.

2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has white space that needs to be cropped.

3. Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.

Figure 291  Before Using IntelligentCrop

- Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.
4. Click the Crop tab. If necessary, modify the IntelligentCrop settings on the Crop tab. The following table describes each setting:

Table 74 IntelligentCrop Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black Crop</td>
<td>This feature detects black border around an image’s perimeter resulting from scanning or other input system and “bleaches” out this unnecessary feature without actually removing it.</td>
</tr>
<tr>
<td>White Crop</td>
<td>This feature trims the white space around the border of an image where no data appears. The value entered here is the white border size in pixels that remains after cropping. You can substitute this feature for registration, but it is not as precise. Setting the value to 0 deactivates this feature. AppXtender performs black crop first if both are activated.</td>
</tr>
</tbody>
</table>

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. The border of the image is bleached or trimmed as specified. The enhanced image appears in the Enhance Image dialog box window. The white space surrounding the example image has been cropped.
Performing Advanced Image Enhancement

Figure 293  After Using IntelligentCrop
This appendix describes how to work with Centera retention for Document Manager.

- Overview .......................................................... 584
- Filing Documents for Centera Retention ......................... 586
- Processing Documents for Centera Retention Hold ........... 591
Overview

Centera retention is a licensed feature that protects documents from loss, whether accidental or malicious. The feature also ensures documents are retained in an AppXtender repository for a prespecified period of time, in accordance with legal, regulatory, fiscal, or operational requirements.

Note: Your retention administrator creates retention policies or classes that determine how long documents must remain in the AppXtender repository.

For more information, refer to:

- “Centera Retention Concepts” on page 584
- “Identifying Retention Applications” on page 585

Centera Retention Concepts

Document Manager displays retention options if your AppXtender content management system is configured for Centera retention and your retention administrator has assigned retention privileges to your AppXtender user account. The options allow you to file documents for retention or apply a retention hold to documents.

Documents that are filed for retention cannot be modified or deleted until the retention period expires. At the end of the retention period, your retention administrator determines if the document must be removed from the AppXtender repository or if the document should remain in the repository as a writable document. Contact your retention administrator if you need assistance with documents that have been filed for retention or placed on retention hold.
Identifying Retention Applications

In the Document Manager Applications view, a folder and clock icon (.between numbers) appears next to applications that are configured for Centera retention. The following figure shows an application that is configured for Centera retention and an application that is not.

![Application Icons](image)

**Figure 294** Document Manager Applications View: Application Folder Icons

Note: The folder and clock icon also appears next to applications that are configured for Records Manager retention. Refer to Appendix B, “Working with Records Manager for AppXtender,” for more information.
Filing Documents for Centera Retention

Document Manager allows you to file a document for Centera retention if your retention administrator assigned the retention user privilege to your AppXtender user account.

Note: Document Manager does not allow you to file ApplicationXtender Reports Management documents for retention.

If you need to modify a document after you file it for retention, you must check out the document, modify it, and then check it into the AppXtender repository. Document Manager saves the modified document as a new version.

For more information, refer to:

- “Filing a Document for Retention from Document Display View” on page 586
- “Filing a Document for Retention from the Query View Result Set” on page 587
- “Filing Multiple Documents for Retention” on page 589

Filing a Document for Retention from Document Display View

To file a document for Centera retention from the Document Display view:

1. Query the application to locate the document. Refer to “Retrieving Documents” on page 243 for more information.
4. Select a retention class or policy from the Retention Class or Policy list box. The Retention Ending Date field displays the date on which the retention period expires.

   **Note:** You must have retention administrator privileges to select a policy or class other than the default.

5. Click OK.

   Document Manager displays a document and clock icon ( ) next to the document in the Result Set after the Centera storage device processes the request.

---

**Filing a Document for Retention from the Query View Result Set**

To file a document for Centera retention from the Query view Result Set:

1. Query the application to locate the document. Refer to “Retrieving Documents” on page 243 for more information.

2. Right-click the document from the Result Set to open the Document Manager shortcut menu.

4. Select a retention class or policy from the Retention Class or Policy list box.

   **Note:** You must have retention administrator privileges to select a policy or class other than the default.

5. To apply the retention setting to previous versions of the document, enable File all available previous revisions for retention.

   **Note:** Document Manager applies the retention setting to the current version of the document if you do not enable File all available previous revisions for retention.

6. Click Set Retention. The document ID, job ID, and job status appear in the Results section of the Set Retention Options dialog box.

7. Click OK.

   Document Manager displays a document and clock icon ( ⌚️ ) next to the document in the Result Set after the Centera storage device processes the request.
To file multiple documents for Centera retention:

1. Query the application to locate the documents. Refer to “Retrieving Documents” on page 243 for more information.

2. Select the documents from the Query view Result Set.
   
   To select multiple, consecutive documents:
   
   a. Select the first document.
   
   b. Press and hold Shift.
   
   c. Select the last document.

   To select multiple, non-consecutive documents:
   
   a. Select the first document.
   
   b. Press and hold Ctrl.
   
   c. Select the documents.

3. Right-click to open the Document Manager shortcut menu.


5. Select a retention class or policy from the Retention Class or Policy list box.
Note: You must have retention administrator privileges to select a policy or class other than the default.

6. To apply the retention setting to previous versions of the documents, enable File all available previous revisions for retention.

Note: Document Manager applies the retention setting to the current versions of the documents if you do not enable File all available previous revisions for retention.

7. Click Set Retention. The document IDs, job IDs, and job statuses appear in the Results section of the Set Retention Options dialog box.

8. Click OK.

Document Manager displays a document and clock icon ( ) next to each document in the Result Set after the Centera storage device processes the request.
Processing Documents for Centera Retention Hold

The Centera retention hold feature allows you to apply and remove retention holds. A retention hold prevents users from deleting documents after the retention period expires.

Note: You must have retention administrator privileges to use the Centera retention hold feature.

For more information, refer to:

◆ “Applying Centera Retention Holds” on page 591
◆ “Removing Centera Retention Holds” on page 593

Applying Centera Retention Holds

Document Manager allows you to apply a retention hold from Document Display view and the Query view Result Set. For more information, refer to:

◆ “Applying a Retention Hold from Document Display View” on page 591
◆ “Applying a Retention Hold from the Query View Result Set” on page 592

Applying a Retention Hold from Document Display View

To apply a retention hold from Document Display view:

1. Query the application to locate the document. Refer to “Retrieving Documents” on page 243 for more information.

![Retention Hold Options Dialog Box](image)
Working with Centera Retention

4. Select a retention hold label from the Retention Hold Label list box.

5. To create a new retention hold label, type the name of the new label (for example, W2) in the list box, and then click Create New.

6. Click OK.

Document Manager displays a retention hold icon ( ) next to the document in the Result Set after the Centera storage device processes the request.

To apply a retention hold from the Query view Result Set:

1. Query the application to locate the document. Refer to "Retrieving Documents" on page 243 for more information.

2. Right-click the document to open the Document Manager shortcut menu.

3. Select Place Retention Hold. Document Manager displays the Retention Hold Options dialog box.

![Retention Hold Options Dialog Box](image)

**Figure 299 Retention Hold Options Dialog Box**

4. Select a retention hold label from the Retention Hold Label list box.

5. To create a new retention hold label, type the name of the new label (for example, W2) in the list box, and then click Create New.

6. Click OK.

Document Manager displays a retention hold icon ( ) next to the document in the Result Set after the Centera storage device processes the request.
Removing Centera Retention Holds

Document Manager allows you to remove a Centera retention hold from a single document or a set of documents. You cannot delete a document from the AppXtender repository until the retention period expires and the retention hold is removed from the document.

**Note:** You must have retention administrator privileges to remove a retention hold.

For more information, refer to:
- “Removing a Retention Hold from Document Display View” on page 593
- “Removing a Retention Hold from the Query View Result Set” on page 594
- “Removing a Retention Hold from a Set of Documents” on page 594

Removing a Retention Hold from Document Display View

To remove a Centera retention hold from Document Display view:

1. Query the application to locate the document. Refer to “Retrieving Documents” on page 243 for more information.

![Retention Hold Options Dialog Box](image)

4. Click Yes to confirm you want to remove the retention hold.

Document Manager removes the retention hold icon ( ) from the Result Set after the Centera storage device processes the request.
Removing a Retention Hold from the Query View Result Set

To remove a Centera retention hold from the Query view Result Set:

1. Query the application to locate the document. Refer to “Retrieving Documents” on page 243 for more information.
2. Right-click the document to open the Document Manager shortcut menu.
3. Select Remove Retention Hold. Document Manager displays the Retention Hold Options dialog box.

   ![Retention Hold Options Dialog Box](image)

   *Figure 301 Retention Hold Options Dialog Box*

   4. Click Yes to confirm you want to remove the retention hold. Document Manager removes the retention hold icon ( ) from the Result Set after the Centera storage device processes the request.

Removing a Retention Hold from a Set of Documents

To remove a Centera retention hold from a set of documents:

1. Select Utilities > Remove Retention Holds from the Document Manager menu bar. Document Manager displays the Remove Holds dialog box.

   ![Remove Holds Dialog Box](image)

   *Figure 302 Remove Holds Dialog Box*

2. Select the application from the Application list box.
3. Select the retention hold label from the Label list box.

4. Click Display Docs. Document Manager displays the documents that have been filed for retention with the selected hold label.

5. Select the documents from which you want to remove the retention hold:
   - To select all the documents, click Select All.
   - To select a specific document, select the check box next to that document.

6. Click Remove Holds.

   Document Manager removes the retention hold icon (ispiel) from each document in the Result Set after the Centera storage device processes the request.
Working with Centera Retention
This appendix describes how to transfer documents using Records Manager for ApplicationXtender.

- Introduction to Records Manager for ApplicationXtender ...... 598
- RM for ApplicationXtender Concepts ....................................................... 600
- Identifying RM for ApplicationXtender Applications in ApplicationXtender . 603
- Transferring ApplicationXtender Documents for Records Management.... 605
- Filing ApplicationXtender Documents for Retention Administration . 608
- Working With ApplicationXtender Documents That Are Filed for Retention ................................................................. 611
Introduction to Records Manager for ApplicationXtender

Records Manager for ApplicationXtender (RM for AppXtender) is a Department of Defense (DoD) compliant and certified records management module of ApplicationXtender. From either the ApplicationXtender (AppXtender) or ApplicationXtender Web Access (AppXtender Web Access) desktop, users can transfer AppXtender documents into Documentum Records Manager (DRM), where the documents become official corporate records and are no longer accessible through ApplicationXtender or ApplicationXtender Web Access.

Users can also use RM for AppXtender to provide retention administration for documents in the AppXtender repository. RM for AppXtender retention administration ensures that documents that have been filed for retention remain in the AppXtender repository for a prespecified period of time.

Note: Retention and classification rules that the administrator configures determine this period of time and the conditions under which documents are retained and eventually archived or destroyed.

Depending on how your administrator has configured your AppXtender applications, you may be able to transfer documents to RM for AppXtender for records management, file documents in RM for AppXtender for retention administration for documents retained in AppXtender, or both.

There are several advantages for organizations using RM for AppXtender:

◆ Records in the RM for AppXtender filing system are protected from loss, whether accidental or malicious.

◆ Filing documents in RM for AppXtender for retention administration ensures that your organization meets all legal and policy requirements regarding how long to keep documents on file before disposing of them.

◆ In cases requiring supporting documentation, such as for litigation purposes, authorized users can quickly and easily find relevant retained records in RM for AppXtender.
Authorized users can access documents in RM for AppXtender for retention administration regardless of which user originally transferred the document into the filing system. This means that you can access others’ documents from the RM for AppXtender system and they can access your documents.

Documents transferred to the RM for AppXtender system can provide valuable reference information for your organization.

The following topics are discussed in this section:

- “RM for AppXtender Concepts” on page 600
- “RM for AppXtender Concepts” on page 600
- “Transferring AppXtender Documents for Records Management” on page 605
- “Filing AppXtender Documents for Retention Administration” on page 608
- “Working With AppXtender Documents That Are Filed for Retention” on page 611
RM for AppXtender Concepts

Understanding how the RM for AppXtender system functions can help you when you transfer documents from AppXtender to RM for AppXtender for records management, file documents for retention, or both.

Note: The RM for AppXtender authentication and authorization system controls which users can use AppXtender to transfer documents to RM for AppXtender and access documents from RM for AppXtender, as well as which users can log into the RM for AppXtender server to perform procedures such as document deletion. If you have questions about your user privileges, consult your records administrator.

This topic includes information on the following concepts:
- “Filing Systems and File Plans” on page 600
- “Records Management” on page 601
- “Retention Administration” on page 602

Filing Systems and File Plans

Records Manager for ApplicationXtender applications allow you to transfer AppXtender documents to the appropriate filing system and file plan in the RM for AppXtender repository. Based on your organization’s specific requirements, your administrator designs and implements RM for AppXtender filing systems, file plans, and rules for records management and retention administration.

Note: ApplicationXtender Reports Management reports cannot be transferred to the RM for AppXtender repository.

While multiple filing systems may be configured for each RM for AppXtender server, only one RM for AppXtender server may be configured per AppXtender data source group. The filing system may consist of one or more file plans, which hold official records and retained documents. There can be up to 20 levels of files in a file plan.
The following figure shows an example of a filing system called AXRM520 that has one file plan called Corporate_name and several file levels.

![File System Configuration in RM for AppXtender Server](Figure 303)

When you transfer an AppXtender document to Records Manager for ApplicationXtender for records management, RM for AppXtender creates an official record using metadata from the AppXtender document. The official record for the document is filed in the specified filing system file plan in the RM for AppXtender system, and the document index in AppXtender is deleted. Although the document contents (page files, annotation files, etc.) remain in ApplicationXtender after the transfer process, once a document is transferred to RM for AppXtender for records management, you cannot search for the document in AppXtender or make any changes to it.

**Note:** Since the index is deleted when a document is transferred to RM for AppXtender for records management, you can no longer access that document from ApplicationXtender. For this reason, it is imperative to verify that you are working with the correct AppXtender document before starting the transfer process.
RetentionPolicyAdministration

When you assign an AppXtender document to RM for AppXtender for retention administration, RM for AppXtender creates a copy of the document and a document profile and files both in the selected RM for AppXtender file plan for a pre-specified period of time. The exact amount of time is based on legal, regulatory, fiscal, or operational requirements relating to the type of document. The document contents (page files, annotation files, etc.) and document index remain in the AppXtender system.

**Note:** ApplicationXtender Reports Management documents cannot be added to the RM for AppXtender repository.

As long as a document is under retention administration in RM for AppXtender, RM for AppXtender rather than AppXtender controls access to the document. Assuming you have the appropriate user privileges, you can use AppXtender queries to find the document in the repository. From AppXtender Search Result Set view, you can then view the document in Document Display view or check the document out and make changes to the document in AppXtender or AppXtender Web Access. For information on retrieving retained documents, refer to “Working With AppXtender Documents That Are Filed for Retention” on page 611.

**Note:** Unless the RM for AppXtender retention policy for a particular file allows deletion, you will not be able to delete the retained document in ApplicationXtender before the retention time period expires.

At the end of the retention time period, the document may be archived or deleted from the system. Depending on how the retention policy is configured, document disposal may be carried out by either RM for AppXtender or AppXtender.

**Note:** Only users with the appropriate RM for AppXtender authentication and authorization privileges can delete documents from the RM for AppXtender system.
Identifying RM for AppXtender Applications in AppXtender

Like other AppXtender applications, applications configured for RM for AppXtender retention administration, records management, or both are represented in AppXtender Applications view by file folder icons. The appearance of the file folder icon indicates whether an application is a regular ApplicationXtender application, an application configured for retention administration, an application configured for records management, or an application configured for both retention administration and records management.

The following figure shows four types of application file folder icons that may appear in Application view when you work with Records Manager for ApplicationXtender. The table following the figure describes what each type of application folder icon represents.

Figure 304 Application Folder Icons on RM for AppXtender Desktop
The following table describes the configuration each type of application folder in Application view represents.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Manila folder" /></td>
<td>Manila folders represent applications with neither records management nor retention administration.</td>
</tr>
<tr>
<td><img src="image" alt="Blue folder" /></td>
<td>Blue folders represent applications configured with records management.</td>
</tr>
<tr>
<td><img src="image" alt="Manila folder with clock" /></td>
<td>Manila folders with a clock icon on the lower right corner represent applications configured with retention administration.</td>
</tr>
<tr>
<td><img src="image" alt="Blue folder with clock" /></td>
<td>Blue folders with a clock icon on the lower right corner represent applications configured with both records management and retention administration.</td>
</tr>
</tbody>
</table>

Your desktop may also include an icon to access the RM for AppXtender server.

![Records Management Servers](image)

**Figure 305  Records Management Servers Icon**

Using this icon, AppXtender users with the required RM for AppXtender privileges can log into the Records Management server to search for records, view a list of records, open records, view record properties, and delete records. For more information on document access and management through the Records Management node, refer to the *Retention Manager for ApplicationXtender Integration Guide*. 
Transferring AppXtender Documents for Records Management

You use the Classify and Transfer function from the AppXtender Documents menu to transfer documents from AppXtender to the RM for AppXtender system for records management. During this procedure, you select the file plan from the RM for AppXtender filing system to which the document should be transferred.

CAUTION

Once AppXtender documents are transferred to the RM for AppXtender system for records management, they can no longer be accessed in ApplicationXtender.

To transfer an AppXtender document to the RM for AppXtender system for records management:

1. From the AppXtender application configured for records management, search for the AppXtender documents to be transferred. For information on using AppXtender queries to retrieve documents, refer to “Entering Index Values as Search Criteria” on page 250.

   Note: Before you search for documents in RM for AppXtender, make sure the RM for AppXtender Indexer has been run to index any new documents added to RM for AppXtender. For more information, refer to the Retention Manager for ApplicationXtender Integration Guide.

2. From the documents in AppXtender Search Result Set view, right-click on the document you want to classify and transfer. The shortcut menu appears.

3. On the shortcut menu, select Classify and Transfer.

   If this is the first time in any AppXtender session that you have selected to access the Records Management system, the Records Management login dialog box appears.

   Note: You only need to log into the Records Management system once from AppXtender. From then on, when you select to classify and transfer an AppXtender document, the RM for AppXtender login dialog box is bypassed. This applies not only to the current AppXtender session but to future sessions as well.
4. Enter your RM for AppXtender user name and password.

   **Note:** If you have questions about your RM for AppXtender password, consult your system administrator.

5. Click Login. The Select File Plan dialog box appears.

![Select File Plan Dialog Box](image)

**Figure 306** Select File Plan Dialog Box

6. Find the filing system file plan to which the document should be transferred by clicking the plus signs (+) to the left of the filing system and file plan names until the destination file plan appears.

7. Select the destination file plan folder. This enables the OK button in the lower part of the dialog box.

![Destination Filing System File Plan Selected](image)

**Figure 307** Destination Filing System File Plan Selected
8. Click OK to transfer the AppXtender documents to the selected file plan. The Select File Plan dialog box closes, and the transferred document is removed from the list of documents in Search Result Set view.

9. If other documents in Search Result Set view need to be transferred to RM for AppXtender for record management, repeat steps 2 through 6 for each document.
Filing AppXtender Documents for Retention Administration

You use the File for Retention function to file AppXtender documents with the RM for AppXtender system for retention administration. You file documents for retention from the AppXtender desktop using the File for Retention function. Once documents are filed for retention, RM for AppXtender manages document deletion.

Note: For information on document access and management through the Records Management node, refer to the Retention Manager for ApplicationXtender Integration Guide.

To file an AppXtender document for retention administration by the RM for AppXtender system:

1. From the AppXtender application configured with records administration, search for the AppXtender documents to be filed for retention. For information on using AppXtender queries to retrieve documents, refer to “Entering Index Values as Search Criteria” on page 250.

Note: Before you search for documents in RM for AppXtender, make sure the RM for AppXtender Indexer has been run to index any new documents added to RM for AppXtender. For more information, refer to the Retention Manager for ApplicationXtender Integration Guide Integration Guide.

2. From the documents in AppXtender Search Result Set view, select the document you want to file for retention and right-click. The shortcut menu appears.

3. On the shortcut menu, select File for Retention.

   If this is the first time in any AppXtender session that you have selected to access the Records Management system, the Records Management login dialog box appears.

   Note: You only need to log into the Records Management system once from AppXtender. From then on, when you select to file an AppXtender document for retention, the RM for AppXtender login dialog box is bypassed. This applies not only to the current AppXtender session but to future sessions as well.
4. Enter your RM for AppXtender user name and password.

   **Note:** If you have questions about your RM for AppXtender password, consult your system administrator.

5. Click Login. The Select File Plan dialog box appears.

6. Find the filing system file plan to which the document should be filed by clicking the plus signs (+) to the left of the filing system and file plan names until the destination file plan appears.

7. Click on the destination file plan folder. This enables the OK button in the lower part of the dialog box.
8. Click OK to file the AppXtender document to the selected file plan. The Select File Plan dialog window closes.

When the file for retention process finishes successfully, a clock icon appears on the far right in the AppXtender status bar.

Figure 310  Retention Administration Clock Icon in AppXtender Status Bar

Once an AppXtender document is filed for retention in RM for AppXtender, if you need to modify the document, you must check it out of the repository. When you finish working with the document, you must check it back in. As long as you have a document checked out, other users can access that document only in read-only mode.

For information on document checkout and check-in, as well as cancelling document checkout, refer to the following topics:

- “Getting Started” on page 17
- “Selecting a Document Display Mode” on page 280
- “Checking in and Canceling Changes” on page 425
- “Checking a New Document into AppXtender” on page 452
- “Choosing a Viewing Mode for an AppXtender Document” on page 461
- “Working with Checked Out AppXtender Documents” on page 469
When you need to view or modify an AppXtender document that is filed for retention in RM for AppXtender, you query the corresponding AppXtender application for the document using the same query methods that you normally use to retrieve AppXtender documents. These methods include index value, wildcard, expression range, and list of values queries, searching by ODMA attributes, and using compound queries. For information on setting up AppXtender queries, refer to Chapter 5, “Retrieving Documents.”

**Note:** When you query for retained documents from RM for AppXtender, the query results may include non-AppXtender documents such as documents added directly via the RM for AppXtender client. The icons for these documents in AppXtender Search Result view differ from the RM for AppXtender icons. You cannot view non-AppXtender documents in ApplicationXtender.

After viewing the retrieved document, if you need to modify it, before you can start, you must check the document out of RM for AppXtender so that you can access it in edit mode. When you finish modifying the document, you check it back into RM for AppXtender.

**Note:** If you check a document out of RM for AppXtender and then find you do not need to work with it, you can cancel the checkout.

The procedures to check retained documents out, check them back in, and to cancel checkout when working with RM for AppXtender are the same as those normally used in ApplicationXtender. For information, refer to the following topics:

- “Ways of Using ApplicationXtender” on page 40
- “Selecting a Document Display Mode” on page 280
- “Checking in and Canceling Changes” on page 425
- “Checking a New Document into AppXtender” on page 452
- “Choosing a Viewing Mode for an AppXtender Document” on page 461
- “Working with Checked Out AppXtender Documents” on page 469
This glossary contains terms and definitions found in this guide.

A

annotation  An annotation is a note or a shape added to a document or batch page, typically to focus attention on a particular part of the page. Users can use annotations to comment on the contents of a page, block areas of the page from view, or highlight important information. When a user creates an annotation, it is associated with the AppXtender document page on which her or she created it. Annotations are edited and stored separately from the image, but they are displayed along with the image in ApplicationXtender. The types of annotations available include text, highlighting, lines, arrows, shapes, and rubber stamps.

annotation group  AppXtender administrators use annotation groups to create associations between users, groups, and specific annotations. The administrator can specify which users and groups can view or modify specific annotations and which users and groups can hide or modify specific redactions.

append  Attach one or more pages to the end of a document.

application  An AppXtender application is an index-driven data storage structure where documents can be stored and retrieved. An AppXtender application is based on an index that is composed of one or many fields. AppXtender applications are created in ApplicationXtender Application Generator (AppXtender AppGen).

application security profile  Application security profiles allow an AppXtender administrator to grant a particular set of privileges to a user or group of users. Each application can be set up with its own set of privileges.
**audit trail**
The Audit Trails feature allows AppXtender administrators to track user activity within the AppXtender system. System-wide activities, such as the creation, modification, and deletion of applications, users, and groups can be tracked. Administrators can also track user activity in applications by tracking items such as the creation and deletion of documents, the addition of pages, and the modification of index information for documents.

**authentication**
Authentication requires all users to enter a valid user name and password to access software modules. Authentication ensures that each user is who he or she claims to be.

**authorization**
Authorization is the granting of specific access privileges according to the user name. Security profiles contain information pertaining to a user’s specific privileges within the AppXtender system.

**auto index import**
The ApplicationXtender Auto Index Import function allows users to automatically populate indexes using data imported from records in the AppXtender Auto Index Import table. Once data has been exported from the record to populate index fields, the record is deleted from the AppXtender Auto Index Import table. AppXtender Auto Index Import is ideal for the import of index records that are applicable to only one document.

**B**

**batch**
A group of electronic files for one or more documents, each of which has one or more pages.

**C**

**check in/check out mode**
When AppXtender is in check in/check out mode, use of revision control with AppXtender documents is mandatory. Users must check out a document in order to modify it. If they do not check the document out, it is opened in read-only mode and cannot be modified.

**COLD**
COLD (computer output to laser disk) data is report data generated for existing applications. COLD data can be added to AppXtender as documents through the use of ApplicationXtender Reports Management™ (AppXtender Reports Mgmt).
D

data source
A data source is the means by which ApplicationXtender accesses data from a database. When a data source is defined, an OLE DB data provider is configured to access the database. All of these characteristics in combination – where the data is stored, the format of the stored data, and the data provider used to access the data – comprise the data source.

database
A database is a collection of data tables of a particular database format (such as Oracle or Microsoft SQL Server). ApplicationXtender uses databases to store application information. When an application is created, details such as the field definitions and security information are stored in database tables. Once documents are added to an application, index information is stored in a table, as are the pointers to the location of the documents.

digital signature
The Digital Signature features allows authorized users to electronically sign pages in AppXtender documents from Document Display view. If the document is modified later, the existing digital signature is invalidated and a new digital signature must be applied.

document
A document is a page or group of pages stored in an application and identified by index information. Each page of a document is comprised of a single object such as a scanned image file or a word processing document. To create a new document, users add an object to an application and attach index information to it. Subsequent objects can be added as additional pages of the same document.

Document Level Security
Document Level Security (DLS) pinpoints user access within an AppXtender application. With DLS, the administrator can deny a group of users access to any classified or sensitive documents without restricting access to other documents in the application. DLS can also be configured to grant a group of users access to only a specific set of documents in an application.

dual data entry
A validation measure used when indexing documents to ensure that each document is indexed correctly. Users must enter each index value twice when adding or modifying index field data. The first index value is accepted only when AppXtender verifies a match with the second entry.
ERM
ERM (enterprise report management) data is report data generated for existing applications. ERM data can be added to AppXtender as documents through the use of ApplicationXtender Reports Management™ (AppXtender Reports Mgmt).

Expression operators
A query using expression operators to focus the document search. Users can use operators to combine index words or text strings into a single expression.

Full-text
Users can index documents for full-text searching by submitting them to the ApplicationXtender Index Server. With a full-text search, users can find documents even if they do not know any of the index values. Users can also use full-text searching to refine an index value search.

Global security profile
Global security profiles can be established to automatically assign a uniform set of access privileges for a user or group of users every time a new application is created. When a global profile exists for a user or group of users, the privileges assigned in that profile are automatically assigned when an application is created. If a user or group of users does not have a global profile, an application-specific profile must be created for that user or group before they can access an application.

Index
An AppXtender index contains a group of fields where descriptive information pertaining to documents can be stored. This group of field definitions is used by AppXtender when storing index information within an application.

Index Server
The ApplicationXtender Index Server is an optional module that adds full-text indexing and OCR functionality to ApplicationXtender systems.
installed components
Third-party components that users can download to use while working with ApplicationXtender. This includes software for a scanning component required for interactive control, viewing and printing components for PDF files, and a KeyView component required for rendering foreign files.

J
"just-in-time" compilation
The first time a user accesses a page, ApplicationXtender compiles the page into its native code. The page is then cached and downloaded. With this method, although the page takes longer to load initially, it should load quickly the next time it is accessed.

K
Key Reference
The ApplicationXtender Key Reference function allows users to automatically populate indexes using data imported from records in the AppXtender Key Reference table. The record from which data has been exported to populate index fields remains in the AppXtender Key Reference table—it is not deleted. For this reason, ApplicationXtender Key Reference indexing is useful in populating index information that will be used to describe multiple documents and that may need to be changed frequently. Any change made to a record in the AppXtender Key Reference table is reflected in the indexes of all documents described by that record.

L
Last Index
The Last Index function allows users to populate the index fields for one record with the index values used for the previous record.

list of values query
A query in which multiple index values can be specified for each search criteria index field. This allows users to retrieve documents matching multiple index values in a single search.

OCR
Users can process both bi-tonal and color images using optical character recognition (OCR). This process converts an image of text into text. After a user processes an image using OCR, it can then be submitted to the ApplicationXtender Index Server for full-text searching.
**OLE DB**
OLE DB is a programming interface for accessing data and is a fundamental building block for storing and retrieving data using Microsoft’s Data Access Components (MDAC). OLE DB provides flexible data architecture that offers applications like AppXtender efficient access to databases. Data is accessed through OLE DB data providers.

**P**

**page**
The word “page” typically implies a single entity. Since AppXtender supports multiple object types, the term “page” is redefined within AppXtender to mean a single object. A very long word processing file is considered a page to AppXtender. A page could also be, for example, a single scanned image, a 30-minute video clip, or an audio recording. Each page of a document has the same index record attached.

**privileges**
Privileges govern the ability of a user or group of users to access functions in AppXtender.

**R**

**range query**
A query in which users can search for documents with index values that match one or more values in a specified range of values. This allows users to narrow a search within a single index field to get more concise and accurate results.

**reason audit mode**
When the AppXtender administrator selects the Reason Code option for ApplicationXtender, all document creation, printing, e-mail, and export actions are audited. With Reason Code selected, when printing, e-mailing, and exporting documents, users are required to enter a comment explaining the reason for the action and to indicate which function they intend to use.

**redactions**
A redaction is a filled and opaque annotation shape, which can be used to secure or hide portions of image and text document pages. Users can apply redaction to all available shapes: lines, freehand lines, arrows, rectangles, rounded rectangles, and ovals. When applied, the area of the page behind the redaction is not visible.
S

security
Security is the combination of authentication and authorization.

security provider
Security providers implement authentication, which requires all users to enter a valid user name and password to access most modules. ApplicationXtender offers two pre-packaged security providers (CM and Windows) to ensure that each user is who he or she claims to be.

configuration option settings
Settings available from the Settings dialog box that allow authorized users to configure ApplicationXtender functionality based on their specific work requirements. Configuration option settings are saved on the ApplicationXtender server as part of the user profiles.

W

wildcard query
A query in which a single asterisk (*) is used as a wildcard in search criteria to match one or more characters. This allows users to control the number of documents returned in a result set by narrowing search results.

write paths
Write paths are used to instruct ApplicationXtender where to store documents, annotations, OCR output, and the ProIndex full-text database for a particular AppXtender application.
Symbols

_FORMS application
  create documents 170
  index fields 172
_RSTAMP application
  create documents 170
  index fields 171

A
Acrobat Reader
  view PDF files 112
activating
  application 64
  data source 64
ActiveX embeddable objects, inserting 359
actual scale. See actual size
actual size 324
  display image 348
actual size display, as default 111
add
  focus 551
  new document 161
  ODMA document summary attributes 450
  page 356
  rubber stamp 512, 513
adding
  toolbar buttons 92
advanced registration 548
  horizontal/vertical 551
  add focus 551
  central focus 551
  find line for register 552
  ignore holes 552
resultant left 552
top margin 552
advanced sub image 576
  bottom edge 578
  left edge 578
  right edge 578
  top edge 578
allowing
  docking 100
  map of unknown data sources to existing 112
annotation group
  assigning to annotation 516
  hiding 518
  setting default 517
  toolbar button 78, 79
annotation selection toolbar button 77, 526
annotation toolbar 77
Annotation toolbar buttons
  Rubber Stamp 80
annotation toolbar buttons 77
annotation group 78, 79
annotation selection 77, 526
arrow 77, 494
  bring to front 78, 79
  cancel changes 80
  color 80
  delete annotations 80
eraser 78, 79, 536
  fill 78, 79
  freehand line 77, 494
hide annotations 78, 79
highlight 77
  line width 78, 79
oval 78, 79, 496
polygon 78, 79
polyline 78, 79
rectangle 78, 79, 496
redaction 78, 79
rounded rectangle 78, 79, 496
save annotations 80
select all 78, 79, 526
send to back 78, 79, 515
straight line 77, 494
text annotation 77
Annotation toolbar, enabling display 91
annotations 18
arrows 493
assigning annotation group 516
basic lines 493
basic shapes 496
configuring 488
creating 492
default color
for line and shape 489
for text 529
deleting 537
e-mail document 521
erasing 536
export document 523
filled or hollow 490
freehand lines 493
hiding annotation group 518
highlight 498
lines 493
modifying 525
shape 527
text 531
move 515
to the back layer 515
to the front layer 515
ovals 496
overlapping 515
polygons 497
polyline 494
print document 520
printing text annotation 535
properties, changing 525
rectangles 496
redactions 491
resizing 527
rounded rectangles 496
rubber stamp 512
saving 487
selecting 526
setting default annotation group 517
shape 496
straight lines 493
text 499, 512
types 486
application
activating 64
definition 19
hide 63
module for managing 25
ODMA compliant 482
open to search 454
querying 248
show 63
views 61
AppXtender 40
ODMA support 439
on your network 31
SDK 82
starting 50
AppXtender
configuring 87, 109
desktop, customizing 99
AppXtender AppGen 25
AppXtender AppGen. See Application Generator
AppXtender Archive Wizard 28
AppXtender Auto Index Import Wizard 27
AppXtender Index Image Import Wizard 26
AppXtender Index Server 26
AppXtender Migration Wizard, description 28
AppXtender Queue Manager 28
AppXtender Reports Mgmt
definition 19
AppXtender Reports Mgmt reports
open 293
query 290
view 292
AppXtender views
Applications 61
customize 99
display as dialog box 101
display as subwindow 102
docking 99
Document Display 67
hiding on use 103
Index 68
Query 64
Workflow 71
AppXtender Web KeyView Comp
view foreign files 339
AppXtender Workflow
password change 88
submit documents 419
ArchiveXtender - Ascent Storage Edition
as document storage server 24
ArchiveXtender - Ascent Storage Edition
Configuration 29
arrow annotations 493
arrow toolbar button 77, 494
ascending order, as default 116
assigning annotation group 516
attach
all toolbar button 83
feature
AX result set 194, 195
page toolbar button 83
author, search by 257
auto enhance toolbar button 85
auto feed toolbar button 85
auto-index
table 27
with dual data entry 191
automatic features
appending to existing document 86, 189
cropping 579
deskewed characters, protecting 548, 557
dots, removing 553
enhancing images during scan 85
full-text indexing new documents 206
hiding a view on use 103
indexing
using auto-index 27, 86, 189, 190, 191
using existing index data 86, 189, 195
using key reference 26, 189, 192, 369
using last index saved 86, 189, 195
using unused Key Reference records 86
KeyView Viewer 112
lines, removing 561
noise, removing 553
OCR
using during full-text indexing 207, 411
registering an image 548
rotating pages during scan 85, 221
saving desktop layout on exit 113
scanning all pages in feeder 85, 217
setting tab size 349
shading, removing 553
skew, removing 544
view settings, applying to page types 97, 318
automatically logging in 53
AX views
Thumbnail 72

B
back page, rotation during scan 85, 221
band width, color bar 337
basic annotations
lines 493
shapes 496
batch
create by fax-in 183
deleting 433
index 200
index from a list 202
resetting status 204
single index 200
batch import
creating a file 175
creation 181
log 181
performing 179
utility 174, 181
batch index toolbar 83
batch index toolbar buttons 83
attach all 83
attach page 83
delete page 83
new document 83
next page 83
previous page 83
bi-tonal image enhancement 539, 540
default settings 542
blank pages
removing while scanning 223, 227
bring to front toolbar button 78, 79
building full-text search expressions 262
buttons, toolbar
  adding 92
  annotation group 78, 79
  annotation selection 77, 526
  applications view 75
  arrow 77, 494
  attach all 83
  attach page 83
  auto enhance 85
  auto feed 85
  back rotation 85
  bring to front 78, 79
  cancel changes 80
  cascade 76
  change size 92
  color 80
  configuration 76
  copy 76
  customizing 92
  cut 75
  delete annotations 80
  delete page 83
  EmailXtender Search 76
  eraser 78, 79, 536
  fill 78, 79
  fit height 80
  fit to window 80
  fit width 80
  form overlay 82
  freehand line 77, 494
  front rotation 85
  full screen 76
  hide annotations 78, 79
  hide index 70
  highlight 77
  Index View 70
  Index view 82
  line width 78, 79
  magnifier 81
  manual feed 85
  new CAQ query 75
  new document 75, 83
  new query 75
  next page 81
  next subpage 82
  next version 81
  OCR page 81
  oval 78, 79, 496
  pan mode 68, 81
  paste 76
  polygon 78, 79
  polyline 78, 79
  previous page 81, 83
  previous subpage 82
  previous version 81
  print 75, 379, 381
  query view 75
  rectangle 78, 79, 496
  redaction 78, 79
  removing 92
  rescan 85
  rotate left 80
  rotate right 81
  rounded rectangle 78, 79, 496
  Rubber Stamp 80
  Run Query 75
  save annotations 80
  scan 85
  scan document 76
  scanner setup 85
  select all 78, 79, 526
  select scanner 76
  selection mode 68
  send to back 78, 79, 515
  show text 81
  single feed 85
  sticky view 80
  straight line 77, 494
  text annotation 77
  text search 76
  thumbnail view 75
  tile horizontally 76
  tile vertically 76
  workflow view 75
  zoom in 81
  zoom out 81

C
  cancel
    check out 427, 480
  cancel changes toolbar button 80
  cascade
document windows 76, 316
toolbar button 76
cell height
change 65, 70
restore 65, 70
Centera
applying retention holds 591
filing documents for retention 586
identifying applications 585
removing a retention hold 593
central focus 551
change cells
Query view 65, 70
change password
ApplicationXtender 88
AppXtender Workflow 88
change toolbar button size 92
changing
font of rubber stamp 508
character
protection 557
check in
definition 41
document 426, 473
major revision 476
minor revision 477
new document 452
new page version 478
open document 462
replacement page version 479
check in, definition of the term 280
check out
cancel 427, 480
definition 41, 462
definition of the term 280
document 283
open document 464
check out mode, open document 286
checked out documents
close 471
save 470
working with 469
checking for updates 57
clear
all regions 331
one region 331
clipboard
paste special, new document 153
paste special, new page 358
clockwise, rotating an image 324
close
checked out documents 471
COLD
display as image only 333
documents, configuring 335
documents, definition 19
files 35
collapse columns 108
color bar
color, setting 337
enabling for text 335
width in lines, setting 337
color of annotations
configuring 489, 529
modifying 525
color toolbar button 80
column
hide in result set 106
insert into search 258
order in result set 107
save in result set 107
show in result set 106
widths in result set 107
comment, search by 257
compound queries 258
compression, viewing type for a page 354
concepts 18
configuration
load 133
toolbar button 76
configuring
annotation colors 489, 529
annotation line width 489
annotation rubber stamps 503
annotations 488
ApplicationXtender 87
ApplicationXtender password 88
AppXtender Image Capture workstation 109
AppXtender Workflow password 88
AX workstation 109
COLD/ERM settings 335
data sources 30
display settings 114
document display 93
fonts 117
Index

image enhancement settings 542
multiple data sources 48
ODMA support in AppXtender 440
printer fonts for COLD/ERM documents 382
printer fonts for CX/ERMX documents 119
scaling 110
scanner properties 216
scanner selection 214
scanning 121
status bar 95
thumbnails 311
title bar 93
toolbars 91
view settings 110
viewer for foreign files 338
workstation 87
zoom 110
content management 355
copy
  existing index information to a new document 195
  index values 196, 251
  regions to clipboard 330
toolbar button 76
counterclockwise, rotating an image 324
create
document
  in batches 139
  one at a time 138
creating
  annotations 492
  document toolbar button 75
creator, search by 257
crop
  intelligent 579
  manual 571
  ScanFix advanced settings tab 572, 575, 577,
  580
cross app query 265
crop
  create new 265
  modify 273
  perform 270
  run 271
Ctrl key 431
customize
  AppXtender views 99
customizing
toolbar buttons 92
cut toolbar button 75
cutting a page 431

D
data field
  definition 193
  modifying for existing document 369
data source
  unknown 112
data sources 44
  activating 64
  configuration module 30
default 47
  locating 45
  multiple 48
  multiple, login 55
  specify default 47
data types
  supported in AppXtender 33
default
  actual size 111
  ascending order 116
data sources, specify 47
  descending order 116
  fit left to right 111
  fit to window 111
  fit top to bottom 111
default annotation group 517
definition 18
  annotation 18
  application 19
  AppXtender Reports Mgmt 19
  check in 41
  check out 41, 462
  COLD 19
data field 193
document 20
document revisions 473
full-text 21
index 21
key field 193
normal mode 42
ODMA 43
page 22
read-only mode 461
definition of terms
    check in 280
    check out 280
    grab bar 99
    normal document display mode 282
    normal mode 281
    query 246
    read-only mode 282
delete
    annotations 537
    annotations toolbar button 80
    batch 433
    document 432
    from the document menu 433
    from the page menu 430
    from the query result set 432
    from thumbnail view 431
    page 430, 431
    page toolbar button 83
    page version 428, 429
    page, by cutting 431
    query 306
    revision 423
descending order, as default 116
de-skew
    ScanFix advanced settings tab 545
    text 544
de-speck 557
    horizontal 559
    isolated 560
    vertical 560
dialog boxes, display views as 101
direction
    text search 299
disabling remember password option 89
DiskXtender
    as document storage server 24
Display 338
display
    as icon
      ActiveX object 342
      text annotation 500
    document 67, 308
duplicate document 317
next page 309
palette 347
previous page 309
scale 321
scrollbars 345
setting defaults for page types 97, 318
status bar 95
thumbnails 311
toolbars 92
display settings, configuring 114
document
    add 161
    check in 426, 473
    configure display 93
    create
      shortcut 312
    through ODMA 442
    create new 140
definition 20
deleting 432
deleting from query result set 432
display 93, 276, 278, 308
displayed 33, 67
duplicate 317
e-mail 383
e-mailing with annotations 521
e-mailing without annotations 521
entering properties 448
exporting 392
    with annotations 523
    without annotations 523
fax-in queue 167
faxing 374
faxing from display 377
faxing from the result set 374
import 161
index 187
index view 369
mailing 387
new
    check in 452
    ODMA attributes 450
    open
      in check out mode 286
      in normal mode 283
    open from the result set 458
    open with ODMA 443
    printing 374, 377
      with annotations 520
      without annotations 520
properties 344
  general tab 448
  index tab 451
  summary tab 450
read-only
  in normal mode 284
retrieval 244
retrieve through ODMA 453
revision history 423
revisions, definition 473
save new ODMA documents to AppXtender 445
search 456
stored 33
submit
  OCR queue 407
  to AppXtender Workflow 419
text searches 298
  from document display view 298
to index 451
view 308
  from unknown data source 295, 297
  with form overlay 333
view properties 277, 421
working with checked out 469
document level security 25
document properties
  general tab 344
  image tab 346
  OCR tab 350
  revision history 423
  text tab 348
DPI resolution setting
  scan 219
DPI, screen 114
drag-and-drop methods
  foreign file document 163, 165
  foreign file page 364
  import file document 163, 165
  importing file page 364
drawing a region 327
driver
  select for scanner 221
dual data entry 198
  with auto-index 191
duplicate document 317

E
calculate cleaning factor 565
edit
  menu, in magnify window 329
editing
  query 304
e-mail
  documents 383
  documents with annotations 521
  documents without annotations 521
  page 391
  pages 383
EmailXtender
  search 76
toolbar button 76
enhancement
  of images 539, 540
  options, bi-tonal images 543
erase annotations 536
eraser toolbar button 78, 79, 536
ERM
  display as image only 333
  files 35
export
  document
    with annotations 523
    without annotations 523
document to file 393
documents 392
  multiple text documents to single file 397
  page 392, 400, 401
  page to a file 400
to a file 393
to an XPS file 395, 399
to OCR 395, 401

F
F1 function key 86
F3 function key 86
F4 function key 86, 189
F5 function key 86, 255, 256
F7 function key 86, 189, 190
  using auto-index to index documents 191
F8 function key 86, 253, 254
F9 function key 86, 189, 195
fax
batch create 183
document 374
  from display 377
  from the result set 374
  from page menu 379
  pages 379
fax-in queue
  new document 167
  new page 365
fax-out
  documents 374
  pages 379
feed
  manual 217
  single 217
field values, list query 256
file
  batch import format 176
  import 160
file menu
  in magnify window 329
  print command 96
file types
  COLD 35
  ERM 35
  foreign 38
  hypertext markup language (HTML) 37
  portable document format (PDF) 37
  supported 33, 34, 143
  text 35
fill
  modifying for an annotation 525
  toolbar button 78, 79
find
  line for register 552
  text 299
fit
  left to right, as default 111
  toolbar button 80
fit to window 323
  as default 111
  toolbar button 80
fit to window height 323
fit to window width 323
fit top to bottom
  as default 111
  toolbar button 80
float as MDI window 102
font
  changing for rubber stamp 508
  fonts 382
    configuring 117
    configuring for zoom feature with text 322
  printer 119
fonts tab 117
foreign files
  adding as page 363, 364
  closing 341
  importing 363, 364
  KeyView Viewer 112
  launching 339
  saving 342
  types 38, 144
  updating 341
  view 338
  view as icons 339
form overlay 19
  modifying 334
  toolbar button 82
  view documents 333
freehand line annotations 493
  toolbar button 77, 494
front page, rotation during scan 221
full screen 104
  toolbar button 76
full-text
  AppXtender Index Server 26
  building search expressions 262
  definition 21
  query 260
  search functionality
    module for accessing 26
    search results, view 294
function keys
  F1 86
  F3 86
  F4 86, 189
  F5 86, 255, 256
  F7 86, 189, 190
  F8 86, 253, 254
  F9 86, 189, 195
fuzzy
  logic 299, 300
  search 300
Index

G

general tab 448
GIF animation files 176
go to page 309
  in a displayed document 310
grab bar, defined 99
grayscale, display as 111
green bar
  enabling for text 335

H

heading
  creating non-scrollable in text page 335
height
  change Query view cells 65, 70
  minimum 556
hide
  annotation groups 518
  annotations 518
  application 63
  index toolbar button 70
  Index View toolbar button 70
  result set columns 106
  status bar 95
Hide Annotations toolbar button 78, 79
hide on use 103
highlight annotations 498
Highlight toolbar button 77
horizontal
  de-speck 559
  margin alignment 551
HTML file 37

I

ignore
  case 299, 300
  holes 552
image
  bi-tonal enhancement 539, 540
  enhancement 539, 540
  configuring 542
  options 543
  referencing in batch import file 176
  rotating 324
  left 324
  right 324
  size options 110
  sub, advanced 576
    bottom edge 578
    left edge 578
    right edge 578
    top edge 578
  view 81
image toolbar 80
Image toolbar buttons
  Index View 70
  Index view 82
image toolbar buttons 80
  fit height 80
  fit to window 80
  fit width 80
  form overlay 82
  hide index 70
  magnifier 81
  next page 81
  next subpage 82
  next version 81
  OCR page 81
  pan mode 68, 81
  previous page 81
  previous subpage 82
  previous version 81
  rotate left 80
  rotate right 81
  selection mode 68
  show text 81
  sticky view 80
  zoom in 81
  zoom out 81
Image toolbar, enabling display 91
import
  AppXtender Auto Index 27
  as input method for turnkey apps 161
  batch 174
  file 160
  file format 176
  foreign file format 363, 364
  index image 26
  multiple files 179
  specifications, module for configuring 25
  used to add a new page 364
import file
as input method for turnkey apps 509
index
  appending pages 195
  auto-index table 191
  batch from a list 202
  batches 200
  copy values 196
  definition 21
  dual data entry 198
  entering and saving 225
  hide index toolbar button 70
  Index View toolbar button 70
  key reference table 192
  modifying 369
  new documents 187
  parsing MICRE codes into 190
  paste values 196
  query 251
  saving 163
  single batch 200
  using last index saved 195
  validation 197
index field
  _FORMS application 172
  _RSTAMP application 171
index import types
  auto-index 27
  key reference 26
index saving information 510
index server
  submit from document menu 207, 413
  submitting from the result set 412
index tab 451
Index view 68, 369
  toolbar button 82
insert
  column into search 258
  object 155
introduction 17
inverse text
  ScanFix advanced settings tab 565

K
key field
  definition 193
  modifying for existing document 369
key reference 190
  able 26
  import wizard 26
  modifying existing index data 369
  using to index documents 192
keyboard keys
  Ctrl 431
  F1 86
  F3 86
  F4 86, 189
  F5 86, 253, 254
  F7 86, 189, 190
  F8 86, 253, 254
  F9 86, 189, 195
  Page Down 114
  Page Up 114
  Shift 53, 431
  Tab 190
KeyView Viewer
  view foreign files 112
keyword, search by 257

L
layout, restore previous 113
left, rotating an image 324
length, detect minimum 547
line
  annotations 493
  gap 552
  removal 561
  report, text search 301
width
  color bar 337
  configuring for annotations 489
  modifying for an annotation 525
  toolbar button 78, 79
list of values 255
load
  workstation settings 133, 134
  AppXtender cannot log in 133
locating
  data sources 45
log, batch import 181
logging in automatically 53
login
  AppXtender, cannot 133
Index

dialog box 54
multiple data sources 55
new 53

M
magnifier toolbar button 81
magnifying a region 328
edit menu 329
file menu 329
mail
document 387
page 391
main toolbar 74
Main toolbar buttons
Run Query 75
main toolbar buttons 74
applications view 75
cascade 76
configuration 76
copy 76
cut 75
EmailXtender Search 76
full screen 76
new CAQ query 75
new document 75
new query 75
paste 76
print 75, 379, 381
query view 75
scan document 76
select scanner 76
text search 76
thumbnail view 75
tile horizontally 76
tile vertically 76
workflow view 75
Main toolbar, enabling display 91
major revision 475
checking in a new document 476
make
private query 305
public query 305
managing
Result Set 104
manual
crop 571

feed 217
toolbar button 85
manual feed
scanner timeout 123
map
unknown data sources 112
maximum
acceptable skew 547
line gap 564
line thickness 564
maximum number of results 115
MICRE codes, parsing 190
minimum length of a line
line removal 564
minor revision 475
checking in a new document 477
mode
check in 41
check out 41
choose 461
display, select 280
normal 42, 281
normal document display 282
pan mode toolbar button 68
read-only 282
scanning 219
selection mode toolbar button 68
modifying
shape annotations 527
text annotations 531
monitoring for updates 59
move to front toolbar button 515
multiple
data sources 48
data sources, login 55
documents, displaying simultaneously 316
file import 179

N
network 31
new
cross app query 265
login 53
object 360
new CAQ query
toolbar button 75
new document
check in 452
copying existing index information 195
creating 140
from fax-in queue 167
from imported file 160
index 187
toolbar button 75, 83
new page
from fax-in queue 365
from imported foreign file 363, 364
new page version
add 368
view 314
new query 248
toolbar button 75
next page 309
toolbar button 81, 83
next search result 295
next subpage
toolbar button 82
next version toolbar button 81
noise removal
ScanFix advanced settings tab 553, 557
normal mode 42
definition 281, 282
open document 283

O
object
create new 360
insert from file 361
inserting in documents 155
OLE 39
OCR
displaying text 332
document submit to queue 407
exporting to 395, 401
proofing 187
submitting to index server 207, 411
toolbar button 81
OCR Result Format setting
document 351
ODMA
AppXtender support 439
attributes, search by 257
compliant application 482
configuring support 440
create document 442
definition 43
file support 149
open non-AppXtender documents 443
retrieve document 453
save new ODMA documents to AppXtender 445
view properties 461
OLE objects 39
close 343
edit 343
return to 343
view 342
opacity
modifying for an annotation 525
open
AppXtender Reports Mgmt reports 293
document
in check out mode 286
in normal mode 283
in read-only mode 284, 465
that is checked in 462
that is checked out 464
non-AppXtender documents 443
opening
AppXtender configuration 109
origin 299
oval annotations 496
oval toolbar button 78, 79, 496
owner, search by 257

P
page
adding a new 356
adding an Active X object as a 359
adding an import file as a 363
adding from the scanner 227
appende by scanning 228
cutting 431
definition 22
displaying from the thumbnail view 312
exporting 392, 400
faxing 379
go to in a displayed document 310
importing a foreign file as a 363, 364
inserting by scanning
  after current page 228
  before current page 227
print command 379
selecting 309
  next page 309
  previous page 309
sending by e-mail 383, 391
Page Down key 114
page numbers, adding 379
page size
  scan 220
Page Up key 114
page version
  adding 368
  deleting 428
  purging 429
  viewing 313
palette, display 347
pan mode toolbar button 68, 81
parsing MICRE codes 190
password
  change 88
  configuration 88
  disabling 89
  remember option 53, 56
paste
  index values 196, 251
  toolbar button 76
PDF files 37
  Acrobat Reader 112
  print document 377
  print page 379
pick a data source 296
pixels, viewing number of for a page 353
pointer mode
  pan mode toolbar button 68
  selection mode toolbar button 68
polygon
  annotations 497
  toolbar button 78, 79
polyline
  annotations 494
  toolbar button 78, 79
Portable Document Format file. See PDF files
previous
  page 309
  search result 295
previous page toolbar button 81, 83
previous subpage toolbar button 82
previous version toolbar button 81
print
  configure fonts for COLD/ERM and ASCII
documents 382
document 374, 377
  with annotations 520
  without annotations 520
endorsement feature 379
from file menu 96
from page menu 379
page 379
PDF document 377
PDF page 379
region 381
text annotation 535
toolbar button 75, 379, 381
printing
  configuring fonts for CX/ERMX and ASCII
documents 119
properties
  document revision history 423
  entering 448
  view document 277, 344
protection
  character 557
  horizontal 559, 560
  purging page versions 429
Q
query
  AppXtender Reports Mgmt report 290
  by index 251
  combination 264
  compound 258
  create new 248
  cross app 265
    create new 265
    modify 273
    perform 270
    run 271
definition 246
delete 306
edit 304
expression range 253
full text 260
list of values 255
make private 305
make public 305
new CAQ query toolbar button 75
new query toolbar button 75
rename 306
result set tab 275
results 115
run 304
save 303
wildcard 251
query result set
collapsing the columns 108
deleting from 432
e-mailing documents from 384
exporting COLD/ERM documents from 397
faxing documents from 374
hiding columns 106
printing documents from 374
reordering the columns 107
resizing the columns 107
saving the columns 107
showing columns 106
sorting 106
Query view 64
change cell height 65, 70
restore cell height 65, 70
toolbar button 75
QuickScan Pro
configuring export profiles 232
document batch 237
single document 232
creating export profiles 229
integrated with ApplicationXtender 229
R
range of values, searching by 253
read-only mode
definition 282, 461
open document 284, 465
that is checked out by someone else in 467
that is checked out by you in 466
that is not checked out in 465
reconstruction width/height 565
rectangle annotations 496
toolbar button 78, 79, 496
redaction 491
modifying for an annotation 525
toolbar button 78, 79
reference file fields
key reference feature 26
regions 326
clear all 331
clear one 331
copy to clipboard 330
drawing 327
magnify 328
print 381
registration
ScanFix advanced settings tab 548
skip 553
remember password 53, 56
remove
blank pages while scanning 223, 227
skew 544
speck 557
Remove Blank Pages 121
removing
toolbar buttons 92
rename query 306
reorder columns 107
replace page 367
rescan 225
toolbar button 85
reset
result set columns 107
status of a batch 204
resize
annotations 527
columns 107
resolution
setting for scanning 219
restore cell height
Query view 65, 70
restore last layout at startup 113
result set 275
auto-index 192
changing document list 105
collapsing columns 108
faxing documents from 374
hiding columns 106
managing 104
matching index records 194, 195
opening a document from 458
reordering columns 107
resetting columns 107
resizing columns 107
saving as a text file 424
saving columns 107
shortcut menu 421, 424
showing columns 106
sort automatically 115
sorting 106
tab 249
text search 300
view 64
resultant left 552
retrieving documents 244
revision
delete 423
history 423
major 475
minor 475
right, rotating an image 324
right-click context menu 345
rotate
image to the left 324
image to the right 324
toolbar button, back 85
toolbar button, front 85
toolbar button, left 80
toolbar button, right 81
using 324
rounded rectangle annotation 496
toolbar button 78, 79, 496
rubber stamp
change font 508
configuring annotations 503
creating 503
from a file 509
customize 506
default settings 506
format 505
reset 506
rubber stamp annotations 512
add 512, 513
Rubber Stamp toolbar button 80
rubber stamps
creating 170
Run Query
toolbar button 75
run query 304
save
annotations
toolbar button 80
changes to a document and keep it checked out 479
checked out documents 470
columns 107
new ODMA documents to AppXtender 445
query 303
result set as a text file 424
settings 124
sticky view settings 98
workstation settings 125
saved query
deleting 306
editing 304
make private 305
make public 305
scale to gray 111, 326
scaling 321
scaling, configuring 110
scan
synchronized 123
Scan toolbar 84
Scan toolbar, enabling display 91
scanner
list of those supported 214
properties, configuring 216
settings 221
scanner timeout
manual feed 123
scanning
adding a new page 227
configuration 121
enabling image processing 121
manual feed 217
mode 219
page size 220
removing blank pages 223, 227
rescanning 225
resolution 219
rotation 221
select scanner 214
single feed 217
source 220
supported scanners 214
synchronized 217, 223, 227
toolbar buttons 84
  Auto Enhance 85
  Auto Feed 85
  Back Rotation 85
  Front Rotation 85
  Manual Feed 85
  Rescan 85
  Scan 85
  Scan Document 76
  Scanner Setup 85
  Select Scanner 76
  Single Feed 85
scope, text search 299
screen
  DPI 114
  resolution 348
script toolbar 82
  buttons 82
scrolling 81, 345
SDK 82
search
  by ODMA attributes 257
  deleting 306
  document text 298
  editing 304
  EmailXtender 76
  expression 253
  for documents 244, 456
  for text from Document Display view 298
  for text from query result set 300
  list of values 255
  make private 305
  make public 305
  opening an application 454
  run query 304
  saving 303
  string 300
  tab 64, 248
text search toolbar button 76
  using a wildcard 251
  wildcards in text searches 301
  with list 256
security 50
  login dialog box 54
  module for configuring 25
select
  annotations 345, 526
  toolbar button, all 526
  display mode 280
  image 345
  pages 309
  next page 309
  previous page 309
  region 81
  scanner 214
  toolbar button 76
  view mode 327
select all
  toolbar button 78, 79
selection mode toolbar button 68
send to back toolbar button 78, 79, 515
server, index 26
setting default annotation group 517
settings
  annotations 488
  load when AppXtender cannot log in 133
  vertical adjustment 552
  workstation, load 133, 134
  workstation, save 124, 125
shape annotations 496
Shift key 53, 431
shortcuts
  create 312
show
  all hits on this page 295
  annotations 518
  application 63
  columns 106
  Index View toolbar button 70
  status bar 95
  thumbnails 311
show text toolbar button 81
single batch indexing 200
single batch indexing 217
single feed 217
toolbar button 85
size
  adjust, horizontal 556
  adjust, vertical 556
  change for toolbar buttons 92
  maximum for dots 557
skew, maximum acceptable for images 547
smooth characters in an image 568
sort
  ascending order 116
  descending order 116
  order of document id 116
  result set 106
  result set automatically 115
source
  scanning 220
speck
  removal 557
  removal, horizontal 559
  removal, vertical 560
split view 317
status bar
  configuring 95
  enabling display of 95
  hiding 95
  showing 95
sticky view 318
  save settings 98
  switching settings 319
  toolbar button 80
storage
  device for AppXtender documents 23
straight line annotation 493
tab key 189, 190
text
  color bar 335
  display OCR text 332
  exporting multiple documents to a single file 397
  file for batch import 174
  files 35
  string in searches 261
  view pages 333
  viewing 81
text annotations 499
  printing 535
  spell-checking 500, 502
  toolbar button 77
text searches
  document 298
  from document display view 298
  from result set 300
  toolbar button 76
  wildcard characters 301
third-party software programs 40
Threshold slider 121
thumbnail view 75
  toolbar button 75
thumbnails
  always displaying 311
  configuring 311
  display 311
  display page 312
  view 310
tile
document windows 316
  toolbar button, horizontally 76
  toolbar button, vertically 76
timeout
  scanner manual feed 123
title bar
  configuring 93
title, search by 257
toolbar buttons
  annotation group 78, 79
  annotation selection 77, 526
  applications view 77
  arrow 77, 494
attach all 83
attach page 83
auto enhance 85
auto feed 85
back rotation 85
bring to front 78, 79
cancel changes 80
cascade 76
change size 92
color 80
configuration 76
copy 76
cut 75
delete annotations 80
delete page 83
EmailXtender Search 76
eraser 78, 79, 536
fill 78, 79
fit height 80
fit to window 80
fit width 80
form overlay 82
freehand line 77, 494
front rotation 85
full screen 76
hide annotations 78, 79
hide index 70
highlight 77
Index View 70
Index view 82
line width 78, 79
magnifier 81
manual feed 85
new CAQ query 75
new document 75, 83
new query 75
next page 81, 83
next subpage 82
next version 81
OCR page 81
oval 78, 79, 496
pan mode 68, 81
paste 76
polygon 78, 79
polyline 78, 79
previous page 81, 83
previous subpage 82
previous version 81
print 75, 379, 381
query view 75
rectangle 78, 79, 496
redaction 78, 79
rescan 85
rotate left 80
rotate right 81
rounded rectangle 78, 79, 496
Rubber Stamp 80
Run Query 75
save annotations 80
scan 85
scan document 76
scanner setup 85
select all 78, 79, 526
select scanner 76
selection mode 68
send to back 78, 79, 515
show text 81
single feed 85
sticky view 80
straight line 77, 494
text annotation 77
text search 76
thumbnail view 75
tile horizontally 76
tile vertically 76
workflow view 75
zoom in 81
zoom out 81

Index

toolbars

adding buttons 92
annotation 77
batch index 83
configuring 91
customizing 92
display 92
enabling display 91
image 80
main 74
removing buttons 92
scan 84
script 82
top margin 552
troubleshooting, indexing 209
truetype font, using with zoom feature 322
unknown data source  112
updates
    checking for  57
    monitoring for  59
use multi-page files option  395
user
    enter password  50
    login  54

validation, index  197
versions
    adding new page version  368
    check in
        new page  478
        replacement page  479
    deleting  428
    new page  476
    newest  314
    next  314
    oldest  314
    previous  314
    replace page  476
    viewing page  313
vertical adjustment
    margin alignment  552
    line gap  552
    registration skip  553
    settings  552
vertical de-speck  560
vertical tiling
    tile horizontally toolbar button  76
    tile vertically toolbar button  76
view
    AppXtender Reports Mgmt reports  292
    document properties  277, 421
    documents  308
        from unknown data source  295, 297
duplicate document  317
foreign files  338
    as icons  339
    with AppXtender Web KeyView Comp  339
full-text search results  294
index  68

next page  309
OLE objects  342
options, full screen  104
previous page  309
properties from the ODMA result set  461
sticky  318
text pages  333
thumbnails  310, 311
view settings, configuring  110
view tab  110
views
    Applications  61
display as dialog box  101
display as subwindow  102
docking  99
Document Display  67
hiding on use  103
Index  68
Query  64
Thumbnail  72
Workflow  71
volume label, using in batch import file  178

width
    color bar lines  337
    minimum area  556
wildcard  251
    in batch import text file  179
    in text searches  301
searchable data types  252
windows clipboard
    paste special, new document  153
    paste special, new page  358
wizards
    AppXtender Archive  28
    AppXtender Auto Index Import  27
    AppXtender Index Image Import  26
    AppXtender Key Reference Import  26
workflow view  71
toolbar button  75
workstation
    load settings  134
    save settings  125
workstation, configuring  87
Z
zoom 321
  configuring 110
  in 322
  out 322
  percent 323

  ratio 345
  settings as pixels 111
  to percent 322
  zoom in toolbar button 81
  zoom out toolbar button 81
  zoom percent 111